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Limited Warranty on Media and Replacement 
If you discover physirnl def eels in the manuals dis1ribu1ed wilh an Applt: product or in 
the media on which a soflwarc product is distributed, Apple \\'ill replace the media or 
manuals at no charge to you. prol'ided you return the item to be replaced "ith proof of 
purcha:.<: to Apple or an authorizL'CI Apple dealer during the 90·day period after you 
purcha.'>(.'CI the software. In addition. Apple wiU replace damaged software media anti 
manuals for as long as the soft\\ arc product is included in Apple's \lctlia Exchangt: 
Program. While not an upgrade or update method. this program offers additional 
protection for two years or more from the date of )'Our original purchase. Sec your 
authorized Apple dealer for program cm·erage and details. In some countries lhe 
replacemenl period may be difforcnt; check with your authorized Apple dealer. 

All IMPLIED WARRANTIES ON THE MEDIA AND MANUAIS, INUUDING 
IMPLIED WARRANTIES OF MERCHANTABllllY AND FIT~ FOR A 
PARTICUIAR PURPOSE, ARE LIMITED IN DURATION TO NINE1Y (90) DAYS 
FROM THE DATE OF THE ORIGINAL RETAil. PURCHASE OF THIS PRODUCT. 

b ·en though Apple has tl!Sted the software and rel'iewc:d tht: documentation, APPLE 
MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESSED OR 
IMPLIED, WITII RESPECT TO SOFIWARE, ITS QUALITY, PERFORMANCE, 
MERCHM"L\BllllY, OR FITNF.SS FOR A PARTICULAR PURPOSE. AS A RESULT, 
THIS SOFIWARE IS SOLD "AS IS," AND YOU, THE PURCHASER, ARE ASSUMING 
THE ENTIRE RISK AS TO ITS QUALITY A.VD PERFORMANCE. 

JN NO EVENT Will APPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT 
IN THE SOFI'WARE OR ITS DOCUMENfATION, el'en if adriscd of the possibility of 
such damages. In panicular. Apple ~hall have no liabili1y for any programs or data 
stored in or used with Apple products, including the cosls of rcrn1•cring such programs 
or data. 

THE WARRANfY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN 
LIEU OF All OTHERS, ORAL OR WRITI'EN, EXPRESSED OR IMPLIED. 'lo Applt' 
dealer. agent. or employee is authorized to make any modification. exten.~ion. or 
addition to this warranty. 

Some states do not allow the exclusion or limi1.1tion of implk'CI warranties or li:tbilit1 for 
incidental or consequential damages. so the abo1·c: limitation or exclusion mai nOl 
apply to you. This warrant) giws you specific legal rights. and \'OU may also h;11 t' other 
rights which l'ary from state to state. 

lmponant 

This equipment has IJt:cn teslt:d anti found to rnmply with the limits for a Class 13 
digital de1·ice in accordance with the specilkallons in Pan 15 of FCC rules. See 
instructions if intt>rft:rence to radio or tde1·ision rel·eption is suspected. 

DOC Class B Compliance This digi1;1) appar.uus docs nm exceed the Class B limits 
for radio noise emissions from digital appamni- sci out in the r.1dio interference 
regulations of the Canadian Depanment of Communications. 

Observation des normes-Classe B Le present appareil numerique 11°emet pas de 
bruits radioelt::ctriques depassant Jes limiies applicablcs aux appardls numeriques de la 
Classc B prescriles dans Jes reglemcnts sur le hrouill:tge radioelec1rique cdictcs par le 
i\linistere des Communications du C:mada. 
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Radio and television interference 

The equipment described in this manual generdtes. uses. and can radiate 
radio-frequency energy. If ic is not installed and used properly-that is, in strict 
accordance with Apple's instructions-it may cause interference with radio and 
television reception. 

This equipment has been reseed and found to comply with the limits for a 
Class B digital device in accordance with the specifications in Part 15 of FCC 
rules. These specifications are designed to provide reasonable protection 
against such interference in a residential installation. However, there is no 
guarantee that interference will noc occur in a particular installation. 

You can determine whether your computer system is causing interference by 
turning it off. If the interference stops. it was probably caused by chc computer 
or one of the peripheral devices. 

If your computer syscem does cause interference to radio or tele,·ision 
reception, try to correct the interference by using one or more of the following 
measures: 

• Turn the television or radio antenna until the interference stops. 

• Move the compuccr to one side or the other of the television or radio. 

• Move the computer farther away from the television or radio. 

• Plug the computer into an outlet that is on a different circuit from the 
television or radio. (That is, make certain the computer and the television 
or radio are on circuits controlled by different circuit breakers or fuses.) 

If neo.~ssary. consult your authorized Apple dealer or an experienced 
radio/television technician for additional suggestions. Ybu may find helpful the 
following booklet prepared by che Federal Communications Commission: 
lnteiference Hand hook (stock number 004-000-00345-4). This hook let is 
available from the U.S. Government Printing Office, Washington, DC 20402. 

~ Important: Changes or modifications to this product not authorized by 
Apple Computer, Inc., could void the FCC Certification and negate your 
authority to operacc the product. 

This product was rested for FCC compliance under conditions chat included 
the use of shielded cables and connectors between system components. It 
is imponant that you use shielded cables and connectors to reduce the 
possibility of causing interference to radios, tele\'ision sets, and other 
electronic de\·iccs. 

For Apple peripheral devices, you can obtain the proper shielded cables 
from your authorized Apple dealer. For non-Apple peripheral devices, 
contact the manufacturer or dealer for assistance. ~ 
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Preface 

How to Use This Book 
This book has two parts. Parr I. leami11g Maci111osli. covers 
everything you need to know to begin using your Macintoshw 
computer. Part II , Macintosh R(!/ere11ce, contains information that 
you may want as you become more proficient in using your 
Macintosh. 

Go through Part I first if you are new to computers or new to the 
\lacintosh. Read the chapters in sequence. from Chapter I to 
Chapter 7. \'<'hen you·re clone with Pan I. you can stan learning 
the programs that you intend ro u ·e \Yith your ~lacintosh. 

Use Part II as you would a dictiona1y or encyclopedia: Lurn Lo iL 
when you need specific information. and then read only those 
parrs that give you that information- so you can go on with your 
\\'Ork. 

To find information in this book. use the index and the table of 
contents. Also. use the glossa1y and the summary. "\Vorking on the 
\facintosh De "ktop·· (on the green pages after Chapter 16). if 
you're looking for short definitions or brief summaries of concept 
and procedures. 

Tf you need information on setting up your Macintosh or on 
features specific to your particular model, go to the setup book 
that came with your computer. 

Use this book in combinarion ,,·ith the setup book and the books 
and disks that came 'iYith ~·our application programs to find the 
information you need. \bu can al. o find u:eful information 
through 13alloon Help"'. a feature of your Macintosh system that is 
explained in Chapter 7. 

Welcome to Macintosh. 

X\' 





Patt I 
I 

Learning Macintosh 
Chaprer 1 Turning the Macintosh On and Off 

Chapter 2 Understanding the Desktop 

Chapter 3 Setting Up Your Programs 

Chapter 4 Creating a Document and Saving Your Work 

Chapter 5 Changing a Document and Printing Your Work 

Chapter 6 Organizing Your Work 

Chapter 7 Learning More About Your Macintosh 

Go through Learning Macintosh ifyou are 11ew to computers or 

11ew to the J\laci11toslr computer Nead the chapters i11 sequence. 

from Chapter l .to Chapter 7. /:.'ve1ythi11g yo11 need to know to 

begin using the 1'laci11toslz productive~y is covered in this part of 

the book. 

Before you use Leaming Macintosh, you should have already 

• set up your Macintosh according to the instructions in the 
setup book that came with your computer 

• gone through the Macintosh Basics tour. supplied on disk with 
your computer 

When you·re done with this part of the book, you can start 

learning the programs that you intend to use with your Macintosh. 

(Turn to the materials that came with the programs- all the skills 

you learn in Leaming .Hacinroslz will prove useful in any 

Macinrosh program.) 

For information that you may need as you become more proficient 

in using your Macinrosh, go to Part II, Macintosh Reference. 



To find information in this book. use the index and the table of 

contents. Also, use the glossary and the summary. "Working on the 

Macintosh Desktop" (on the green pages after Chapter 16)~ If 

you're looking for short definitions or brief summaries of concepts 

and procedures. 

If you need information on setting up your Macintosh or any 

information on features specific to your pa1ticular model, go to the 

setup book that came with your computer. 

Use this book in combination with the setup book and the books 

and disks that came with your application programs to find the 

information you need. You can also find useful information 

through Balloon Help"', a feature of your Macintosh system that is 

explained in Chapter 7. 
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Chapter 1 

TL1rning the Macintosh 
On and Off 
In this chapter 

You'll learn ho\Y to 

• rurn the ~ lacintosh on and off 

Also. you'll learn about 

• the startup disk 

• the Macintosh desktop 

It will rake about five minutes to go through this chapter. 

Before you begin 
You should have already 

• set up your Macintosh according to the instructions in the 
setup book that came with your computer 

• gone through the .'vlaci11tosli Basics tour, supplied on disk with 
your computer 

• read the introclucrion to this section of rhe book (page 1) 

3 



Turn your computer on 
How you turn on your Macintosh depends on which model it is. 
For specific information, go to the setup book that came with your 
computer. 

~ Important: If an external hard disk or other external devices 
are connected to your Macintosh, turn on those external 
devices before you turn on the Macintosh. ~ 

• If your Macintosh is the Macintosh LC or it does not have a 
separate monitor (like the Macintosh Classic®), press the on/off 
switch on the back of your computer. 

_J 

•:• If the 1\!lacintosh LC monitor doesn't tum 011, make sure that 
the monitor's on/off switch is on. (If you don't know where the 
switch is, go to the manual that came with your monitor.) •:• 

4 Chapter 1: Turning the Macintosh On and Off 

• If your computer is one of the Macintosh II models (such as 
the Ilci or the Ilfx), press the Power On key on your keyboard. 

Power On kcv 11 
·I~ 

·:· If the monitor doesn't turn on, make sure that its on/off switch 
is on. (If you don't know where the switch is, go to the manual 
that came with your monitor.) ·:· 

• If your Macintosh is a portable model~ press any key (except 
Caps Lock) on the keyboard. 



When you turn on your computer 
The Macintosh looks for a stat1up disk, which is a disk that 
contains the information it needs to "start itself up." In your case, 
the startup disk is a hard disk that's inside or connected to your 

computer. When the Macintosh finds a startup disk, it 
displays the icon shown at left and proceeds to 
start itself up. 

When your computer is done starting itself up, the screen 
displays the Macintosh "desktop." The desktop is a field of gray 
(or another color) with 

• a menu bar across the top (containing the names and icons 
of menus) 

• an icon near the upper-right corner representing the startup 
disk 

• a Trash icon near the lower-right corner 

Chapter 2, "Understanding the Desktop," gives you more 
information on these features. 

Menu bar 

It File Edit 1Ji1~m Label Special 

Trash 
icon 

If the Macintosh doesn't find a startup disk, it displays this icon 
instead. In this case, you may need to prepare a startup disk or 

connect one to your computer. Go to Chapter 8 (in 

?
c 

Part II of this book) or your setup book for 
instructions. 

Chapter I: Turning the Macintosh On and Off 5 



Turn your computer off 
Before you can tum off your computer. you need to know how to 
use the mouse to choose a command from a menu. The 
. Macintosh Basics tour lets you practice choosing commands. If 
you need more practice, go through the next chapter (Chapter 2) 

and then come back to this section to turn off your computer. 

1. Point to the Special menu name in the menu bar. 

2. Press and hold down the mouse button. 

3. Drag through the items in the menu until the Shut 
Down command is highlighted, then release the mouse 
button. 

Clean Up Desktop 
E:mp t~~ ·rrnst1 , .. 

[j•~c'f Di~k :a:E: 
Erase Disk ••• 

Restart 
Shut Down 

6 Chapter 1: lllrning the Macintosh On and Off 

• If your !vlacintosh does not have a separate monitor (like the 
Macintosh Classic), press the on/off switch on the back of the 
computer when a message on screen indicates that it's safe to 
do so . 

• If your !vlacintosh is the Macintosh LC, press the on/ off switch 
on the back of the computer when a message on screen 
indicates that it's safe to do so. and switch off the monitor as 
well. 

• If your computer is a Macintosh II or a portable modeL the 
computer and the monitor turn off by themselves. 

~ Important: If an external hard disk or other external device is 
connected to your Macintosh, n1m off those external devices 
after you turn off the Macintosh. ~ 

Turn off your computer at the end of your work day or when you 
know you won't be using it for several hours. 

What next? 
Go to Chapter 2, where you'll learn how to work on the Macintosh 
desktop. 



Chapter 2 

Understanding the Desktop 
In th is chapter 

'rou'll rede\\' how to 

• use rhe mouse 

• choose a conunand 

• open an icon 

• look at the contents or a window 

• close a window 

(The ,\/aci11tosli Basics rour introduced you ro these skills.) 

You'll learn ho\\· ro 

Also. you'll learn about 

• using rhe keyboard 

It will rake about 30 minutes co go through rhis chapter. 

Before you begin 

You should ha,·e alread\' 

• gone th rough Chapter J 

If you turned off the ~lacintosh ar rhe end of Chapter 1, rurn it 
hack on no\\·. 

7 



Use the mouse 
You use the mouse ro control the morements of a poinrcr on 
screen. Csually, the pointer i · an arro"'· that"s set at an angle. 

= 

liil 

J\luch of the \\'Ork you do on the ~lacintosh u~es four mouse 
actions: pointing, clicking, pressing. dragging. 

8 Chapter 2: Understanding the Desktop 

Point 

You point to an object on screen by moving the mouse so that the 
pointer is posirioned on that object. When the poimer is an arrow, 
the ve1y lifJ of the <llTO"-. must be exact~) ' on the object. 

·-----

liii 

Practice by pointing to different objects on the ).-lacintosh desktop, 
such as rhe startup hard disk icon near the upper-right corner, the 
Ti«tsh icon near the lo"'·er-righr corner, and the Help menu icon 
near the right corner of rhe menu bar. 



Click 

You click an object on screen by pressing and quickly releasing 
rhe mouse button while rhe poinrer is on rhar object. 

!iii 

Practice by clicking different objecrs on the Macintosh desktop, 
such as the startup hard disk icon near the upper-right corner and 
the Tt·ash icon near rhe lower-right corner. 

. .......... .... ....... 

,~Ill 
y:y:y:yn:<ICC 

::::::::::::::::::::::;:::::::;:::::::;:;:::: 

i 
:::::::::::::: ::: :::::::::::::::::::::::::::: 

When you click an icon, it becomes highlighted (the icon is 
darkened), which means that iris selected. A selected icon is the 
object of whatever action you choose next. 

Press 

You press by holding dO\Yn the mouse bunon without moving the 
mouse. Don·t bear dmYn on the mouse itself. 

= 

[[j 

Practice by pressing the menu names and menu icons in the menu 
bar (start with the Apple menu icon in the left corner, through the 
menu names, and across to the Help and Application menu icons 
in the right corner). Pressing a menu name or icon "pulls down .. 
rhe menu. Read the items in each menu you pull down. 

~About This Macintosh ... 

~ Alarm Clock 

Will Calculator 
rp Chooser 

~ Cont rol Panels 

(@) Key Caps 
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Drag 

You drag an object on screen by poincing ro that object and 
holding dmYn the mouse buuon while you mo\·e the mouse. 

= 

~I 
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How to hold the mouse 

• You can u e the mou e with eirher hand. !\lost people 
prefer ro use it ~·irh rheir dominanc hand (rhe right if they're 
right-handed. rhe lefr if they're left-handed). If you wanr ro 
switch mouse po itions, go to the setup book that came 
\\'ith your computer. 

• Keep the heel of your hand on your desk. (Your arm will 
rire quickly if you hold your hand up in the air.) 

• Lightly resr your index and middle fingers on the mouse 
burron. 

• Make sure that the mouse cable is pointing away from you. 



Practice by dragging the startup hard disk icon and the Trash icon 
around the .\facintosh desktop. Make sure you return the icons 
close to their original positions. 

When you drag an icon, an outline of the icon follows the pointer 
on the screen. \\Then you release the mouse button, the icon itself 
moves. 

tf!hen you moue the mouse 
• Glide the mouse over the surface of your desk . Don't press 

down on it. 

• If you run out of room on your desk as you're moving the 
mouse, pick it up and put it down where tl1ere's more 
room. When you pick up ci1e mouse, the pointer on screen 
does not move, or does so only slightly. 

= 

!iii 
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Choose a command 
Choosing a command involves a combination of the mouse 
actions you've reviewed. 

1. Point to the Special menu name in the menu bar. 

2. Press to pull down the Special menu. 

3. Drag to the first item in the menu (the Clean Up 
Desktop command) so that it is highlighted, then 
release the mouse button. 

Ej•~c1 m~k :o:E: 
Ems<~ m~k .,, 

Restart 
Shut Down 

When you choose the Clean Up Desktop command, the 
startup hard disk icon and the Trash icon return exactly to the 
positions they occupied when you first turned on the 
computer (as long as they're already close to their original 
positions). 

12 Chapter 2: Cnderstanding the Desktop 

When you talk to your Macintosh 
Talking Macintosh always involves two steps: 

1 selecting an object on the screen, and 

2 choosing the action you want to perform on the object. 

An icon or a window on the Macintosh desktop, text in a 
word-processing program, a picture in a graphics program-all 
of these are objects that you can select. 

The actions you choose to perform on a selected object are 
usually commands (like the Open command), but you can also 
perform actions directly using the mouse (like dragging an 
icon). 

When you select an object, you're telling the Macintosh to act 
upon that object. 

Talking Macintosh is like using a very simple language with 
only two kinds of words: 

• nouns (the objects), and 

• verbs (the actions) 

and with only one rule to remember: 

• First the noun, then the verb (to this object, do that action). 



Open an icon 
Opening an icon is your first exercise in "talking Macintosh": 
telling your computer what you want it to do. 

1. Click the startup hard disk icon (unless it's been 
changed, it should be named "Macintosh HD") near the 
upper-right corner of the screen to select it. 

Make sure that the icon is highlighted (darkened), which 
means that ifs selected. 

2. Point to the File menu name in the menu bar. 

3, Press to pull down the File menu. 

4. Drag to the Open command (the second item in the File 
menu) so that it is highlighted, then release the mouse 
button. 

Get Info 881 
flEmffr;l'f IA l1ft0 

When you choose the Open command, the selected icon (in 
this case, the Macintosh HD icon) opens into a window (the 
Macintosh HD window). The icon itself becomes filled in with 
a pattern of dots, indicating that it has been opened. 

ID @ Macintosh HD '¥6 em 
i5 lttlnS 3.6M81nd~k 14.4 MB avalW>i. 

II LeJ ~ ~ 
RHdMt S\ISl«n Foldtr THohT•xt 

2 
!QT IQI~ 
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Look at the contents of a window 
Every window has seYeral features that help you view the 
window's contents. You can 

• make the window bigger or smaller 

• move any hidden contents into view 

Before you work with the contents of a window, you need to 
make that window the active window. 

Make a window the active window 

You can have several windows on screen, but only one window at 
a time can be the active window. 

The Macintosh HD window should already be on your .Macintosh 
desktop. (The window appeared when you opened the 
.Macintosh HD icon.) 

1. Click the Trash icon near the lower-right corner of the 
screen to select it. 

Make sure that the icon is highlighted, which means that it's 
selected. 

I 
lllJI 
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2. Point to the File menu name in the menu bar. 

3. Press to pull down the File menu. 

4. Drag to the Open command (the second item in the File 
menu) so that it is highlighted, then release the mouse 
button. 

Get Info ~I 

When you choose the Open command, the selected icon (in 
this case, the Trash icon) opens into a window (the Trash 
window). The icon itself becomes filled in with a pattern of 
dots, indicating that it has been opened. 



You should now have two windows on your Macintosh 
desktop: the Macintosh HD window and the Trash window. 
The Trash window is the active window because you opened 
the Trash icon most recently. 

~ r==-, ~ 
l!mJ ~ ~ 

Rtad Mt S~sttm Foldor TtaehTt><l 

- -- Trash 

Dottoms 

Active window 

5. Click anywhere in the Macintosh HD window to make it 
the active window. 

The active window is the one with solid lines across the top 
(the title bar), on either side of its title. When windows 
overlap, the active window is the one that's on top. 

Make a window bigger or smaller 
You can change a window's size by dragging its size box or by 
clicking its zoom box. 

1. With the Macintosh HD window the active window, 
point to the size box in the lower-right corner of the 
window. 

RD Macintosh HD em 
3lttms 3.6Mll ln disk 34.4 MB 1v.nablt 

II llJ ~ 
jQ 

RNd Mt St,isttm Foldtr Tt1chT.,.t 

lQ 
12.I IQ 1'2:31--- Size box 

2. Drag the size box in any direction, then release the 
mouse button. 

An outline indicates the window's new size. The outline 
follows the pointer as you drag. You can drag in any direction 
to make the window bigger or smaller, wider or narrower. 

continues..., 
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3. Click the zoom box near the right end of the title bar. 

Macintosh HD Zoom box 
31ttfl'll; l.6M91ne!isk 34.4 MB •v•fl&blt 

• llJ ~ p! 
Rud Mt Svstttn Foldtr Tuchr.irt 

~ ]i 
~ 

The window "zooms" to a size that shows all of its contents. 

4. Click the zoom box again. 

The window zooms back to its previous size (the size that you 
changed it to in step 2). 

Clicking the zoom box is a quick way to view as much of a 
window's contents as your screen size allows. 

Move the hidden contents of a window into view 
Without changing the size of the window, you can view any 
contents that are currently out of sight by using the window's 
scroll bars and scroll arrows. 
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1. With the Macintosh HD window the active window, click 
the System Folder to select it. 

[o Macintosh HD 01 
!lttm• 3.6MS r. diJk 34,'4 M8 tntl•blt . -"- ~ ~ 

Rud Mt Tt.chTtxt 

IQ 
~ Ji 

Make sure that the icon is highlighted, which means that it's 
selected. 

2. Point to the File menu name in the menu bar. 

3. Press to pull down the File menu. 

4. Drag to the Open command (the second item in the File 
menu) so that it is highlighted, then release the mouse 
button. 

When you choose the Open command, the selected icon (in 
this case, the System Folder) opens into a window (the System 
Folder window). 

You should now have three windoi;vs on your Macintosh 
desktop: the .Vlacinrosh HD window, the 'frash window, and 
the System Folder window. The System Folder window is the 
active window because you opened the System Folder last. 



5. Point to the size box in the lower-right corner of the 
System Folder window. 

6. Drag the size box diagonally to make the window 
smaller (about half its current size), then release the 
mouse button. 

S stem Folder Pll 

[D !!!_stem Folder Pll 
IOlttm1 3.6 MiJ indi$k 3 .. ,4 t'"S.tv•ilablt 

Lil (Q] [llJ .~ 
~ .. ~tth'M Exttnrions 51,istf'l'n Control P~ 

e ~ ~ 
find..- Pnftr'tnctr Scrapbool(ri\t IQ 

12.[ 1 .i<!. I~ 

The bars across the bottom (the horizontal scroll bar) and 
along the right (the vertical scroll bar) of the System Folder 
window should now be gray, indicating that the window has 
contents that you cannot see at its current size. 

7. Press the right scroll arrow at the right end of the 
horizontal scroll bar. 

The contents of the window scroll past, bringing into view the 
icons that had been out of sight and to the right. 

The scroll box moves to the right across the bar, showing what 
part of the window's contents you're looking at. 

8. Press the left scroll arrow at the left end of the 
horizontal scroll bar. 

The contents of the window scroll past, bringing back into 
view the icons that had been out of sight and to the left. 

The scroll box moves to the left across the bar, showing what 
part of the window's contents you're looking at. 

continues ~ 
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What's on the desktop? 

The Macintosh desktop is a field of gray (or another color) with 
a menu bar across the top, an icon near the upper-right corner 
representing the startup disk, and a Trash icon near the lower­
right corner. 

The desktop is your work space on the computer-as the top of 
a wooden desk is a work space. It gives you a familiar way of 
thinking about how to use the Macintosh. 

Aside from the field of gray (the "surface of your work space), 
the Macintosh desktop has icons, windows, and menus. 

• Icons represent containers. 

• Windows let you view the contents of containers. 

• Menus offer you actions that you apply to selected containers 
(or their contents). 

Icons represent containers 

You can think of icons as containers. Icons can contain other 
icons, or they can contain information. 

For example, the startup disk icon near the upper-right corner of 
the desktop contains the System Folder icon. The System Folder 
icon contains the programs and other files (more icons) that 
contain the information the Macintosh needs to start itself up. 

18 Chapter 2: Cnderstanding the Desktop 

Several types of icons represent different types of containers. 

Hard disks and floppy disks are like filing cabinets. You use 
disks to store files-programs you use and documents you 
create. 

1. [g] 
Hard Disk Floppy Disk 

Shared disks are like filing cabinets containing office supplies or 
records that you share with others in your work group. Your 
Macintosh needs to be connected to a network before you can 
use shared disks. 

~ ~ 
NetMart Community Communique 

~ ~ 
Shared Disk lduna Stacks 



Folders are like folders in a file drawer. You use folders to 
organize your files. 

Sy stem Folder Manila Folder 

June Letters House Plans Mailing Lists 

Programs are files containing instructions to the computer that 
let you do certain types of work. 

~ 4i m • 
Teach Text SketchP ad MemoMaker Bean Counter 

Documents are files containing words, pictures, numbers, 
sounds-whatever you create using programs. 

B [lJ B . 

Kitchen plans Rough sketch Sandino 

B B i . 
-

The Trash is a container for files that you no longer want or 
need. 

I 
Trash 

Windows let you view the contents of containers 

Windows let you see what's "inside" all of these containers. 
When you open a disk icon, the window that appears shows 
you what's on the disk. When you open a document icon and 
the document is a memo, for example, the window that appears 
lets you see the memo. 

Menus offer you choices 

Like the menus in a restaurant, Macintosh menus let you choose. 
You choose among different actions that the computer can 
perform on containers (icons) or the contents of containers 
(words in a memo) that you've selected. 
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9. Drag the scroll box toward the middle of the horizontal 
scroll bar, then release the mouse button. 

!II.stem Folder 
IOittmi l.6t'9ticr\slc 34.4 MB n.11fllblt 

LiJ [QJ LID ~~ 
It t1ttN lttms bt""iont SVstttn CohtrolP1nt~ 

~ ~ ~ ~· -
flndtr Pr•ftrtnctt S<lr~Fllt ~ 

!QI --r:r -.c;: 1i 
- "\'" 

i\ow you see the icons near the middle of the windoi;\•, 

10. Press the down scroll arrow at the bottom end of the 
vertical scroll bar. 

!!!_stem Folder 
10\l.ms U111lndklc 34 .Ct'Sn.a~» 

~ ....... [QJ LID ~ IQ 
tx1tnt*i• &iistttn Cotltro1 PlMls 

[!gJ [J ~ 
[;;' 

-
'""" Prtftrtne+s Scrtpbook file 

I-fr 
Cit• ·{ 16 

The contents of the window scroll past, bringing into view the 
icons that had been out of sight and toi;\·ard the bottom. 

The scroll box moYes down along the bar. 
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11. Press the up scroll arrow at the top end of the vertical 
scroll bar. 

The contents of the window scroll pasr, bringing into view the 
icons that had been out of sight and toward the top. 

The scroll box moves up along rhe bar. 

12. Drag the scroll box toward the middle of the vertical 
scroll bar, then release the mouse button. 

Now you see the icons near the middle of the window. 

~ Remember: Changing rhe size of a window or moving rhe 
contenrs of a window does not change its contents. The 
conrents remain the same; only what you see of the contents 
changes. ~ 



Close a window 
When you no longer need ro see rhe conrenrs of a ~fodow, you 
can close ir by clicking rhe close box. 

1. With the System Folder window the active window, 
point to the close box near the left end of the title bar. 

2. Click the close box. 

The window closes, and rhe Sysrem Folder icon is no longer 
filled in wirh a panern of docs, indicaring char ir is nor open. 

You should have rwo windows on rhe Macintosh deskrop: rhe 
Macinrosh HD window, which is now rhe active window, and 
rhe Trash window. 

Move a window 
You can move a window anywhere on screen by dragging its 
title bar By changing the position and rhe size of windows, you 
can arrange \vindows in any way thar works best for you. 

1. Point to the title bar of the Macintosh HD window 
(anywhere on the title bar except the close box or the 
zoom box). 

Macintosh HD Title bar 

2. Drag the title bar in any direction, then release the 
mouse button. 

When you drag a window's rirle bar, an ourline of rhe window 
follows the pointer on screen. When you release the mouse 
butron, rhe window itself moves ro the position of rhe outline. 

Moclntosh HD 
32M8Ylduk 

LeJ • ~ 
..,,,.., , .,. ... 1 .... "' T"""Toxt 

I 
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3. Click anywhere in the Trash window to make it the 
active window. 

4. Point to the title bar of the Trash window (anywhere on 
the title bar except the close box or the zoom box). 

5. Drag the title bar in any direction, then release the 
mouse button. 

Notice that the Trash window, because it is the active window, 
stays on top of the Macintosh HD window if the two windows 
overlap. 

::::. :·:< .,· :. : 

Macintosh HD 
3.2 MB in diJk 34.8 MB •vail>blt I:: 

Trash - -

.; --------- - -- -·-··-·-----·-----·------------------·----

-. ·.-: 77_.7 ... _-:::: _ _. -.. -------- ---- :-: -

6. Click anywhere in the Macintosh HD window to make it 
the active window. 
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7. Close the Macintosh HD window by clicking the close 
box near the left end of the window's title bar. 

rHf. Macintosh HD fr· ==rt'E!IB 
3ttoms 3.2MBtndWc 34.8 MB antlM>lt 

II riJ ~ 
iQ 

Rt.cl Mt $¥sltm Foldtr Tt.el>Tt><I 

~ 
~ 1¢11;)] 

The window closes, and the Macintosh HD icon is no longer 
filled in with a pattern of dots, indicating that it is not open. 

The Trash window (the remaining window on the Macintosh 
desktop) becomes the active window. 

8. Close the Trash window by choosing Close Window 
from the File menu . 

You choose Close Window by pointing to the File menu name, 
pressing to pull down the menu, dragging to the Close 
Window command, and, with the command highlighted, 
releasing the mouse button. 

Of course, you can also close the window by clicking its close box. 



When to use the keyboard 

You use the keyboard to type te11 and numbers, of course, as 
you would on a typewriter. (For touch typists, Macintosh 
keyboards have raised dots in the middle of the D key and the 
K key to help position your fingers on the home row.) 

Depending on the program you're using, you can use special 
keys on the keyboard to give commands to the computer and ro 
replace or change the effect of certain mouse actions. Macintosh 
~eyboards have ci1ree types of special keys: modifier keys. arrow 
keys, and function keys (Chapter 5 gives you examples of how 
to use these special keys). 

Modifier keys 

All Macintosh keyboards have four modifier keys: Shift, 
3€ (Command), Option, and Control. 

Pressed by itself, a modifier key does nothing. You need to press 
it in combination with another key (or while using the mouse). 
The modifier key "modifies" the other key or the mouse action, 
giving a different result. 

You type a capital letter. for example, by pressing the Shift key 
with a letter key. Most programs let you give commands by 
pressing the 3€ key with certain letter keys. 

Arrow keys 

All Macintosh keyboards have four arrow keys: Up Arrow, 
Down Arrow. Left Arrow, and Right Arrow. 

Many programs let you use the arrow keys as well as the mouse 
to control the movements of the pointer on screen. 

Function keys 

Extended Macintosh keyboards have a row of function keys 
across the top of the keyboard. 

Some programs let you give commands. or a sequence of 
commands, by pressing certain function keys. 

Q 

0 

0 IUIUlulUI IUIUUIUI IUIUIUIUI IUIUIUI - - - [Q] 
0 

=:J i\lodifier keys D Function keys D :\rrO\Y keys 
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What next? 

Go to Chapter 3, where you'll learn how to set up your programs, 
or take a break. Remember to turn off your Macintosh if you'll be 
away for more than a few hours. 
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Chapter 3 

Setting Up Your Programs 
In th is chapter 

You'll learn how to 

• insert a floppy disk 

• initialize a disk 

• copy the contents of a disk 

• rake a floppy disk our of its drive 

• safeguard the contents of a disk 

• use the Trash 

You·ll also learn about 

• types of floppy disks 

• the difference berween hard disks and floppy disks 

• caring for floppy disks 

And you'll learn more about 

• the startup disk and the System Folder 

It will take about 40 minutes to go through this chapter. 

Before you begin 

You should have already 

• gone through Chapters 1 and 2 

Also, you need 

• a new floppy disk 

If you turned off the Macintosh at the end of Chapter 2, turn it 
back on. 

r - ) 



Inse1t a floppy disk 
You should be able roger floppy disks from ~\"11ere,·er you gor 
your ~ lacinrosh . The 3.5-inch (86-millimerer) floppy disks rhar fir 
in your Macintosh computer's SuperDri,·e"' come in m·o rypes: 
high-density and <luuble-sidecl . Your ~lacinrosh uses either rype. 

hole 

Double-sided (SOOK) 

High-tkn~i11 · 

disk ·'~rnbol 

I ligh-density ( 1.4 \ lB) 

ome older Macinrosh models. ho~·e,·er. do nor ha,-e the 
SuperDrive floppy disk drive and cannot properly use high­
densirv disks. 
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1. Write "Practice" on a blank disk label. 

2. Affix the label onto your new floppy disk. 

HO\Y the label goes onro the floppy disk is apparent from the 
molding of the di k"s prorecri,·e plastic case. Do nor affix the 
label O\·er the metal shuner. 

3. Hold the disk between thumb and forefinger, with your 
thumb on the label and the metal shutter pointing away 
from you. 

4. Push the disk into the computer's SuperDrive, label side 
up and metal shutter first, until the SuperDrive pulls the 
disk in the rest of the way. 



Why a floppy disk isn't floppy 
A floppy disk is made of thin, flexible material with a magnetic 
coating. To protect it and to make it easier to handle, the floppy 
disk itself is enclosed in a rigid plastic case, which gives the 
floppy disk its "non-floppy" character. 

A metal shutter on the plastic case allows access to the floppy 
disk, which carries information in the form of magnetic signals. 
The shutter moves out of the way when you insert the floppy 
disk in a disk drive. 

You can use either of two types of 3.5-inch (86-millimeter) 
floppy disks in your computer's SuperDrive: high-density and 
double-sided. 

·:· If you use another Macintosh: Some older Macintosh 
computers may not have the SuperDrive floppy disk drive 
and therefore cannot use high-density disks. Use only 
double-sided disks on these older Macintosh computers. ·:· 

High-density disks can hold 1.4 megabytes (MB) of information 
(about 300 typewritten pages). Double-sided disks can hold 
800 kilobytes (K) of information (about 200 typewritten pages). 
(One thousand twenty-four kilobytes make a megabyte.) 

10,000 pages 

5,000 pages 

300 pages 
200 pages ~-

;, ~~ 
4K SOOK 1.4 MB 20 MB 40 MB 

Floppy disks Hard disks 

Floppy disks are also called diskettes. 
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Initialize a disk 
Before you can use a new floppy disk, you need to prepare it so 
that the computer knows where to store and retrieve information 
on the disk. Preparing a disk is called initializing. Initializing a 
disk is like drawing the lines on a newly paved parking lot: you 
don't know what fits where until you figure out how much room 
you have. 

1. After you insert your practice disk into the SuperDrive, 
read the dialog box that appears on screen. 

If you inserted a high-density disk, this dialog box appears: 

r -;:-! This disk Is unreadable: 

Do you want to lnltlollze It? 

([ ·Eject JJ [ Initialize J 

If you inserted a double-sided disk, this dialog box appears: 

In This disk Is unreadable: 

\§1 Do you want to lnltlollze it? 

(I Eject ll [one-Sided) (Two-Sided) 
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2. Depending on which dialog box appears, click Initialize 
or 1\vo-Sided. 

Another dialog box appears: 

J.\ This process wlll erase all 
ill Information on this disk. 

Cancel [{ Erase JI 

This dialog box gives you one last chance to cancel. It alerts 
you that you're about to erase-and therefore lose-any 
information that may be on the floppy disk. In this case, 
because the floppy disk is new, you have no information to 
lose. 

3. Click Erase. 

A third dialog box appears: 

IJ;J Please name this disk: 

n OK 11 



4. 'fype "Practice". 

If you make any typing errors, press the Delete key to 
backspace over them. 

When you name a disk you can type up to 27 characters, 
including spaces. You cannot use a colon (:) in the name. 

5. ClickOK. 

The computer takes about a minute to initialize the disk. A 
series of messages appears on the screen to let you know how 
the process is going. 

When the computer is done initializing the floppy disk, the 
disk's icon appears on the Macintosh desktop directly below 
the Macintosh HD icon (the startup hard disk icon) near the 
upper-right corner. 

Copy the contents of a disk 
Most programs you get are supplied on one or more floppy disks. 
You can more efficiently use a program if you first install it on 
your hard disk (copy it from its floppy disk to your hard disk). 

To practice copying the contents of a floppy disk to your sta11up 
disk, use your practice disk (even if there's nothing on it). 

1. Make sure that the Practice floppy disk icon is selected. 
Hit isn't, click the icon (not its name). 

11:1::.1:1,:1:::::::::·:::;·1:·:1.::: 

:;:;: Macintosh HD :::: 

11111111111111111111: 
·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·:·: 

c0111inues 1iJ1ii-
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Floppy disks, hard disks, and startup disks 

Both floppy disks and hard disks function like filing cabinets: 
you store files in them. The differences bet\\·een floppy disks 
and hard disks are in how much information they can store. ho\\· 
quickly you can retrieve information from them. and how easily 
you can cany them around. 

You can store much more info1mation on a hard disk and 
retrieve it much faster than you can on a floppy disk. 

And while you can carry a floppy disk in your shirt pocket, a 
hard disk is sealed in a hard disk drive, which is installed inside 
the computer or enclosed in a plastic box that's connected to the 
computer. 

D 
t--· -- -- -
' , __ ______ , 

Internal 
hard disk 

External Floppy 
hard disk disk 
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You can tell whether a disk is a lloppy disk or a hard disk by 
looking at its icon on the desktop. 

1. 
Hard Disk 

Floppy Disk 

The disk whose icon appears near the upper-right corner is the 
startup disk, which contains the information that the Macintosh 
uses to start itself up. 

That '·srarrup" information is contained in programs and other 
files that are in the ystem Folder on the startup disk. The startup 
disk must have only one ystem Folder. If it has more than one. 
the computer becomes confused about where to get the 
information it needs to start up and run, with unpredicrable­
and undesirable-re ulrs. 



2. Drag the Practice floppy disk icon to the Macintosh HD 
icon until both icons are highlighted, then release the 
mouse button. 

Both icons are highlighted when the tip of the arrow pointer 
reaches the Macintosh HD icon as you drag the Practice floppy 
disk icon. 

When you release the mouse button, rhe Macintosh copies the 
contents of the Practice floppy disk onto Macintosh HD (your 
startup hard disk). The copy is in a folder named Practice, 
which is now on Macintosh HD. 

3. Click the Macintosh HD icon to select it 

4. Choose Open from the File menu. 

Ybu choose Open by pointing co the File menu name, pressing 
to pull down the menu, dragging to the Open command so 
that it's highlighted, and releasing the mouse button. 

The .Macintosh HD window appears, showing you the contents 
of the startup hard disk. The contents should include a new 
folder called Practice, which the computer created when 
it copied the contents of the Practice floppy disk to 
Macintosh HD. 

You may have to make the window bigger or use the scroll 
bars to find the Practice folder. 

5. Click the Practice folder to select it. 

6. Choose Open from the File menu. 

You choose Open by pointing to the File menu name, pressing 
to pull down the menu, dragging to the Open command so 
that it's selected, and releasing the mouse button. 

The folder holds the contents of the floppy disk you've copied 
(in this case, the folder contains nothing because there's 
nothing on the Practice disk). 

7. Close all the windows you have on the Macintosh 
desktop. 

You close a windmv (when it's the active window) by either 
clicking its close box or choosing Close Window from the File 
menu. 
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Take a floppy disk out of its drive 
While there's only one way to inse1t a floppy disk into the 
SuperDrive, there's more than one way to take it out. Here is the 
best way: 

1. Make sure that the Practice floppy disk icon is selected. 
If it's not selected, click it. 
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2. Eject the floppy disk by choosing Put Away from the File 
menu. 

New Folder SCN 
Open SCO 
Print ,J(,p 
[ ~os<~ Wlndon~ ,;(,HJ 

Get Info SCI 
OupHc<•1 <~ ,Jt'O 
Make Rlias 
Put Away , :#:Y 

Find... SCF 
Find Rgain SCG 

Page Setup ••• 
Print Desktop ••• 

You choose Put Away by pointing to the File menu name, 
pressing to pull down the menu, dragging to the Put Away 
command so that it's highlighted, and releasing the mouse 
button. 

Put A\Yay puts the object you·ve selected back in its place (in 
this case. it allows you to remove the floppy disk from the disk 
drive and put it away). 



Safeguard the contents of a disk 
You can lock a disk so that its contents cannot be changed in any 
\Yay. When a disk is locked, you cannot change the fi les that are 
on it, delete any fil es, or store additional files. 

To practice locking and unlocking a floppy disk, use your practice 
disk. 

1. Hold the practice disk between thumb and forefinger, 
with your thumb on the label and the metal shutter 
pointing away from you (as if you were going to insert 
the disk into a drive). 

2. Find the square hole in the near-left corner of the 
floppy disk. 

A moveable tab on the back side of the disk should be 
blocking the hole, indicating that the disk is unlocked. 

·:· I/you ·re using a /Jigh-de11sityj7oppy disk: You ·11 notice an 
additional square hole. across the label from the first hole. This 
second hole has no rno\·eable tab and is ah\·ays open. ·:· 

3. Turn the disk over and lock the disk by sliding the tab 
on the back side of the disk so that the square hole is 
open. 

• •• • • • • • •• 
•• ·· ~· <---------~ 

Lock eel Unlocked 

Use your thumbnail or a push pin to move the tab. 

4. Unlock the disk by sliding the tab back so that the 
square hole is blocked. 

Your practice disk should be unlocked so you can use it to 
store files in the next chapter. 
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Taking care o.ffloppl' disks 
Follow the in !ructions about care and maintenance that came 
with your disks. At minimum. remember these three points: 

• Keep the di. ks a\\'a)' from magnets. Information on the 
disks is in the form of magnetic signals. so a magnetic field 
can destroy that information. Televisions and monitors. 
telephones, loudspeakers. and certain kinds of lighting 
fixtures all have magnets. 

• Protect disks from extremes of temperature and humidity. 

• Do nor open the disk's metal shutter. Touching the disk 
inside the shutter could damage it. 
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Use the ]:ash 
When you no longer need or \\·ant a file or folder. you throw it 
away by dragging its icon to the 'fra ·h. (A file can be either a 
documem or a program.) Practice using the Trash by throwing 
a\\·ay the Practice folder. which you created \\·hen you copied the 
contents of your Practice disk onto .\ lacintosh HD. 

1. Click the Macintosh HD icon to select it. 

2. Choose Open from the File menu. 

'You choose Open by pointing to the File menu name, pressing 
to pull do\\'n the menu, dragging LO the Open command so 
that it's highlighted. and releasing the mouse button. 

The Macimosh HD \rindow appears, showing you the conrents 
of the startup hard disk. The contents should include the 
Practice folder. 

You may ha,·e to make the \\·indO\\' bigger or use the scroll 
arro'\YS to find the Practice folder. 

3. Click the Practice folder icon to select it. 



4. Drag the Practice folder icon to the Trash icon until both 
icons are highlighted, then release the mouse button. 

Both icons are highlighted when the tip of the arrmv pointer 
reaches the lrash icon. 

When you release the mouse button, the Practice folder 
"disappears'' into the Trash. When you put a file or folder in the 
Trash, the Trash icon bulges to indicate that it is no longer 
empty. 

5. Open the Trash icon. 

You open an icon by clicking it to select it and then choosing 
Open from the File menu. 

When you open the lh1sh icon, the 1h1sh window appears. 
The Practice folder you've just thrown away is in the window. 
Anything you put in the Trash stays there until you empty the 
Trash. 

You can put anything that's in the Trash back where it was by 
clicking it to select it and then choosing Put Away from the File 
menu. (Or you can drag it back where it was.) 

6. Choose Empty Trash from the Special menu. 

A dialog box appears asking you to confirm that you want to 
permanently remove the contents of the Trash. If you change 
your mind, you can click the Cancel button. 

Clicking OK empties the Trash, and you lose anything that's 
in it. 

7. Click the OK button. 

Notice that the Trash icon no longer bulges, indicating that it is 
empty. 

8. Close the Trash window by clicking its close box. 
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On your own: Install your progra1ns 
If you have any disks containing programs (such as word 
processing or graphics) that you plan to use on your J\iiacintosh~ 
install the programs now on your hard disk. If you do not have 
any program disks yet, go to the next chapter. 

~ Important: Some programs need to be installed in a specific 
way, so follow the instmctions that came with each program. ...:::. 

If a program didn't come with specific installation instructions, 
these general instructions tell you how to copy the contents of a 
program disk to your startup disk: 

1. Lock the program disk. 

The program disk contains your master copy of the program. 
Locking the disk protects its contents but doesn't keep you 
from copying the contents onto another disk. 

2. Insert the program disk into the floppy disk drive. 
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3. Drag the program disk icon to the Macintosh HD icon 
(your startup hard disk icon) until both icons are 
highlighted, then release the mouse button. 

Both icons are highlighted when the tip of the pointer arrmv 
reaches the Macintosh HD icon as you drag the program disk 
icon. 

When you release the mouse button, a series of messages 
briefly appears on screen to let you know that the computer is 
copying the contents of the program floppy disk onto 
Macintosh HD. The copy is in a folder on Macintosh HD with 
the same name as the program disk. 

4. Eject the program disk by making sure it's selected and 
then choosing Put Away from the File menu. 

5. If the Macintosh HD window is not on the desktop, 
open the Macintosh HD icon. 

When you open the ~Iacintosh HD icon, the Macintosh HD 
winclo-w appears, showing you the contents of your startup 
hard disk. Among its contents is the program folder holding 
the contents of the disk you've copied. 

6. Click the program folder to select it 



7. Choose Open from the File menu. 

The folder window appears, showing the contents of the 
program folder. The folder has the same contents as the 
program disk. 

8. Look for a System Folder in the program folder. 

Some program disks have a System Folder (so they can be 
used as startup disks). If the program disk you've copied 
has a System Folder, you now have two System Folders on 
!vlacintosh HD. 

Throw away extra System Folders 

Your startup disk must have only one System Folder. Whenever 
you copy the contents of a program disk to your startup hard disk, 
check to see that you have not copied an extra System Folder. If 
you have, throw away the extra System Folder. 

1. Drag the extra System Folder to the Trash in the lower­
right corner of the screen until both icons are 
highlighted, then release the mouse button. 

2. Choose Empty Trash from the Special menu. 

A dialog box alerts you that you're about to throw away­
permanently-the contents of the Trash (in this case, the extra 
System Folder). 

3. Click OK to confirm that you want to throw away the 
contents of the Trash. 

4. Close the program folder window by clicking its dose 
box. 

What neJ.:t? 

Go to Chapter 4, where you'll learn how to create a document. Or 
take a break. Remember to turn off your Macintosh if you'll be 
a\vay for more than a few hours. 
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Chapter 4 

Creating a Document and 
Saving Your Work 
In th is chapter 

• open a program 

• creare a document in a program 

• save your work 

• switch programs 

• close a document 

(The Maci11toslt Basics tour disk introduced you lO these skills.) 

You'll also learn about 

• what happens when you open a program icon 

• \Yhy it's imponarn to sa\·e your \\"Ork 

• the difference bem·een applicarion programs and system 
soff\\·arc 

It will rake about 30 minutes ro go through this chapter. 

Before you begin 

You should have already 

• gone through Chapters 1 through 3 

If you turned off the Macintosh at the end of Chapter 3. turn it 
back on. 
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Open a program 
To practice using a program to create a document and save your 
work~ you can use TeachText. a simple word-processing program 
that comes with your computer. 

1. If you closed the Macintosh HD window at the end of 
Chapter 3, open the Macintosh HD icon. 

To open the icon! click it to select it and then choose Open 
from the File menu. 

The Macintosh HD window appears! showing you the contents 
of your startup disk. The contents include a program called 
Teach Text. 

2. Open the TeachText icon. 

a 
~ 

Teach Text 

To open the icon, click it to select it and then choose Open 
from the File menu. 

40 Chapcer 4: Crearing a Document and Sa,·ing four \X'ork 

When you open the TeachText program, 

• an untitled window appears 

• the menu bar shows TeachText menu names 

• the Application menu icon in the right corner of the menu bar 
becomes the TeachText icon 

TeachTexc menus 

S File Edit 

Untitled~·--

Application menu 
(TeachText icon) 

Uncitled TeachText window 

The untitled 'vinclow contains nothing because you haven't 
\\Titten anything in it. It remains untitled until you save 
whatever you've \\Titten and give it a name. The file that you 
create and name is called a document. 



Create a document 
The untitled window is like a blank sheet of paper, a document 
waiting to be created. In the upper-left corner of the empty 
document is a blinking vertical line. The line is called the insertion 
point, because it marks the place where the text you type will be 
inserted. 

As you type, you use the Macintosh keyboard as you would a 
typewriter keyboard, except: 

• If you make a mistake, press the Delete key to backspace over it. 

• Don't press the Return key when you get to the end of a line. 
Keep typing. The text will continue on the next line 
automatically. 

Type the following text: 

Sailing across an unknown sea, we saw the 
lights of a city in the distant horizon. Was 
it another strange land, with strange and 
cruel people speaking different languages, 
eating different food, wearing different 
clothes? We wished it were home. 

You will be changing this text in the next chapter. 

Save your work 
Until you save your work, it exists only in the computer's 
memory-like thoughts that are lost unless you write them down. 

1. Choose Save from the File menu. 

Page Setup ... 
Print... 3€P 

Quit 3€0 

The dialog hox that appears lets you name the document and 
decide where you want the computer to store it. 

co111i1111es ~ 
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2. Type "Opening lines". 

.....,-~l=c:1==M=ac=in=to::::s::::h ::::"D:::""=...I ---,...,..., &::::i Macintosh HD 

Cl Hetld Me ~ [ E:Jec1 ) 
CJ System Folder 
~ ·r..•tu:hfeH1 ( Desktop ] 

[ New LJ) 

cancel J 

'------------'-~"-' [[ Seue 1) 
Saue this document as: 

I .... o_pe_n_in_g_L_ln_es .... l ____ _,I ® EJ 013 

Because the word "Untitled" is selected (it's highlighted) when 
the dialog box appears, all you have to do is start typing. 
Whatever you type replaces the selected text. You'll learn more 
about selecting text later. 

3. Click Save. 

So111ng ecross an unknown sea, we sow the 11ghts of 8 city In the 
dlstcnt horizon. Was tt another strenge Hind, with strange and 
cruel people speoktng different lenguoges, eating different food, 
weerlng different clothes? we wished tt were home! 

The window is now titled "Opening Lines)! and the document 
has been stored on Macintosh HD. 
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Save it or say so long 

You need to save your document before you turn off the 
computer. 

Using a Macintosh may seem like using a typewriter, pencil 
and ledger, paintbmsh and canvas, or pen and drafting 
paper-but a computer is unlike those other tools in one 
important aspect: anything you create on a computer exists 
only temporarily in the computer's memory until you save your 
work. 

That is, until you tell the computer to record your creation on a 
disk, your finest work is no better than a mental note­
forgotten faster than you can turn off a switch. 



Switch programs 
The Opening Lines window is the active window and TeachText is 
the active program, but TeachText is not the only program that's 
open. 

The Finder"'-the program that displays the Macintosh 
desktop-is also open, but right now it is not active. (The Finder is 
always open when your Macintosh is on.) 

You can have several programs open at one time (hmv many 
programs depends on how much memory your computer has), 
but only one program at a time can be the active program. The 
active program is the one that's "on top" of other open 
programs-just as the active window is on top of other windows. 

1. Make the Opening Lines window smaller by dragging its 
size box and releasing the mouse button. 

After you resize the window, you should be able to see the 
Macintosh HD icon in the upper-right corner of the Macintosh 
desktop. 

2. Make the Finder the active program by clicking the 
Macintosh HD icon or anywhere on the desktop. 

The Finder becomes the active program. Notice that 

• the Macintosh HD window appears on top of the Opening 
Lines window 

• the menu bar shows Finder menu names 

• the Application menu icon in the right corner of the menu 
bar becomes the Finder icon 

• File Edit Uiew Lobel Speci11I 

Opening Lines 
Se1l1ng ecross en unknown see. we s11w the lights of e ctty in the 

: distent horizon. W11s it another str11nge 111nd, with strenge end 
· cruel people speeking different lengue.g_es, eeting different food, 

weering iiD · ·-" - -- M11cintosh HD -·01 
4 1t•ms 3.7 MB In disk 34 4 MB •v.iloblo 

¢1 

Notice the icon in the Macintosh HD window representing the 
document Opening Lines, which you've just created and saved 
on Macintosh HD. 

continues.,... 
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1iuo types ofprograms 

Programs that you use to do your work on the computer are 
called application programs, or applications, because they're 
ways of app~ying computer technology to the work that you do. 

Word-processing programs, for example, are applications 
because they enable you to write memos, reports, papers, 
theses, novels-whatever you need or want to write. And if 
your work involves creating graphics, calculating numbers, 
composing music, or keeping track of large amounts of 
data-there are application programs for your work as well. 

Most Macintosh programs work in similar ways, so most of 
what you learn using one application you can use in other 
applications. 

Programs that the computer uses to operate, on the other 
hand, are called system software (or "the oper'dting system"). 

And then there's the Finder 

Between you and system software is an application called the 
Finder, which is the program that displays the Macintosh 
desktop. Ifs called the Finder because, like the viewfinder in a 
camera, it gives you a view of all the object5-disks, programs, 
documents-that you have in your computing work space 
(your "desktop"). 

Using the Finder, you can tell system software what you want it 
to do for you: which disks you want to use, which programs and 
documents you want to open, where you want files to be stored. 

3. Make the Opening Lines window active by clicking 
anywhere in it It's partially hidden by the Macintosh HD 
window. 

The Opening Lines windmv comes back to the top. It's now 
the active window, and Teach1ext becomes the active program. 

You make a window active by clicking any pa11 of it. The 
program that "mvns" the window becomes active as soon as 
the windmv becomes active. 

4. Make the Finder the active program by choosing Finder 
from the Application menu in the right corner of the 
menu bar. 

You choose Finder by pointing to the Application menu icon, 
pressing to pull dmvn the menu, dragging to the item .. Finder" 
so that ifs highlighted, and then releasing the mouse button. 

The Finder becomes the active program, and the Macintosh HD 
window becomes the active window. 



; . Make TeachText the active program by choosing 
TeachText from the Application menu. 

Ill 

Hide Finder 
Hide Others 
St!ow flll 

../ 19.J Finder 
~TeachTeHt 

Teach Text becomes the active program. and the Opening Lines 
\\·indow becomes the active windo"·· 

From the Application menu. you can choose the open program 
that you want to make the active program. All open programs 
are listed in the Application menu. The icon at the top of rhe 
Application menu is the icon of rhe active program. 

Close a docu1nent 
When you close a document. you do not close the program that 
you used to create it. (Closing a program is called quitting.) The 
program remains open and remains the active program until you 
quit the program or make another program the active program. 

1. If the Opening Lines window is not the active window, 
click anywhere in it to make it the active window . 

2. Close the Opening Lines window by clicking the close 
box near the left end of the title bar, or by choosing 
Close from the File menu. 

The Opening Lines window closes but TeachText is still the 
active program. Notice that 

• the menu bar still shows Teach Text menu names 

• the Application menu icon in the right corner of the menu 
bar is sti ll the Teach Text icon 

What next? 

Go to Chapter 5, where you ·II learn how to revise your document 
and then print it. 
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Chapter 5 

Changing a Document and 
Printing Your Work 
In this chapter 

You'll learn how to 

• open a document 

• change a document 

• choose a printer 

• print a document 

• quit a program 

• make a backup copy of a documenr 

You'll also learn about 

• double-clicking as a way ro open icons 

• using keyboard shortcuts 

It will take about 40 minutes to go through this chapter. 

B~/ore you begin 

You should have already 

• gone through Chapters 1 through 4 

Also, make sure that 

• your computer is connected ro a printer 

A printer can be connected directly to your computer, or it can be 
connected through a network . 

Go to the instructions that came with your printer if you need to 
connect it ro your computer. 

If your computer is connected to a network, find out from your 
network adm inistJator (or the person who set up your computer) 

• which printer on the network you can use 

• where it is on the network (its ""zone," if the network has 
zones) 

• what its name is (every printer on a network has its own name) 

If you turned off the Macintosh at the encl of Chapter 4, turn it 
back on. 
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Open a document 
When you open a document, the program that you used to create 
that document becomes the active program. 

1. If you closed the Macintosh HD window at the end of 
Chapter 4, open the Macintosh HD icon. 

To open the icon: click it to select it and then choose Open 
from the File menu. 

The Macintosh HD windovv appears, showing you the contents 
of your startup hard disk. The contents include the TeachText 
program and the TeachText document called Opening Lines, 
which you created in Chapter 4. 

2. Open the Opening Lines icon. 

g 
D 

Open;ng Lines 

You can open an icon by double-clicking it: click the icon 
twice in rapid succession, without moving the pointer. Double­
clicking an icon has the same effect as selecting the icon and 
then choosing the Open command. 
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When you open Opening Lines, TeachText becomes the active 
program. (TeachText is the program that you used to create 
Opening Lines.) Notice that 

• the Opening Lines window appears 

• the menu bar shows TeachText menu names 

• the Application icon in the right corner of the menu bar 
becomes the TeachText icon 

4' File Edit Cf) ~ 
m: • Opening lines : -0ii /: '.:',:;:''.'. 
1Sa111ng across an unknown sea, we sew the lights ore city 1n the ~:J:~J 
dl st ant horizon. Was 1 t another strange lend, with strenge and :::Hord Disk::: 
cruel people speeking different l!mguages, eating different food, ...................... -.·. 
wearing different clothes? We wished it were home. 

Change a document 
The Opening Lines window shows you the text you typed in 
Chapter 4. You will be making some changes to the text using 
techniques that work in most Macintosh programs. 

Keep two things in mind: 

• The insertion point-the blinking ve1tical line-is where 
anything you type appears. 

• The I-beam pointer replaces the arrow pointer when you're 
dealing with text. You control the I-beam pointer with the 
mouse as you would the arrow pointer. 
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1. Locate the insertion point. It should be in the upper-left 
corner of the document. 

2. Locate the I-beam pointer. If you don't see it, move the 
mouse slightly. The pointer moves as the mouse moves. 

\ow you're ready to insert some text. 

3. Move the I-beam pointer to the immediate left of the 
word "an" (after "Sailing across"). 

4. Click. By clicking, you put the insertion point where 
you were pointing with the I-beam pointer. Anything 
you type is inserted at that point. 

Openln lines E!I 
Salling across n unknown sea, we sow the lights of o city in the 
distant horizon. Was It another strange land, with strange and 
cruel people speaking different languages, eating different food, 
weor1ng different clothes? We wished It were home. 

5. Type the words "the blackness of space, adrift in". 

If you make any typing errors. press rhe Delete key to 
backspace over them. 

D Openln lines I 
Soiling across the blackness of space. adrift In n unknown sea, 0 
we sow the lights of o ctty In t ho dl~tont horizon. Wes ii enother 
strange land, with strange ond cruel people speaking diff erent 
languages, eating different rood, wear ing different clothes? We 
wished It were home 

\ext. you'll change some text. 

6. Move the I-beam pointer to the immediate left of the 
word "lights" (after "we saw the"). 

7. Drag horizontally, selecting the word "lights", then 
release the mouse button. 

To drag, hold the mouse button down as you move the mouse. 
The selected \\"Orel is highlighted (surrounded by black or 
another color). 

ID Openin lines E:!li 
Selling across the blackness of space, adrift In on unknown sea, 0 
we sow the lmJlll of o city In t he distant horizon. Was It another 
strange land, with st range and cruel people speaking different 
languages, eating different rood, wearing different clothes? We 
wl shed It were home. 

8. With "lights" selected, type the words "clear blue". 

Whatever you type replaces the text you selected. If you make 
any typing errors, press the Delete key ro backspace over 
them. 

9. Now move the I-beam pointer to the immediate left of 
the word "city" (after "of a"). 

ID Opening lines 0 ! 
Soiling across the blackness or space, adrift In on unknown sea. 0 
we sow the clear blue of o ~ity in the distant horizon. Was It 
another strange land, with strange and cruel people speaking 
different languages, eating different food, wearing different 
clothes? we wished 1t were home. 

co11ti1111es Iii-
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10. Drag horizontally, selecting the word "city", then 
release the mouse button. 

I !&+___.....__..... & _3 Opening Lines El! 
Selling across the blackness of space, adrift fn 11n unknown se11, 0 
we sew the clear blue of II min the dlstent horizon. W11s it 
enother strenge lend, with strenge end cruel people speeklng 
different lengueges, eetlng different food, weerfng different 
clothes? We wished it were home. 

11. With "city" selected, type the word "planet". 

\\lhatever you type replaces the text you selected. 

12. Move the I-beam pointer between the letters "n" and "t" 
in the word "distant" (after "in the"). 

a! I l!iiik .•• ~ I Openln Lines§ - -c:@ 

Seiling 11cross the bleckness of space, 11drtft in en unknown se11, .0 
we sew the clear blue of t1 plt1net In the dlstt1njt horizon. Wes It 
another strenge land, with strange t1nd cruel people speaking 
different lt1ngu11ges, et1ting different food, wet1rlng different 
clothes? We wished It were home. 
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13. Drag horizontally, selecting the letter "t" and the word 
"horizon", then release the mouse button. 

1.11 Ir - - - - - - - - Opening Lines E!m 
Seiling 11cross the bleckness of spt1ce, t1drift in en unknown set1, 
we s11w the cleer blue of 8 pl11net in the dist11nmB!m- Wes It 
enother strenge lend, with strenge end cruel people spet1king 
different lengueges. e11tfng different food, weering different 
clothes? We wished it were home. 

14. With "t horizon" selected, type the letters "ce". 

If the period is missing after "distance". type one now. 

Opening Lines ! _- tt_ - - - reia 
Seiling ecross the bleckness of spt1ce, edrift in en unknown set1, 0 
we sew the cleer blue of 11 planet in the di stone~. Wt1s it another 
strange lend, with strenge and cruel people speaking different 
111ngu11ges, eetlng different food, wearing different clothes? We 
wished it were home. 

If you make any typing errors, press the Delete key to 
backspace over them. 



Save your work so far 
The changes you\."e made so far are not part of Opening Lines until 
you save them; that is, you need to tell the computer to record the 
changes in the document that's stored on Macintosh HD (your 
stam1p hard disk). 

Until you save them, the changes are in a very temporary, 
electronic state. You could lose them if power to the computer 
were intem1pted or if a problem with a program caused the 
computer to stop \vorking properly. 

Choose Save from the File menu. 

Or hold down the X (Command) key on the keyboard as you 
press the S key. Pressing X-S is a keyboard sl1011cu1 for choosing 
Save from the File menu. 

Save regularly, and save often. 

Taking a shortcut 

Many commands that you choose from menus can also be 
given using keyboard shortcuts. A keyboard shortcut is a 
combination of keys that you press at the same time to get the 
same result as choosing a command from a menu. One of the 
keys is always the X key or another modifier key. 

For example, instead of choosing Save from the File menu, you 
could press the X key and the S key together. 

You can find out the keyboard shortcuts for commands by 
pressing a menu name and looking at the commands in the 
menu. Any keyboard shortcuts are shown in a column next to 
the commands. 

Make more changes to a document 
You've saved the changes you've made so far: the changes are 
now part of the document that's stored on Macintosh HD. You'll 
be making a few more changes before you're done. 

You continue by moving some text to another place in the 
paragraph. 

1. Move the I-beam pointer to the immediate left of the 
words "We wished" (the start of the last sentence). 

2. Click. By clicking, you put the insertion point where 
you were pointing with the I-beam pointer. 

3. Move the I-beam pointer between the letter "e" in 
"home" and the period at the end of the last sentence. 

4. Hold down the Shift key on your keyboard and click to 
select the words "We wished it were home". 

Holding down the Shift key as you click selects the text 
between the insertion point and wherever you click. 

WJfua-- --- Opening Lines 
S11iling 11cross the bl11ckness of space, adrift in en unknown see, <> 
we s11w the clecr blue of 11 planet In the distance. Wes It 11nother 
strange lend, with strange end cruel people speaking different 
l11ngu11ges, e11t1ng different food, weer1ng different clothes? •.. , .... 

continues ..,. 
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5. With "We wished it were home" selected, choose Cut 
from the Edit menu. 

Choosing Cut removes whatever you've selected from the 
document and stores the selected material in a temporary 
electronic space called the Clipboard. 

Select Rll XR 

Show Clipboard 

6. Move the I-beam pointer to the immediate left of the 
words "Was" (in "Was it another strange land"). 

7. Click to set the insertion point. 
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8. Choose Paste from the Edit menu. 

Select Rll XR 

Show Clipboard 

The words "\Ve wished it were home'' appear at the location of 
the insertion point. When you choose Paste~ the Macintosh 
takes whatever's in the Clipboard and puts it in the document. 

Next. you ·11 del~te a sentence. 

9. Drag the I-beam pointer across the words "Was it 
another strange land" to select them, then release the 
mouse button. 

If the words are on two lines, drag down to the second line 
and release the mouse button when the pointer is to the 
immediate right of the word ''land". 

ID Opening Lines E!ll! 
S1111tng ccross the b111ckness of spece, edrift In en unknown see, 0 
we sew the cle11r blue of 8 plenet in the distence. We wished it 
were home , with strange and cruel 
people speeklng different lengueges, eeting different food, 
weering different clothes? . 



10. With "Was it another strange land" selected, choose 
Clear from the Edit menu. 

When you choose Clear, the Macintosh removes the selected 
teA1 from the document. (Pressing the Delete key once has the 
same effect.) 

Cut XH 
Copy XC 
Paste XU 
Clear , 

Select All XA 

Show Clipboard 

11. Select the word "cruel" (after "strange and") by double­
clicking it. 

You can select a word by double-clicking it: point to it with the 
I-beam pointer and click twice in rapid succession, without 
moving the pointer. 

!iO& Openln Lines E!:ID 
Seiling ecross the bleckness of spece. edrlft In en unknown see, <> 
we sew the cleer blue of e plenet in the distence. We wished It 
were h6me. with strenge end- people speeklng different 
l!mgueges. eetlng different food, weerlng different clothes? . 

12. With "cruel'' selected, type "wonderful". 

Whatever you type replaces the text you selected. 

13. Drag the I-beam pointer across the question mark (after 
"different clothes") and the stray period at the end of 
the paragraph, then release the mouse button. 

ID Opening Lines ---~ 
Selling across the blackness of space. adrift in en unknown see, 
we sew the clear blue of e planet in the distance. We wished It 
were home. with strenge end wonderful people speaking different 
languages, eating different food, weering different clothes 

14. With the question mark and the period selected, type a 
period 

You may have left extra spaces or no spaces between words. If 
you did, position the I-beam pointer where you need to delete 
or add a space, click to set the insertion point, and press the 
Delete key or the Space bar as necessa1y. 

Opening Lines -1011 
Seiling across the blackness of spece. adrift in en unknown see. <> 
we sew the cleer blue of e planet in the distence. We wished it 
were home. with strenge end wonderful people speaking different 
languages, eating different food, wearing different clothes! 

15. Choose Save from the File menu (or use the keyboard 
shortcut ~-S). 
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Choose a printer 
Before you can print a document, you have to tell the Macintosh 
which printer to use by choosing a printer in a program called the 
Chooser. 

You don't need to choose a printer every time you print. You need 
to choose one only when you want to use a printer for the first 
time and whenever ~ou decide to change printers. 

How you use the Chooser depends on whether your Macintosh is 
connected directly to the printer or connected to a network. 

If your printer is not on a network 

Make sure that you've connected the printer according to the 
instructions that came with it and that you know which pon you 
used (on the back of the computer) to connect the printer. 
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1. Choose the Chooser from the Apple menu. 

~ Control Panels 
(@)Key Caps 
b:J Note Pad 
~Puzzle 
ml Scrapbook 

The Chooser winduw appears. 

2. Click the icon representing the printer you want to use. 

lllI 

Make sure the icon is selected. 

~ 
AppltShort 

a6m 
§ 

LO AppltT ... 90'Wriltr 

IJ 
Pwson•l ... 'Wrltw SC 

~ 
AppltT•• ... 90'Writw 

@ 
Lasw'Writw 

~ 
LO lm09t'Wrilw 

Chooser · --

IQ Select 11 port: 

OActive 
AppleTelk ® lnectlve 

7.0 



·:· Ifyou have a Personal laser\firiter® SC, go to step 5 after you 
click the Personal LaserWriter SC icon. ·:· 

3. Click to select the icon representing the port that you 
used to connect the printer. 

You have two choices: the printer port or the modem port. The 
printer po1t is automatically selected. Click the icon that 
matches the icon of the port (on the back of the computer) to 
which you connected the printer cable. 

4. Click the word "Inactive" next to the word '~ppleTalk". 

5. Close the Chooser by clicking the close box near the 
upper-left corner of the Chooser window. 

The Opening Lines window should now be the active window. 
(If it isn\ click anywhere in it to make it the active window.) 

If your printer is on a network 

Find out from your nenvork administrator (or the person who set 
up your computer) \\'hich printer you can use, which zone it's in 
(if your network has zones)~ and what its name is (every printer on 
a network has its own name). 

1. Choose the Chooser from the Apple menu. 

~ Control Panels 
~Key Caps 
~Note Pad 
~Puzzle 
ml Scrapbook 

The Chooser window appears. 

continues ~ 
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2. Click the word "Active" next to the word '~ppleTalk". 

If Active wasn't already selected, a dialog box appears. 
Click OK. 

- Chooser 5± 

~ '°'. I Select a LaserWriter: 
:d. :: ! Backside 

.__""-~-·~_r11._r _Ap_·:__'a_--

9

_'.:_rn ...... w "'~I I ;i~1£f~~~'•• 
~ 

AppltShort 
lsMof.i E•unc.}n rffX , 

AppleTelk Zones: 

'°' 
.I.I

I Sojourn (LW NTX) 
Trek (NTX) 

DlllllDllB••··~ Turn me off when you're done. 
Loading ~ I 
No Perking l o 
0 ~1i=----------------------==~ 
Texi ~:li i Beckground Printing: ®On 0 Off 

~~~~~~t :~~ I ----·--·---·----®----·-·------·-·--·--· 
Unloading ~ ! AppleTelk • ActiYe 
~-~--------........ "" ' O lnectlYe 7.0 

3. Click the icon representing the type of printer you want 
to use. 

4. If you see a list of AppleTalk zones, click the zone where 
the printer is located. 

You may have to click the up and down scroll arrows to find 
the zone. The zones are listed alphabetically. 

5. Click the name of the printer you want to use, even if 
it's the only one that appears. 
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6. Click the close box near the upper-left corner of the 
Chooser window. 

If you changed printers, a dialog box appears. Click OK. 

The Opening Lines window should now be the active window. 
(If it isn:t, click anywhere in it to make it the active window.) 

Print a document 
Once a printer has been selected in the Chooser, printing becomes 
a two-step process. To practice printing, use the Opening Lines 
document you created. 

1. Make sure that the Opening Lines window is the active 
window, then choose Print from the File menu. 

New 
Opt~n ,,, 

Close XW 
Sm~e ~lt'S 

Saue As ... 

If the Opening Lines window is not the active window, click 
any\\rhere in it to make it the active window. 



The dialog box that appears when you choose Print offers you 
many options, depending on the program and the printer 
you're using. You can learn more about these options from the 
instructions that come with your programs and from 
Macintosh Reference, Part II of this book. 

Loserwrlter "Isadore Duncan NTH" ll Print B 
Coples:l•I Poges:@ Rll 0 from: D To: D ( Cancel ) 

Couer Poge: ®No O first Poge O Last Page 

Paper Source:® Paper Cassette O Manual Feed 

Print: ®Bleck & White O Color/Grayscale 
Destination: ®Printer 0 Postscript® Fiie 

2. Click the button labeled Print. 

The printer you chose prints your Opening Lines document. 

Quit a program 
Quitting a program closes the program as well as any documents 
you may have open that were created using that program. Quitting 
a program is not the same as closing a document (which you did 
at the end of Chapter 4). Closing a document leaves the program 
open and active. 

Make sure that the Opening Lines window is the active 
window, then choose Quit from the File menu. 

N<~W ~J{'N 

() IH~ lL,, ~Jt' 0 

Close xw 
Sm.-c~ ~}t'S 

Saue As ••• 

Page Setup ••• 
Print... XP 

Quit ., :~:o 

Or press the X key and the Q key together. 

·:· !la dialog box asks Ll'l1etheryo11 ll'ant to save an.v changes, 
click Save. ·:· 

The Opening Lines document and the TeachText program are 
closed, and the Finder, the program that displays the 
Macintosh desktop, becomes the active program. 
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Make a backup copy 
Storing a copy of your work on another disk is wise practice. like 
saving regularly and saving often. In case a file or an entire disk is 
damaged, you have a copy of the file on another disk as a backup. 
Ot seldom happens, but if it happens once to you. ifs happened 
once too often.) 

To practice making a backup copy, put a copy of Opening Lines 
on your practice disk. 

1. Make sure your practice disk is unlocked. 

A moveable tab on the back side of the case should be 
blocking the square hole near the lower-left corner (when you 
hold the disk as if to insert it), indicating that the disk is 
unlocked. 

2. Insert the practice disk in your computer's floppy disk 
drive. 

The Practice disk icon appears on the desktop, directly below 
the Macintosh HO icon. 

58 Chapter 5: Changing a Document and Printing 'ibur Work 

3. Drag the Opening Lines icon to the Practice disk icon 
until both icons are highlighted, then release the mouse 
button. 

·~=·=~·=-:i-:·~=-:·~=·=~·=·=i·=·~=-:-~:·:~·:·:i·:·i=-:·§:·:]·=·:~·:·::::::::=====:=========================================:=========:=======:=:=: 
El _____ 0_§ ~t??t????tttt]~~~~~~~Wlf ff 

34.2 MB available ~{{:}~:}~:}}~(:}~:~ M~·~;·~~~~i; HD\ 

I 
ii1S6!&141M 

0

llllllllllllllllllll11111
1

1
1

1
1

lllllllllllllllllllllilll 
~((~{}}~~~~~(~{!;~;~;~;~;~;~;~;~;~;~;~;~;~;~;J}{ 
:;:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: 

en_ :·:·:·:·:·:·:·:-:·:·:·:·:·:·:·:·:-:·:-:-:·:·:-:·:·:-:·:-:-:-:·:·:·:·:·:·:·:·:· 

Both icons are highlighted when the tip of the pointer arrow 
reaches the Practice disk icon. 

When you release the mouse button, the Macintosh copies the 
contents of the Opening Lines icon to the Practice disk. 

You copy an icon when you drag it to a d([ferent disk. When 
you drag it elsewhere on the same disk, you are merely 
moving the icon. 



4. Open the Practice disk icon. 

YOu open the Practice disk icon by clicking the icon to select it 
and then choosing Open from the File menu, or you can 
double-dick the icon. 

The Practice disk window appears, showing that a backup 
copy of the file, also called Opening Lines, is stored on the 
floppy disk. 

5. Eject the Practice disk from the disk drive. 

You eject the disk by clicking the Practice disk icon to select it 
and then choosing Put Away from the File menu. 

New Folder XN 
Open XO 
Print ~lw 

[ tos<~ Window ~lt'UJ 

Get Info XI 
OupHC<lt <~ ~]t'O 

Make Alias 
Put Awa_y :~:Y 

Find... XF 
Find Again XG 

Page Setup ... 
Print Desktop ... 

\f!hat 1 z ext? 

Go to Chapter 6~ where you'll learn how to organize your work. 
Or take a break. Remember to turn off your Macintosh if you'll be 
away for more than a few hours. 
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Chapter6 

Organizing Your Work 
In this chapter 

You 'll learn how to 

• make a copy of a document 

• change the name of an icon 

• sa,·e another ,·ersion of a document under a different name 

• open a document while its program is the active program 

• organize icons in a folder 

• use an alias for a document or program 

• create statione1y 

• throw ct\\·ay files you no longer \Yant or need 

You·11 also learn about 

• the difference between Save and Save As 

• what an alias is 

It \\·ill take about an hour to go through this chapter. 

Beforeyou begin 
You do not need to go through this chapter before you st:irt 
learning how to use your Macintosh programs. 

You should have already 

• gone through Chapters 1 through 5 

If your Macintosh is off. turn it back on. 
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Make a copy of a docun1ent 
In the course of your work, you ·11 often want to make a copy of a 
document so you can preserve the original while making changes 
to the copy. To practice making a copy of a document, first create 
a new document, as you did in Chapter 5. 

1. If you closed the Macintosh HD window, open the 
Macintosh HD icon. 

To open the icon, click it to select it and then choose Open 
from the File menu. Or double-click the icon. 

The Macintosh HD window appears, showing you the contents 
of your startup hard disk. 

2. Open the TeachText icon. 

To open the icon, click it to select it and then choose Open 
from the File menu. Or double-dick the icon. 

When you open the TeachText program, 

• an untitled window appears 

• the menu bar shows 'IeachText menu names 

• the Application menu icon in the right corner of the 
menu bar becomes the TeachText icon 

The untitled "\Vindow contains nothing because you haven't 
written anything in it. It stays untitled until the first time you 
save your work (name the document and store it on a disk). 
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3. Type the following text: 

Dear Mom and Dad, 

This letter is overdue, I know, but until I 
sat down to write, I had no idea how long 
overdue it is. Time sure flies when you 
don't have enough of it. 

Julie and I are doing well. The dog is 
getting better all the time. How are you 
all? 

Remember: 

• If you make a mistake, press the Delete key to backspace 
over it. 

• Don't press the Return key when you get to the end of a 
line. Keep typing. The text will continue on the next line 
automatically. 

• Press the Return key only when you want to start a new 
paragraph. 

• The inse11ion point-the blinking vertical line-is where 
the text you type will appear. 

• The I-beam pointer replaces the arrow pointer 'vhen you're 
dealing with text. You control the I-beam pointer with the 
mouse as you would the arrow pointer. 



4. Choose Save from the File menu. 

The dialog box that appears lets you name the document and 
decide where you want the computer to store it. 

;. Type "Letter to Parents". 

-~'=c:::>=M=a=cl:::nt:::::::os=h=H=D•~! ~~ c:::> Macintosh HD 
D Openin1.1 l.ine~ Si ( Ijl•1:1 ) 
Ci Heod Mt~ 
Cl System Folder ( Desktop ) 
~ ·r.~1u:ttr<m1 I New LI ) 

I Cancel J 

,__ _______ _._-0~ (I Saue J) 

Saue this document as: Q g 
._[lett!_et_te_r _to_P_ar_en_t_,_~ __ __,I ®CJ 0 OJ 

Usually you need to select text or set the insertion point before 
you type text. In this case, because "Untitled'' is selected when 
the dialog box appears, all you have to do is start typing. 
Whatever you type replaces the selected text. 

6. Click Save. 

The winduw is now titled .. Letter to Parents" and the document 
has been stored on Macintosh HD (your startup hard disk). 

7. Close the Letter to Parents window. 

To close the window, dick the close box near the left end of 
the title bar, or choose Close from the File menu. 

The window closes, and TeachText remains the active 
program. 

8. Click the Macintosh HD icon, the Macintosh HD 
window, or anywhere on the desktop. 

The Finder becomes the active program. Among the contents 
of the Macintosh HD window is the Letter to Parents icon, 
representing the document you created and saved. 

9. Locate the Letter to Parents icon in the Macintosh HD 
window. 

Ybu may have to make the window bigger or use the scroll 
arrows to find it. 

10. Click the Letter to Parents icon to select it. 

I 
''"""WW' 

continues ...,. 
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11. Choose Duplicate from the File menu. 

New Folder 
Open 
Print 

3CN 
:!CO 
3CP 

Close Window :!CW 

Get Info :lei 

Put nurnq 

Find.. . :!CF 
Find Again :!CG 

Page Setup .•. 
Print Window ... 

Another icon. labeled ''Letter to Parents copy". appears in the 
Macintosh HD window. Notice that the icon (as well as its 
name) is selected and that the Letter to Parents icon is no 
longer selected. 

Letter to 

64 Chapter 6: Organizing Your Work 

Change the nan1e of an icon 
You can change the name of any icon to anything you like, using 
spaces, capital and lowercase lerters, numbers. and any other 
characters except a colon(:). If you open the icon, you'll see that 
the name of its window has also changed. 

1. Drag the "Letter to Parents copy" icon away from the 
original icon so that the two icons do not overlap. 

2. Click the name (not the icon) "Letter to Parents copy" 
(even if the icon is selected). 

When the name is selected, it is highlighted and a box appears 
around it. Notice that when you point to the selected name, 
the arrow pointer becomes an I-beam poinrer. 

3. With the name selected, type "Letter to Sister". 

Or drag the I-beam pointer over the words ·'Parents copy" to 
select them, and then type "Sister" to replace them. 

Another way to select a wore! is to double-click it: click 
anywhere inside the word twice in rapid succession, without 
moving the pointer. 

\'X1hatever you type replaces the selected text. 



4. Press the Return key. 

Q 
D 

Le Her to Pa rents 
I 

Now you have rwo documents. One is a copy of the orher but 
they have different names. You can revise one without 
changing the other. 

5. Open the Letter to Sister icon. 

To open the icon, click it to select it and then choose Open 
from the File menu. Or double-click the icon. 

TeachTexr becomes the active program. 

6. Drag the I-beam pointer over the words "Mom and Dad" 
to select them. 

- l etter to Siste r 01 
{} 

This letter fs overdue. I know, but unlfl I set down to write, I had 
no Idea how long overdue H Is. Time sure rlfes when you don't have 
enough of II. 
J uli e end I ere doing well. The dog is getlfng belier ell the lime. 
How ere you ell? 

7. 'I)'pe "Sis". 

Whatever you type replaces the selected text. 

~ l etter to Sis t e r 
Deer SI . 
This letter Is overdue, I know. but unt11 I sol down to wri te, I had 
no Ides how long overdue It Is. Time sure rlfes when you don' t 
hove enough of It. 
Julie and I ere doing well. The dog is getlfng better ell the time. 
How ere you ell? 

8. Choose Save from the File menu. 

9. Choose Close from the File menu. 

Or click the close box near the upper-left corner of the Lener 
to Sister ~·inclow. You now have two slightly different versions 
of your letter: one for your parents, and the other for your 
sister. 

Teach'Text remains the active program. 
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Save another version of a docu1nent 
There is another way to make a different version of a document. 
You can stay in the program you're using to create the document 
and save a different version under a different name. 

1. Click the Macintosh HD icon, the Macintosh HD 
window, or anywhere on the desktop. 

The Finder becomes the active program. 

2. Open the Letter to Parents icon. 

'lb open the icon, click it to select it and then choose Open 
from the File menu. Or double-click the icon. 

TeachText becomes the active program. 

3. Drag the I-beam pointer over the words "Mom and Dad" 
to select them. 

4. Type "Juan". 

Whatever you type replaces the selected text. 

iiOt:.r+e;. -~ ·s Letter to Parents Eli! 
Deer Jue • -0 
This letter is overdue, I know, but until I set down to write, I had 
no idea how long overdue It ls. Time sure flies when you don't have 
enough of It. 
Julie and I ere doing well. The dog is getting better ell the time_ 
How ere you ell? 
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5. Choose Save As from the File menu. Do not choose Save. 

NHW 

OtH~n.,, 

Close XW 
Saue XS 

Page Setup ... 
Print... XP 

Quit XQ 

Choosing Save would change the original letter (so that the 
letter to your parents would read .. Dear Juan"). 

Choosing Save As. in contrast, lets you create a new document 
based on the original document. hut including the changes 
you made. 

The dialog box that appears lets you name the new document 
and decide where you want the computer to store it. "Letter to 
Parents,., the name of the original document, is already 
selected and ready to be changed. 



6. Type "Letter to Juan". 

lc::::1 Moclntosh HD• I c::> Moclntosh HD 
~~~ .• -l.e~11=ei=·1=o=P.=·1r=er=1h====---~~ 
D l.<!11<ff 1o Sis1<ff 

i..:::.. ( r.11~1:1 ] 

D D1>1~nin1.J l.irl<!~ ( Desktop J 
D Hl'IH1 Me 
CJ System Folder ( New CJ J 
¢1 ·re11r.tll'<m1 

Concel 

~-------......... Q ([ Soue )J 
Soue this document os: 

I .... L_et_te_r_to_J_u_o~ __________ __.I @ B 0 a 

Whatever you type replaces the selected text. 

7. Click Save. 

The new document, "Letter to Juan," now appears in the active 
window, replacing the original document, "Letter to Parents." 
Notice that the window's title bar now says, ''Letter to Juan". 

The original document is set aside, unchanged (if you open it, 
you'll find that the first line is still "Dear Mom and Dad''). 

Save?--or Save As? 

Choosing Save stores the changes you've made to the active 
document (the document in the active window) since you 
opened it or since the last time you chose Save. 

Choosing Save As, on the other handi creates a new document 
that includes the changes you've made. Save As sets aside the 
original document without storing the changes (in other 
words, the original document remains unchanged from when 
you opened it or last chose Save). 

After you give the new document a name, it replaces the 
original document in the active window. The title bar of the 
active window shows the name of the new document. 
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Open a docun1ent while its progra111 is 
the active program 
You can open a document without making the Finder the active 
program and then opening its icon on the Macintosh desktop. You 
can open a document while the program that you used to create it 
remains the active program. 

1. Close the document "Letter to Juan." 

Click the close box near the upper-left corner of the document 
window or choose Close from the File menu. 

TeachText remains the active program. 

2. Choose Open from the File menu. 

The dialog box that appears lets you find the document you 
want to open. 
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3. Click "Letter to Parents." 

l=Mocintosh HD..,.. I 
D Letter to Juon 0 
mi· ' .. 
D Letter to Sister -"l'" 

D Opening Lines 
D Reocl Me 
O System Folder 

to 

4. Click the Open button. 

= Mocintosh HD 

( [jf)f.1 l 
[ Desktop 

[ concel J 

(( Open Jl 

The "Lener to Parents'" document window appears. 

Organize icons in a folder 
Sooner or later, in the course of your work, you'll have too many 
documents and programs to keep track of easily. The Macintosh 
offers numerous tools and techniques (all of them explained in 
Macintosh Reference. Parr II of this book) to hel p you organize 
your work. Creating a folder and putting files in it is the simplest 
way. 



1. If "Letter to Parents" is open and TeachText is the active 
program, choose Quit from the File menu. 

The Finder becomes the active program. 

2. If the Macintosh HD icon is not open, open it. 

The Macintosh HD window should be the active window. 

3. Choose New Folder from the File menu. 

DIH~n 
Print ~}(:p 

Close Window XW 

An icon named "untitled folder" appears in the Macintosh HD 
window. The icon, including its name! is already selected. (The 
name is highlighted and has a box around it.) 

4. fype "Letters to Family". 

-

Whatever you type replaces the selected text. If nothing 
happens when you type, click the name so that a box appears 
around it and then t1y again. 

5. Drag the Letter to Parents icon to the new folder icon 
until both icons are highlighted, then release the mouse 
button. 

I 
g 
D 

Letter to Juan 

I"'""''! 
r.::::::::...! ... ! 

g 
D 

Letter to Sister 

6. Drag the Letter to Sister icon to the Letters to Family 
folder icon until both icons are highlighted, then release 
the mouse button. 

I 
r ...... ~ 

, ............. = •••••••••• , 
: : :.......... . .......... : ,., ..• 

The Letters to Family folder now contains Letter to Parents and 
Letter to Sister. You can open the Letters to Family folder icon if 
you want to make sure that they are there. 
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Use an alias 
As you work, you may find it handy to have the same program or 
document stored in more than one folder, so you can open it 
quickly when you're in a particular folder. 

1. If the Macintosh HD icon is not open, open it. 

The Macintosh HD window should be the active window. 

2. Choose New Folder from the File menu. 

An icon named "untitled folder" appears in the Macintosh HD 
window. The icon, including its name, is already selected. 
(The name is highlighted and has a box around it.) 

3. Type "October Letters". 

Whatever you type replaces the selected text. 

4. Open the Letters to Family folder icon. 

5. Click the Letter to Sister icon to select it. 

I 
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6. Choose Make Alias from the File menu. 

New Folder WN 
Open WO 
Print WP 
Close Window WW 

Get Info 
Duplicate 

WI 
WO 

An icon named "Letter to Sister alias·· appears on top of the 
Letter to Sister icon. The icon and its name are already 
selected. 

Letter to 

Note that the name of the alias appears in italics. The name of 
an alias appears in italics so you have a way to tell which 
icons are aliases. 



tflhat 's an alias? 

An alias is a way to represent a program or document in any 
folder without having to make a copy of the file. An alias 
merely "points" to the original fi le that it represents, so when 
you open an alias, you're actually opening the original file. 
Any changes you make and save are stored with the original 
file, so you see them when you open any of the aliases for the 
original file (you can make as many aliases for a program or 
document as you need). 

You could make copies of a program or document and put 
them in separate folders, but the copies would take up much 
more room on your disk than a single copy. And if you want 
the copies to be always exactly alike, you'd have to make the 
same changes to each copy if you make any changes to one 
copy. 

Using aliases instead of making copies of a program or 
document Jets you save space on your disks. 

7. Drag the Letters to Family window to the right. You 
should be able to see the October Letters folder in the 
Macintosh HD window behind it. 

8. Drag the Letter to Sister alias to the October Letters 
folder in the Macintosh HD window, then release the 
mouse button. 

Mocintosh HO } 
7 ittms ID Letters to roml!JL 1!11 

B 
l•tttr to .Ju1n 

You may have to change the size and position of the Letters 10 

Family windo\\· so you can see both icons. 

9. Open the October Letters folder icon. 

10. Open the Letter to Sister alias icon. 

The document Lener to Sister opens. and Teach Text becomes 
the acti,·e program. 

The insertion point (the blinking vertical line) should be at the 
beginning of the document, to the left of Din ·'Dear". 

co11/i1111es .,.. 

Chapter 6: Organizing Your Work 71 



11. 1}'pe "16 October 91" and press the Return key once. 

0 Letter to Sis ter 01 
16 October 91 0 

pear Sis, 
This leller Is overdue, I know, but unt11 I sal down lo write, I had 
no Idea how long overdue 1t Is. Time sure rites when you don' t have 
enough or It. 
J ulle and I are doing well. The dog Is gel ling belier all l he lime. 
How are you all? 

12. Choose Save from the File menu. 

13. Choose Close from the File menu. 

The Letter ro Sister document closes, and TeachText remains 
the active program. 

You can open the original Letter to Sister icon (in the Letters to 
Family folder) and see that it is non· dared 16 October 91. 

Letter to ister is now available in both the Letters to Family 
folder and the October Letters folder. By keeping the original 
in one folder and an alias in the other folder, you have access 
Lo the same letter from either folder. 

14 . . Close all the windows on the desktop. 
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Create statione1y 
In your work, you may find it convenient to have a document that 
serves as the computer equivalent of srarione1y, like a memo pad 
or "While You Were Out" form. Each time you need a sheet, you 
take one from your endless supply uf stationery and fill iL in. 

To practice creating statione1y create a document in Teach Text 
Lhat works like a memo pad. 

1. With TeachText the active program and no TeachText 
window open, choose New from the File menu. 

t: lose :)f:IH 
Sm•(~ :)f:S 

If TeachTexr is not the active program, open the TeachTexr icon 
in the Macintosh HD window, or choose Teach Text from the 
Application menu. 

An untitled 'leachText window appears. 



2. 'fype the following text: 

DATE: 

TO: 

FROM: [Type your name here.] 

RE: 

3. Choose Save from the File menu. 

The dialog box that appears lets you name the document and 
decide where you want the computer to store it. 

·:· If Macintosh HD does not appear above the list, click 
Macintosh HD above the Eject button. •:• 

4. 'fype "Memo Pad". 

...,,,---!:lc:J=M=nc:::ln=to=s=h ="o:::..-=.1___,,...,,..., c:::> MDClntosh HD 

D l.<~11<ff 1<1 Jmm Q [ [j•~c1 ) 
Cl Letters to Fnmlly 
Cl October Letters ( Desktop J 
D DtH~llil\I] Lin<~~ 
u lh~1uS M•~ ( New LI ) 
Cl system Folder 
~ Tr.tu:tll'cm1 I Cnncel ) 

......__ _______ ...._.-0 ([ Snue }J 

Snue this document as: g 
..... I M_e_m_o P_a ..... ~ ____ _..l ® EJ 0 OJ 

Because "[ntitlecr is selected when the dialog box appears, all 
you have to do is start typing. Whatever you type replaces the 
selected text. 

5. Click Save. 

The window is now titled iiMemo Pad" and the document has 
been stored on Macintosh HD. 

6. Close the Memo Pad document. 

To close the window, click the close box near the left end of 
the title bar, or choose Close from the File menu. 

The windmv closes. and TeachText remains the active 
program. 

7. Click the Macintosh HD icon, the Macintosh HD 
window, or anywhere on the desktop. 

The Finder becomes the active program, and the Macintosh HD 
window becomes the active window. Among its contents is the 
Memo Pad document icon. 

8. Click the Memo Pad icon to select it. 

conti1111es .... 
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9. Choose Get Info from the File menu. 

New Folder XN 
Open XO 
Print XP 
Close Window XW 

The Info window that appears contains information on the 
selected icon. 

10. Click "Stationery pad" near the lower-right corner so 
that anX appears in the checkbox. 

Ii~ Memo Pad Info ~ 

13 MtmoPMI 

Ktncl: TtochToxt sl•tioMnJ p•d 
Sin: tl<ond\$k(t9b<,ltu~std) 

Yhr•: ~intosh HO: 

CrHt•d: Tut, Stp J, t99t, ':S7 AM 
tlodtfl.d : Tut, Stp J, 1991 , 6 ;57 AM 
Ynslo•: not •voli.lt 

0 L.clc9d 181 StatlHff9 pad 
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Clicking "Stationery pad" converts Memo Pad from an ordinary 
document to a stationery pad. When you open a stationery 
pad, an untitled window appears showing a blank "fonn" 
from that stationery, or a dialog box appears asking you to 
name the new document. 

You cannot change the stationery pad itself unless you turn it 
back into a regular document. You do this by opening the 
stationery pad's Info window and clicking "Stationery pad" 
again to remove the .X. 

11. Close the Info window. 

To close the window, click the close box near the left end of 
the title bar, or choose Close Window from the File menu. 

Note that the Memo Pad icon has changed from an ordinary 
document icon to a stationery pad icon. 

f;J 
OJ 

Memo Pad 



On your own: Fill out some statione1y 
Open the Memo Pad stationery pad icon and type a short memo. 

Remember to click the I-beam pointer where you want vour text 
to appear before you start typing. Clicking in this way s~ts the 
insertion point (the vertical blinking line). 

Choose Save from the File menu, name your memo, click the Save 
button, and choose Quit from the File menu. 

Note that the Memo Pad stationery icon remains in the Macintosh HD 
window. The icon for the memo you created (an ordinaiy document 
icon) should also be in the window. 

What next? 

Go to Chapter 7, where you'll learn how to find out more about 
your Macintosh. Or take a break. 

Remember to turn off your Macintosh if you'll be away for more 
than a few hours. 
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Chapter 7 

Learning More About 
Your Macintosh 
!11 th is chapter 

You'll learn ho"'· to 

• use the Balloon Help system 

• use Macintosh Reference. Part II of this book 

You·11 also learn about 

• the contents of 1llaci11tosh Reference 

It will rake about 20 minutes ro go through this chapter. 

At the end of this chapter. you'll be ready to start learning the 
programs that you intend to use on the Macintosh. 

Before you begin 

You should have already 

• gone through Chapters 1 through 6 

If you turned off the Macintosh at the encl of Chapter 6, turn it 
back on. 
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Use Balloon Help 
Balloon Help explains the function or significance of icons, 
menus, commands, and other features on the Macintosh screen 
using balloons similar to those you see in comic strips. The 
balloon points to the object it explains. 

Many Macintosh programs have Balloon Help. 

1. Point to the Help icon near the right end of the menu 
bar. 

2. Press to pull down the Help menu. 

' 

3. Drag to the Show Balloons command (the second item 
in the Help menu) so that it is highlighted, then release 
the mouse button. 

Finder Shortcuts 

After you choose Show Balloons, balloons containing 
explanatory text appear next to objects that you point to on 
screen. 
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4. To show a balloon describing the 1htsh, point to the 
1htsh icon. 

Except for the fact that balloons appear next to objects that you 
point to, the way you work is the same: you can select icons, 
choose commands, and so on. 

5. Point to the Macintosh HD icon (your startup hard disk). 

A balloon appears next to the icon. 

6. Click the Macintosh HD icon to select it. 

You can select the icon even with the balloon showing. 

7. Point to the File menu. 

A balloon appears next to the menu name. 

8. Press to pull down the File menu. 

The balloon disappears when you pull down the menu. 

9. Slowly drag to the Open command so that it is 
highlighted, then release the mouse button. 

Notice that a balloon appears next to a command if you pause 
briefly as you drag past it. 

The Macintosh HD ·window becomes the active window. To 
see more balloons, you can point to different parts of the 
window and to different icons in the window. 



10. Choose Hide Balloons from the Help menu. 

Finder Shortcuts 

To choose Hide Balloons, point to the Help icon in the menu 
bar, press to pull down the Help menu, drag to the Hide 
Balloons command so that the command is highlighted, and 
release the mouse button. 

Hide Balloons and Show Balloons replace each other in the 
Help menu (after you choose one, the other appears in its 
place). 

Use JV!acintosh Reference 
iliacintosh Reference, Part II of this book, contains all the 
information you need to use your computer effectively and 
efficiently. Unlike Part I, which is meant to be read from beginning 
to end, Part II is meant to he used like a dictionary: you turn to it 
when you need to look up some information, and then you read 
only that information. 

To help you find the information, this book has a table of contents, 
an index, a glossary, and a summary after Chapter 16 (on the 
green pages). To practice using the reference, look up a few topics 
that you'll probably need to know about in the near future. 

1. Find "Cleaning the mouse" under Chapter 15 in the 
table of contents. 

2. Go to the page that you're referred to and read about 
how to clean the mouse. 

3. Use the index to find information on erasing floppy 
disks. 

Erasing a disk is the same as initializing. Initializing a new disk 
is explained in Chapter 3 of this book. 

Several index entries refer you to the infonnation you need. 

• You could look under "disks'' and find "erasing.'' 

• You could look under "erasing'' and find "disks ... 

• You could look under "floppy disks" and find "erasing ... 
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What's in Macintosh Reference 

Part II of this book, Macintosh Reference, has almost no 
information on using application programs. Your best source 
of information about a pa11icular program is the set of books 
and disks that came with that program. 

JV/acintosh Reference has detailed infonnation on 

• setting up your system software 

• using hard disks and floppy disks 

• organizing your files 

• adapting your Macintosh to your own use 

• printing 

• using your .Macintosh on a network 

• expanding your computer system 

• care and maintenance 

• tips and troubleshooting 

The setup book that came with your computer has information 
on the features specific to your particular model. 
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4. Go to the pages that you're referred to and read about 
erasing disks. 

Some of the pages are about initializing disks. 

5. Find "Glossary" in the table of contents. 

6. Look up "keyboard shortcuts" in the glossary. 

Using keyboard shortcuts as a way of choosing commands is 
explained in Chapter 5. 



What next? 

Congratulations. You've gone through the J11lacintosh Basics tour 
and you're done with Learning Macintosh, Part I of this hook. 
You've been introduced to and practiced everything you need to 
know to start using the Macintosh in a productive way. 

There is more to learn before you're using your computer in the 
most effective and most efficient ways-but you'll be learning 
those ways as you use your programs and gain more experience 
·with the Macintosh. 

At this point, you could 

• start learning how to use your Macintosh programs 

• go to Chapter 11 to learn about ways to adapt your Macintosh 
to your specific needs or preferences 

• go to Chapter 13 to learn about using your Macintosh on a 
network with printers and other computers 

• take a break 

To help you find information in this book. use the table of 
contents; the index; the glossary; or the summary, "Working on the 
Macintosh Desktop," on the green pages after Chapter 16. 
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Part II 

Macintosh Reference 
Chapter 8 Setting Up Your Macintosh System 

Chapter 9 Hard Disks and Floppy Disks 

Chapter 10 Organizing four Files 

Chapter 11 Adapting Your Macintosh to Your Own Use 

Chapter 12 Printing 

Chapter 13 Using Your Macintosh on a .\etwork 

Chapter 14 Expanding Your Macintosh System 

Chapter 15 Care and Maintenance 

Chapter 16 Tips and T!'Oubleshooting 

Summary Working on the Macintosh Desktop 

How to use Pait II 
U'ie this part qf" the book as you would a dictionmy or 

e11cyclopedia: 7i1m to ii wlze11 yo1111eed spec[fic i11formation, and 

then read 011~ ) ' those parts that gii;e you that i1!/omwtio11 - so you 

CCIII go Oil ll'ith JOU/' ll'Ork. 

i1vlaci11tosh R4ere11ce contains little or no information on how to 

use your application programs. If you need information on a 

particular program, go to the hooks and disks that came with that 

program. 

Tf you're new to computers or new to the Macintosh, go through 

the Macintosh Basics tour and Parr l of this book, Leami11g 

Maci11tosh. to learn basic .\lacinrosh skills before you use 

Macintosh Neference. 

To help you find information in this book, use the index and the 

table of contents. Also, use the summary, ··working on the 

Macintosh Desktop ... on the green pages after Chapter 16 and the 

glossary at the hack of the book if you're looking for short 

definitions or brief summaries of concepts and procedures. 
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If you need information on setting up your Macintosh or any 

information on features specific to your parlicular model, go to the 

setup book that came with your computer. 

Use this book in combination with the setup book, the books and 

disks that came with your application programs, and Balloon Help 

to find the information you need. 
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Chapter 8 

Setting Up Your 
Macintosh System 
In this chapter 

• Serting up your computer hardware 

Arranging your office 

Avoiding fatigue 

Adjusting your keyboard 

• Setting up your system software 

Installing. reinstalling. or updating system sofr\\·are 

Starting up ''"ith a floppy disk 

• Setting up your programs 

Installing a program 

Working with several programs at a time 

Setting up your computer hardware 
For information on assembling the hardware components of 
your computer system, go to the setup book that came with 
your Macintosh. 

If you're connecting your ~'laci ntosh to a printer, a modem, an 
external floppy disk dri,·e. an external hard disk drive, or other 
external devices, go to the instructions that came with the device, 
or see Chapter 14. "Expanding Your .'vlacintosh System:· 

If you're connecting your computer to another Macintosh or to a 
printer on a network. see Chapter 13, ··using Your Macintosh on a 
Network:· 
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Arranging your office 

Here are some guidelines for adjusting the furniture in your office 
to accommodate your physical size and shape. 

• Adjust the chair so your thighs are horizontal. your feet flat on 
the floor, and the backs of your knees slightly higher than the 
seat of your chair. (If your chair is too high for your feet to rest 
on the floor, use a footrest.) 

• Use a chair that supp011s your lower back. 

• When you use the computer keyboard, your shoulders should 
be relaxed. )bur upper arm and forearm should form a right 
angle, with your wrist and hand in roughly a straight line. 

• Arrange the monitor so the top of the screen is at or slightly 
below eye level when you're sitting at the keyboard. 

• Position the monitor to minimize glare and reflections on the 
screen from overhead lights and windows. 

• Clean your screen regularly. 

A variety of accessories, including document holders, keyboard 
trays, and monitor stands, may enhance your comfort ·while using 
the computer. 
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Avoiding fatigue 

These tips should help you get the most out of your work sessions 
with the computer. 

• Regularly change your seated position, stand up, or stretch 
whenever you sta11 to feel tired. Research indicates that 
frequent "micro-breaks'' are helpful in reducing fatigue and 
discomfort. 

• Use a soft touch on the keyboard and keep your hands and 
fingers relaxed. Some computer users may develop discomfort 
in their hands, wrists, or arms if they do intensive work without 
breaks. If you begin to develop chronic pain and discomfort in 
your hands, wrisrn, or arms, consult your physician. 

• Keep two fingers (the index and middle fingers) resting lightly 
on the mouse button when you use the mouse. 

• Occasionally rest your eyes. From time to time focus your eyes 
on a distant object. Blink often while you work. 



Adjusting your keyboard 

If you bought the Apple" Extended Keyboard 11 with you r 
'vlacintosh. or if your Macintosh Classic or Macintosh LC came \Yith 
its standard keyboard, you can adjust the angle of the keyboard so 
that your hands and wrists are relaxed and you·re comfortable as 
you rype. 

The J\Iacintosh Classic or ~facinto·h LC standard keyboa rd has 
tabs on either side that S\Ying out under the keyboard. changing 
the angle of the keyboard on your desk. 

The Apple Extended Keyboard II has a sliding tab in the back that 
controls how much a bar extends under the keyboard , changing 
the angle of the keyboard on your desk. 

A bar extend~ 
as the slide is mored. 
increasing the 
keyboard anglt:. 
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Setting up your system software 
four .Macintosh cannot operate without system software-the 
programs and other files that the Macintosh needs to sta11 itself up 
and to run the application programs you use. \\lhen you turn on 
your Macintosh, it looks for a disk that contains the svstem 
software (in a folder called the System Folder). Any disk that 
contains the system software is a sta11up disk. 

Almost always, the startup disk is a hard disk that's inside or 
connected to your computer. A floppy disk can also be a startup 
disk. 

If your Macintosh cannot find a startup disk. it displays this icon in 
the middle of the screen: 

If you see this icon, you have to install system software on your 
computer's internal hard disk (or an external hard disk that vou 
turned on before you turned on your Macintosh). ' 

·:· Ifyou'ue a/reac(r i11stalled system sojill'are and you see this 
icon. you may need to reinstall system software. See "Sta11ing 
Up \X'ith a Floppy Disk'' later in this chapter. ·:· 
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Installing, reinstalling, or updating system software 

You use the Installer program to install, reinstall, or update system 
software on a hard disk that you want to be able to use as a 
startup disk. 

~ Important: Before you install a new version of system 
software, make a backup copy of the old version on another 
disk in case you need it at a later time (to run a program that is 
incompatible with the new version, for example). ~ 

When you use the Installer to update your system software, you 
keep any fonts. sounds, drivers, and other files you may have 
installed in addition to standard system soft\vare. (You could 
throw a·way your current System Folder and replace it with the 
newer one, but then you'd lose those special files.) 

Before vou heoin 
J ~ 

To install, reinstall, or update system software, you need 

• an initialized hard disk 

• the set of Macintosh system soft\vare disks that came with your 
computer or that you purchased as a separate system sothvare 
kit. The Installer program is on the disk named Install 1. 



If your Macintosh is connected to a network and you have access 
to the Installer program and system software on a file server or 
another computer, you don't need the system software disks. You 
can open the Installer program and then follow the procedure 
below, beginning with step 4. 

If you have a hard disk that hasn't been initialized (that is, its icon 
doesn't even appear on the Macintosh desktop). go to Chapter 9, 
"Hard Disks and Floppy Disks,., for instrnctions on initializing a 
hard disk. 

A Warning: If you purchased a hard disk with the A/UX~ 
operating system installed on it do not initialize that disk: 
doing so will erase A/UX. See the instructions that came with 
the A/UX operating system. • 

Installing a standard system 

The Installer program's Easy Install dialog box lets you install the 
standard system software on your Macintosh. 

1. Turn off your Macintosh. 

2. Insert the Install 1 disk into the internal floppy disk 
drive. 

If your Macintosh has two floppy disk drives, you can use 
either one. 

3. Turn on your Macintosh. 

The Installer program opens automatically. 

4. Click OK or press the Return key on your keyboard. 

The Easy Install dialog box appears. 

Parts of the svstem 
software to tje installed 

Easy Install 

Button to switch 
to a different disk 
for installation 

r-........... ·-·-·-----... -... - ... --··-··-·· .. ·----· .. ·----·--·--------.. ·· .. -----.. ··--·-··-·-··----·-·-··1 
! Click Install to update to Uerslon 7.0 of ! 
I • Macintosh 11 System Software I 
1 

• Any (Histing Printing Software ([ Install D ! 
• File Sharing Software , ... 

1

1

1

i. 

on the hard disk named 

L .. ,_ ~ .... ~~.~~!.~.~~~!-·--·-.. ---·---.. --··-·-----··--·-.. ---·----··- ··-··-·-·-· .. -·-·-·-··-·--·-·-·-· .. ! 
[ E}EHt DM: I 

Help 

Disk on which svstem 
software will be 'installed 

L( Switch Disk J 

Customize J 
Quit 

Button to change to a 
customized installation 

co11/i1111es ._ 
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5. Make sure that the hard disk indicated in the box is the 
one you want to install system software on. If a different 
disk name appears, click the Switch Disk button until 
the correct disk name appears. 

6. Click Install or press the Return key on your keyboard. 

The Installer hegins to install system software for your 
Macintosh model. 

7. Follow the instructions that appear on screen. 

When a disk is ejected and you see a message instnicting you 
to insert another system software disk, inse1t the disk specified. 

8. When you see a message reporting that the installation 
was successful, click Quit or press the Return key to quit 
the Installer program. 

If a message reports that installation \Vas not successful, follow 
the instructions on screen to try installing again. 

9. Click Restart in the dialog box that appears when you 
quit the Installer. 

The Macintosh restarts using the newly installed system (or 
using your current startup disk if you already have one). If you 
want to change your startup disk, see ''Designating a Hard Disk 
as the Sta1tup Disk'' in Chapter 9, "Hard Disks and Floppy 
Disks ... 
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Installing a customized system 

Custom installation allows you to select the combination of system 
files, drivers, and other files you want for your own specific needs. 
You can also use custom installation to install or update a single 
system software component or to save space on your startup disk 
by not installing files that you don't need. 

1. Turn off your Macintosh. 

2. Insert the l11stall l disk into the internal floppy disk 
drive. 

If your Macintosh has two floppy disk drives. you can use 
either one. 

3. Turn on your Macintosh. 

The Installer program opens automatically. 

4. Click OK or press the Return key on your keyboard 

The Easy Install dialog box appears. 

5. Make sure that the hard disk indicated in the box is the 
one you want to install system software on. If a different 
disk name appears, click the Switch Disk button until 
the correct disk name appears. 

6. Click the Customize button. 

The custom installation box appears. All parts of the system 
software are listed, and you have a choice of standard or 
minimal system software for each model of the Macintosh 
computer. 



7. Scroll through the list of items and hold down the Shift 
key as you click the items you want to install. 

Click the items you wont to select; 
Shift-click to select multiple items. 

Software for lmageWriter LQ ~ 
Software for AppleTalk lmogeWriler LQ R 
-·-·-----·-------.. -·------------------·--·--·-------·----H 
AppleShare (workstation so ftware) 
File Sharing Software 
l:(i . • 

Tokenlalk software 0 

~ EtherT• lk s ofhnro J 
j ·-"'" :·· r------stz•: 221< I 
I v.,.~~~: ~ ~.~~,Oct 16, 1991 I 
l This p~kaqe ~ the sofl'W'ar• nto~f'd to un yoor J 
I H~intosh 1n n Eth•r-Talk nttwor k. An Ethtrhlk Cit'd must bf • 
! installf'd in t.1i-" Macintosh to us• this softw.-e I 

'~--1--------'j 

lnfor111a1ion abmn 1he i1e111 selec1ed 

([ Install )J 

= Wallhrop 

( [jl.'C1 Ih~I< ) 

( Switch lli~K J 

[Easy I nstoll J 

Quit 

·:· Ifyou wa11110 install a SI/IC/II ~FSfe/11 to conse1w space on your 
startup disk. cl ick rhe .. ~linimal sofm·are .. option. ·:· 

~ Important: Be sure to install the system sofr,,·arc files that 
your Macintosh uses ro communicate wirh the printers and any 
other de\'ices you use. ~ 

8. Click Install or press the Return key on your keyboard. 

The Installer begins to install system software for your 
\ lacintosh model. 

9. Follow the instructions that appear on screen. 

When a disk is ejected and you sec a message instructing 
you ro insert another system software disk, insert the disk 
specified. 

10. When you see a message reporting that the installation 
was successful, click Quit or press the Return key to 
quit the Installer program. 

If a message reports that insta llation was not successful, follow 
the instructions on screen to rry insta ll ing again. 

11. Click Restart in the dialog box that appears when you 
quit the Installer. 

~1lake a backup copy of the System Folder or its contenLs on one 
or more Ooppr disks (or on another hard disk), and keep the disks 
in a safe place. 

·:· [{your .\/aci11tosli is n11111i11<~ .~)'s/e/11 6. you cannot use desk 
accessories and lh1cType'" fonts supplied \Yith System 7. Also. 
you may notice extra or missing f'olders on any disk that 
contains System 7. The contents of the System 7 disk will 
appear normally \\'hen you resume running System 7. ·:· 

.A Warning: Your startup disk must ha,·e only one System 
Folder. Ha,·ing more than one System Folder on your startup 
disk can cause your ~ lacinrosh to malfu nction and cause you 
to lose information. lse the Find command (in the Finder's 
File menu) to see if there is more than one System Folder on 
your hard disk . .& 
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Starting up with a floppy disk 

You need a hard disk as the startup disk to use Macintosh system 
software version 7, but if vou·re unable to use vour hard disk vou 

• ' ~ J 

can start up your Macintosh by inserting the Disk Tools disk in the 
internal floppy disk drive and then turning on your computer. This 
disk contains programs that you can use to initialize, test, and 
repair disks. 

If your startup hard disk has malfunctioned, see 'Testing and 
Repairing Disks" in Chapter 9, "Hard Disks and Floppy Disks.·' 

Setting up your programs 
In addition to setup information, this section describes how to 
work with more than one program at a time. 

Installing a program 

You can install many application programs simply by copying 
them from the original disk to your hard disk. (Some programs 
have specific installation procedures. See the instructions that 
came with your program.) 

~ Important: Some program disks contain a System Folder. 
Whenever you copy the contents of a program disk to your 
startup hard disk, check that you have not copied an extra 
System Folder. If you have, throw away the extra System 
Folder. ~ 
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Put only one copy of each program on your hard disk. Having 
more than one copy of the same program on the disk can lead to 
problems when you·re running the program. 

If you want to open a program automatically when you start up 
your Macintosh, go to "Speci~'ing Which Items You Want Opened 
at Stanup" in Chapter 11, "Adapting Your Macintosh to Your Own 
Use·· for instructions. 

You can also put a program or an alias for it in the Apple menu, so 
you can open the program more conveniently. See "Installing an 
Item in the Apple Menu" in Chapter 11. 

~ Important: Keep the original program disk in a safe place as 
a backup copy. If the program on your hard disk malfunctions 
consistently, you can replace it with a fresh copy from your 
backup disk. ~ 

If a program malfunctions consistently, and installing a fresh copy 
of the program does not correct the problem, you may need to 
find out from the software manufacturer whether the version of 
the program you have is compatible with the Macintosh system 
software you·re using. (You can often upgrade to the latest version 
of a program at no charge or for a modest fee.) 



Checking for computer vimses 

In recent years, "viruses''-malicious programs that damage files 
or erase disks-have become a significant problem for people 
who use computers. A vims can be introduced into your 
Macintosh system from a disk you or someone else puts in a disk 
drive, from a network device such as a file server, or from an 
electronic bulletin board service. 

You can use any of several virus-detection and -elimination 
programs to check your .Macintosh disks for viruses. Such 
programs are available from user groups, computer bulletin 
boards, and dealers. 

Even if you don't notice problems with your computer's operation 
or with the information on your disks, you should check for 
viruses frequently if you exchange disks or information with other 
users. 

• Whenever you get a disk from anyone-even if it's commercial 
software-check it for viruses before using it or copying 
anything from it to your hard disk. 

• Check your startup disk and other disks regularly with a virus­
detection program and correct any problems it finds. 

• If your .Macintosh is on a network or you use a modem to 
connect with information services or bulletin boards, check for 
viruses as often as it's practical-ideally, each time you copy 
any infonnation from an outside source. 

• If you are part of a work group that includes a number of 
.Macintosh users, set up a "virus-detection station'' that 
everyone can use to check disks (and to copy the latest version 
of the vims-detection software your group uses). 

• If you give infonnation to other Macintosh users on disks or 
send information electronically, make certain that there are no 
viruses on your computer system before distributing the 
information. 

• Since new vimses appear regularly, make sure you have the 
latest version of any virus-detection software. 

• To avoid compatibility problems, be sure to use only one virus­
cletection program at a time. 
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Working with several programs at a time 
You can keep as many programs and desk accessories open at the 
same time as your computer's memory allows. 

All open programs are listed in the Application menu, which 
appears at the right end of the menu bar. The active program's 
name has a checkmark next to it, and its icon appears in the menu 
bar as the Application menu icon. 

...._ __ Commands used to hide or 
display windows currently open 

./ fey Finder 
i.;si i--- Open programs 
~TeachleHt 

Checkmark indicates the 
program currently in use 
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Switching programs 

You switch between open programs or desk accessories by 
choosing their names from the Application menu in the right end 
of the menu bar. 

If a program's icon is dimmed in the menu, that means its 
windows are hidden. You can choose it from the Application 
menu to display its windows. 

You can also click in a window that "belongs" to an open 
program, or double-dick a program icon (or the icon of a 
document that was created in the program) to make that program 
the active program. 

Finding out what programs are open 

If you have several programs and windmvs open, you can find out 
which program is active and what other programs are open by 
pulling down the Application menu. 



Hiding and showing windows on the desktop 

You can hide all the open windows except those of the active 
program by choosing the Hide Others command in the 
Application menu. Though hidden, the other windows remain 
available. 

When the command takes effect, all windows except those 
belonging to the active program are hidden. 

The windows remain hidden until you switch to another open 
program, at which time that program's open windows are 
displayed. If you want to see the '\vindows of all your open 
programs, choose Show All from the Application menu. 

Changing the amount of memory a program uses 

On rare occasions you may need to increase or decrease the 
amount of memory a program sets aside for itself. You might want 
to increase the program's memory allocation so that you can open 
more documents at once, or you might want to decrease it so that 
you can open more programs. You can do this by adjusting the 
program's memory size in its Info window. 

1. Quit the program if it's open, then click the program's 
icon to select it 

2. Choose Get Info from the File menu. 

The Info windmv appears. 

ID~ TeachTeHt Info~ 

~ T.achText V S\jsttmSoflwarov7.0 

Kiiad:.pplication pr09ram 
Siz•: 36K on di$!< (36,612 bytH u .. d) 

CrHted:Tu•, Jul 17, 1991, 12:00PM 
Hodtfi•d:Tu.. Jul 17, 1~1, 12:00PM 
Yerston: 7.0, © l\pplt Computor, toe. 

1995-91 

0Loclced 

r· .. H•morv····-···· .... -- .. ................ 1 j Sugg•st•d sizt: 192 

i Current size : 

Program manufacmrer's suggested 
minimum memory 

Current memory allocation 

continues .,.. 
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3. Drag across the number in the box labeled "Current 
size" to select it. 

4. 'fype the number of kilobytes (K) of memory you want 
the program to set aside for itself. 

~ laking the program smaller 1han rhe amounr sho,,·n in rhe 
box labeled ··sugges1ed ·izc·· may cause it to work more slm,·ly 
or cause other problems. 

s. Close the Info window. 

If you make the alloca1ion 100 small. you·11 see a message 
asking \\·hether you want ro make it smaller than the 
manufacturer's suggested minimum size. 

A Warning: If you set the memory allocation for a program to a 
size that's smaller than the manufacturer's suggested minimum 
size. the program may function improperly or nor at all. .&. 
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Chapter 9 

Hard Disks and 
Floppy Disks 
Jn th is chapter 

• Initializing disks 

• Erasing a disk 

• Designating a hard disk as the startup disk 

• Protecting the informacion on a disk 

Locking a lloppy disk 

Locking a file 

Backing up your files 

• If you can·t sa\·e files on a tloppy disk 

• Ejecting a disk 

• Disk care 

Hard disk precautions 

• Testing and repairing disks 

Using Disk First Aid'" 

·resting a hard disk 

Initializing disks 
Before you can use a ne\\' disk, you need to initialize it-lo 
prepare ii so that the computer knO\\"S \\·here IO store and retrieve 
information on the disk. 

.A. Warning: You lose any information you may have on a disk 
when you initialize or reinitialize it. .& 

Most hard disks clcsignecl for use with the i\llacintosh arc already 
initialized (that is. ready to store information) when they leave the 
facto1~-. \\?hen ne\Y. rhe 3.5 -inch (86-millimeter) floppy disks that 
your .\lacintosh uses need to be intializecl. 



Initializing a hard disk 

If you have a hard disk that hasn·t been initialized. its icon docs 
not appear on screen when you start up your ~ lacintosh using 
another hard disk or a floppy disk as a stanup disk. (See 
Chapter 14. ""Expanding Your Macintosh System." if you need 
instructions on connecting a hard disk to your computer. See 
Chapter 8. ··. euing Cp Your Macintosh System ... if you need to 
create a startup disk.) 1\Jake sure that you turn on the hard disk 
before you turn on your Macintosh. 

If your hard disk's icon does not appear on screen. use the 
Apple HD SC, erup program. on rhe system sofr\Yare floppy 
disk labeled Disk Tools, ro initialize and name rhe disk. 

A Warning: If you purcha ·ed a hard disk \\'ith the A L'X 
operaring system insralled on it. do nor initial ize that disk: 
doing so \\'ill erase UX. See the insrructions that came \\'ith 
the A/LJC operating system. • 
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1. Locate the Apple HD SC Setup icon and open it. 

Apple HD SC 'ctup is on rhe sysrem sofL\\'are floppy disk 
labeled Disk 7bols. If you're already using a ha rd disk as a 
startup disk, you can copy the program to your startup disk 
and open rhc program from rhere. 

~ 
l==:I 

App lf? HD SC Sf?tup 

A dialog box appears. The name of the hard di ·k currently 
·elected for initialization is shO\\·n as the ··volume name:· The 
SCSI ID number of the selected hard disk is displayed above 
rhe Drire buuon. (The ID number of an internal hard disk is 0. 
The ID number of an external hard disk i. usually preset ro 5.) 

Apple 11 0 SC Se tup 

[ lnlliolize J 
[ Update J 
[ Partition ) 

[ Test J 

{( Quit JI 

scs1 oeulce: o---SCSI ID number 
of the: currc:nl 
hard disk 

~The uolume no me Is Hard disk--!~ Thl' name or lhl' 
~ "2 currl'n! hard disk 



2. If the "volume name" or the SCSI ID number shown 
does not belong to the hard disk you want to initialize, 
click the Drive button until the hard disk you want to 
initialize is the selected hard disk. 

You cannot initialize your current startup disk or the disk that 
the Apple HD SC Setup program is on. 

3. When the SCSI ID number (and name, if any) of the 
hard disk you want to initialize is shown, click the 
Initialize button. 

A dialog box appears in which you must confirm or cancel 
your decision. 

4. Click the Init button to initialize the hard disk. 

Messages appear to update you on the initialization process. If 
a message reports that initialization failed, begin the process 
again. 

5. In the dialog box that appears asking you to name the 
disk, type a name and then click OK. 

6. Click Quit when the message reports that initialization 
was successful. 

Initializing a floppy disk 

Before you can use a ne'\\' floppy disk, you need to initialize 
it-prepare it so that the computer knows where to store and 
retrieve information on the disk. 

1. Insert your new floppy disk into the floppy disk drive. 

If you inse11ed a high-density disk, this dialog box appears: 

I' -;:-! This disk Is unreadable: 

Do you want to lnitlollze It? 

([ Eject Jl ( I nltlallze ) 

If you inserted a double-sided (SOOK) disk, this dialog box 
appears: 

fn This disk Is unreadable: 

'.§ Do you want to Initialize It? 

([ Eject Jl (One-Sided J [Two-Sided] 

co11ti1111es ..,,.. 
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2. Depending on which dialog box appears, click Initialize 
or 1\vo-Sided. 

Another dialog box appears: 

J.\ This process will erase all 
ill information on this disk. 

Cancel ([ Erase }) 

This dialog box gives you one last chance to cancel. It alerts 
you that you're about to erase-and therefore lose-any 
infonnation that may be on the floppy disk. 

3. Click Erase. 

A third dialog box appears: 

Please name this disk: 

[( OK JI 
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4. Type the name you want for the disk. 

If you make any typing errors, press the Delete key to 
backspace over them. 

When you name a disk, you can type up to 27 characters, 
including spaces. You cannot use a colon in the name. If you 
don't name the disk, it will have the name "Untitled." 

5. Click OK or press the Return key on the keyboard. 

The computer takes about a minute to initialize the disk. A 
series of messages appears on the screen to let you know hmv 
the process is going. 

When initialization is completed, the floppy disk's icon 
appears on the desktop. You can rename the disk by dicking 
its name and typing a new one. 



Erasing a disk 
Erasing a disk actually initializes it. 

~ Warning: You lose any information you may have on a disk 
when you erase it. .&. 

1. Click the icon of the disk you want to erase. 

2. Choose Erase Disk from the Special menu. 

A dialog box appears, giving you a chance to cancel the 
procedure. 

3. Depending on the type of disk you're erasing, click 
Initialize or 1\vo-Sided. 

Designating a hard disk 
as the startup disk 
If you use more than one startup disk ~Yith your . facimosh, you 
can speci~1 "-'hich hard disk you want used as the startup disk the 
next time you turn on yo(1r computer. 

1. Choose Control Panels from the Apple menu and then 
open the Startup Disk control panel. 

:o Startup Disk 

Se loot a Startup Disk: 

- c=i +:@fMM 'w'althrop 

2. Click the icon of the disk you want to use as the startup 
disk. 

co11lin11es .,.. 
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3. Close the Startup Disk control panel. 

When you turn on your Macintosh, it looks for a startup disk (a 
disk containing a System Folder) in the following sequence: 

1. internal floppy disk drive 

2. second internal floppy drive (if any) 

3. external floppy drive (if any) 

4. startup device selected in the Startup Disk control panel (if 
any) 

5. internal SCSI hard disk (the computer waits a few seconds for 
the internal hard disk to warm up) 

6. external SCSI hard disk (if there is more than one, it looks for 
the hard disk with the greatest SCSI ID number) 

7. internal hard disk (the computer returns to this drive and waits 
another few seconds) 
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If no startup disk is found, the computer displays a blinking 
question mark in the middle of the screen. 

·:· If you want to bypass the internal hard disk as a stm1up disk, 
press 3€-0ption-Shift when the computer start~ up. ·:· 

~ Important: If you use any external hard disks, turn them on 
and wait a few seconds before you turn on your Macintosh; 
otherwise, the computer will not recognize them. ~ 

Protecting the information on a disk 
You can protect all the information on a floppy disk and you can 
lock individual documents and application programs. Another 
way to protect your work is to keep backup copies of all your 
files. 

The information in a locked document or on a locked disk can't be 
changed or thrown away, but it can be opened or copied. 



Locking a floppy disk 

To lock a floppy disk: 

• Slide the tab on the back side of the disk so that the 
square hole is open. 

Cse your thumbnail to moYe the tab. or a push pin inserted 
into the notch next to the tab. 

~. . . . . . .. . . .. . . .. . . .. 

~~ 
Locked l'nlocked 

Sliding the tab back so that it covers the square hole unlocks 
the disk. 

Locking a file 

You use the Get Info command to lock a document or program. 
Locking a program may affect its operation. 

1. Click the icon of the file you want to lock. 

2. Choose Get Info from the File menu. 

The file's Info window appears. 

3. Click the Locked box in the lower-left corner so that an 
X appears in the box. 

I~ rrom Amy Info~ 

B rromArr~ 
Kfod : Tu<t1hx t 6ocum+nt 
Stu : 1Kondu:lr::(161 tM)t •slJS.#d) 

'W'h r e: J't du~ from Arr-. 

Cr-H ted : Mon, Oct 8, 1991, 10:3 3 Ptl 
t1odifietl :Mon,Oc t 8, l 'J91, 10·3 '5PH 
Y•rs ion : not •v'111bW 

ij;} Lochd 

co11ti1111es ..,_ 
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4. Close the Info window. 

·:· Lockingfolders: You can't lock a folder. but you can lock the 
items in a folder. Also, you can protect the contents of folders 
that you're sharing on a network. (See Chapter 13. ·Tsing Your 
Macintosh on a Network ... for more information.) ·:· 

·:· Locking cm alias: You can lock an alias. but doing so does not 
lock the original file. Locking an alias merely protects it from 
being thrown away. ·:· 

Backing up your files 

You can back up the work you store on a hard disk by copying 
individual files onto another disk in the usual way (dragging their 
icons to the icon of the other disk). You can back up the contents 
of an entire floppy disk by dragging its icon to another floppy disk 
icon or a hard disk icon. 

You can also use a commercial backup program to copy some or 
all files from a hard disk to another hard disk, to a tape drive, or to 
a series of floppy disks. 
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If you can't save files on a floppy disk 
If you can't save files on a floppy disk then the disk is damaged or 
locked, it ·s too full to store more infonnation, or the disk drive is 
not working properly. 

• Make sure the locking tab on the back of the disk is in the 
unlocked position (so that the square hole is closed). 

• If you sec a message reporting that the disk is not initialized, 
and you know that it has been initialized, eject the disk and 
carefully inse11 it again. If the same message appears, the disk 
is probably damaged. (You may be able to recover the 
information on it with Disk First Aid or a disk-recovery 
program; see ''Testing and Repairing Disks'' later in this 
chapter.) 

• If you see a message reporting that the disk is full, eject that 
disk and insert another that has adequate space for your 
document. or erase unneeded files from the disk. 

• Check the disk for obvious damage to the plastic case or the 
sliding metal shutter. 

• Insert a different disk and try saving again. If you can't save on 
the second disk. the problem may be with the disk drive. 

• Before concluding that the disk drive is the problem, save your 
files on a disk in a different drive! if you have one, and then 
restart the Macintosh. Tiy using a disk that you know is not 
damaged in the suspect drive. See your service provider if you 
still can't save any files using that drive. 



Ejecting a disk 
You can eject a floppy disk by doing one of the following: 

• Click the disk icon to select it and choose Put Away from the 
File menu. The icon disappears from the desktop. 

• Drag the disk icon to the Trash icon. The disk icon disappears 
from the desktop. (Dragging a disk to the Trash does not erase 
the disk's contents.) 

• Click the disk icon to select it and choose Eject Disk from the 
Special menu. The disk!s icon remains on the desktop, but it's 
dimmed. 

You can use the first two methods to remove a hard disk icon from 
the Macintosh desktop (or to remove an icon for a disk that you're 
connected to over a network). 

All three methods also work with CD-ROM disks. 

If you can't eject a floppy disk 

The signal to eject the disk is not reaching the computer or the 
disk or drive is damaged. 

1. Hold down the X and Shift keys and press the number 1 
key in the top row of the keyboard to eject a disk in the 
internal drive; press X-Shift and the number 2 to eject a 
disk in an external floppy drive or the second internal 
drive. 

2. If step 1 doesn't work, turn off the Macintosh. If the disk 
isn't ejected, then hold down the mouse button when 
you turn the computer on again. 

3. If step 2 doesn't work, locate the small hole to the right 
of the disk drive's opening, and carefully insert the end 
of a large straightened paper clip into it. Push gently . 
until the disk is ejected. Do not use excessive force. 

4. If step 3 doesn't work, take the computer or disk drive 
to your authorized Apple service provider to have the 
disk removed. 

Chapter 9: Hard Disks and Floppy Disks 105 



Disk care 
For information on floppy disk care, see Chapter 3, "Setting Gp 
Your Programs,'' or read the instructions that came \vith your 
floppy disks. 

Hard disk precautions 

Hard disk drives are very delicate mechanisms and should he 
handled \Vith care. 

• Do not roughly handle a hard disk or a computer with an 
internal hard disk. Never move either when it's turned on and 
the hard disk drive is operating. 

• Do not place your Macintosh on its side unless it is designed to 
operate this way; it could damage the hard disk. See your 
setup book to check if your Macintosh model can he placed on 
its side. 

• Always keep the hard disk on a sturdy. level surface. 

• Operate a hard disk at temperatures hem·een 10 and 
40 degrees Celsius (50 and 104 degrees Fahrenheit) and at 
a relative humidity of 20 to 80 percent. 

• Do not spill any liquids on or near the drive. 

• Do not expose the drive to hazardous va pars. such as those 
from cleaning solvents. 
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Testing and repairing disks 
Both floppy disks and hard disks can become damaged from 
repeated use and handling. If you see a message reporting that a 
disk is damaged or unreadable. Disk First Aid or Apple HD SC 
Setup (both programs are supplied with the system software) may 
help diagnose and correct the problem. 

If you can't start up from a hard disk or don't see its icon on the 
desktop, the computer does not recognize the disk or the disk 
drive is not working properly. 

• If the hard disk drive is an external one. make sure it is turned 
on and its cable is connected firmly. then restart the Macintosh. 

• If the disk drive is an internal one, turn off the Macintosh, wait 
at least 10 seconds. then turn it on again. 

• If the hard disk is your startup disk. start up with a different 
disk and. if the disk's icon appears. reinstall the system 
sofrware on the hard disk. 

• If you hare more than one hard disk in your Macintosh system, 
check the SCSI ID number of each external hard disk and all 
other SCSI de\·ices connected to your computer. If two devices 
haw the same ID number. or if any external device has the ID 
number 7 or 0. the computer will not recognize one of the 
devices. 



Using Disk First Aid 

Yem can test floppy disks and hard disks with the Disk First Aid 
application. Disk First Aid also repairs some types of disk damage. 

1. Locate and open the Disk First Aid icon. 

Disk First Aid is on the svstem software disk labeled Disk Tools. 
J 

~ 
Disk F;rst A;d 

A dialog box appears. 

2. Click the Drive or Eject button as necessary until the 
name of the disk you want to test appears. You may 
have to insert the damaged floppy disk. 

3. Click Open or press the Return key. 

The name of the disk you selected appears, and a message 
reports that Disk First Aid is ready. 

4. Choose Repair Automatically from the Options menu, or 
click the Start button to begin testing the disk. 

••• Uolume: Rrchiues 

Start 

5. When testing and repair are completed, choose Quit 
from the File menu. 

·:· {/you want to test another disk, choose Close from the File 
menu, then select and open the other disk (as in step 2). ·:· 

If Disk First Aid doesn't correct the problem: 

• Cse Disk First Aid one or two more times with the disk. 
Occasionally~ repeating this process corrects the problem. 

• Use another disk repair or recovery utility. Some disk repair 
utilities let you recover information from a damaged disk. 

• Consult a technician or other specialist for help. 

• Once you have recovered all the information you can, erase 
(reinitialize) the disk. If reinitializing doesn't work, discard the 
damaged disk. 
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Testing a hard disk 

You can test a SCSI hard disk with the Apple HD SC ?etup 
program. 

1. Locate and open the Apple HD SC Setup icon. 

Apple HD SC Setup is on the system software disk labeled 
Disk Tools. 

~ 
I. I 

App le HD SC Setup 

A dialog box appears. 

Rpple HD SC Setup 

[ Initialize ) 

( Update ) 

( Partition ) 

( Test J 

(! Quit JJ 

scs1 oeulce: 0--1+--The disk's SCSI ID number 

j·;s··tt.~~--~~1;;;-;;~~···j~· .. j:j;;~i-d·i;k"-- r-- The disk's name 
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2. Click the Drive button until the name of the disk you 
want to test appears as the "volume name." 

3. Click Test 

A dialog box appears asking you to confirm that you want to 
test the disk. 

4. ClickOK. 

5. When a dialog box appears telling you that testing is 
complete, click Quit 

If the test reveals a problem, you may be able to correct it by 
using Disk First Aid or another disk repair utility, or you may 
have to reinitialize the disk. Consult a technician or other 
specialist for assistance if necessary. 



Chapter 10 

Organizing Yol1r Files 
In this chapter 

• Straightening up your files 

• Using folders to organize your files 
Creating and naming folders 

• Saving your files where you want to 

• Making items easier to find 
Using an alias 
Installing an item in the Apple menu 
Moving an item to the desktop 

• Finding a file or a folder 
Finding an item by name 
Finding an item by other characteristics 
Finding items through a rwo-stage search 
Uses of the Find command 

• Creating a template 

• Getting information about your files 
Csing the Info \Yinclo~· 
Using the View menu 

Straightening up your files 
Choose the Clean Up command from the Special menu to 
straighten up the icons in the active window or on the desktop. 
(The form of the Clean Up command changes depending on 
which items are active or selected.) 

Hold clown the Option key while choosing Clean Up Window to 
arrange icons alphabetically by name or according to the list view 
displayed most recently in that window. Holding clown the Option 
key also mo,·es the icons to the top left portion of the window. 

Hold do~·n the Option key while choosing Clean Up Desktop to 
line up icons near the right edge of the screen. 

If one or more items are selected. holding down the Shift key 
while choosing the Clean Up command rearranges the selected 
items only. 
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Using folders to organize your files 
Like paper filing systems, the Macintosh uses folders to store and 
organize documents. You can place one folder inside another to 
create a hierarchy of files that has many levels. 

Comments 

Budgets 

• • •••••••• 

• • ••••••••••••• 

Resumes 
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Issues 
list 

Creating and naming folders 

Most programs let you create and name a new folder in the 
directory dialog box that appears when you first save a document, 
or when you choose Save As from the File menu to save another 
version of a document. 

When you're working on the desktop (when the Finder is the 
active program), you create and name a new folder as follows. 

1. With the Finder the active program, choose New Folder 
from the File menu . 

A new folder named "untitled folder" appears in the active 
window (or on the desktop if no window is active). The name 
is already selected . 

2. Type a name for the folder and press Return. 

You move, copy, and remove folders in the same way that you do 
any other icons. (See the summary, "Working on the Macintosh 
Desktop,., on the green pages after Chapter 16, for instructions.) 



Saving your files where you want to 
The first time you save a document that you're creating in an 
application program (or whenever you choose Save As from the 
File menu to create another version of a document), a direct01y 
dialog box appears. A directoJJ' is the list of files and folders 
contained in a folder or a disk. 

You use the directory dialog box to name your document and 
decide where to store it. Directory dialog boxes vary slightly from 
program to program, but every directory dialog box has certain 
features. 

The current directorv: 
a list of the files ancf 
folders in the folder 
or disk that's named 
in the pop-up menu 
above the directory 

Use this pop-up The name 
menu to choose of the 
a higher-level current 
directory. disk 

-=----=.o=M=n=cl:=n::to:::s=h ::Ho=~=--- c:1 Mctintosh HD 

Click to list the disks 
on the .\lacintosh 
dL'sktop in the D flnm1<1I rn~1or1 91 

Rpp. progrnms 
L <1rt form 

nrl snmples 
L H1•tst1 tl!27/90 
l. Hook H~t 

\X'hen you open 
a folder. its contents 
are listed in the 
current directory. 

..-----....u..- current directory. 
Desktop 

New Ll Click to create a 
new folder. 

Cnncel 

St)IJ<i 

Type the name Click San: \Yhen rnu haw 
of the document named the docmi1ent and the 
here. directoiy you want to put it in 

is the current directory. 

A similar dialog box appears when you choose Open from the File 
menu to open a document that w~ts created in the program you're 
ctmemly in (the ··active" program). The dialog box lets you find 
the document and open it. 

lc:::>Walthrop ~I 
1 I !Jm!JI!Illl:o 

Cl art-10/4 
Cl Car info 
Cl Cnspar mops 
Cl Enuelopes 
Cl Glossary 
Cl JH Status reports 
Cl Matching Deuel. 
Cl old bnckups 
Cl Paint pies 
D Picture O 

c:::>Walthrop 

f.j<H t 

Desktop 

Open 

Cancel 
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Making items easier to find 
Your Macintosh offers several ways to make a file, folder, or other 
item easy to find and open. You can 

• create aliases for the item and put the aliases wherever it's 
convenient for you 

• install the item in the Apple menu 

• move the item to the Macintosh desktop so that it ·s in plain 
sight 

Using an alias 

An alias serves as a signpost to a file, a folder, a disk, or another 
item (even a shared item that you access over a network). You can 
make as many aliases for an item as you want. See Chapter 6, 
"Organizing Your Work," for more information on aliases. 

Creating an alias 

1. Click to select the item that you want to make an alias 
for. 

2. Choose Make Alias from the File menu. 

The alias appears on top of the original. Its name is in italics 
and ends ·with ''alias." The name is already selected. 

3. If you wish, change the name of the alias, then move it 
to wherever you want to put it. 
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Uses of aliases 

Alias of 

Any document or 
folder that could be 
stored in sewral 
places 

Apple \'lenu 
Items folder 

A program that 
muse be locacecl 
with associated files 

A document or folder 
stored on a separate 
archive disk 

A program, document, 
or folder on a me 
server 

Location 

Every part of your 
flling system where 
that item logically 
fies 

On the desktop 

On the desktop; in 
the Apple menu 

Anywhere on your 
prima1y disk or 
disks 

Anywhere on your 
primary disk or 
disks 

Purpose 

Access to key information 
from several places 

Easy way to put items into or 
take items out of the Apple 
menu 

Starting the program without 
opening the folder or disk in 
which the original and its 
associated files are locaced 

When opened, the alias 
displays a message with the 
name of lhe disk needed, then 
opens the original when the 
disk is inserted. 

When opened, the alias 
automatically finds and 
opens its original on the 
server, essentially creating an 
automalic server connection. 

·:· Tinuble? If you open an alias and nothing happens, or you see 
a message reporting that the original file isn't available~ then 
the alias is damaged or the original has been deleted. Open the 
alias 's Info windmv to find out ·where its original is. ·:· 



Locating the original of an alias 

You can locale the original of an alias by opening the alias 's Info 
window. 

1. Select the icon of the alias whose original you want to 
find. 

2. Choose Get Info from the File menu. 

The alias's Info window appears. 

JH memos alias Info ~ 

o.M-•llu 
Kll>dallu 
Sia: IK en dUk (:121 b\jlH uud) 

Yhr•: SE~ •2: dloosor2 •lias 

CrHt•d:Mcn,Oot7, 1991, B:41 AM 
Modlft•d:Mcn,Oot7, 1991,B:41 AM 
Ortgln•l: SE b*llP •2 :choor.,.2 

0Lock.d 

Location of the original-includes 
folder levels and disk name (if the 
original is on a different disk) 

3. Click the Find Original button. 

The window containing the original item opens, with the 
item's icon highlighted. 

If you deleted the original, you'll see a message reporting that 
the original can't be found. Aliases are not deleted when the 
original files are deleted. 

Installing an item in the Apple menu 

You can install a file or other item in the Apple menu so you can 
open it by choosing it from the menu. 

1. Open the System Folder icon and locate the Apple Menu 
Items folder. 

2. Locate the item you want to install in the Apple menu 
and drag it (or its alias) into the Apple Menu Items 
folder inside the System Folder. 

The item appears immediately in the Apple menu. 

You remove an item from the Apple menu by opening the Apple 
Menu Items folder and dragging its icon (or its alias) out of the 
folder. 

•:• 'kouble? If the Apple menu does not contain the items it 
should, make sure that the Apple Menu Items folder is in the 
System Folder of your startup disk. Also, open the Apple Menu 
Items folder to check that all the items that you want in the 
menu are in the folder. ·:· 
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Moving an item to the desktop 

You can make an item easy to find by dragging its icon to the 
desktop. The icon stays there until you remore the disk on which 
the item is actually stored. 

If you've placed an icon on the desktop, you can put it back in its 
original location by using the Put Away command. 

1. Click to select the item you want to put back in its 
original location. 

2. Choose Put Away from the File menu. 

Finding a file or a folder 
When the Finder is the active program. you can use the Find 
command in the File menu to find a file or folder on any disk 
whose icon is on the desktop. <The Find command cannot locate 
items inside the System file. such as fonts and sounds. You must 
open the System file to see its contents.) 
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Finding an item by name 

1. Choose Find from the File menu, or press X-E 

The dialog box that appears lets you find a file or a folder by 
searching for its name. 

- Find·- Yim type the name (or partial 
Find: [.__ ________ __,!-~name) you want to find here. 

( More Choices l ~ (~)-~Clicking this button 

Clicking this button displays a larger 
dialog box with more choices of 
search characteristics. 

starts a search. 

If the dialog box has more items in ic chan shown here, click 
the Fewer Choices button in the lo\\'er-leti corner. 

2. Type the name (or part of the name) of the file or folder 
you want to find. 

It doesn't matter '\vhether you capitalize any letters, as long as 
the letters or numbers you type are in the name of the item 
you're looking for. 



3. Click the Find button. 

The first item that matches the name (or partial name) you 
typed is shown highlighted in a Finder window. If no item is 
found. your Macintosh makes the alert sound. 

4. To see the next matching item, choose Find Again from 
the File menu, or press X-G. 

If no more items are found, your Macintosh makes the alert 
sound. 

Finding an item by other characteristics 

You can use the Find command to find a file or a folder by 
searching for its size, its label. the date it ·was created or modified, 
or other characteristics. 

1. Choose Find from the File menu. 

The Find dialog box appears. 

2. Click the More Choices button. 

The dialog box that appears lets you set different search 
characteristics through pop-up menus that together form a 
search order. 

Pop-up menus of Type text (,,·hen searching 
se·1rch clnncteristics for text) or set ·1 date here. r ' ' ' ' 

I 
Find 

Find end select items"J:'hose 1 
Option to 
display 
search results 
all at once 
<instead of 
one at a time) 

I name •II contains •If l 
----- --· 

Search I on all disks •I 011ll 11t once 

--~··-··-·----··----···-··-······- ---··-·- -···-···--

(Fewer Choices ) 

Clickin 1 this button g 
displays a smaller 
dialog box. 

I Cancel ) ~ 

Po -u p p menu of 
search locations 

Find Jt 

Clickin this g button 
begins the search. 

l11e content of the middle pop-up menu and the text area vary 
according to the item selected in the left pop-up menu. 

3. Press the pop-up menu on the left to open it, drag to 
choose an item, and then release the mouse button. 

4. Press the pop-up menu in the middle to open it, drag to 
choose an item, and then release the mouse button. 

co111i1111es .,.. 
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5. Adjust the date, choose an item, or type text in the 
upper-right area of the dialog box. 

Clicking a number selects it: clicking the up or 
down arrow changes the selected number. 

Find 

Find and select Items whose 

I date modi fied ..,.1 1 Is before ... I 10/ / 90 

Search I on all disk s Dall a t once 

( Fewer Choices) [ Cancel J ([ Find JI 

6. Choose a search location from the pop-up menu labeled 
"Search." 

You can choose to search all disks, a specific disk, or the active 
Finder window. 

Find 

Find and select items whose 

I date modified ..,.1 1 is before 10/l]/ 90 

Search v'On all disks ] D all at once 

Disk selected for searching 
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7. If you want all found items displayed at once, click the 
checkbox labeled "all at once" so that an X appears. 

8. Click the Find button when you've finished setting your 
search characteristics. 

The first item that matches your search characteristics is shown 
highlighted in a Finder window. To see the next item found , 
choose Find Again from the File menu (or press 3€-G). 

When the items found are displayed all at once, they are shown 
highlighted in one or more Finder windows. 

ii 

A list view shows the 
contents of folders at 
all levels on the disk. 

1 

in outline form. 

r ~ 
D Read H t> 

Items found in the search 

1 

are highlighted 

J's disk 
Sitt> Lu t Modified 

II ifSl@§.1§$#iliil -I 
3K \fod, Oct 10, 1990, 11 :13 PM~ 

D nvethts! 
V D ScanMr 

1~~ ~~.s:1:~·1~:~\1:~~s;MAM !i'il: 

29~ ::~:~;,1 ~:.2~0;;~ ~I 
34K Thu,Juo22, 1989, 2:51 PM 

382K Moo, Au9 7, 1989, 7:16 AM ~ 
Moo IJ<:t S 1990 2:0SPM 0 

Indentation indicates that the item 
located is inside a fo lder. 
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Finding items through a two-stage search 

You can use two sets of characteristics and locate the items that 
meet both sets of characteristics. 

1. Choose the first set of characteristics you want to search 
for. 

2. Click the "all at once" box so that an X appears. 

Checking "all at once" displays the items found highlighted in 
a list. 

3. Click the Find button. 

The items found are shown highlighted in a Finder window. 

4. Choose the Find command again, before you click or 
take any other action. 

You choose Find before taking any other action so the items 
located in the first stage of the search remain highlighted. 

5. Choose the second set of characteristics you want to 
search for. 

6. Choose "the selected items" in the Search pop-up menu. 

7. Click Find to begin the second stage of your search. 

The search is limited to the items found in the first stage, and 
only those matching both sets of characteristics are 
highlighted. 

Uses of the Find command 

The Find command can help you locate files quickly, organize 
large quantities of documents, and develop an efficient system for 
backing up and archiving your work. 

Search characteristic 

:\ame 

Kind 

Size 

Label 

Lock 

Modification date 

Creation date 

Can be used to locate 

1. Files whose names you can't recall exactly 
2. All items for which you use a standard name, 

such as status reports or expense reports 

1. All application programs 
2. All aliases 

Large files, to make space available on a disk 

All the files to which you added the same label 
(such as "top secret" ) 

Locked files, to unlock them for editing 

All files changed since a certain date, for regular 
backup of new and changed files 

All files created before a certain date. for 
archiving or erasing outdated material 
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Creating a template 
Most documents can be saved as or converted into a statione1y 
pad, which is a template form of the document. The template 
retains the format and content it had at the time you made it into 
stationery, and you can use it repeatedly as a master for similar 
documents. 

Many application programs let you save a document as a 
statione1y pad when you first save the document or choose Save 
As from the File menu. If the directory dialog box that appears has 
a stationery pad option~ you can click it to save your new 
document as a template. 

D flrmtt<ll rnswr1 'H 
Cl App. programs 
D <11'1 form 
Cl art samples 
D H<~h1.~ H/l'1!9l 
Cl Hook li~t 
Cl cer Info 

c::::::>Walthrop 

~ [ r.t•~c1 I 
( Desktop J 

[ New Ll J 

Cancel 
Cl Caspar mops 
D flr1<1ru f.> n'f)l)rt 

Saue this document as: 

Regular 
~~~::!!....~_document icon 

When this button is selected. the 
document is saved as a stationery pad. 
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Stationery pad icon 

If the program you ·re using does not off er a stationery pad option. 
you can use a document ·s Info window to create a statione1y pad. 

1. Click to select the icon of the document you want to use 
as a template. 

2. Choose Get Info from the File menu. 

3. Click "Stationery pad" near the lower-right corner so 
that an X appears in the checkbox. 

lfo~ Memo Pad Info ~ 

13 HtmoPod 

KllUI: r .. cllTtxt rt•l1-"I pod 
Slz.: 1Kondisk(l9~tttustd) 

CrHt•d: T ... , $4op 3, 1991, 6:S7 N1 
Hodlft.d: Tu•, Sop 3, 1991, 6.:17 N1 
Y•rsion: not •ntloblt 

Clicking "Stationery pad" converts the document from an 
ordinary document to a stationery pad. 

4. Close the Info window. 

The document icon has changed into a stationery pad icon. 



When you open a srarionery pad, an unrirled ,,·indow appears 
showing a blank .. form .. from rhat srationery, or a dialog box 
appears asking you ro name the ne\Y document. 

You cannot change the starionery pad itself unless you rurn ir back 
into a regular document. You do this by opening the starionery 
pad's Info window and clicking .. Starione1~1 pad .. to remove the X. 

Getting inf 01n1ation about your files 
\Vhen you·re ,,·orking on rhe desktop. you can choose rhe Get 
Info command from the File menu ro get information about a file. 
such as when a document was crcared or how much memory a 
program needs. 

You can also use the View menu to see cerrain rypes of 
information abour the files listed in a Finder window. 

Using the Info window 

The Get Info command displays infonnarion abour a selected item 
in a window. 

1. Click to select the item you want information about. 

2. Choose Get Info from the File menu, or press ~-I. 

I~ Read Me Info ---· 

~ ReadM~ 
~ System Softvirt 

Kind: doctJmtnt 
S ize : 3K on disk ( 1 ,622 ~tes usf'd) 

Y hue : J's disk : Rud Mt 

Cre<iited :Thu, July 11, 199 1, 11 :13 PM 
Modified :'Wed, Nov6, 1991 , 12:00 PM 
Ver s ion : not -11v.111iblt 

Comme-nts: 

0 Locked 0 StationutJ pad 

I3esicles getting information. you can use the Info window to 
lock a file (so it can·r be changed or thrown away), turn a 
document into a statione1y pad, change a program's memo1y 
allocation. and change the file·s icon. (See Chapter 11, 
"Adapting Your Macintosh ro Your Own Use, .. for informarion 
on the last two procedures.) 

You can type commenrs in the Info window and larer search 
for them \Yirh the Find command. 

3. Click the close box. 
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Using the View menu 

You can use the View menu to display the contents of a windo\Y 
by icon or small icon, or you can list them according to name. 
size. kind. elate. or label. (See Chapter 11. "Adariing Your 
Macintosh tu Your Own U ·e ... for information on using the Vie\\·s 
control panel to change how files are listed and what information 
is included.) 

Windows are set to show items in the icon view. One of the list 
views (name, size, kind, label. or date) is useful when you have 
too many files to see easily as icons or if you want your files 
arranged according to a panicular anribute. For example, listing 
documents by the date and time of their most recent modification 
makes backing up files an orderly task. 

The type of list displayed is underlined 

l 
JH dota/2 'JI 

t!l!ll1 Stu Khl lobol Lu~ Mod1f"\fd 

l>D.v11<1us - foldtr Esuntial S•I, Ml\I S, 1 {!. 
I> Dcup..-nwps - foldtr Hot Thu, Nov 2, 1 1-: 

D ortdit w.'°" ~t 171<-t Ptt"SOft.11 ':::·.-::?~~. 'o _n_ ......... "" P-< 
¢ 1 } Ji'•'fil ~ 

,..,·•. Ji5 '2l 
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\\:then the contems of a \\'indow are displayed ::ts a list and you 
want them arranged in another list view, you don't have to use the 
View menu. You can click a column heading (such as Size or the 
Last Modified elate) to rearrange the list according to that heading. 

Sec the summary. "Working on the Macintosh Desktop ... on the 
green pages after Chapter 16 for information on using a list view 
to select items in different folders. 



Chapter 11 

Adapting Your Macintosh 
to Your Own Use 
Jn this chapter 

• Speci~ring which items you want opened at startup 

• Installing an item in the Apple menu 

• Installing files in the System Folder 

• Changing the items in the Label menu 

• Setting the time and date 

• Setting a time for the Alarm Clock to go off 
Turning the alarm off 

• Adjusting the way the mouse <;\Urks 

• Adjusting the way the keyboard works 
Controlling the pointer from the keyboard 
Making keyboard shortcuts easier to type 
Adjusting d1e keyboard for very slow typing 

• Setting the alert sound 
Installing a sound 
Removing a sound 
Hecorcling sounds 

• Changing the desktop pattern 

• Adjusting the blinking of a menu item 

• Adjusting the blinking of the insertion point 

• Changing the way the contents of windows appear 

• Changing the appearance ur icons 

Changing an icon 
Assigning a label and a color to an icon 

• Changing the highlight color 

• Changing the color of windows 

• Displaying colors or grays 

• Configuring multiple monitors 

• Adjusting screen brightness 

• Magnit)1ing the screen image 

• Turning off the Empty Trash warning 

• Managing memory 
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Specifying which items 
you want opened at startup 
'fo have a file (a program or a document) open automatically 
when you sta11 up your ivlacintosh, drag the file's icon or its alias 
to the Startup Items folder, which is inside the System Folder. Any 
programs or documents (or their aliases) that you put in the 
Startup Items folder are opened when you start up your 
.Macintosh. l:bu can have as many files open automatically as your 
computer's memory allows. 

If you no longer \Vant a file to open automatically when you start 
up your Macintosh, remove the file's icon or its alias from the 
Sta11up Items folder. 

Installing an item in the Apple menu 
To have a program, document, or other item appear in the Apple 
menu, drag the item's icon or its alias to the Apple Menu Items 
folder, which is inside the System Folder. 

)bu remove an item from the Apple menu by opening the Apple 
l\knu Items folder and dragging the item's icon (or its alias) out of 
the folder. 

122 Chapter 11: Adapting 'tbur .\lacintosh to four 0\Yn Cse 

Installing files in the System Folder 
Certain types of programs and other files need to he installed in 
the System Folder so your Macintosh can use them as pait of the 
system software. These files include 

• .~rstem exte11sio11s and control panels (also called II\ITs and 
CDEVs) 

• files of preferences for application programs 

• drivers for printers, scanners, and other devices 

• sounds (instructions for installing sounds are in this chapter) 

• fonts (see Chapter 12, ''Printing," for instructions on installing 
fonts) 

lsually, you install these files by dragging their icons to the 
System Folder icon (not the System Folder \Yindow). Sometimes 
these files are installed using an installer program that comes with 
the files. Check the instructions that came with the files for any 
specific installation procedure. 



These files are stored in specific folders inside the System Folder. 
When you drag a file's icon to the System Folder icon, your 
Macintosh recognizes which type of file it is and stores the file in 
the appropriate folder. 

This folder holds networking 
software, printer software, and 
other system extensions. 

D 
Sittms 

~ 
Startup Items 

This folder holds settings 
for application programs. 

The Svstem file holds fonts. 
sounds, kevhoarc.1 lavouts, 
and other resources.' 

~ 
Control Pant ls 

-- 21! 

1--1--1---This program 
manages the 
Macintosh 
desktop. 

This file holds items mu 
put in the Scrapbook. 

If you drag one of these files to the System Folder window instead 
of the System Folder icon, the file is not stored in the appropriate 
folder automatically. Items you want in the Apple Menu Items 
folder or the Stam1p Items folder inside the System Folder need to 
be dragged to either folder directly. (See the instructions in this 
chapter for installing Apple menu items and specifying the files 
you want opened at startup.) 

Removing files from the System Folder 

You remove a file from the System Folder by dragging its icon out 
of the System Folder. 

Depending on the e:\.1:ernal devices you use1 whether or not you ·re 
on a network, and how you use your Macintosh, you can remove 
the following types of files from your System Folder if you \Vant to 
conserve space on your sta11up disk: 

• drivers for printers or other devices you don't use (for 
example. the AppleTalk'" Image\Xt'riterQ!~ driver) 

• networking drivers, if you are not on a network (such as 
AppleShare@ software) 

• Apple menu items you don't use (you need the control panels, 
but you may not need the Calculator or the Puzzle, for 
example) 

• extra fonts, sounds, or keyboard files you have installed 

Be sure you have backup copies of the files on floppy disks before 
you remove them from your System Folder. 
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Changing the items in the Label menu 
You can change the labels (and colors, if your monitor displays 
colors or shades of gray) available in the Label menu. You make 
these changes in the Labels control panel (choose Control Panels 
from rhe Apple menu and open the Labels control panel). 

~ 
Labels 

ID- Labels~ 

L:J -= 
t--

Ml11o1 I 
Labels 

Ml1nPr!!2!:m I 
[i!iil lcoo1 I 
[i!iil I Ptrson•I I 
[i!iil I ProJrct 1 I 
[i!iil I ProJtct 2 I 

I=_ ...::::: 

Colors 

To change a label, drag across it to select ir and rhen rype your 
new label. 
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To change a color: 

1. Click the color you want to change. 

The color wheel dialog box appears. 

Color square (new color appears in top half. 
current color in bottom half) 

Color for Essentio1· 

Numbers correspond to 
the selected color on 

the color wheel. 

- ----F9-i1t-- Circle 
indicates 
selected 
color. 

Brightness 
control 

Color wheel shows colors available. 
(When four colors or grays are 
selected, letters appear in the wheel 
indicating color values.) 



2. Click a color on the color wheel to select it. 

The new color is displayed in the top half of the color square. 
The current color remains in the bottom half of the square for 
comparison. 

3. To experiment with other colors or shades, drag the 
pointer around the wheel or click at another point on 
the wheel. 

The new color is displayed in the upper half of the color 
square as you drag or click. 

4. Click OK when you have selected the color you want. 

The color wheel dialog box closes. 

5. Close the Labels panel. 

The labels and colors you choose remain in effect until you 
change them. 

Setting the time and date 
Your Macintosh has a clock that keeps track of the time and date 
(a battery keeps it mnning when the computer is turned off). 

Many programs rely on the clock to automatically enter times and 
·dates in documents you create or print, so sooner or later you will 
need to set the clock to the current time and date. 

1. Choose Control Panels from the Apple menu. 

The Control Panels window appears, showing you the 
different control panels that are installed in your System Folder. 

2. Open the General Controls panel. 

The General Controls window appears. The time and date 
adjustments are in the lower-right corner. 

~ Genenll Controls ~ 

0 O®O 
Off123 

Time @ 
11:31:55 AM 

® 12tlr. 0 24hr. 

Oat• lli!J 
12/21/91 

co11ti1111es ~ 

Chapter 11: Adapting Your Macintosh to Your Own Use 125 



3. If you want to change the way the time is displayed 
(12-hour or 24-hour), click the appropriate button. 

The 12-hour fonnat uses A.i\I. and P.M.: the 24-hour fom1at does 
not 0:30 P.M. is displayed as 13:30). 

4. Click the hours, minutes, or seconds in the time display 
to select them. 

Up and down airnws appear to the right of the time display. 

Time (9 
111:32: 12 AM m 

5. Click the up or down arrows repeatedly until the 
current hour, minute, or second appears. 

6. Repeat steps 4 and 5 as necessary to set the entire time 
display. 

7. Click the clock icon (above the time display) to set the 
current time. 
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8. In the date display, click the month, day, or year to 
select it. 

Up and dmvn arrows appear to the right of the date display. 

9. Click the up or down arrows repeatedly until the 
current month, day, or year appears. 

10. Repeat steps 8 and 9 as necessary to set the entire date 
display. 

11. Click the calendar icon (next to the word "Date") to set 
the current date. 

12. Close the General Controls window. 

YOu can also set the time and date in the Alarm Clock~ which you 
open by choosing Alann Clock from the Apple menu. 



Setting a time for the 
Alarm Clock to go off 
You can set the Alarm Clock to alert you when it ·s time for an 
appointment or a meeting. 

1. Choose Alarm Clock from the Apple menu. 

The Alarm Clock opens. 

2. Click the upward-pointing lever near the upper-right 
corner to expand the Alarm Clock. 

r:::::--=-::=-:-:-=-:--;:~--- Lever to make the Alarm Clock 
I D 3

=
52

= 
1 8 PM a~] bigger or smaller 

The lever pointli downward, and the Alarm Clock expands to 
its full size. 

0 3:52:40 PM e 
6/21/90 

___,,,,,........1---- The highlighted icon indicates what ·s 
displayed in the middle section-the 
elate. in this example. 

3. Click the alarm clock icon in the lower-right corner to 
select it. 

The alarm clock icon is highlighted when you select it. The 
time that appears in the middle section is the current alarm 
clock setting. 

D 3:53:34 PM e 
l!J 8:21:00 RM 

@1~1• 

4. Click the hours, minutes, or seconds in the alarm clock 
setting to select them. 

Cp and clown arrows appear to the right of the time display. 

5. Click the up or down arrows repeatedly until the hour, 
minute, or second when you want the alarm to go off 
appears. 

6. Repeat steps 4 and 5 as necessary. 

c011/i1111es .,_ 
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7. Click the button to the left of the alarm clock setting to 
turn the alarm on. 

When you click, the button moves up and the alarm clock icon 
changes to indicate that the alarm is turned on. (Clicking again 
turns the alann off.) 

Button in the upper position 
indicates that the alann is on. 

....__ __ kon showing ringing alarm 

8. Click the close box to close the Alarm Clock. 

The alam1 will not go off unless you close the Alarm Clock or 
click the lever to make the alarm clock smaller, click elsewhere 
in the clock, or make another window active. 

Turning the alann off 

When the svstem clock reaches the time set for the alarm, the alert 
sound play~ twice (the menu bar flashes once if the speaker 
volume is set to zero) and an alarm clock icon blinks over the 
Apple icon at the left end of the menu bar. 

To turn off the alaffil, choose Alarm Clock from the Apple menu 
and click the button to the left of the alarm clock setting so that 
the button moves down. 
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Adjusting the way the mouse works 
You can adjust two aspects of mouse operation in the Mouse 
control panel: tracking, which is the relation between mouse 
movement on your desk and pointer movement on the screen, 
and double-clicking speed. 

1. Choose Control Panels from the Apple menu. 

2. Open the Mouse control panel. 

Mouse 

Ml~Mouse 

Moust Tr.toking 

[1J ~ ii 
0 000®00 

Vtr11 Slow Slow Fast 



3. Click the tracking speed you want. 

If you click Fast, the pointer moves more than twice as fast as 
you move the mouse. The Very Slow option is useful for 
drawing with the mouse or a graphics tablet because the 
pointer moves at a constant speed relative to mouse 
movement. 

Your choice takes effect immediately and remains in effect 
until you choose a different tracking option. 

4. Click the double-clicking speed you want. 

You may have to adjust the double-clicking speed if your 
Macintosh often interprets two clicks as a double click, or a 
double click as two single clicks. 

+ + +--- The space bet·ween arrows 
+ O + ~ + O corresponds to the interval 

~ between dicks. 
Doub le-Click Speed 

Mouse button highlights twice at the 
interval selected when you click a button. 

Your choice remains in effect until you choose a different 
double-clicking speed. 

Adjusting the way the keyboard works 
You can adjust the rate at which a character repeats when its key is 
held down as well as the delay before the character begins 
repeating. You can also change the keyboard layout. 

1. Choose Control Panels from the Apple menu. 

2. Open the Keyboard control panel. 

Slow 

[:] 
Keyboard 

Options for che speed ac 
which a character repeats 

0.111,1 Until Rtpeat 

0 0®00 
Fast Off Long Short 

Kt1,1board Layout 

Options for delay before a 
character begins repeating 

conlinues ..,.. 
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3. To adjust the rate at which a key repeats when it is held 
down, click the button for the rate you want. 

After you close the control panel, your choice remains in effect 
until you change it. 

4. To adjust the delay before keys repeat, click the button 
for the delay you want. 

If the keys repeat when you don't \Vant them to, you should 
adjust the keyboard's sensitivity to your touch by setting a 
longer delay before a character begins repeating. Of you click 
the Off button, the keys don't repeat at all.) 

After you close the control panel, your choice remains in effect 
until you change it. 

5. To change the keyboard layout, click the name of the 
keyboard layout you want to use. 

Depending on which count1y you bought your Macintosh in, 
you may have a choice of more than one keyboard layout. 
(Additional keyboard layouts are available from various 
sources, and you install them in the System Folder as you 
would fonts or sounds.) 

After you close the control panel, your choice remains in effect 
until you change it. 

6. Close the Keyboard control panel 
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Controlling the pointer from the keyboard 

\Vith a Macintosh system software feature called Mouse Keys, you 
can use the numeric keypad on the right side of the keyboard 
(instead of the mouse) to control the movement of the pointer on 
the screen. 

To turn Mouse Keys on, press x-Shift-Clear (the Clear key is on 
the numeric keypad). 

To turn Mouse Keys off, press Clear. 

\'\Tith Mouse Keys on, you can click. drag, and perform all the 
usual mouse actions from the numeric keypad. The 5 key serves 
as the mouse button: press once to click; press twice to double­
click. The 0 key locks the mouse button down for dragging. The 
decimal point key (to the right of 0) or the 5 key unlocks the 
mouse button. 



0 

l~J LJ LJ 
~--- Press once to 

click; press twice 
to double-dick. 

Press eilher key 
to release the 
mouse button. 

Press to lock 
mouse button 
down for dragging. 

You can adjust how quickly the pointer moves on the screen and 
how long the delay is before the pointer starts moving when you 
press a mouse key. You make these adjustments in the Easy Access 
control panel (choose Control Panels from the Apple menu and 
open Easy Access). 

Making keyboard shortcuts easier to type 

With the Macintosh system software f ea tu re called Sticky Keys, 
you can type keyboard shortcuts (such as 3€-S for the Save 
command) without actually pressing the keys simultaneously. 

To turn Sticky Keys on or off. press the Shift key five times without 
moving the mouse. 

With Sticky Keys on, you can type a keyboard shortcut by first 
pressing the modifier key (3€, Option, Control, or Shift) and then 
pressing the character key. An icon in the right end of the menu 
bar (to the right of the Application menu icon) changes to indicate 
whether Sticky Keys is on and whether a modifier key has been 
pressed or locked. 

Sticky 
Keys 

A modifier A modifier key is locked 
key has (pressing the key twice 
been presse~d. locks it for repeated use). 

~· ....... . . . . . . . . .. . . . ...... . 

You can have Sticky Keys make an alert sound when a modifier 
key is pressed. You set this option in the Easy Access control panel 
(choose Control Panels from the Apple menu and open Easy 
Access). 
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Adjusting the keyboard for very slow typing 

The Macintosh system software feature called Slow Keys lees you 
type ve1y slowly and ignores accidental keysrrokes by delaying 
the acceptance of the next keystroke. 

To turn Slow Keys on or off, hold down the Heturn key for about 
fou r seconds, until an alert sound indicares thar rhe feature is on 
or off. 

You can adjust how long you want Slow Keys to delay acceptance 
of the next keystroke. You can also set Slow Keys to make an 
audible click each time a key is pressed. You make these 
adjustments in the Easy Access control panel (choose Control 
Panels from the Apple menu and open Easy Access). 
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Setting the alert sound 
Many programs have the Macintosh make a sound, called the ale1t 
sound, when your attention is required or when you're giving a 
command or attempting an action that the computer cannot 
recognize or perform at that time. 

You can choose among several sounds that you want the 
Macintosh to make. You can also set the sound's volume. 

1. Choose Control Panels from the Apple menu. 

2. Open the Sound control paneL 

~ 
Sound 

The Sound window appears. The ale1t sound that your computer 
is currently using is already selected. 

3. Click the alert sound that you want the Macintosh to 
use. 

ID Sound 
SpHk.,- Altrt Sounds 
Vobno 

~i.t 0 ,, Ouaok 6-
~ ·-

Simpl< Bttp 

4 - Sosumi 

3- \llld Etp 

2-
I 
o- '<> 



When you click a sound to select it, it's played at the current 
volume setting. 

Your Macintosh may have sounds installed in addition to those 
shown here. It may also have additional features in its Sound 
control panel, such as controls for recording sounds. See 
"Recording Sounds" later in this chapter for information on 
recording sounds. For information on any additional features, 
go to the setup book that came with your Macintosh. 

4. Drag the slide control up or down to set the volume 
level. 

·:· If you want to be alerted silently: Drag the slide control to 
zero. Instead of hearing an alert sound, you'll see the menu bar 
flash. ·:· 

5. Close the Sound control panel. 

Installing a sound 

The Macintosh comes with a standard set of alert sounds. You can 
get additional sounds from various sources. To install a sound, you 
drag its icon to the System Folder icon (not the System Folder 
window). The sound is automatically installed in the System file, 
where it belongs. 

ri 
Oom-pah 

Once you add a sound to the System file, it is listed in the Sound 
control panel. 
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Removing a sound 

You can remove sounds in the Sound control panel. Make sure 
you have a backup copy of the sounds on floppy disk before you 
remove them from your Macintosh system. 

1. Choose Control Panels from the Apple menu. 

2. Open the Sound control panel 

3. Click to select the sound you want to remove. 

Make sure you select the correct sound. You cannot undo the 
next step. 

4. Choose Cut or Clear from the Edit menu. 

5. Close the Sound control panel. 

You can also remove a sound by dragging its icon out of the 
System file and out of the System Folder. If your Macintosh can 
record sounds) you can remove a sound by clicking to select it and 
then clicking the Remove button. 

Recording sounds 

Some Macintosh models (such as the Macintosh LC) can accept 
and process sound input. These computers come with a sound 
input port, to which you can connect either a microphone (to 
record sounds that you create) or a phono jack adapter (to record 
sounds from another audio source such as a compact disc or an 
audio cassette). 
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You can record a sound and add it to your available alert sounds 
in the Sound control panel. Make sure you've connected a 
microphone to your Macintosh as described in the setup book that 
came with your computer. 

1. Choose Control Panels from the Apple menu. 

2. Open the Sound control panel 

The Sound control panel appears. Icons representing the 
available sound input devices appear near the bottom of the 
window. 

3. Click the icon that represents the sound input device 
you want to use. 

Mt ophont ( Ot>tions ... } 

4. Click the Add button. 

A dialog box that looks like the controls of a tape recorder 
appears. 



5. To record your new sound, click the Record button. 

Recording begins immediately; you have ten seconds to 
record your sound. There is no recording volume control. 

~~@][I] <J 
R.cord Stop P&USt Play 

:OD 
0 Hconds :10 

~ 
[~) 

6. Click Stop to stop recording. 

7. To listen to the sound you recorded, click Play. 

8. To save the sound you recorded, click Save. 

A dialog box appears in which you name your new sound. 

9. 'fype a name for the sound. 

10. Click OK. 

Glue this sound o nome: 

I Andreo's first wor~ 

( Concel ) lCEJ 

The new sound appears in the Alert Sounds list in the Sound 
control panel. 

When you 're finished recording new sounds, close the Sound 
control panel. 

Changing the desktop pattern 
You can change the pattern that appears on the Macintosh 
desktop in the General Controls panel. 

1. Choose Control Panels from the Apple menu. 

2. Open the General Controls panel. 

~ 
Gener a 1 Controls 

000® 
Offl23 

Fast 

Time CS> 
10:27:51 AM 

@ 12hr. 02411r. 

D.ate llfil 
3/28/90 

co11Jim1es llJJ-
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You can choose from a variety of patterns provided for the 
Macintosh desktop, or you can create your own design by 
editing one of the patterns supplied. If your Macintosh can 
display colors or shades of gray, you can also select your own 
colors to use in the pattern. 

r--::======t.- Paucrn-editing area 

Desktop Pattern 

••• 

(magnified \·ie" · of pattern) 

~ liniature desktop 

Color bar for selecting 
colors or shades of gray 

3. To see the patterns available, click either of the small 
triangles at the top of the miniature desktop on the right 
side of the Desktop Pattern area. 

The pattern changes each time you click. 

4. To choose a pattern, click the miniature desktop to see 
the new pattern on your desktop. 

The new pattern replaces the current pattern for the desktop. 
The desktop pattern remains in effect until you change it. 
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5. To edit a pattern, click in the square to the left of the 
miniature desktop. 

Each clot in the square changes color when you click it. Your 
changes are displayed in the miniature desktop. 

Desktop Pattern 

••• • 
6. To use another color, click the color in the color bar 

(under the words "Desktop Pattern") to select it, then 
click the dots you want to change. 

You can also change the color of an existing pattern by double­
clicking a color in the color bar and choosing a new color from 
the color wheel in the dialog box d1at appears. 

7. When you've finished creating your new pattern, click 
in the miniature desktop to display the pattern on your 
desktop. 

By double-clicking in the miniature desktop, you can save the 
ne"' pattern. OthenYise it is lost when you display another 
panern in the miniature desktop. 



Adjusting the blinking of a menu item 
You can change the number of times a menu item blinks when it's 
chosen. You make this adjustment in the General Controls panel 
(choose Control Panels from the Apple menu and then open the 
General Controls panel). 

To adjust menu blinking, click the button for the number of times 
you want the menu item to blink. Clicking the Off button prevents 
a menu item from blinking. 

Menu Blinking 

0 00® 
Off123 

The option you selected remains in effect until you change it. 

Adjusting the blinking of 
the insertion point 
You can adjust how quickly the insertion point blinks (the 
insertion point indicates where any text you type will appear). You 
make this adjustment in the General Controls panel (choose 
Control Panels from the Apple menu and then open the General 
Controls panel). 

To adjust the blinking of the insertion point, click the button for 
the blinking rate you want. 

Rate of Insertion 
Point Blinking 

"·I·" ·::: :::· 
O®O 

Slow Fast 

When you click, the insertion point in the control panel shows the 
rate of blinking you selected. 

The option you selected remains in effect until you change it. 
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Changing the way the contents 
of windows appear 
You can change the way the contents of Finder ,,·inclmYs are 
displayed in the different views arailable from the Vie"· menu 
(icon view. small icon view. and the list r ie\rs by name, size, kind. 
label, and date). You make these changes in the Vie\YS control 
panel (choose Control Panels from the Apple menu and open the 
Views control panel). 

Vie\vs 

Cse the Views control panel to change 

• the font and font size used in all views (press to open the r op­
up menu. then drag to choose a font or a size) 

• the arrangement of icons or small icons in icon and small icon 
,·iews 

• the size of icons used in list ,·ie\\·s 

• what information is included in list ,·ie\\·s. including folder 
sizes and the amount of available space on disk 
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Options for 
hymll of icons ' 

Pop-up menu of fonts for 
icon names and list views 

i Ulews 

r ont ( Of' vitws [ Geneua ... J lg]~ 
kon YWYS 

t-oooo @ Str •iQht grid 
0 Alw1<1• Sn"9 to.,~-

l 
Ost_.-«!<yld I ~ooo - ----·---

1~YM;•---;~----!8i Sho" si.tt I 
(8i Sho" kln<I ! 

® 0 0 !81 Sho" l>Ml ! I I-- _ !81 Shov d··· i 0 C.loulllt f oldtc ,.,.. 0 Shov VtrSIOn ! 0 Shov duJc ftfo 11\ htldtr _ 0 Shov oommt<1ls ! 

0 )lions for tile size I Options for information 
of icons displayed 
in list vie\\'~ 

displayed in list views 

Pop-up menu of font 
sizes for icon names 
and list vie,,·s 

Option to snap icons 
to an invisible grid 
whenever they are 
mOl'Cci 

The options you select remain in effect until you change them. 
(See the summary, "Working on the Macintosh Desktop." on the 
oreen naoes after Chapter 16 for more information about using u .... b 

windows and list vie\\·s.) 



Changing the appearance of icons 
Ybu can customize icons by changing the icons themselves. If your 
Macintosh displays color or shades of gray, you can have icons 
appear in a specific color that's associated with a label. 

Changing an icon 

In a graphics program~ you can create or copy the picture you 
want to use as an icon, and then paste it into an icon's Info 
window. 

Some icons can~t be changed, including those for control panels 
and other parts of the system software. Every icon fits inside a 
32-pixel square. (A pixel, or picture element, is the smallest dot 
you can draw on the screen.) 

1. In a graphics program, select the picture you want to 
use for the icon. 

: s-- - -_, ----A moving dashed line 
1 1 indicates the selected area 
1 ____ 1 in many graphics programs. 

2. Copy the picture by choosing Copy from the Edit menu. 

3. Switch to the Finder, then click to select the icon you 
want to change. 

4. Choose Get Info from the File menu. 

The icon's Info window appears. 

5. Click the icon at the upper-left corner of the Info 
window to select it. 

A box appears around the icon when it's selected. If no box 
appears when you click, the icon can't be changed. 

i!D§ ouerseos accounts Info ~ 

B ovtr-stas accounts 

Kind: foldtr-
Siu: zer-o I< on disk (O b11t•s used), for- 0 

Items 
Yh•r•: J's disk: untitl.cl folder-

CrHt•d: 'lr'•d, Oct 9, 1991, 9:25 AM 
Hodiffed: \\'td, Oct 9, 1991, 9:25 AM 

Comments: 

A box around the icon 
indicates that it's selected. 

continues ..._ 
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6. Choose Paste from the Edit menu. 

The picture you copied replaces the selected icon in the Info 
window. If the picture is bigger than the icon, it automatically 
shrinks to fit. 

lftCW~ ouerseas accounts Info~ 

I S I overseauooounts 

7. Click the close box to close the Info window. 

You can change an icon back to its original by clicking the 
picture in the upper-left corner of the Info window and 
choosing Cut from the Edit menu. 

Assigning a label and a color to an icon 

You can add a label and its associated color to each icon. A label is 
different from the icon's name. The label is visible only when the 
contents of a window are displayed as a list. The associated color 
is visible whenever the Macintosh is set to display colors or grays. 

Labels provide a way to group related files (choose By Label from 
the View menu). If you have a color monitor, you can identify 
related icons by assigning a label and its color to each group. 

To assign a label and color to an icon, click the icon to select it and 
then choose the label (and its color) that you want from the Label 
menu. 
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Changing the highlight color 
If your Macintosh displays colors or shades of gray, you can 
change the color your .Macintosh uses to highlight selected text on 
the screen. You make this adjustment in the Color control panel 
(choose Control Panels from the Apple menu and open the Color 
control panel). 

~ 
Color 

i!L Color 

Highlight color: [•Black & White ~Pop-~p ~enu of choices 
for h1ghhght color 

l@@M•I 

Window color: f 0 Standard ..-i-:f-Pop-up menu of choices 
for window color 

You can also use the Color control panel to change the color of 
window borders (go to "Changing the Color of Windows" in this 
chapter). 



1. Press the "Highlight color" pop-up menu to open it and 
drag to choose a color or choose Other. 

If you choose a color. it appears in rhe "Sample rexr" box \Yhen 
you release the mouse button. 

If you choose Other, rhe color wheel dialog box appears. 

Highlight color square (new color appears 
in top half, current color in bonom half) 

Choos a highlight color • 

Saturation 3605 1 

Brightness 50229 

Red 35933 

Green 50229 

Blue 2259B 

Numbers correspond to 
the selected color on 

the color wheel. 

----+-+-tt-- Circle 
indicates 
selected 
color. 

Brightness 
control 

Color wheel shows colors avai lable. 
(When four colors or grays arc 
selected, letters appear in the wheel 
indicating color values.) 

2. To change the brightness of the color wheel, drag the 
scroll box up or down. 

3. Click a color on the color wheel to select it 

The new color is displayed in the cop half of ci1e color square if 
your monitor is set to display 16 or more colors or grays. The 
current color remains in the bottom half of the square for 
comparison; you can click there to go back to it. 

4. To experiment with other colors or shades, drag the 
pointer around the wheel or click at another point on 
the wheel. 

The new color is displayed in the upper half of ilie color 
square as you drag or click. 

5. Click OK when you have selected the color you want 

The dialog box closes. The new highlight color is displayed in 
the "Sample text" box in ilie Color control panel. 

The highlight color you specified takes effect immediately and 
remains in effect until you change it. 
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Changing the color of windows 
If your Macintosh displays colors or shades of gray, you can 
change the color of window borders. You make this adjustment in 
the Color control panel (choose Control Panels from the Apple 
menu and open the Color conrrol panel). 

Co lot· 

ID Color 

Highlight color: I• Black I> White •I 
MW*I 
Window color: D Stendard ... 

Pop-up menu of choices 
for highligln color 

Pop-up menu of choices 
for " ·indO\Y rnlor 

You can also use the Color control panel to change the color your 
Macintosh uses to highlight selected text on the screen (go to 
"Changing the Highlight Color" in ch is chapter). 

To change the color of window borders. press the pop-up menu 
labeled ''Window color" co open it and then drag co choose <t ne,,· 
color. 

The color you choose cakes effect immediately and remains in 
effect until you change ir. 
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Displaying colors or grays 
If your i\ !acimosh displays colors or shades of gray, you 0 111 

designate the number of colors or shades of gray you want 
displayed. (Ho\\· many colors or shades your Macintosh can 
display depends on the ,·ideo capability it has. See the serup book 
chat came \\'ith your ~lacimosh and rhe instructions that came ~\'ith 

your monitor for more information.) 

You set the number of colors or grays in the Monitors control 
panel (choose Control Panels from the Apple menu and open the 
Monitors control panel). 

g 
Monito..-s 

iO~ Monitors 
C'h1r~ttftstics of ulf'Cttd monitor: 

~::','.D (options ... ] 

Or rnon1~ors ~in.nub¥ to rur-r thtm 

( Identify ] 



You also use the Monitors control panel to configure your 
monitors if you h;l\·e more than one (go to "Configuring Mulriple 
Monitors," the next section in this chapter). 

1. If you have more than one monitor, click the icon of the 
monitor whose colors you want to adjust. 

A dark border appears around the icon to show that it is 
selected. 

2. Click the Grays or the Colors button. 

Some monitors can display only shades of gray, even if you 
cl ick the Colors button. 

3. Click the number of colors or shades of gray you want 
displayed on the selected monitor (or click Black & 
White). 

Your changes take effect immediately. The number of colors or 
shades of gray you specified remains in effect until you change it. 

·:· !/your i'vlacintosh has built-ill video (you dicln't have to install a 
video card in your .Vlacintosh before you could connect a 
monitor). increasing the number of colors or grays you \Yant 
displayed increases the amount of memory your Macintosh 
uses for its video display and decreases the amount of memory 
available co run your programs. Your programs· performance 
may suffer as a result. If you \\·ant to change the amount of 
memory set aside for video, cl ick the Options button in the 
Monitors control panel and click the appropriate buttons in the 
dialog box that appears. ·:· 

Configuring multiple 111onitors 
If you use more than one monitor with your Macintosh, you need 
to indicate rhe monitors' positions and designate one as the main 
monitor (the one that displays the menu bar). 

You make these adjustments in the Monitors control panel (choose 
Control Panels from the Apple menu and open the Monitors 
control panel). 

[SJ 
Monitors 

~o~ Monitors -- Clicking Options opens a dialog 
box th<ll lists rhe type of video 
card to which the selected 
monitor is connected. 

Characteris lies: of stl•ctrd monitor : 

Ocolors: ~6 Options ... ®G"Y·=o··. 
256 

Drag the tiny white menu bar to 
the ~nonitor.you want to display 

~:;;;:::;;::::1---H-- the menu bar. 

B 
L---t-- -11-- The dark line around a monitor icon 

indicates thar it is selected. 

Colors in this box I 
correspond tn the 
number of colors 
the selected monitor 
is set to dispby. 

Clicking Identify displays each 
monitor°s ID number on its screen. 

Icons for the monitors 
connected to the i\ lacintosh. 
sho11·ing their ID numbers 
and tllL'ir rclatil'e positions 
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You also use the Monitors control panel to set the number of 
colors or shades of gray you want displayed (go to "Displaying 
Colors or Grays" in this chapter). 

1. Check the ID numbers of your monitors by clicking the 
Identify button. 

A large number appears in the center of each monitor's screen; 
it corresponds to the number of the icon in the control panel. 

The ID numbers help you identify which icon belongs to 
which monitor. 

2. Decide which monitor is your main monitor and drag 
the menu bar to the top of that monitor icon. 

The menu bar snaps to the top of that monitor icon when you 
release the mouse button. 

If one of your monitors displays colors or shades of gray, you 
may want to make it the main monitor so you can use the color 
capabilities of your programs and of the Finder. 

If your monitors are different sizes, you may want to make the 
largest one the main monitor because some programs limit 
their window size to the size of the main monitor. 
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3. Drag the icons of the other monitors to their positions 
relative to the main monitor. 

lb avoid becoming disoriented when you're using the 
monitors, position the monitor icons so that they correspond to 
their actual positions on your desk. 

The pointer can cross from one screen to another where the 
monitors' icons touch in the control panel. 

4. Choose Restart from the Special menu. 

The positions you specified remain in effect until you change 
them and restart your computer. 



Adjusting screen brightness 
Most Macintosh models have brightness and contrast dials on the 
monitor or a brightness dial on the computer itself. See the setup 
book that came with your computer or the instructions that came 
with your monitor for more information. 

-=~~~n----Brightness 
control 

A few models do not have brightness and contrast dials. If your 
Macintosh does not have such dials, you adjust screen brightness 
in the Brightness control panel (choose Control Panels from the 
Apple menu and open the Brightness control panel). 

Brightness 

To adjust screen brightness in the Brightness control panel, drag 
the slider control to the left or the right. 

·:· Tip: Turn down the brightness if you'll be away from your 
computer for a while. If an image is left on the screen for 
several hours or more, it may begin to "burn in" and damage 
the screen. You can use "screen saver'' programs, available 
from various sources, to dim the screen automatically or 
display a moving image after a set period of inactivity. •:· 
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Magnifying the 
• screen unage 

The CloseView control panel lets you 
n1agnify the image on your Macintosh screen 
up to sixteen ti111es. It is supplied on one of 
the Macintosh systen1 software disks. 

CloseView is not automatically installed by 
the Installer program when you install systen1 
software. 
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To install CloseView: 

1. Locate the CloseView control panel . 

Close'1,•
1ie·vl 

2. Drag the CloseView icon to the 
System Folder icon (not the System 
Folder window) on your startup disk. 

3. Choose Restart from the Special 
menu. 

To turn CloseView on or off, press 
~-Option-0 . 



To turn the magnification on or off, press 
X-Option-X. (When CloseView is on and 
the magnification is off, a rectangle on the 
screen indicates which area will be 
1nagnified. You can move the rectangle by 
moving the pointer.) 

To increase or decrease magnification, press 
X-Option-Up Arrow or X-Option-Down 
Arrow. 

You can set additional options in the 
CloseView control panel (choose Control 
Panels from the Apple menu and open the 
CloseView control panel): 

§0 CloseUiew Turns 
Close View 

-------1-0n or off Cl~e 
View 

Inve1ts Turns 
screen shortcuts 
image on or off 

Turns 
magnification 

M_a9_nif_ica_tio_n ____ onoroff 

Keyboard 
shortcuts 

Arrows change 
magnification 
power 
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Turning off the Empty Trash warning 
When. you choose Empty 'frash from the Special menu, a dialog 
box appears warning you that you will nor be able to recover the 
contents of the 'frash once it's emptied. (The warning helps you 
avoid throwing away items unintentionally.) 

You can turn off this warning in the Trash's Info box. 

1. Click the li'ash icon to select it. 

2. Choose Get Info from the File menu. 

3. Click the checkbox labeled "Warn before emptying" to 
remove the X. 

To turn the warning back on, click the checkbox so that an X 
appears. 

You can also override the Empty Trash warning when it is on by 
holding down the Option key when you choose the Empty Ti·ash 
command. 

Until you choose the Empty Trash command, items in the 1i-ash 
continue to occupy space on your disk. 
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Managing men1ory 
Occasionally you may need to make adjustments in how your 
Macintosh uses irs random-access memory (RAM) in order to work 
efficiently wirh large programs or wirh several programs ar once. 

Checking memo1y use 

You can find out how much memory your Macintosh has, how 
much of it is not being used, and how much memory is being 
used by each program you have open. You find this information 
by making t11e Finder the acrive program and choosing About This 
Macintosh from the Apple menu. 

ID Rbout This Mocintosh E!l! 

I· - - ! H~cintosh llrH 

Tohil H•m1H"9 : ~.12" 
"! S.,,sttm Sotlw .... 

--, 
1~ 

~ TexhTtxt 
r-

Pro rams g 
currently 
open 

192.!:..., 

Memor y 
allocated for 

each program 

SIJSt•m Software 7 .0 

4!>Applo Comput..-' ~. 1983• 1991 

l.M'9•s·t Unused Bloct : 3~1'lK 

ll=i 
IQ 
to 
£: 

Total memory in 
rhis Macinrosh 

The bar indicates how mu ch memory a 
program reserves for its own use. The dark 
ponion is the amount it is actually using. 

Your Macintosh must have at least 2 megabytes (MB), or 
2048 kilobytes (K), of RAM to use Sysrem 7. 



You can adjust how much memory a program sets aside for itself 
when you open it (go to "Setting Up Your Programs" in Chapter 8, 
"Setting Up Your Macintosh System," for instructions). 

If you're unable to open a program or use network services such 
as printers or electronic mail, you may have to quit from one or 
more programs to free some memory for what you want to do. 
You can also restart your Macintosh to reset the way its memory is 
being used. 

Adjusting the disk cache 

The disk cache is memory set aside to help programs work more 
quickly and efficiently. The memo1y in the disk cache is not 
available for opening more programs or documents, so the size of 
the disk cache affects how many files you can have open at the 
same time. 

The preset and maximum sizes of the disk cache depend on the 
amount of memory your Macintosh has. If you often want to open 
more programs than memo1y allows, set the disk cache to a 
smaller size-such as 32K or 64K. 

You set the size of the disk cache in the Memory control panel 
(choose Control Panels from the Apple menu and open the 
Memory control panel). 

Memory 

To set the size of the disk cache, click the up or down arrows next 
to the Cache Size box. The new size takes effect after you restart 
your Macintosh and remains in effect until you change it. 

BO Memory 

Virtual MtmortJ 

Oan 
®orr 

32·9it Addr'ts.sing 

Oan 
@Off 

CxhtStu ia28K 1 f<H ~Arrows adjusc cache in lMi . 

S.1«:\ H>rd Disk: 

:,-~ 11111nmN ..- J 
Avail•bl• on disk : 27M 
Tot.al memorv ; 4M 

presec mcremems. 

This button sets the disk 
cache at the svstem's 
presec amouni (which 
depends on the RAM in 

[ use Defaul ts 1--.i--- YOLir computer). 

Depending on your Macintosh model, you also use the Memory 
control panel to adjust how virtual memory is used and to turn 
32-bit addressing on or off (see '"Using Hard Disk Space as 
Memo1y" and "Turning On 32-bit Addressing" in this chapter). 
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Using hard disk space as rnerno1y 

Some Macintosh models can use space on a hard disk ro increase 
rhe compurer's memo1y. The disk space. called uirt11a/ 111emo1y. is 
nor available for storing information when iris being used for rhis 
purpose. 

four Macintosh should contain enough built-in memo1~· for your 
regular needs- rliac is. for the programs you frequently ha\·c open 
simultaneously. You can use virtual memory when you want to 
open additional programs or to work with extremely large 
documents that can't be opened while using only rhe built-in 
memo1y. 

Virtual memory is more effective when you are using several small 
programs simultaneously. It is less effecti\·e ~·hen using one rery 
large program. 
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If your Macintosh can use virtual memory, you can adjust its use of 
\·ircual memory in the Memory control panel (choose Control 
Panel · from the Apple menu and open the Memory control panel). 

ID 

!'.5m 

@) 

~ 

Memory 

Memory 

Otsk C.ach+ Cachf. Si:• !illLl !ID A .... >'jSOn 

S~ltctH¥d01Jlic : _ _ -~ 1--

Vrtua1 Mtmory I= Humnn~r ~ J 
Q0n Avail~J. on disk : 27M 

@ Off Tot•l,_,.,...y 41 
32-B1t MdrtSJft9 

Q0n 
@Off 

( Use Defoults ) 

Pop-up menu of hard disks 
in use (dimmed when 
virtual memory is off) 

Space arailablc on the 
disk H11111111er 

Total memorv 
(exclusirclr i{:\.\l in this 
example: includes rirtual 
111e11101y if it 's on) 



You also use the Memory control panel to adjust the size of the 
disk cache and (depending on your Macintosh model) to turn 
32-bit addressing on or off (see "Adjusting the Disk Cache" and 
"Turning On 32-bit Addressing" in this chapter). 

1. Click the On button to turn on virtual memory. 

The Select Hard Disk pop-up menu becomes active (black) 
when you click On. 

2. Press the pop-up menu to open it and drag to choose 
the hard disk on which space will be allocated for 
virtual memory. 

3. Click the up and down arrows to adjust the amount of 
disk space to be used as virtual memory. 

The Memory control panel is preset to allot the same amount 
of virtual memory as the amount of RAM installed in your 
Macintosh. Choosing a larger amount of virtual memory is 
likely to slow the computer's performance. 

It is recommended that you accept the preset size. The 
numbers for "Available on disk" and "After resta1t'· change as 
you adjust the amount of disk space. 

4. Choose Restart from the Special menu. 

After you restart, your computer"s total mem01y (as indicated in 
the window that appears when you choose About This Macintosh 
from the Apple menu) includes the virtual memory you set aside 
on the hard disk. 

.~ Important: When you turn on vittual memory. the system 
software creates a file named VM Storage in your System 
Folder (if the sta11up disk is used for virtual memo1y) or on the 
desktop (if another hard disk is used for vi1tual memoty). This 
file is large-the size of the computer's RAM and the 
designated amount of ,·irtual memory combined. For example. 
if your Macintosh has 4 MB of Rfu\I and you add 2 MB of 
virtual memory. the VM Storage file will occupy 6 MR of space 
on your startup disk. ~ 
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Turning on 32-bit addressing 

Some .Macintosh models can use very large amounts of memo1y 
(more than 8 megabytes) by taking advantage of a feature called 
32-bit addressing-the use of ve1y long (32-digit) binary numbers 
to control the way data is manipulated. 

If your Macintosh can use 32-bit addressing, you can turn the 
feature on or off in the Memo1y control panel (choose Control 
Panels from the Apple menu and open the Memo1y control panel). 

To turn 32-bit addressing on or off, click the appropriate buttons 
in the control panel, then choose Restart from the Special menu. 

~ 
Memory 
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~~ 

@) 

~ 

Memory 

Oisl<C>el>O 
,._lw~sOn 

Virtual Memor\j 

00n 
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32-Bit Addr'Hs~ 

00n 
@Off 

CJCMSiu li2SK I [ID 

S.ltct H.ard Disk : 

l= Humnu~r ··1 
Av.tilable on disk: 27M 
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You also use the Memory control panel to adjust the size of the 
disk cache and (depending on your Macintosh model) to set aside 
hard disk space for use as memory (see "Adjusting the Disk Cache" 
and '·Using Hard Disk Space as Memo1y" in this chapter). 



Chapter 12 

Printing 
In this chapter 

• Before you print 

Choosing a printer 

Selecting Page Serup options 

Updating printer drivers on nemmked computers 

• Printing your work 

Printing the contents of a window 

If the printer doesn't print your document 

• Printing while using the computer for other work 

• Working with fonts 

Outline fonts and bitmapped fonts 

Installing fonts 

Removing fonts 

Transferring fonts to a LaserWriter printer 

Finding out about available fonts 

Using the LaserWriter Font Utility 

Before you print 
Before you can print, your Macintosh must be connected to a 
printer, either directly or over a net\vork. See the instructions that 
came with your printer if you need information about connecting 
it to your computer. 

Then, you must tell your Macintosh which printer rouse by 
choosing the printer. 

Choosing a printer 

You tell die Macintosh which printer to use by choosing the 
printer in a program called the Chooser. You don't need to choose 
a printer every time you print. You need to choose one only when 
you're using a printer for the fi rst time and whenever you decide 
to change printers. 

Hmv you use the Chooser depends on whether your Macintosh is 
connected directly ro the printer or connected ro a network. 
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If your printer is not on a network 

Make sure that you've connected the printer according to the 
instmctions that came ·with it and that you know which po11 you 
used (on the back of the computer) to connect the printer. 

1. Choose the Chooser from the Apple menu. 

The Chooser \Vindow appears. 

2. Click the icon of the printer you want to use. Make sure 
the icon is selected (highlighted). 

~ 
AppleShu-e 

.11., 
rmiiilm 

§. 
LQ AppltT...~'W'riter 

m 
Personal ... 'li'riter SC 

~ 
AppltTallc .... ;i~\v'riter 

~ 
LQ~\v'riter 
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Chooser 

i1! Select a port: 

• 
0 Active 

AppleTalk ®Inactive 

·:· {j'yourpri11ter:~ icon does not appear in the Choose1; then the 
appropriate printer driver-the program that communicates 
with, or "'drives,'' the printer-has not been installed in your 
System Folder. Close the Chooser and install the driver you 
need. You can use the Customize option in the Installer 
program (sec Chapter 8, "Setting Cp Your Macintosh System"), 
or you can install the driver directly by dragging its icon into 
the System Folder. If your printer is not an Apple printer, 
review the instructions that came with it for information on 
installing its driver. ·:· 

If you have a Personal LaserWritd~) SC. close the Chooser window 
after you click the Personal LaserWriter SC icon. 

3. Click the icon representing the port that you used to 
connect the printer. Make sure the icon is selected . 

You have only two choices: the printer pott or the modem 
polt. Click the icon that matches the icon of the port (on the 
back of the computer) to which you connected the printer 
cable. 

4. Click the Inactive button next to the word "AppleTalk." 

If the Inactive wasn't already selected~ a dialog box appears. 
Click OK. 

5. Close the Chooser window. 



If your printer is on a network 

Find out from your net\vork administrator (or the person who set 
up your computer) which printer you can use, ·which zone it's in 
(if your network has zones), and what its name is (every printer on 
a network has its own name). 

1. Choose the Chooser from the Apple menu. 

The Chooser window appears. 

2. Click the Active button next to the word "AppleTalk." 

If Active wasn't already selected, a dialog box appears. 
Click OK. 

Trpes of devices availahle :'\·tmes of inchidual printers . ' 

Ill.[ ~~ - Chooser ·=·~,----

~ .a. ~ 
lm19•'w'rll•r dim 

ro 
~pleTolk Zones: 

4th floor west jQj 
5th floor eest 
SUI i loor w~st 
6th floor eest 
~h floor west 

IQ 

Network zones (a pp earonlv 
if the Macintosh is on a 
network that has zones) 

Select e Leserwri er: 

Accounting - ~ 
Humcm Resources 
MerkeUng 
Se I es -

IQj 
Beckground Printing: ® On O Off 

·---·~------·----------·---

AppleTelk ~Active 
0 lnectlve 

lu leTalk must h I p e active to 
use anv network dc\'iccs. 
indudfng network printers. 

3. Click the icon representing the type of printer you want 
to use. 

You may have to click the up and down scroll arrows to find 
the icon. 

·:· {fyourpriJlfer's icon does not appear in the Choose1: then the 
appropriate printer driver-the program that communicates 
\\··ith, or ··drives." che printer-has not been installed in your 
System Folder. Close the Chooser and install the driver you 
need. You can use the Customize option in the Installer 
program (see Chapter 8, "Setting Cp Your Macintosh System"), 
or you can install the driver directly by dragging its icon into 
the System Folder. (If you install the LaserWriter driver, be sure 
to install the PrintMonitor program also.) If your printer is not 
an Apple printer, review the instrnctions that came with it for 
information on installing its driver. ·:· 

4. H you see a list of AppleTalk zones, click the zone where 
the printer is located. 

You may have to click the up and down scroll an-ows to find 
the zone. The zones are listed alphabetically. 

5. Click the name of the printer you want to use, even if 
it's the only one that appears. 

continues llJll-
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6. If you want to be able to use your Macintosh for other 
work while it's printing documents, click the On button 
next to Background Printing. 

The background printing option is available only if both the 
PrintMonitor program and the LaserWriter driver have been 
installed in your System Folder. (See "Printing While Using the 
Computer for Other Work" in this chapter for information 
about using PrintMonitor.) 

7. Close the Chooser. 

Selecting Page Setup options 
You use the Page Setup dialog box when you've selected a new 
printer in the Chooser or when you want to use a different paper 
size or printing option. 

• Choose Page Setup from the File menu and select the options 
you want. 
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When a LaserWriter printer is chosen, this Page Setup dialog 
box appears: 

Pop-up menu of special paper sizes 

LoserWriter Page Setup II OK II 
Paper: ® US Letter O R4 Letter 

0 US Legal 0 85 Letter 0 f Tabloid • J (Cancel I ,....-
(Options] Reduce or [lliDJI% Printer Effects: 

~large: 181 Font Substitution? 
Orientation 181 TeHt Smoothing? 

-~ 
181 Graphics Smoothing? 
181 Faster Bitmap Printing? 

Printed co ,. as P. 
percentage of original 

Clicking the Options button 
opens a dialog box for 

selecting enhancements 
to the printed image. 

When an ImageWriter printer is chosen, this Page Setup dialog 
box appears: 

lmageWrlter ([ OK JI 
Paper: ®us Letter O R4 Letter 

O us Legal O International Fanfold I cancel ) 
O Computer Paper 

Orientation Special Effects: O Tall Adjusted 
fiil ~ 0 50 3 Reduction 
~ ~ O No Gaps Between Pages 



You can choose Show Balloons from the Help menu to get 
descriptions of the enhancement~ provided in the Options dialog 
box, or check your printer's manual for details. 

You'll see different options for each type of printer you use. Some 
programs provide additional options. Options you set in the Page 
Setup dialog box remain in effect until you change them. 

Updating printer drivers on networked computers 

All computers on a network that share one or more printers must 
have the same version of the printer driver software that 
communicates with (or "drives") the printers. When someone on 
the network sends a document to the printer using a version of the 
printer driver that's different from the last version the printer 
recognized, the printer restarts itself (which takes time and clears 
any font~ from its temporary memory). 

,~ Important: All computers on a network must have the same 
version of printer drivers in their System Folders. ~ 

If your Macintosh is part of a network, you or your network 
administrator should update the printer drivers on any Macintosh 
computers on your network that are nmning any system software 
version earlier than version 7.0. You do not have to update other 
components of the system software; version 7.0 printer drivers 
work with earlier versions of the system software. 

To update printer driver software, you use the Installer program 
and the accompanying Printer Update document (both files are on 
one of the system software disks that came with your computer). 

~ [jJ 
Inst.a ller Pr;nter Update 

You can store these files on a file server or a shared disk on the 
network and install the update from there. 

1. Locate the Installer and Printer Update fdes {supplied 
on one of the system software disks), and then open the 
Installer icon. 

A dialog box appears, showing the printer driver icons and 
explaining your installation options. 

continues ..,_ 
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2. Click OK. 

The Easy Install dialog box appears. 

Drivers lo be updated 

Ensy Install 

r·--~~·~k Install to update to Uerslon 7.0 of 

[_; ;~~;;~.~~~ :::~:g Soltwo~ 

( Help ] 

Disk on \\'hich drh·ers will be updated 

(I Install )J 

[ E )ec t Disk ] 

I Switch Disk ] 

I Customize J 

I Qu1t I 

·; 

3. Make sure that the hard disk indicated in the box is the 
one you want to update the printer drivers on. If a 
different disk name appears, click the Switch Disk 
button until the correct disk name appears. 
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4. If you want to install different printer drivers in 
addition to those already on your disk, click the 
Customize button, then click the names of the drivers 
you want to install. 

If you ·want to update only the drivers that are already installed 
on your disk, go to step 5. 

When you click Customize, the custom installation dialog box 
appears, showing a list of the printer drivers available. Press 
the Shift key while you click if you want to select more than 
one printer driver. 

Printer drivers ·1v·1ihble . ' ' ' 

Click the items you wont to select; 
~lft-click to select multiple items. 

Software for LoserWriter ~ 
Software for Personal LoserWriter SC 

[ lns1<Jll ) 
'-t-

o Hard disk #2 

~ 
[ EjtH:1 [li~I< I 
( Switch Disk ) 

··-··-·-··-···· ............................... 

(Easy Install) 

I Quit ) 



5. Click Install. 

6. Click Quit when you see a dialog box reporting that 
installation was successful. 

If a dialog box reports that installation was not successful, tty 
the update again. 

Printing your work 
The most common way to print a document is while it's open and 
while its window is the active window. You can also print 
documents while the Finder is the active program. 

1. Make sure that the document you want to print is in the 
active window. 

·:· If you're printing from the Finde1; click the icon of the 
document you want to print (or click several document icons 
while holding down the Shift key). ·:· 

2. Choose Print from the File menu, or press X-R 

A dialog box appears~ in which you can set printing options. 
The options vary depending on the printer you have chosen 
and the program in which the document was created. 

[fa LaserWriter printer is chosen in the Chooser, this dialog 
box appears: 

Paper-feed Number 
method of copies 

Page range (clicking All prints the entire 
document; entering page numbers in the 
From and To boxes prints those pages only) 

====I=========~===~==: (! Print ]J 
Copies: Pages: All O From: D To: D I Cancel J 

Couer Page: @ No O First Page O Last Page 

Paper Source:@ Paper Cassette O Manual Feed 

Print: @Black & White O Color/Grayscale 

Destination: ® Printer O Postscript® File 

·:· Printing color or gray-scale documents: You can print color or 
gray-scale documents on any color printer that can use the 
LaserWriter driver. If you print a color document on a printer 
that prints only in black and white, the document will be 
produced in a ha{ftone format; that is, it will be composed of 
patterns of dots. ·:· 

Some programs off er additional printing options, such as the 
order in which a document's pages are printed. See the 
manuals that came with your programs for more information 
on their printing features. 

3. Click the Print button in the upper-right corner. 

After a moment, a status box appears. If background printing is 
turned on in the Chooser, the status box disappears after a few· 
seconds, and you can do other work while printing continues. 
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Printing the contents of a window 

You can print the contents of the active window when you're 
working in the Finder. 

1. Make sure that the window whose contents you want to 
print is the active window. 

2. Choose Print Window from the File menu. 

A dialog box appears. 

3. Select the options you want. 

4. Click the Print button. 

The window's contents are printed in the format currently 
displayed, including items not visible on the screen. 

When no window is active, you can print the contents of the 
Macintosh desktop by choosing Print Desktop from the File menu. 
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If the printer doesn't print your document 

The Print command isn't reaching the printer, the printer is getting 
conflicting signals, or the printerisn't working properly. 

• Check that the printer is turned on and warmed up (if it's a 
LaserWriter, it should have printed a sample page). 

• Check the cable connections to the printer. 

• If your printer is an ImageWriter, make sure that the Select light 
is on. (Press the Select button to turn the light on.) A dialog 
box on the screen may inform you that the printer is not 
responding. 

• Check that the printer (and its name, if it's a LaserWriter) is 
selected in the Chooser. 

• Make sure that you are using the same version of the printer 
driver as all other people on your network. 

• If an error message states that the printer could not print your 
document, turn off the printer for at least 10 seconds, then turn 
it on again and wait for the printer to warm up before trying to 
print again. 



Printing while using the computer 
for other work 
You can use your Macintosh for other work while you're printing 
on a LaserWriter printer if the background printing option is 
turned on in the Chooser. (See "Choosing a Printer'' in this chapter 
for information about turning on background priming.) 

You can control background printing with PrintMonitor, a program 
that's installed automatically when you install system software 
using the Installer program's Easy Install option. 

1. After you have started printing a document, choose 
PrintMonitor from the Application menu. 

When background printing begins, Print.Monitor opens 
automatically and its name appears in the Application menu at 
the right end of the menu bar. 

When you choose its name from the Application menu, the 
PrintMonitor window appears. 

Name of the document being printed 
and printer currently in use 

I I} Read Me • Wettesley 
2 ~ B11nene Slug Lyrics " Wellesley 

-~-+--- Documents to be printed 
next (a selected item can 
be removed from the list) 

i------ Clicking this button lets 
~~~.,:u.i~....u:.11u.J.W.Lo1.111:;:~~~~~~::--1 you set the print time. 

Clicking this bunon cancels 
the current printing job. 

-+--Description and status 
of the current job 
appear here. 

continues ..,. 
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You can use PrintMonitor to 

• monitor the status of printing 

• cancel a document currently printing or waiting to print 

• set the time you want a document to print (date and hour) 
or postpone a job indefinitely 

• monitor paper supply (Print.\fonitor's icon blinks at the 
right end of the menu bar when the printer is out of paper; 
you can change the notification method with the program ·s 
Preferences command in the File menu.) 

• signal when to feed paper manually (Print.Monitor's icon 
blinks at the right end of the menu bar to signal that you 
must confirm the manual operation; you can change this 
notification with the program's Preferences command in the 
File menu.) 

2. Select the options you want, and then click the close 
box. 
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Working with fonts 
A font is a collection of letters, numbers, and symbols in a 
distinctive typographic design. 

When you install Macintosh system software, several fonts are 
installed in the System file, which is in the System Folder on your 
stanup disk. Ybu can install additional fonts and remove fonts. 

Additional fonts are supplied on one of the system software disks. 
Fonts are also available from independent manufacturers, user 
groups, and computer bulletin board services. 

Outline fonts and bitmapped fonts 

Ybur Macintosh uses two types of fonts: 

• outline fonts 

• bitmapped fonts 

Both types of fonts arc installed in the System file in the System 
Folder of your startup disk when you install system software. 



Outline fonrs (also called scalable or va riable-size fonts) describe 
each letter, number, or symbol as a marhemarical formula that 
defines the character's shape and adjusts itself to make the 
character's size larger or smaller. Your ~i!acintosh. therefore. need · 
only a single outline font in a parricular typeface (such as Times) 
to be able to print or display that typeface in different sizes. 

The outline fonts supplied \Yith .\lacintosh system soft\\·are arc 
called lh1eType fonts. 

~ 
CC1urier 

·:· \f/he11 yo11r.\Jaci11tosh is m1111i11g ~)'Siem 6. you cannot use 
lh1eType fonts supplied 'ivith System 7. ·:· 

13irmapped fonts (also called fixed-size ronts), on the other hand, 
describe each character as a grid or black and white clots (called a 
bit map), ""hich is a rendering of rhe character's shape in a specific 
size. 

Your Macimosh needs a separate bitmapped font or a typeface in 
each size it prints or displays. such as 12-point Times~ or 10-point 
Helretic1 ". 

rd] 
MonacCI 9 

An outline font character is like a cookie recipe that you can use to 
make as big or as small a hatch or cookies as you need. A 
bitmapped font character is like a cookie cutter: it gi\·es you one 
size- that's all. 

For information on how the system soft\\·are finds the fonts it 
needs. see "Gerring the Best-Looking Fon!. .. in Chapter 16. "Tips 
and Troubleshooting ... 
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Installing fonts 
To install a font: 

1. Quit all programs that are open. 

Pull down the Application menu to make sure that the Finder 
is the only open program. Choose any other open program 
from the Application menu and then choose Quit from the File 
menu. 

2. Locate the icon of the font you want to install and drag 
it to the System Folder icon (not the System Folder 
window) on your startup disk. 

You can click multiple font icons while holding down the Shift 
key to select more than one icon. 

A dialog box appears, letting you know that the fonts will be 
stored in the System file, where they belong. 

3. Click OK. 
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Removing fonts 
To remove a font: 

1. Open the System Folder on your startup disk. 

2. Locate the System file icon and open it 

3. Locate the icon of the font you want to remove and drag 
it out of the System window and out of the System 
Folder window. 

4. Close the System window and the System Folder 
window. 



'fransf en"ing fonts to a Laser\Vriter printer 

If you're using a LaserWriter printer that's equipped to handle 
PostScript® and you \Vant to print using Postscript outline fonts 
that are not built into your printer, you can transfer, or download, 
outline fonts from your System Folder to the printer. (Postscript is 
a programming language that describes the characters, symbols, 
and images appearing on each page of a document.) 
Downloading fonts saves you printing time if you plan to print a 
batch of documents that use those fonts. 

When you download a font, it's stored in the printer's memory or 
on a hard disk attached to the printer. You can download as many 
outline fonts as the printer's memory and hard disk space allow. 

You download a font using the LaserWriter Font Utility, which is 
supplied on the system software disks. 

1. Locate and open the LaserWriter Font Utility icon. 

Laser'w'riter Font Utility 

2. Choose Download Fonts from the File menu. 

A dialog box appears. 

["ownlood to 
®Printer j O f>rinh~r's dl~l<h) 

Fonts to download: 
Courier - ~ 
Courier-Bold 
Courler-BoldObllque 
Courier-Oblique 
Heluetlca 
Heluetlca-Bold -

~ 
.--{ Rdd ... J l nem<we I 

·-· ·-·-... ·--.. -··-·--· .. ·-·---·-----·-·------
I Cancel l [( Download )l 

Clickin this button dis la s a directo dialo1 g p y ry g 
box for locating and selecting additional fonts. 

Fonts currently 
available for 
downloading 

Clicking this bunon 
removes any fonts 
selected in the list. 

Clicking this button 
downloads all fonts 
listed to the printer. 

3. H the font you want to download is not listed, click the 
Add button to add fonts to the list 

A directory dialog box appears, which you use to locate the 
fonts you want. 

continues .._ 
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4. Click the name of the font you want, then click Add. 

You can press the Shift key while you click to select more than 
one font. 

la Condensed Garamond • l 
D Gma rnBol It a 
[) Garamlig 
[) Garamliglta 
Cl Gt Printer Fonts 
[) Gt Screen Fonts 

{} G:::>Hard disk 

( f:j<Ht J 

[ Desktop ) 

ll Add ~J 
[ Done ) 

5. When you've added all the fonts you want to download, 
click Done. 

The directory dialog box closes and the fonts you added are 
listed in the Font Utility dialog box. 

6. Click the Download button to send all the fonts in the 
list to the printer or its hard disk. 

A status box appears. You can click Cancel to stop the process. 

7. Click OK when the status box reports the results of 
downloading. 

8. Choose Quit from the File menu. 
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Finding out about available fonts 

.Most application programs have a Font menu that lists the fonts 
installed in your System file. though some programs do not list 
them all (you can open the System file icon, inside the System 
Folder. to see all the fonts stored there). 

The LaserWriter Font Utility program (supplied on the system 
software disks) provides three ways to see the fonts available for 
printing on a Laser\X'riter. 'tbu can display a list of fonts on the 
screen. print a catalog of fonts, or print a set of font samples. You 
choose the method you want from the LaserWriter Font Utility's 
File menu. 

Download Fonts... 3€D 
Display Ruailable Fonts... OOL 
lnHh~U~w Pr~nh~r$s m~k,,, 

Displays a window 
listing all fonts 
currenrlv available 10 

the printer 

Prints a list of the 
P Setup fonts available to age •.• 
Print Font Catalog... SCP the printer 
Print Font Samples ••• ------1-- Prints a sample of 

each font available 

Quit 3€Q to the printer 



Using the LaserWriter Font Utility 

While the Laser\Vriter Font Utility is most useful for transferring (or 
downloading) fonts from your System Folder to a Laser\X7riter 
printer and finding out about available fonts, you can also use the 
program to 

• initialize a hard disk attached to a printer 

• control whether a printer prints a sample page when you turn 
it on 

• restart a printer 

• send Postscript files to a printer 

The LaserWriter Font Utility program is supplied on the system 
software disks. 

Initializing a hard disk attached to a printer 

Some printers let you attach a hard disk so you can store fonts on 
it (in addition to the fonts stored in the printer's memory). See the 
manuals that came with your printer if you need information 
about connecting a hard disk. 

1. Open the LaserWriter Font Utility icon. 

2. Choose Initialize Printer's Disk from the File menu. 

A dialog box appears. 

3. Click the Drive button until the hard disk that's shown 
is the one you want to initialize. 

4. Click the Initialize button. 

Turning the printer's sample page on or off 

The LaserWriter prints a sample page each time it is turned on or 
restarted. 

1. Open the LaserWriter Font Utility icon. 

2. Choose Start Page Options from the Utilities menu. 

A dialog box appears. 

Printer start page: 

@On 
QOff 

( Cancel ) (~) 

3. Click the On or Off button. 

4. ClickOK. 
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Restarting a LaserWriter printer 

Restarting the printer clears its memory, removing the fonts stored 
there and making room for other fonts that you may want to 
transfer to the printer. 

1. Open the LaserWriter Font Utility icon. 

2. Choose Restart Printer from the Utilities menu. 

A dialog box appears. 

Are you sure you want to · 
restart your Postscript printer? 
Doing so will erase ell fonts In 
the printer's memory. 

n Cancel ll I Restart ] 

3. Click Restart. 

Transferring a PostScript file to a LaserWriter 

You can use the LaserWriter Font Utility to send a file in PostScript 
format to a LaserWriter. (Postscript is a programming language that 
describes the characters, symbols, and images in a file to be 
printed or displayed.) 

1. Open the LaserWriter Font Utility icon. 
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2. Choose Download PostScript File from the Utilities 
menu. 

A dialog box appears. 

3. Click the name of the file you want to download to the 
printer, and then click Open (or double-click the name). 

A second dialog box appears, asking you to name a file that 
saves a record of the PostScript activity. This file has the preset 
name "Postscript Log." 

r-=--,,,.....,......!::lc::>=Tra=u=e=I d=is=lc=""='-~ c::>Treuel disk 
CJ 7 .O be to droft g [ Eject ) 
CJ 7.0 figs 

.... ~-~-a_.;.T~-~;...;;;..;;.::;_;_~----L.::..11 ~ 
Soue Postscript output os: Cancel 

n seue n 

The name of a printing log, 
which records Postscript activity 

4. Type a name for the printing log, then click Save. 

The file is sent to the printer and a record of the PostScript 
activity is saved in the printing log. 

You can open the printing log to see the sequence of Postscript 
commands when the file was sent. 
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What you can do on the network 
You can do sereral rhings \\'ilh your .\ lacintosh once ir is 
connected 10 a net\\'ork: 

• Gain access ro informarion on ocher computers. 

Working at your O\Yn compurer, you can connl:ct to orher 
computers and gain access w files that are stored there. 

• Allmr access 10 information on your O\\'n computer. 

'\Du can designarc the contents of specific folders and hard disks 
on your computer as ··shared files·· that other people can gain 
access 10 m·er the nero·ork. 
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• Print documents on net\\'ork printers. 

\C>u can print documents on network printers a you ~roulcl on 
printers that are connected direct I~· w your computer. 

• I.ink programs to programs on other computers. 

You can link your programs 10 programs on other computers in 
order to share features between those programs. For example, you 
could link a \\'Ord-processing program to a dictionary program 10 

chl:ck the meaning and spelling of the \\"Ords in a clocumenl. 



• lpdate files orer the network automatically. 

'lou can automatically update documents created in programs that 
use the J\ lacinto ·h ·ystern soft,,·are·s publish-and-subscribe feature 
(sec the documentation that came ,,.ith your programs for 
information about th is feature). 

Setting up your Macintosh on a network 
Before you can use your .\lacintosh on a net\\·ork. you hare to 
physically connect your computer to the net\rnrk, install 
nerworking sofrware. make sure thar your computer can 
communicate with the nel\\urk, and identi~· your computer and 
yourself to others on the net,,·ork. 

If you ha,·e a network administraror. he or she may ha,·e already 
set up your .\Iacintosh on the nern·ork. Before you proceed, ask 
your network administrator whether these tasks hare been 
completed. 

Connecting to a nem·ork 

Your Macintosh has built-in Apple'falk networking soft\vare that 
allows your computer to connect to a net\York quickly and easily. 

If you·re using a LocalTalk' nef\\urk (a type of Apple'falk 
net\York). then all of the soft,rarc and harch\"are you need is 
already built into your Macintosh. You can connect your computer 
ro the network hy plugging LocalTalk-cornpatible cables into the 
back of your computer. (Sec the documentation that came with 
your cables if you need more information.) 

Prirni:r pon ~ ~- _ 

I - \. 
----12' 
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If you're using an Ethernet or a Token Ring network, your 
Macintosh needs both an EtherTalk® or a TokenTalk® expansion 
card installed in one of its expansion slots and the appropriate 
software to communicate with the network. (See the 
documentation that came with your expansion card if you need 
more information.) 

The EtherTalk and the TokenTalk software are provided on the 
system software disks that came with your computer. If a network 
expansion card was already installed in your computer when you 
installed system software, the software for it was installed 
automatically. If you installed the expansion card after you 
installed the system software, you need to install the network 
software separately (see "Installing a Customized System" in 
Chapter 8, "Setting Up Your Macintosh System"). 

Configuring your Macintosh for a network 

Before you can use the networking f ea tu res of your Macintosh, 
you ha~·e to take a few steps to prepare it. 
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Making sure AppleTalk is on 

The first tin1e you turn on your computer after you have 
connected it to a network, AppleTalk-your computer's built-in 
networking software-is turned on automatically. But if you have 
turned AppleTalk off-for example, to connect an ImageWriter 
printer to your printer port-you need to turn it back on again. 

1. Choose the Chooser from the Apple menu. 

AppleTelk Zones: 
Engineering 

Merkellng 
Production 
Publications 
Reseerch 

This list appears only if your 
network has zones. 

Select a file server: 
Artificial Intelligence 
Artiste 
Corner Pocket 
Generol Purpose 
Greg's Macintosh 
Kitty Morgolo's Macintosh 
Monterey 
Niles oovls's Noclntosh 
Sonom11 
Ventura 

~ 
®Active---+-- Applelalk 

AppleTelk 0 lnectlve n1USt be acti\•e 

for vour 
Macintosh 
to use a 
network. 

2. Click the Active button (in the lower-right corner of the 
Chooser) to turn on AppleTalk. 

3. Close the Chooser. 

AppleTalk remains on until you turn it off in the Chooser. 



Selecting a network connection 

If you're using a LocalTalk network, go to the next section, 
"Naming Your Macintosh and Its Owner." 

If you want to use an EtherTalk or a TokenTalk network 
connection type or switch between two or more types of network 
connections, you have to select which connection you want in the 
Network control panel. 

1. Choose Control Panels from the Apple menu and 
double-click the Network icon to open it. 

[U] 
Network 

·:· {{you can't find the Network control panel: The Network 
control panel, EtherTalk software, and TokenTalk software 
were installed only if you already had an EtherTalk or a 
TokenTalk expansion card in your computer when you 
installed the system software. If you have an expansion card 
installed now and no Network control panel appears in the 
Control Panels folder, use the Installer program to install 
EtherTalk or TokenTalk software. (See "Installing a Customized 
System" in Chapter 8.) ·:· 

2. Click the icon of the network connection you want to 
use. 

- Network -

II ~ 
- EU....T11k 

A dialog box warns you that you may be disconnected from 
any network services (such as printers or file servers) that you 
are using with your current network connection. This means 
that you must reconnect to the network services on the new 
netwurk. 

3. ClickOK. 

Next, you need to select the network zone your computer will 
use. 

co11ti11ues ..,_ 
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4. Double-click the icon of the network connection you 
chose in step 2. 

The default zone that's preselected hy 
vour network ·tdministrator ' 

Soles 6roupllf 
Plense select 
this computer's 

Finance AppleTalk zone. 
Product Support 

~ 

I OK ~ I concel l 

5. Click the name of the zone you want to use. 

Zones are set up by a network administrator and are used to 
distribute the devices on a network among groups for easier 
access. 

6. ClickOK. 

7. Close the Network control panel. 

fou can now use the network connection you selected. 

Naming your .Macintosh and its mvner 

Before you begin to use the network. you must give your 
Macintosh a name and name yourself as its owner. The name you 
give your Macintosh appears in the Chooser of other computers 
on the network so that people on the network can gain access to 
files on your computer. 
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1. Choose Control Panels from the Apple menu and 
double-click the Sharing Setup icon to open it. 

m 
Sharing Setup 

·:· {(you cc11i't.find or can't open the Sharing Setup icon: Make 
sure that the Sharing Setup icon is in the Control Panels folder, 
and that the File Sharing Extension file and the Network 
Extension file are in the Extensions folder inside the System 
Folder. Then restart your computer. ·:· 

l&l -- -- ---- Shoring_ Setup 5- --

(!g} Network Identity _ 

miili!ii!iii!iii!iiiiiiiiiiiiiiiiiil 1-- Type your name, 
Ovntr Pus..,ord: l••H•H• I I vour pass"·orc , 
Macintosh N~,,.: !Jon•lhon JoMS's H•olnlosh l 

and a name for 

OvntrN.omt: 

your Macintosh. LJ File Sharing 
r···Status ·-·-·-····· ............ _. __ ._, ______ , ___ ,_, ... _,_,,, __ ,_,,., ___ , ____ ····-" 

~ ! Flit sharinQ Is off. Click St..-t to •II•"' ou..r- UHrs ! 
L~~ ~~.!-.'~!.:~'-·~·-----------------------· __ , ______ : 

~ Progrom linking 
r-Status--------·-------------, 

~ ! Pro9nm linkln<j is off. Ctlok St-1 to •llov othor ! 
~ [ ~-!!.':! .. ~~-~~~ V°" s~td P.-09'"~--------__j 



2. Type a name in the box labeled Owner Name and press 
Tab. 

Type the name of the primary user of this computer-very 
likely, this is you. 

3. Type your password in the box labeled Owner Password 
and press Tab. 

Your password can be up to eight characters in length. Your 
password prevents others from gaining access to your files 
without your permission. After you type your password and 
press Tab, it is replaced by bullets ( •) to help keep your 
password private. 

4. Type a name for your Macintosh in the box labeled 
Macintosh Name. 

If a name already appears in the Macintosh Name box, you can 
use that name or type in a new one. 

5. Close the Sharing Setup control panel. 

Your computer is now ready to be used on a network. 

Gaining access to files 
on other computers 
When your computer is connected to a network, you can retrieve 
and store information on other computers, including a .file 
server-usually a computer on the network with special software 
that allows you to access it. store files on it, or retrieve files from it. 

Files on a file server are stored on shared disks-hard disks or 
CD-ROM discs that can be accessed over the network. Private 
.Macintosh computers (not file servers) on your network might also 
have shared disks if they are mnning system software version 7 
and if they are using file sharing-the ability to share infonnation 
on a private Macintosh. (See "Sharing Your Files Over the 
Network'' in this chapter.) 
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Before you begin 

Before you attempt to retrieve or store information on the 
network, do the following: 

• Find out the name of the shared disk you want to access 
and the name of the file server or private Macintosh that 
it's on. 

Ask your network administrator for the name of a file server; 
ask the owner of a private Macintosh for its name. 

• If your network has zones, fmd out the name of the 
zone the other computer is in. 

• Find out if you are registered on the computer or if it 
allows guest access. 

A Macintosh owner or network administrator can limit access 
to files on a shared disk. Ask the Macintosh owner or your 
network administrator how much access you have to the files. 

• If you're allowed access as a registered user, ask the 
Macintosh owner or your network administrator for 
your user name and your password. 

Find out exactly how your name and your password are 
spelled, including the use of capital and lowercase letters in 
your password. 

176 Chapter 13: Using Your Macintosh on a Network 

Connecting to a shared disk 
1. Choose the Chooser from the Apple menu. 

The Chooser opens. 

AppleShare File servers and other 
icon computers that have shared disks 

Chooser 

~ o l Select a file server: 
d., ,,.. I Art~ficial Intelligence 

App!.T•lk ... go'rfrit•r :ru I Artiste 
.:;;1 , Comer Pocket 

llfil 1$t. j~ j General Purpose 
~ Pa ;~: ; Greg's Macintosh 

l!:=1m=a=9•'rfr=i=t•r====Las=•r'vl=ri=ttr=1::=i I Kitty Margola's Meicintosh 
I Monterey 

,..,,.AP_Pl,_eT_el..,....k z_on_es_: ------ir-="I li Niles Deivis"s Macintosh 
Engineering -0 Sonomo 

roptncs I Ventura 
Merketlng 
Production 
Publiceitions 
Research 

I ________ ___. ....... 
I 00 l ·-------··-···-···--®·~-~;~-· .. -·······-·---

________ __.~-I) i AppJeTalk O lnect1ve 
7.0 

2. Make sure that AppleTalk is active. 

3. Click the AppleShare icon in the upper-left section of 
the Chooser window. 

•:• If the AppleShare icon does not appear· Make sure that the 
AppleShare file is in the Extensions folder in your System 
Folder. ·:· 



4. H your network has zones, click the zone in which the 
computer with the shared disk you want resides. 

If you do not see a box in your Chooser labeled AppleTalk 
Zones, skip this step. 

5. Click the name of the computer with the shared disk 
that you want to use. 

·:· If the name you want isn't listed: Make sure that you have 
selected the correct zone. If the zone is correct, ask your 
network administrator or the Macintosh owner if the computer 
is turned on. You cannot connect to a computer that's turned 
off. ·:· 

6. ClickOK. 

A dialog box appears for you to identify yourself as a 
registered user or guest. 

Connect to the file seruer 'Artiste• os: 

o Guest ----------tt--Click here if vou are 
® Registered user not registere~I on 
Nome: I Jonathon Jones the COnlpUter you're 
Password: [==:J (ScrombleCI) connecting tO. 

[ Cancel ] I set PossworCI ) H OK ]I 

7. Click Guest or Registered User. 

If you are a guest or if you are not certain that you are 
registered, dick Guest and go to step 10. If you are a registered 
user, click Registered User. 

If the Guest option is dimmed, guests are not permitted access 
to this computer. 

8. H you are a registered user, make sure your user name is 
displayed in the box exactly as it is registered. 

Any name that appears in the box is taken from the Owner 
Name in the Sharing Setup control panel on your computer. If 
that name is different from your registered user name on the 
computer you're connecting to (or if no name appears in the 
box), type your registered user name now. 

9. Type your password. 

Type your password exactly as it is registered. Capital and 
lowercase letters must match. 

·:· !/your password is not accepted: Make sure that you haven't 
made any typographical errors. Check that your Caps Lock key 
has not been pressed inadvertently. •:• 

continues Ill-
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10. Click OK. 

~ Rrtlste 

Select the Items you wont to use: -
I D~ 

Adam's Folder D 
Bollerplote D 
Richner llrt D~ 
Checked items ( 181 ) wlll be opened at -
system startup time. 

( Cancel ) (( OK l) 

Dimmed items arc not ~ffailable to vou or 
you're already connected to them. 

Shared disks 
and folders 

11. Select the shared disk you want to use by clicking its 
name. 

A dimmed name indicates either that you are already 
connected to that shared disk or that you don't have access to 

it. If a folder or disk you want does not appear, then you don't 
have access to it. 

178 Chapter 13: Csing \bur Macintosh on a \erwork 

12. Click OK. 

When you click OK, the dialog box closes and the icon of the 
shared disk appears on the right side of your desktop. 

~ 
Shared disk ioon 

13. Close the Chooser. 

Disconnecting from a shared disk 
When you're finished using a shared disk, you can disconnect 
from it in three ways (after you've closed any open files or 
programs on the shared disk): 

• Click to select the icon of the shared disk you want to 
disconnect from and choose Put Away from the File menu. 

• Drag the icon to the Trash. 

• If you are finished working for the day, choose Shut Down 
from the Special menu. Your computer is disconnected 
automatically when it is shut down. 



Using an alias to connect quickly to a shared disk 

You can connect to a shared disk quickly by using aliases. 

1. Connect to a shared disk. 

2. Click to select the shared disk icon. 

3. Choose Make Alias from the File menu. 

An alias icon appears that has the same name as the shared 
disk with the word alias appended to it. The name is selected 
for editing. 

4. If you wish, rename the alias, then drag it to a 
convenient place on your desktop or disk. 

5. The next time you want to connect to the shared disk, 
open the alias you created in step 3. 

If you originally connected to the shared disk as a registered 
user, a dialog box appears. Type your password. 

If you connected as a guest, this dialog box does not appear. 

The shared disk icon appears on your desktop. 

Connecting automatically when you start up 

You can set up your computer to connect automatically to shared 
disks whenever you turn it on. 

1. Connect to a computer with the shared disk you want. 

You see the dialog box containing a list of shared disks. 

2. Click the checkbox next to the name of a shared disk 
that you want to connect to automatically. 

~ 8tllfil 
Select the Items you want to use: 

Adam's Folder 
Boilerplate 
Richner Art 

Checked Items ( 181 ) wlll be opened at 
system startup time. 

® Saue My Name Only 
O Saue My Name and Password 

Cancel U OK 

co11ti1111es ..,.. 
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3. If you're connecting as a registered user, click the button 
that indicates whether you want the shared disk to save 
your name only or both your name and your password. 

If you select Save My Name Only, you'll have to type your 
password when you start up your computer. Click this option if 
you want to prevent unauthorized people from gaining access 
to the shared disk from your computer. 

If you click Save My Name and Password, your Macintosh will 
automatically connect to the shared disk when it starts up. 

4. Click OK. 

5. Close the Chooser. 
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Working with files and f alders 
on other computers 
Once you are connected to a shared disk, you can use the files 
and folders on it as you would the files and folders on your own 
computer. For example, you can 

• double-dick a folder on the shared disk to open it 

• copy a file to or from the shared disk by dragging the file icon 
to where you want the copy 

In some cases, you are not able to open certain items on a shared 
disk because the owner of the computer that has the shared disk 
has restricted access privileges to them. Access privileges 
determine whether you can see, open, or modify a file or a folder 
on a shared disk. To find out how to check your access privileges, 
see "Working With Privileges That Others Have Sef' in this 
chapter. 

Creating a new folder on another computer 

You can create a new folder on shared disks on other computers 
(as long as you have the necessary access privileges). If you are 
connected to a computer as a registered user, you become the 
owner of any folder that you create on that computer. If you are 
connected as a guest, you share ownership of a folder you create 
with all guests and registered users. To learn about the access 
privileges you need to create a folder, see "Understanding Access 
Privileges" in this chapter. 



The icons of folders that you own have a darkened tab. 

When you own a folder, you can set its access privileges to 
determine who can use it and in what way. See "Using Access 
Privileges" in this chapter for more information. 

Changing your password 

1. Connect to the computer with the shared disk you want. 

A dialog box appears in which you identify yourself as a 
registered user or guest. 

Connect to the file seruer "Artiste• as: 

QGuest 
® Registered User 

Name: I Jonathon Jones 

Password: c==J (Scrambled) 

1
.-------++--Click here to change 

your password. 
[ Cancel J (Set Password] H OK 

2. Click the Set Password button. 

A dialog box appears. 

If a warning box tells you that you cannot change your 
password, your network administrator has prevented you from 
being able to do so. 

Old password: 

New possword: I.__ _ __. 
[( OK U 

3. Type your current password. Then press Tab and type a 
new password. 

A bullet ( •) appears for each letter you type. Use a password 
that will not be easily guessed by someone else. 

4. Click OK. 

A dialog box asks you to retype your new password to verify it. 
Click OK. 

5. Retype your password and click OK. 

Your new password is now in effect. 
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Giving folder ownership to someone else 

You can give away the ownership of any folder that you own. 
Once you do so, the new owner controls access to the folder and 
can restrict your access to it. Make sure that you have moved any 
files you may need to another folder that you mm before you give 
up mvnership. 

fou can only give folder ownership to a registered user or 
rep,istered group on the computer to which you're connected. (See 
"Naming the People Who'll Have Access to Shared Files'' in this 
chapter for more information about registered users and registered 
groups.) 

1. Connect to a shared disk. 

2. Click to select a folder that you own. 

3. Choose Sharing from the File menu. 

4. In the box labeled Owner, type the name of the 
registered user or group that you want to give folder 
ownership to. 

Type the name exactly as your network administrator or the 
Macintosh owner has registered it. 

5. Close the dialog box. 

Another dialog box asks you to confirm that you \Yant to 
change the owner of the folder. 
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6. ClickOK. 

The user or group that you named assumes ownership 
immediately. 

Sharing your files over the network 
You can let other people on the network gain access to files stored 
on your Macintosh. For example, if you've \Vritten a report that 
you'd like people in your work group to read, you can let them 
connect to your computer and open the file from their own 
computers. 

Ybu can always control what infonnation you share and whom 
you share it with: 

• You can share as much or as little as you like. 

• You can specif)' who can use the information on your 
computer-one person, a group of people. or everyone on the 
network. 

• You can gain access to everything on your own computer from 
another computer on the network. 



How file sharing works 

Sharing files on your computer consists of a f e\\' discrete steps that 
allow you to control exactly how you want to share information 
on your computer. This section provides an overview of these 
steps. For detailed instmctions, continue on to subsequent 
sections. 

• First, you turn on the file-sharing capability of your Macintosh. 

• Second, you allmv others to gain access to the files in 
designated folders or disks (you "share" those files). 

Anyone on the network can gain access to the folders and 
disks you've shared. If you want to share certain files with only 
certain people, you continue with the following steps: 

• Third, you name the people (the registered users) whom you'll 
allow to gain access to shared files on your computer. 

• Fourth, for each shared folder or disk, you pick from your list 
of registered users the people whom you want to have access 
to the folder or disk. 

• Fifth, you prevent anyone else from being able to gain access 
to the shared folder or disk. 

Turning file sharing on 

Before you turn file sharing on, make sure that you have named 
your Macintosh as described in ''Naming Your Macintosh and Its 
Owner" earlier in this chapter. 

1. Choose Control Panels from the Apple menu and 
double-click the Sharing Setup icon to open it. 

m 
Sharing Setup 

The Sharing Setup control panel opens. 

ill __ ,_g Sharln_g_ Setup '35¥¥- -

~ Network Identity 

OwnH"N.arM: ~~-~~~~~ 
0-.rMr Pau.,.ord: 1-•M• I 
~1ntoshHorM:! ~Jo<>o-lhon-~-s-·s MK-intQ_sh ___ _, 

LJ Fiie sria,,..n_ng ________ __.~ Click here to 

start [~f,~;~~-;~_;;~;;~~~::.·:~:~~=:i_:~--~::~:] start file sharing. 

~ Program Linking 

~-Sb1us-- -- - .. ------------·----------------·-, 
~ ! Pr09"¥n Hnkir19 u off. Click s1.,.1 to •llow othtr j 
~ ~~_!_to__l~-t~~~-~tdpr':!an-.s. _,, _____ _j 

co11ti1111es ..,.. 
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2. In the section labeled File Sharing, click the Start button. 

When file sharing is turned on, the button is labeled Stop. 

3. Close the Sharing Setup control panel and the Control 
Panels folder. 

File sharing is now turned on. You still need to select a specific 
folder or disk to share over the network. 

Selecting a folder or disk to share 

You can share any folder or disk on your computer-including 
hard disks and CD-ROM discs (but not floppy disks). You can 
share up to ten folders or disks at one time. (This number does not 
include the folders that are within the folders or disks that you 
share.) 

1. Make sure ftle sharing is turned on. 

2. Select a folder, hard disk, or CD-ROM disc to share by 
clicking its icon. 
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3. Choose Sharing from the File menu. 

A window appears. 

!fl I . "-¥For All ~es 

Jon•thon .......... Hocintosh: 

Shor• this ltom nl Its contonts 

s.. s.. ~ 
Foldft's rnu ~ 

o ....... :r~--~ !8i ~ i.8l 
Us.,./Oraup: [-;.;:;:.;·------., !8j i8l i.8] 

[Yft"V- !.8i i8l l8l 
[l Mok• •11 ourrt11tlr,j t110lond foldtrs lik• this ont 

0 C•n't i.. movod, r..,wnod or ct.i.t..i 

Click here to share the 
item you've selected. 

4. Click the box labeled "Share this item and its contents" 
to place an X in it. 

To find out more about the access privileges checkboxes-the 
ones in the columns labeled See Folders, See Files, and Make 
Changes-see "Using Access Privileges" later in this chapter. 

5. Close the window and click Save in the dialog box to 
save your changes. 

The folder or disk you shared is now considered a shared 
folder or shared disk. Anyone on the network can gain access 
to it-and the files and folders inside it-over the network. 



If you shared a folder, its icon appears on your desktop with a 
darkened tab and network cables connected to it. 

LJ 
:~: 

6. Drag any ftles and folders that you want to make 
available to the network into your new shared folder or 
disk. 

The files and folders that you place in the shared folder or disk 
become available to the users who connect to your computer. 

When people on your network are connected to a shared 
folder, the icon of the folder on your desktop appears with 
faces in the center to indicate that it is in use. 

(Qi] 
:~: 

~ Important: Copyright laws apply to sharing programs over a 
network as well as to copying programs from a floppy disk. 
Before you put programs inside shared folders or disks, check 
with any applicable licensing agreements and follow their 
specifications. ~ 

Making a shared folder or disk private 

To make a shared folder or disk private again, click to select the 
shared disk icon, choose Sharing from the file menu, and click the 
"Share this item and its contents'' checkbox to remove the X. After 
you close the window, the folder or disk and any files or folders 
inside it cannot be accessed from the network. 

Naming the people who'll have access to shared files 

You can share a folder or disk only with specific people on the 
network. To do so, you first have to name those people as 
registered users or as belonging to a registered group, and then 
you have to designate a shared folder or disk as being accessible 
to a specific registered user or registered group. 

Naming a registered user 

You can register as many as 100 users and groups of users 
combined, but the network's performance may suffer if you name 
more than 50. 

1. Choose Control Panels from the Apple menu and 
double-click the Users & Groups icon to open it. 

E 
Users&Groups 

COlllilllteS IJlll. 
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The Users and Groups control panel appears. It contains at 
least t\vo icons. One (outlined in bold) represents you as the 
owner and primary user of your Macintosh. 

The other icon is the <Guest> icon. You use this icon to allow 
or disallow guest" to gain access to the shared files on your 
computer. (Guest access is automatically allowed when you 
first turn on file sharing.) 

ID~ Users & Groups ~!:!II 
2 !ltms 

D 0 
~ 

Jon•thon JoMs <Ou.st> 

~ 
l¢T 10!121 

fou tv e this name in rhe .P 
Sharing Setup control panel. 

·:· flyou don't see the bold icou: You haven't named your 
Macintosh and named yourself as its owner. See "Naming Your 
Macintosh and Its O\\rner" earlier in this chapter for 
instructions. ·:· 

2. Choose New User from the File menu. 

An icon labeled New l;ser appears. Its name is selected for 
editing. 

·:· {/'you can't.find the Nell' U\er comma11d. click anywhere in the 
Users & Groups control panel to make it active. ·:· 
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3. Type the name of a person on the network whom you 
want to make a registered user of your computer. 

Make sure that you tell the person exactly how you registered 
him or her as a user. 

Users & Groups ~~ - P!I 

D D 
Jon•thon JoMs <O...st> 

As a registered user. that person has access to any folders or 
disks you decide to share. 

4. To register more users, repeat steps 2 and 3. 

To give your users pass\vords or to name groups of users, continue 
with the next two sections. If you want to start sharing folders or 
disks \Vith your users immediately, go to "Selecting a User or 
Group to Share a Folder or Disk'' in this chapter. 



Setting a user's password 

You can assign passwords for your registered users to help verify 
their identities when they want to gain access to your computer. 

1. Open a user icon in the Users & Groups control panel. 

A window with the name of the user appears. 

The user's name 

Unr P .. ssword: '------=,.,---Type a password 

0 File Shoring 
'~' 181 Allo"' unr to conn.ct 

181 Allo"' uur to chong. pus'Word 

~ Program Linking 

0 Allo'W usor to link to progrMns 
on till> Macintosh 

for this user here. 

2. Type a password in the box labeled User Password, then 
press the Tab key. 

The password can be up to eight characters long. When you 
finish typing the password and press Tab, each character of the 
password is replaced by a bullet to help keep that password 
private. 

3. Close the window and click Save in the dialog box that 
appears. 

Naming a group of users 

You can name a group of registered users as a registered group 
and share a folder or disk with the members of that group. 

1. Open the Users & Groups control panel and choose New 
Group from the File menu. 

An icon labeled New Group appears. The name is selected for 
editing. 

ID - Users & Groups 
9ittms 

[] 
JONt!lon Jones 

0 
Nilts Davis 

0 
Ell•n Fltz'W attr 

0 
<Gwst> 

0 
BtUo,i ~rtitr 

0 
Sttvtro Mortland 

0 
Keith Garretti ---Drag the icons of 

0. the users vou want 
in the gro~1p to the Bill Evens 
group icon. 

co11/i1111es ._ 
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2. Type a name for the group. 

3. Drag the user icon of each person that you want to be a 
member of the group to the new group icon. 

You don't need to drag your Macintosh owner icon to d1e 
group icon because you always have access to the entire 
contents of your computer (unless you specify othe1wise). 
Also, you don't need to include the <Guest> icon in any group. 

Tb allow this group of people to gain access to a shared folder 
or disk, go to the section "Selecting a User or Group to Share a 
Folder or Disk. " 
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Seeing who's in a group 

• To see the names of the members of the group, open the 
group icon. 

A window opens and shows a member icon for every user that 
you added to the group. 

The group's name 

l 
ID Testing Team 0 1 

3 ittms: 

~ ~ lrm 
~ 

Group members 
Ellffl Fitz:w.at•.- e.tt~ C..-tfor ffiltt D.avfs: 

tzy 
<5T ~ 121 

You can open any user's member icon if you want to see or 
change the settings you've made for that user. 



• To see the names of all of the groups that a user belongs 
to, open the user's member icon or user icon. 

You can double-click either the member icon that appears in 
the group window or the original user icon that appears in the 
Users & Groups control panel. A window opens and displays a 
list of all the groups that the user belongs to. 

LJ Fiie Shllrlng 
.~ 

18JAl1owuurto~I 
181 ATiow ustr lo~ purwonl 

~ Program Linking 

0 Allo"' usor lo link lo ~ams 
on this M1oinlosh 

Selecting a user or group to share a folder or disk 

You can give one registered user or group exclusive access to a 
shared folder or disk on your computer. Make sure that file 
sharing is turned on and that you have named the registered user 
or group as described in "Naming the People Who'll Have Access 
to Shared Files" earlier in this chapter. 

1. Select a folder, hard disk, or CD-ROM disc to share with 
a user or group by clicking its icon. 

2. Choose Sharing from the File menu. 

A dialog box appears. 

3. Click the box labeled "Share this item and its contents" 
so an X appears. 

continues ~ 
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4. Choose a user or a group from the User/Group pop-up 
menu. 

iDf'""'- - - for Rll ~es -· -, m-

~th«IJolltt's~i'ltom­

For./lllE~os 

~ Shir. tt'.i-.s: it.m and its contitnts 

Stt Stt M>l:t 
Foldtrs Fli.s Chang .. 

Ownor: ,.....,! J<>na--,.-tho-n Jontc---s --.. I 181 181 l8J 
UHr/Group: • <Hono> l[fl 181 181 

-1;.-1~-r;~------lctJ 181 0 
---1 Cr-jael<T .. m1-t-----

g :: : : ;: ~;~----~' ... •-'hi_•-----+-- The registered users 
c11onF11.. ...... 1.. and groups you're named 
:<'::'=.~ on your computer 
NiluD••is 
Stov.,.Mortlond 

The Cser/Group pop-up menu contains the names of the users 
and groups that you registered. The name you choose is 
displayed when you are done. 
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5. To share this folder or disk with 011ly the user or group 
that you've chosen, click the bottom row of checkboxes 
(to the right of Everyone) to remove the X from each 
box. 

Only you and the user or group you've chosen now have 
access to this folder or disk. For more information about access 
privileges and strategies to use them, see ·'Using Access 
Privileges" later in this chapter. 

irn ---~,%fl For Rll E es - -

CJYMr•: 
,~. 

Jon•lhon Jonts's Hac1nlosh · 
For All E~tt 

181 Sh.,.• this lttm olld Us eontonts 

Stt s.. M•kt 
Foldors FiJ.s Ch~s 

ow .. •r: .-I ~-tho-n J-on.-s --.. I 181 181 181 
Us.,-./Group: I Bl11 Enns •I 12$1 181 12$1 

c • ....,.... D D D 
0 ~•II e..-ront~ onclostd foldtn likt this.,.. 

0 Con't bt movtd, r...- or dtt.ttd 

6. Close the window and click Save in the dialog box that 
appears. 



Preventing a user or guests from accessing your computer 

You can prevent a specific user from connecting to your computer, 
or you can prevent any guests from connecting. 

1. Choose Control Panels from the Apple menu and 
double-click the Users & Groups icon to open it. 

E 
Users & Groups 

2. To deny access to a specific user, open the user icon. To 
deny access to guests, open the <Guest> icon. 

The user's name 

U-Password: ~ 

LJ File Sharing 
,;Q::;:;, 

Allow ustr to conn.ct 
181 Allow U"1' to cew.g. password 

0 AlloY ustr to link to pr.., oms 
on thts M•cintosh 

To denv access to this user. 
remove the x in this box 
by clicking it. 

l<> deny access to guests. 
remove the X in this box 
by dicking it. 

:!_D <Guest> ~EJB 

Q ~ le Sharing 

~Allow psts to COMtet 

~ Program Linking 

0 Allow psis to ltiilc to prognms 
on thts Mocintosh 

3. To deny access to a user, click the box labeled '~ow 
user to connect" to remove the X. To deny access to all 
guest users, click the box labeled "Allow guests to 
connect" to remove the X. 

4. Close the window and click Save in the dialog box that 
appears. 

If you denied access to a specific user, that user can no longer 
access your computer from the network as a registered user. In 
addition, that user is no longer a member of any groups. If the 
user is currently connected, he or she is disconnected 
immediately. If your Macintosh is set up to allow guest access, 
that user can still connect as a guest. 

If you denied access to guests. any guests currently connected 
are disconnected immediately. 

Removing a user's membership in a group 

1. In the Users & Groups control panel, open the group 
icon that the user belongs to. 

2. Drag the member icon for that user to the 'frash. 

3. Select Empty 'frash from the Special menu. 

The user is no longer a member of that group. 
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Removing a user or group from your list of registered users 

You can remove a registered user or group at any time. When you 
remove a user, that user's membership in any registered groups on 
your computer will be removed. 

1. Double-click the Users & Groups icon to open it. 

2. Drag the user or group icon to the 'frash. 

3. Select Empty Trash from the Special menu. 

You cannot throw away the <Guest> icon or the owner icon. To 
prevent guest access, see "Preventing a User or Guests From 
Accessing Your Computer" earlier in this chapter. 

Giving away ownership of a folder 
or disk on your computer 

You can give away ownership of a shared folder or disk on your 
Macintosh to another registered user or a registered group. 
Because you are the owner of your Macintosh, a new owner of a 
folder on your computer cannot restrict your access to it. 
However, the new owner can change the access privileges that 
other people have to the folder or disk. If you give away 
ownership of a folder or disk, make sure that you move any 
important folders or documents out of it first so that no one else 
can see or alter those documents. 
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1. Click to select the icon of a shared folder or disk. 

2. Choose Sharing from the File menu. 

3. Choose the name of a registered user, group, or 
<Any User> in the Owner pop-up menu. 

If you select <Any User>, then anyone on the network can 
change the access privileges of the folder or disk or choose a 
new owner. 

If' For RU ~es 

!dvtwr•: JoNthon Jonff's Macintosh: 
For AnEvu 

181 Shv• this ttm wt its conltnts 

s.. S.• M•k• 
Folders FiJ.s Chan9H 
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t------
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4. Close the window and click Save in the dialog box that 
appears. 

5. Click OK again to confirm that you want to change 
ownership. 



Turning file sharing off 

You can turn off the file-sharing capability of your Macintosh at 
any time. When file sharing is off, people on the network cannot 
access any folders or disks on your computer, and you cannot 
access your computer from another computer on the network. 

If you turn file sharing back on, all of the shared folders or disks 
will again be available to people on the network. 

1. Choose Control Panels from the Apple menu and open 
the Sharing Setup control panel. 

m 
Sharing Setup 

2. In the section labeled File Sharing, click the Stop button. 

If users are currently connected to your computer, a dialog box 
appears in which you can specify a delay before file sharing is 
turned off. This gives current users some time to save their 
work and to disconnect from your computer. 

How meny minutes until file 
shering Is dlsebled? 

Ill 
[.---ce-nc-el- e=.ll ====oK~H 

3. Type the number of minutes you want to elapse before 
me sharing is turned off. 

To disconnect users immediately, type the number 0. 
Otherwise, type the number of minutes to elapse before the 
users are disconnected. 

4. ClickOK. 

File sharing is turned off after the amount of time you specify 
elapses. Users who are currently connected receive warning 
messages so they can save their work. If someone is using files on 
your Macintosh when file sharing is turned off, any changes he or 
she has made and has not saved will be lost. 
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Monitoring file-sharing activity 

When file sharing is on, you can see who is connected to your 
c0mputer and what folders or disks you've shared. 

• Choose Control Panels from the Apple menu and open the File 
Sharing Monitor control panel. 

m 
Fil~ Sharing Monitor 

The File Sharing Monitor control panel opens. 

Folders and disks currenth· 
being shared are lisced here. 

Users currenrly connecced co 
your computer are listed here. 

PA Fiie Sherln Monitor ___ , __ ·-

!:d Shared Items QJ Connecte 
a <ll<lfft> 
0 NiJ.sC>•vis To disconnecc a 

user. click his or 
her name and 

Fiie Sharing Rctlutty: 
oisconnl'ct 1----+---chen click here. 

!di. au..., 
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A list of your shared folders and disks appears on the left side of 
the window. All of the files and folders listed are accessible to 
network users, unless you have restricted their access privileges. 

A scrolling list of all the network users cmTently connected to your 
~Iacintosh appears on the right side of the window. 

Disconnecting someone who is connected to your computer 

You can disconnect users who are currently connected to your 
Macintosh in the File Sharing Monitor control panel. 

1. Select the user or users that you want to disconnect. 

To select more than one user, hold down the Shift key while 
clicking the names of all the users you \Vant to disconnect. 

2. Click Disconnect. 

A dialog box appears. 

How meny minutes until selected 
users are disconnected? 

-cence1 ] &'n """"'oK=~JI 



3. Type the number of minutes that you want to elapse 
before disconnection occurs. 

To disconnect a user immediately, type the number 0. 
Otherwise, type the number of minutes to elapse before the 
user is disconnected. It's a good idea to give people enough 
time to save any changes they have made to the files. 

4. Click OK. 

If you typed a number greater than 0 in step 3, a box displays 
how much time will elapse before the user is disconnected. 
The warning box disappears "'hen the user is disconnected. 
YOu can continue with your work in the meantime. 

5. When the designated amount of time has elapsed, close 
the File Sharing Monitor. 

You can't close the File Sharing Monitor until the amount of 
time you specified has elapsed and the user is disconnected. 
However, you can open other ·windows and continue with 
your work during that time. 

Gaining access to your computer 
when you're away from it 

You can connect to your own Macintosh from another computer 
on the network and access everything on all of the hard disks or 
CD-RO.M discs attached to your computer. As the owner of your 
computer, only you have this privilege. 

1. Make sure that ftle sharing is turned on. 

2. Choose Control Panels from the Apple menu and 
double-click the Users & Groups icon to open it 

E 
Users & Groups 

3. Open the owner icon (the one with the bold outline). 

[O~Jonathon Jones~ 

LJ Fiie Shoring 
,~.~ 

Allo"' UStr to COM<el 

l'8J Allo"' ustr to eMn9o passvord 

~Allow ustr to '" onllr• disk 

Gr0<.9s: 

I c 
~ Program linking 

0 Allow us..- lo llflk b progr¥1\S 
on this M~W\tosh 

\X'ilh an X in this box, you can 
connect to your computer 
from another computer. 

\X:ich an X in this box. 
you can sec crerything 
chat's on your computer. 

co11li11ues .,... 
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4. Click the boxes labeled "Allow user to connect" and 
"Allow user to see entire disk" to place an X in them if 
there isn't one there already. 

When these boxes are checked, you can see and use 
everything on your hard disks or CD-ROM discs from another 
computer. 

To restrict the access you have from another computer, click a 
checkbox to remove the X. 

5. Close the window and the Users & Groups control 
panel 

6. Leave your computer turned on. 

To gain access to your computer from another computer, connect 
to it as a registered user. Type your owner name and password (as 
they appear in the Sharing Setup control panel of your computer). 
Then continue the connection process as you normally would. 

·:· Ifyou are unable to connect to your compute1:· Make sure that 
your computer is turned on, that file sharing is turned on, and 
that you have given yourself access privileges to connect to 
your computer. Also make sure that you type your password 
exactly as it is entered in the Sharing Setup control panel, 
including the use of capital and lowercase letters. ·:· 
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Changing your password 

You can change the password you use to gain access to your own 
computer from another computer. 

1. Choose Control Panels from the Apple menu and open 
the Sharing Setup control panel. 

m 
Sharing Setup 

Sharln Setup 

[!gl Network Identity 

OwnorNomo: 

Owntr Password:~·•:::::•••=":::• =-----------, 
Macintosh r11mt: IJorwthon Jonfl's Macintosh 

LJ Fiie Sharing 
,..-.Sh1tas-··· 1 

~ ! Flit sllarinc,J ts off. Cltctc Start to allow olhtr users!·· 
~ Lt• ~·!_shared toldors. , 

Type your new 
password here. 



2. Type a new password in the box labeled Owner 
Password. 

3. Press Tab. 

Each character of your password is replaced by a bullet ( •) to 
help keep it private. 

4. Close the Sharing Setup control panel 

Your new password is now in effect. 

Using access privileges 
When people share information over a network, network users 
may want to control what other people can do with that 
information. For example, you might want to let people see a file 
but prevent them from changing it. This section describes how to 
use and work with access privileges-the abilities to see files and 
folders and make changes to them. 

Before you proceed with this section, make sure you know how 
to share a folder on your own computer as described in "Sharing 
Your Files Over the Network" earlier in this chapter, or that you 
know how to connect to a shared disk on another computer as 
described in "Gaining Access to Files on Other Computers'' in this 
chapter. 

Understanding access privileges 

You can set access privileges for any shared folders on your own 
computer and any folders you create on a file server or on another 
Macintosh. In addition, owners of other computers can set access 
privileges that restrict what you can do with their shared disks. 

There are three categories of people who can have access 
privileges to shared disks and folders: 

• 17ze ow1ie1: The owner of a folder is the only person (or group) 
who can control the access privileges of the folder. You 
become the owner of a folder automatically when you create 
it. You can keep ownership, or give it to a registered user or 
registered group on the computer. You can also give 
ownership to <Any User>, which allows anyone on the 
network, including guests, to modify the folder's access 
privileges. 

• A registered user or group. 

• Eve1yone. Privileges assigned to guests apply to everyone, 
since everyone can connect to a computer as a guest (as long 
as guest access is allowed). 
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Owners, registered users~ and guests can be giYen three types of 
access to shared disks and folders: 

• See folders allows people to see the folders within a folder or 
disk. If people do not have the See Folders privilege, folders 
within a shared folder do not appear on their screen. 

• See Files allmvs people to see the files \Yithin a folder or disk. If 
people do not have the See Files priYilege. files within the 
folder or disk do not appear on their screen. 

• Make Changes allows people to make changes to a folder or 
disk-copy files or folders to it, delete files or folders, or 
change any of its contents. 

You need different access privileges to do certain operations with 
items in a shared folder or disk. 
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Action See Folders 

Copy or move files to folder D 
Copy a file from folder D 
Copy a folder from folder [8] 

Creare a folder in folder [8] 

Delere a file from folder D 
Delete a folder from folder [8] 

Open and use a file in folder D 
Sare changes to a file in folder D 

See Files Make Changes 

D [8] 

[8] D 
D D 
D [8] 

[8] [81 

D [81 

[8] D 
[81 [8] 



Setting access privileges to folders and disks 

You can set access privileges for any shared folders or disks on 
your own computer and for any folders that you own on other 
computers. 

1. Select the folder or disk by clicking it once. 

2. Choose Sharing from the File menu. 

A window appears. 

iO I For All Eyes &" ¥£ 
Jonathon Jonff's Macrintcsll: 
Fer AU£¥H 

[81 Shan this item ond tts conttnts 

See S.t Makt 
Foldtrs Filts Cha119ts 

OwMr: I JOl\athon ..-. "' I 18] [81 @1 
rc>1t-t-- Use these 

Us.,./llroap: I <Hont> •I 181 181 IQI 

[Vfr¥- 181 181 ~ checkboxes to set 
access pri\'ileges. 

This window may be slightly different on your computer. 

• If you've selected a folder that is inside a shared folder, the 
checkbox labeled .. Share this item and it'i content'i" does not 
appear. Instead, a checkbox labeled ··same as enclosing 
folder" appears. 

• If you've selected a folder on another computer. the area next 
to the Owner and User/Group labels \Viii be boxes, in which 
you type text, and not pop-up menus. 

• If you've selected a folder on another computer and you are 
not its mvner. all of the checkboxes and their labels are 
dimmed. 

3. Choose a registered user or group to share the item 
with. 

If the folder you've selected is on your own computer, choose 
from the list of users and groups in the pop-up menu next to 
the label Cser/Group. This menu contains the names of the 
registered users and groups on your computer. 

If the folder you "ve selected is on another computer, type the 
name of a registered user or group in the box next to the label 
l1ser/Group. You must type the name exactly as it is registered 
on the computer you're connected to. 

c0111i1111es ..._ 
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4. To give access privileges to yourself, to a registered user, 
or to everyone, click the appropriate checkbox to place 
anXin it 

• To set privileges for the folders within this folder or disk, 
place an X in the box labeled "Make all currently enclosed 
folders like this one." When you place an X in this box, the 
access privileges for the folders inside this folder or disk are 
the same as this folder or disk's access privileges. You can 
change the access privileges for an enclosing folder at any 
time. 

If you use this f ea tu re for an item that contains a large 
number of folders, such as a CD-ROM disc, this action 
could take a few minutes to complete. 

• To prevent anyone on the network-including yourself­
from moving, deleting, or renaming this folder, place an X 
in the box labeled "Can't be removed, renamed, or 
deleted." You can use this checkbox to ensure that a folder 
stays where you leave it. 

• To give this folder the same privileges as the folder or disk 
enclosing it, place an X in the checkbox labeled "Same as 
enclosing folder." This checkbox only appears for folders 
that are inside shared folders. When you move a folder that 
has this box checked to another folder, its access privileges 
change to reflect those of its new enclosing folder. 
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5. When you're finished setting access privileges, close the 
Sharing window and then click Save in the dialog box 
that appears. 

The access privileges go into effect immediately. 

Access privilege strategies 

You can combine access privilege settings in any way you like. 
Some useful configurations follow. 

• Allow everyone on the network all access privileges. 

When guest access is allowed on the computer storing a 
shared folder or disk, eveiyone on the network can open, read, 
and change the files and folders inside it. 

SH Stt Make 
FilH Folders ~nges 

Owner 181 181 181 
Ustr/Group 181 181 181 

Evtr\lont 181 181 181 



• Keep a folder or disk private. To keep a folder or disk on 
your own computer private, do not share rhe folder. 'lb keep a 
folder that you own on another computer private. use these 
sertings. You have full access but no one else can open, use, or 
even see its contents. 

See See Mah 
Folders Files Changes 

Owner 181 181 181 
User/Group D D D 

Everyone D D D 

• Allow access by one other person or group. This set of 
privileges allows only you-the owner of rhe folder or 
disk-and rhe registered user or group that you have named to 
gain access to a shared folder or disk. 

See See Make 
Folders Files Changes 

Owner 181 181 181 
User/Group 181 181 181 

Everyone D D D 

• Keep a folder private but allow others to place ftles or 
folders in it. People on the network can deposit files or 
folders into a folder bur cannot see, remove, or change its 
contents. (This configuration is sometimes called a drop box.) 

See See Make 
Folders · Files Changes 

Owner 181 181 181 
User/Group D D 181 

Everyone D D 181 

• Set up a folder as a bulletin board. People can open and 
read the files in a folder but cannot change them. 

See See Make 
Folders Files Changes 

Owner 181 181 181 
User/Group 181 181 D 

Everyone 181 181 D 
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Working with privileges that others have set 

When you are using the 13y Icon or 13y Small Icon view, the 
appearance of shared folders changes to indicate the kinds or 
access you have to that folde r. 

Icon Meaning 

.. -... 

LJ 

tiJ 
LiJ 

A darkened tab indicates that )'Oll arc the owner of the folder 
and you can set its access privileges. Shared folders on your 
own computer have rhis da rkened tab. Folders that you O\\·n 
on other computers also h;l\·e the darkened tab. 

A plain tab indicates that you can opcn and use rhe folder. 
Folders on your own computer have a pl<i in tab when they 
have not been shared. Folders on other computers that have 
this icon indicate that you do have some pri1,ileges to the 
folders. although you are not thcir o\\'ner. 

A folder ,,·ith a strap around it indicates that you do not hare 
any access privileges to this folder. This icon does not appear 
on vour own computer. 

A strapped folder with an arroll' indicates that you can put riles 
or folders into this folder. but you cannot open it or use any 
files or folders \\'ithin it. This icon docs not appear on your 
mrn computer. 
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Checking your access privileges 

When you open a folder on another computer on the network, 
icons arc clisplayecl under the title bar of the folder window that 
indicate the pri\·i leges that you do 1101 have to the folder. 

D 
.fl 

!Ou can't 
make changes. 

=o= - ---- ---- ---- ---

fou can't 
see files. 

§0-- ---- ---

fou can't 
see folders. 

Linking programs over the network 
Some of the programs available for your Macinrosh can exchange 
information di rectly \\'ith other programs. For example. one 
program might be able ro instruct another program to perform a 
specific action. such as adding a row to a spreadsheet or changing 
the font size of a paragraph. 

Programs implement program linking in various \Yays and not all 
programs ha\·e th is capability. See the documentation that came 
with your programs for more information. 



Linking to a program on another computer 

You can only link to programs that have been shared by the 
owners of the computers on which the programs reside. 

1. Within your program, choose the menu command that 
allows you to link programs. 

The menu location and command name differ from program to 
program. A dialog box opens that you use to find the program 
on the network that you want to link to. 

Computers available for 
program linking 

Choose 11 program to llnlc to: 

- Macintoshes Programs 

Artiste IQ CAOWorks • .:-t 
Otene's Mecintosh The Bottom Une 
Monterey WordRtghter 

' Ntles Davis's Macintosh 
Venture _IQ 

I-
RppleTallc Zones 

Engineering Hi 
Merkettng 

J Production 
Publicctlons 

~~ Resecrch 

iS! 

'<> 
OK !) 

Programs 
available for 
linking on 
selected 
computer 

2. If your network has zones, select the zone of the 
Macintosh you want to connect to in the lower-left 
corner of the dialog box. 

3. Select the Macintosh you want to connect to in the 
upper-left section of the dialog box. 

4. Select the program you want to link to. 

5. ClickOK. 

In most cases. a dialog box appears! where you identi~r 
yourself as a guest or a registered user. 

Connect to shared disk "Rrtlste" DS: 

OGuest 
®Registered User 

~~~~~~~~~ 

Nome: I Jonathon Jones 

Password: C==:J 

1001 

co111i1111es .... 
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6. Click Guest or Registered User. 

If you are a guest or if you are not ce11ain that you are 
registered. click Guest and go on to step 9. If you are a 
registered user, click Registered Cser. 

If the Guest option is dimmed, guests are not permitted access 
to this computer. 

7. If you are a registered user, make sure that the name 
shown in the box labeled Name is the exact name that is 
registered. 

If the name is not your user name, type your user name exactly 
as it is registered. 

8. Type your password, exactly as it is registered 
(including capital and lowercase letters). 

9. ClickOK. 

The two programs are now linked. 

Disconnecting a program link 

lb disconnect a link you established to a program on another 
computer, quit the program from which you created the link. 
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Allowing other people to link to your programs 

You can allow people on the network to link their programs to 
programs on your computer. 

How program linking works 

You can allow other users to link to programs on your computer 
by taking a few discrete steps. 

• First. you turn on program linking. 

• Second. you make a specific program available for linking by 
sharing it. 

• Third, you either allow guest access to the shared program or 
name the specific people whom you want to be able to link 
programs to the shared program. 

\\lhen you've completed these three steps, other people can link 
their programs with programs on your computer. 



Turning program linking on 

When you turn program linking on, you let others on the network 
connect to your computer for the purpose of linking programs. 
Before you turn program linking on1 make sure that AppleTalk is 
active (in the Chooser) and that you have named your Macintosh 
(see ·'Naming Your Macintosh and lt5 Owner" earlier in this 
chapter). 

1. Choose Control Panels from the Apple menu and 
double·click the Sharing Setup icon to open it 

i[ ' Shari'!.9_ Setup 

!2J Network Identity 

ClwMrH&IM: ~~--~ 0Wftff"Pusword: ,........ I 
~intosh ,....,., ,....,Jona-u.on-~-.-.• ~-into-sh-----. 

~ Progrom Linking 
r-·St.atus~····--·~-·-········-~· ... ····-··:··------·--·-·-·--1 

Stort ; ProW&M l11\k1nq Ir off. Chek Stort to •11.>"' other l 
i ~•rs to 1~!°..~~-~!'_"!"~.:._ _____ _j 

Click here to turn on program linking. 

2. In the section labeled Program Linking, click the Start 
button. 

Program linking starts up. When program linking is 
established. the bu non changes to Stop (click the Stop bunon 
when you want to turn program linking off). 

3. Close the Sharing Setup control panel. 

Once program linking is turned on 1 you must identify specific 
programs for linking before network users can link to them. 

Selecting a program for linking 

A network user cannot link to your program unless you have 
specifically shared it first. 

1. Select a program on your computer that features 
program linking by clicking the program's icon. 

Check the documentation that came with the program to make 
sure that it has this capability. If the program is open, you have 
to quit from it before you can share it. 

co11ti11ues ..,. 
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2. Choose Sharing from the File menu. 

The Sharing dialog box appears. 

With an X in this box. this 
program is available for linking 

~-----+--- ro others on the net\York. 

3. Click the box labeled '~ow remote program linking" to 
place an X in it (if there isn't one in it already). 

If the checkbox is dimmed, the program you have selected 
does not allow program linking, so you cannot share it. 

4. Close the window. 

After the window closes, programs on other computers can 
link to your program as long as your computer is turned on, 
program linking is turned on, and the program is running. 
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Allmving guests to link to your programs 

You can let everyone on the network link programs to your shared 
programs. 

1. Choose Control Panels from the Apple menu and 
double-click the Users & Groups icon to open it. 

E 
Users&Groups 

2. Double-click the <Guest> icon. 

DI 1- · - - <Guest> f 

LJ File Sharing 
,;e.;;;;;;;;", 

[8l Allow psis to conMcl 

~ Program Linking 

;J Allow psu lo Inc lo pr09"MM 
on thu M .. 1ntosh 

With an X in this box. guests can link 
to programs on your .\lacintosh. 



3. Click the box labeled "Allow guest to link to programs 
on this Macintosh" to place an X in it (if there isn't one 
in if already). 

4. Close the dialog box. 

Guest users can now link programs Lu any of the prugrarns on 
your computer rhat you have shared. 

iaming specific users to link to your programs 

You can identify the registered users and groups you -;yam ro 
allow to link to your programs. (See . ._ 1aming the People \Xfho'll 
Have Access to Shared files" earlier in this chapter for information 
about naming registered users and groups.) 

1. Choose Control Panels from the Apple menu and 
double-click the Users & Groups icon to open it. 

n1 
Users & Groups 

2. Open the icon of a user whom you want to link 
programs with. 

!!D~ Niles D11u ls 

User Pu swiord : ~ 

LJ Fiie Sharing 
~ 

C8I Allow UStt" to ConMCt 

£81 Allow user to ch.ar19• pusword 

Groups : 

I ~ 
~ Program linking 

Allow user t o link to programs 
on this Maointosh 

The user"s nanH.: 

With an X in this box. this 
user can link programs 
\l'ith your programs. 

3. Click the box labeled "Allow user to link to programs on 
this Macintosh" to place an X in it (if there isn't one in it 
already). 

4. Close the window and click Save in the dialog box that 
appears. 

5. To give more registered users access to your programs, 
repeat steps 2 through 4. 
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Using communications products 
with System 7 

Using the Conununications Toolbox 

If you have already installed the Communications Toolbox with 
Macintosh system software version 6.0 or later, read the following 
guidelines to use the Communications Toolbox with Macintosh 
system software version 7.0. Consult the manual that came with 
the program that uses the Communications Toolbox for detailed 
information about how to use it. 

• Do not install the Communications Toolbox. The 
Conununications Toolbox has been integrated into system 
software version 7.0. 

• With versions of system software prior to System 7, 
communications tools were placed in a Communications folder 
in your System Folder. To use communications tools with 
System 7, drag them to the Extensions folder in your System 
Folder. 

• Wherever a program or its documentation refers to the 
"Communications Folder," substitute "Extensions Folder.'' 
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Using Data Access Language 
If you used Data Access Language (DAL) with Macintosh system 
software version 6.0 or later, follmv the steps below to use it with 
Macintosh system software version 7.0. For detailed information 
about using your DAL application program, consult the manual 
that came with it. 

To use programs that search for the "hosts.CU·· file, do the 
following: 

1. Make a copy of the DAL Preferences file that is in the 
Preferences folder in the System Folder. 

2. Rename the duplicate file: Hosts.CU. 

3. Move the renamed file outside the Preferences folder 
but inside the System Folder. 

4. Use your program as you normally do. Whenever you 
make changes to one of these ftles, you must update the 
duplicate file. 



Chapter 14 

Expanding Your 
Macintosh System 
11 z th is chapter 

• Connecting hard disks and other SCSI devices 
Installing a de\·ice clriYer 

Setting the SC I ID number 

Attaching a SCSI device 

• Connecting a printer 

• Connecting a modem 

• Con necting an external floppy disk drive 

• Connecting a trackball or other ADB de\·ice 

• Connecting headphones or speakers 

• Connecting a microphone 

• Connecting additional monitors 

• Install ing expansion cards 
\uBus"' pmvcr requirements 

• Expanding memory 

Connecting hard disks 
and other SCSI devices 
h ery Macintosh computer has a socker. or port. for connecting 
devices that use the Small Computer System Interface (SCSI. 
pronounced ··skuh-zee .. ). The SCSI port permits high-speed 
communication between the computer and the device. The SCSI 
icon appears abo\·e rhe port on rhe computer's back panel. 

I.~ 11 11 IU ') S - (1 :; I 5 ! 1 

0000000000000 
0000('0()00000 SCSI port 

~. CSi icon 

~ Important: Folio~· the instructions in rhis section a11d the 
instructions that came with your hard disk or orher SCSI 
de\·ice \\·hen connecting it to your Macintosh. _..:::,. 
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SCSI devices commonly used wirh rhe Macimosh include hard 
disks, CD-ROM drives, scanners, prinrers, and tape backup drives. 

13y connecting SCSI devices to one another (in a "daisy chain"), 
you can have up ro se\"en such de,·ices. including an internal hard 
disk. connected to your ~ Iaci ntosh. Each cb ·ice must ha,·e its 
own. unique ID number. 

Setting up a SCSI device to use with your Macintosh involves 

• installing any necessary device drivers 

• setting rhe device·s SCSI ID number 

• physically attaching the de,·ice ro your \ Iacintosh 

Installing a device driver 

'HJ install a device driver: 

• Drag the de\"ice dri,·er icon ro the System Folder on your 
startup disk. 

Any device drivers needed for a SCSI device are usually on a 
floppy disk that comes with the device. (If no device drivers come 
with the device, then it doesn·r need any.) You may have to rescan 
your Macintosh to activate the de,·ice driver. which the computer 
needs to communicate \\"ith-or "dri,·e"-the de\'ice. 
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Setting the SCSI ID number 

See the instructions that came with your SCSI device for 
information on sett ing its SCSI ID number. 

A Warning: Each SCSI de,·ice connected to your Macintosh 
must ha,·e its O\\'n. unique ID number bet\\'een 1 and 6 so 
that your computer Gill distinguish it from other attached 
SCSI devices. Using two or more devices with the same TD 
number can cause them to malfunction. You could lose dara 
as a result. • 

Gi\"e greater ID numbers to the deYices you use more often. Your 
Macintosh uses the numbers to set priorities when it 
communicates with its SCSI devices (the greater a device·s ID 
number, the higher its priority). 

If you have an Apple SCSI device. set the SCSI ID number as 
follows: 

1. Make sure the device is switched off. 

2. Choose a munber between 1 and 6 that hasn't been 
assigned to any other SCSI device connected to your 
Macintosh. 

Each de,·ice in a chain of SCSI de,·iccs connected to your 
cornpurer must ha,·e its mm ID number that distinguishes it 
from other cle\'iccs in the chain. The TD number rnust be 
between l and 6 rn· you have an internal hard disk, its ID 
number is preset to 0, and your Macintosh itself has the TD 
number 7). 



3. Insert a straightened paper clip into the small hole 
directly below the ID number indicator (usually on the 
back panel of the SCSI device). The small hole gives you 
access to the ID number switch. 

4. Push the ID number switch repeatedly until the number 
you want appears in the ID number indicator. 

Attaching a SCSI device 

To connect a SCSI device to your Macintosh: 

1. 1\Jrn off your Macintosh. 

2. Make sure the SCSI device is switched off. 

A Warning: Do not connect or disconnect any device while the 
device or your Macintosh is turned on. Doing so could damage 
the device, your computer, or both. £ 

3. Make sure the device has its own, unique ID number 
between 1 and 6. 

4. Use a SCSI cable to connect the device either to the SCSI 
port or to the last SCSI device already in the chain. 

If the device is the first one in the SCSI chain (or the only one 
you're connecting), use a SCSI system cable to connect it to the 
SCSI port. 

If the device is not the first one in the chain, use a SCSI 
peripheral interface cable to connect it to the last SCSI device 
already in the chain. 

~ Important: The total length of a SCSI chain should not 
exceed 6 meters (20 feet). ~ 

5. Make sure that the first device and the last device in the 
SCSI chain each have a terminator and that no other 
external SCSI device has one. 

To ensure accurate transmission of infonnation. a terminator 
must be at each end of a SCSI chain. 

co11ti1111es IJJll.. 
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An internal hard disk, which is always the first device in the 
chain, has a built-in terminator. The Macintosh Classic, 
Macintosh LC, and Macintosh llfx have built-in terminators 
(whether or not they have internal hard disks). 

• If you have an internal hard disk, or if your Macintosh has a 
built-in terminator, you only have to make sure that the last 
device in the chain has a terminator and that no other 
external SCSI device has a terminator. 

• If you do not have an internal hard disk or a Macintosh 
with a built-in terminator and are connecting your 
Macintosh to two or more external SCSI devices, you need 
terminators in the first device and the last device, and none 
in between. 

• If you're connecting your Macintosh to a single SCSI device 
(whether or not you have an internal hard disk), make sure 
the device has a terminator. 

If you have a Macintosh Ilfx. use the black cable tenninator chat 
came with your computer. Do not use any other terminators \vith 
or instead of the black cable terminator. Also, you or your 
authorized service provider should disconnect or remove any 
other terminators built into your SCSI devices. Vsing terminators 
other than or in addition to the black cable terminator may cause 
your SCSI devices to malfunction. and you may lose data as a 
result. 
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A SCSI device may have a built-in terminator. If a device that's at 
the end of the SCSI chain does not have a built-in terminator, you 
need to attach an external cable tem1inator to it. 

'lb find out if your SCSI device has a built-in terminator, go to the 
inst111ctions that came with the device. (External SCSI devices from 
Apple Computer do not have built-in terminators.) Have your 
authorized Apple service provider remove any extra built-in 
terminators. You can attach or remove cable tem1inators yourself. 

~Important: Always turn on any external SCSI devices 
connected to your Macintosh before turning on the computer 
itlielf. Otherwise. your computer cannot recognize the SCSI 
devices. ~ 

Check the setup book that came ·with your Macintosh for any 
additional information on connecting SCSI devices. 



Connecting a printer 
Every Macintosh has a printer port, \vhich you use to connect a 
printer to your computer. 

~Printer pon 

~1: Printer port icon 

The printer port accepts either a direct cable connection (to 
printers such as the ImageWriter II) or a network cable connection 
(to printers such as the LaserWriter IINT). Certain printers (such as 
the Personal LaserWriter SC) are connected through the SCSI port 
as a SCSI device. · 

Follow the instmctions that came with your printer when 
connecting it to your Macintosh. 

A printer can also be connected to the modem port. YOu use the 
Chooser program to indicate the port you used to connect your 
printer. (See Chapter 12, "Printing," for more information.) 

Connecting a n1odem 
Every .Macintosh has a modem port, which you use to connect an 
external modem to your computer. (A modem is a device that 
allows your computer to communicate with other computers over 
standard telephone lines). 

\Iodem port 

(>:)-:?' 
\~::::__; .\loclem pon icon 

Follow the instructions that came with your modem when 
connecting it to your Macintosh. 

You can connect a modem to the printer port (if you're not using it 
for a printer), but your Macintosh gives the modem port priority 
over the printer port when it checks for data transfer activity. This 
priority better ensures that any communications link your 
computer establishes through the modem remains intact. 
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Connecting an external floppy disk drive 
Some Macintosh computers have a disk drive port which you use 
to connect an external floppy disk drive. 

Disk drive port 

l~,-

i y -, ----Disk drin: port icon 

Follow the instructions that came with your external floppy disk 
drive when connecting it to your Macintosh. 

If your Macintosh does not have a disk drive port you can buy an 
external floppy disk drive that attaches to the SCSI port. 
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Connecting a trackball or 
other ADB device 
Every Macintosh computer has at least one Apple Desktop Bus"' 
(ADB) port, which you use to connect the mouse, the keyboard, 
and other input devices such as a trackball, a bar-code reader, or a 
graphics tablet. 

ADB port 

c~, 

r:J~~---- ADB p01t icon 
~1! 

By connecting ADB devices to one another (in a "daisy chain"), 
you can have up to three such devices connected to a single ADB 
port. The exact number depends on how much power the devices 
require. 

~ Important: The total power used by all Apple Desktop Bus 
devices connected to your Macintosh must not exceed 
500 milliamperes (mA). Information about the power 
requirements of your mouse and keyboard are in the setup 
book that came \Yith your Macintosh. See the instrnctions that 
came with any other ADB device if you need information on 
its power requirements. ~ 



Connecting headphones or speakers 
Every Macintosh computer has a sound output port, ·which you 
use to connect speakers, an amplifier, headphones, or other audio 
output devices to your computer. The sound output po1t accepts a 
standard stereo miniplug, like that used to attach headphones to a 
portable stereo audio cassette player. 

@---Sound omput pon 

c:'j )){---Sound output icon 

Connecting a microphone 
Certain .Macintosh models (such as the .Macintosh LC) have a 
sound input port, \vhich you use to connect a microphone or 
other sound source to your computer. The sound input port 
accepts a standard miniplug. 

@---Sound input pot1 

0----Sound input icon 

See the setup book that came with your Macintosh for additional 
information on the sound input port. 

See Chapter 11, ''Adapting Your Macintosh to Your Own Use," for 
information about recording sound on your Macintosh. 
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Connecting additional monitors 
Most .Macintosh computers accept video cards that let you connect 
additional monitors. Your first monitor may be built-in (as in the 
Macintosh Classic), connected to a built-in video p011 (as in the 
Macintosh Ilci), or connected to a video card installed in a NuBus 
slot (as in the Macintosh IIfx). See the setup book that came with 
your computer for information on installing video cards. 

When you set up additional monitors: 

• Make sure that the ventilation openings on the computer and 
the monitor are clear and unobstructed. 

• Some large monitors cannot safely be placed on top of the 
Macintosh. Check the instmctions that came with the monitor 
for setup information. 

• If there is interference on your screens or on a television or 
radio near your lvlacintosh. move the affected equipment 
farther apart. 

See Chapter 11, "Adapting Your Macintosh to four Own Use," for 
information on configuring multiple monitors in the Monitors 
control panel. 
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Installing expansion cards 
All Macintosh computers except the Macintosh Classic accept 
printed circuit boards (called cards) for video and graphics 
applications, networking and communications, additional 
processing power, and other purposes. The cards fit into 
connectors, called e.,\pansion slots. inside the computer. 

~ Important: See your setup book for infonnation on installing 
expansion cards. Some cards may need to be installed by an 
authorized Apple service provider. ~ 

Like all electronic components, expansion cards generate heat. If 
you install several cards in your Macintosh, leave as much room as 
possible between cards and between cards and other internal 
components. 

Macintosh expansion slots come in two types: 

• NuBus slots, "rhich accept l\uBus expansion cards 

• Processor-direct (or memory cache) slots 



All \ lacintosh II models ha,·e al least one f\u l3us slot. (An optional 
slot adapter is required in the 1\ lacintosh Ilsi.) In the models that 
have a processor-direct or memo1y cache slot (such as the 
Macintosh LC and the Macintosh !lei), only one such slot is 
;l\·ailable. 

.&. Warning: Install an expansion card only in the lot designed 
to accept it. Failure to do so could damage the card and your 
computer. NuRus cards fit in any l\ul3us slot. but a processor­
direct or memory-cache card is often designed only for a 
specific \ Jacintosh model. ... 

\ u Bu · po\\·er requirements 

The combined po,,·er consumption of all installed \u Bus cards 
must nor exceed the limits specified for your Macintosh model. If 
you have two or three \uBus cards installed or are concerned 
about the amount of po~,·er consumed by a particular card. make 
sure that your \uRus card<;' power consumption is within 
specified limits. 

1. Find out the power consumption (in amperes) of each 
NuBus card you have .installed by checking its technical 
specifications. 

Nu Bus cards dra~· power from three types of current: 

• +5 rnlt 

• +12\0lt 

• -12,·olt 

2. Calculate the total power consumption in each type of 
current of all installed NuBus cards. 

3. Find out the maximum power consumption for all 
i\"uBus cards specified for your Macintosh by checking 
the setup book that came with your computer. 

.&. Warning: Do not exceed the maximum power consumption 
for all f\ul3us cards specified for your computer. Doing so 
could damage your cards. your ~lacintosh. or borh . ... 
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Expanding n1en101y 
The random-access memory (RAM) in your 1\ lacirnosh can be 
expanded by adding 'ingle In-Line .\lemo1~· modules (or Sl.\l.\ls) 
to those already installed or exchanging inscallccl modules for 
ones rhar have greater storage capacity. (Some .\lacintosh models 
also accepr memory expansion through the insrallation of a 
memory card.) 

.\fake sure that SDl1\ ls you purchase for memory expansion are 
the correct ones for your ~ lacintosh. See the setup hook that came 
with your computer for more information. 

A Warning: .\lernory expansion on the main circuit board 
should be installed only by an authorized Apple se1Yice 
proYic!er or other qualified technician . .\ Jodifica1ion of the 
circuit board by anyone excepl a quali fied technician voids 
your warranty and could damage your computer . .& 
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Chapter 15 

Care and Maintenance 
In this chapter 
• Handling system components 

Monitor 

Keyboard 

Floppy disks and dri,·es 

Power supply 

• Cleaning system components 

Cleaning the mouse 

• Maintaining the proper operating environment 

• Changing the clock battery 

• . e1Yice and support 

Handling system co111ponents 
Follow these guidelines when setting up and using your 
Macintosh computer and its components: 

• Handle all components ,,·ith care. 

• Place components on a sturdy, flat surface. 

• Carefully folio\\' all setup instructions. 

• Ah,·ays hold a cable by its connector (the plug, nor the cord) 
when connecting or disconnecting it. 

• \ e,·er force a connector into a port. If connector and port do 
not join with reasonable ease. they probably do not match. 
Make sure that rhc connector matches the port and that you 
have positioned the connector correctly in relation to the port. 

• Tt1rn off your ~lacintosh and all its components before 
connecting or disconnecting any cables to acid or remove any 
component. Failure to do so could seriously damage your 
equipment. 

• Take care not to spill any rood or li<.juid on the computer, 
keyboard, mouse, or other components. I f you do, turn your 
Macintosh off immediately and unplug it before cleaning up 
the spill. Depending on ~,·hat you spilled and ho" · much of it 
gor into your equir ment, you may have to bring your 
equipment to an authorized Apple service provider. 
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.A. Warning: Plug the power cords for the Macintosh and its 
components only into three-prong. grounded outlets. The 
computer's grounding-type plug is a safety feature. Do not 
defeat the purpose of this plug. Disconnect the power plug if it 
becomes frayed or otherwise damaged. A 

Monitor 

Follow these procedures '.vhether your .Macintosh has a built-in or 
a separate monitor: 

• Turn down the screen brightness control if you leave the 
.Macintosh turned on for extended periods. If the brightness is 
not turned down, the image on the screen could "burn in'' and 
damage the screen. 

You can also use a "screen saver'' program, \vhich dims or 
varies the image on the screen when the Macintosh has been 
idle for a specified period of time. These programs are 
available from independent suppliers and user groups. 
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• Make sure that the ventilation openings on the computer and 
the monitor are clear and unobstrncted. 

• Some large monitors cannot safely be placed on top of the 
Macintosh. Check the instructions that came with the monitor 
for setup infonnation. 

• If there is interference on the monitor's screen or on a 
television or radio near your Macintosh, move the affected 
equipment farther away. 

Keyboard 

Take care not to spill any liquid on the keyboard. If you do. turn 
off your Macintosh immediately. 

• If you spill liquid that is thin and clear, unplug the keyboard, 
tum it upside dmvn to let the liquid drain out and let it dry for 
24 hours at room temperature. If, after you take these steps, 
the keyboard doesn't work, take it to your authorized Apple 
service provider for repair. 

• If you spill liquid that is greasy. sweet, or sticky~ unplug the 
keyboard and take it to your authorized Apple service provider 
for repair. 



Floppy disks and drives 

r, 

Store disks at 
tcmperanires 
between 50°F 
and 125°F. 

125°f (52°() 

I~ 

Do not touch the 
exposed part of the 
disk behind the 
metal shutter. 

Do not use 
an eraser 
on a disk label. 

Keep disks mny 
from magnets. 

Keep disks dry. 

A,·oid exposing 
disks to extremely 
hot temperatures. 

Pmver supply 

The power supply in your Macintosh is a high-voltage component 
and should not be opened for any reason~ even when the 
computer is off. If the power supply needs service, contact your 
authorized Apple dealer or service provider. 

Cleaning systen1 components 
To clean the outside of your i\facintosh and its components: 

• Use a damp, soft, lint-free cloth to clean the computer's 
exterior. Avoid getting moisture in any openings. 

• Don ·t use aerosol sprays, solvents, or abrasives. 

• To clean the screen, put household glass cleaner on a soft cloth 
and wipe the screen. Don·t spray the cleaner directly on the 
screen, because the liquid might drip into the monitor or 
computer. 
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Cleaning the mouse 

The mouse contains a small ball that must roll smoothlv for the 
mouse to work properly. You can keep this ball free or'dirt and 
grease by using the mouse on a clean, lint-free surface and 
cleaning it occasionally. 

You need a few cotton swabs, alcohol, and a clean. soft. lint-free 
cloth. 

1. Turn off your Macintosh. 

2. Turn the mouse upside down and remove the plastic 
ring on the bottom that holds the ball. 

The plastic ring comes in two types. You remove one by 
turni.ng it counterclockwise; you remove the other by pulling 
the nng downward until it pops out. 

222 Chapter 15: Care and :Vlaimenance 

3. Turn the mouse right side up with one hand and catch 
the ring and the ball with your other hand. 

4. Clean the three small rollers inside the mouse with a 
cotton swab moistened with alcohol. 

Rotate the rollers to clean all around them. 



5. Wipe the mouse ball with a clean, soft, dry, and lint-free 
cloth. 

Don't use any liquid to clean the ball. 

6. Gently blow into the mouse case to remove any dust 
that has collected there. 

7. Put the ball and the ring back in place. 

Maintaining the proper operating 
environn1ent 
In generaL any conditions in which you are reasonably 
comfortable should be fine for your Macintosh. 

• See the setup book that came \Vith your computer to find out 
the range of temperature and humidity that your Macintosh is 
designed to operate within. 

• Protect the Macintosh and its components from direct sunlight 
and rain or other moisture. 

• Keep all ventilation openings clear and unobstructed. Without 
proper air circulation. components can overheat, causing 
damage or unreliable operation. 

Changing the clock battery 
Every Macintosh computer has a clock that runs continuously. 
When the computer is turned off, a battery keeps the clock 
running. 

If your clock begins to keep time inaccurately, have your 
authorized Apple service provider replace the battery. 
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Service and suppo1t 
To help you get the best performance from your system. Apple 
Computer has established authorized Apple dealers who offer full 
suppo1t. If you need answers to technical questions or 
information about product updates, your authorized Apple dealer 
can help you. Apple's technical support organization backs each 
dealer and international technical support group via an 
AppleLink~ network. a state-of-the-a1t on-line electronic 
information service, to ensure prompt, reliable assistance. 

Your dealer has the latest information on new hardware and 
software products as 'veil as product updates. If you wish to 

upgrade your system, your dealer can help you select compatible 
components. 

If your product requires service, your local authorized Apple 
dealer is trained and ready to support you. Apple provides facto1y­
quality parts and the latest available diagnostic equipment to the 
more than three thousand authorized Apple service centers 
throughout the world. Apple guarantees parts and warranty labor. 
(Regulations in each country determine the length of \Yarranty. 
Some restrictions may apply, depending on the country of original 
purchase.) 
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If for some reason you cannot return to the authorized dealer from 
whom you purchased your system, go to the nearest service 
location. For the location nearest you. in the United States or 
Canada, call or write to one of the following: 

Apple Computer, Inc. 
Customer Relations 
20525 Mariani Avenue 
Cupe1tino, CA 95014-6299 
C.S.A. 
800-538-9696 

Apple Canada, Inc. 
7 495 Birchmount Road 
Markham, Ontario, L3R 5G2 
Canada 
800-268-7796 or 
800-268-7637 

For locations in other co.untries, either call the Apple headqua1ters 
in your country or write to the United States address given above. 

Apple also offers service plans designed to meet your needs. One 
of these is the AppleCare"' Service Agreement (available in the 
United States, Canada, and Australia only), which extends full 
warranty coverage up to three years. Your AppleCare contract will 
be honored at any participating authorized Apple dealer within 
the country of purchase-an added benefit if you relocate. Local 
service means time saved in getting your Apple system back to 
work. 

You can purchase AppleCare at any time, but it's a good idea to 
purchase it with your system, or at least before your warranty has 
expired, to avoid an inspection at your own expense. 



Chapter 16 

Tips and Troubleshooting 
Jn th is chapter 

• Gell ing the best-looking fonts 

• ·1;1king a "snapshot'' or the screen 

• \X'hen mu run into trouble 

'fake your time 

Start orer 

Rebuild your desktop regularly 

Solutions to common problems 

Getting the best-looking fonts 
To h;l\·e fonts look their best on the screen. install bitmapped fo111s 
in the sizes you use most often. And for the closest march between 
displayed fonts and printed fonts. install the corresponding 
bitmappecl fonts when you install PostScript outline fonts. 

Your Macintosh looks for either outline fonts or bitmappecl fonts 
to use depending on 

• \\·hether the font is displayed on the screen or printed on a 
printer. and 

• \\·hether (if the font is printed) the printer is equipped lo 
handle Postscript (a programming language that describes the 
characters. symbols, and images appearing on each page of a 
clocu ment) 



\'\'hen you print a document on a Postscript printer (such as the 
LaserW'ritcr IINT). the system sofnYare looks for the fonts you use 
in the following places. in order: 

1. PostScript outline fonts in the printer's permanent mem01y 
(ROM) 

2. Postscript outline fonts in the printer's tempora1y mem01y 
(RAM) 

3. Postscript outline fonts in any hard disk connected to the 
printer 

4. PostScript outline fonts in your System Folder 

5. lh1eType outline fonts in your System Folder 

6. bitmapped fonts in your System Folder in the correct size 

7. hitmapped fonts in your System Folder in a different size that 
can he reduced or magnified to roughly approximate the 
correct size 
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\Vhen you print a document on a printer that does not recognize 
Postscript (such as the Personal LaserWriter SC), and when the 
l\-facintosh displays fonts on the screen, the system software looks 
for the fonts as follows: 

1. bitmapped fonts in your System Folder in the correct size 

2. lh1eType outline fonts in your System Folder 

3. bitmapped fonts in your System Folder in a different size that 
can he reduced or magnified to roughly approximate the 
correct size 

Taking a "snapshot" of the screen 
1ou can capture the image on the screen by pressing 3€-Shift-3. 
The image is sa\·ed as a graphics file. which can be opened in 
many programs that handle graphics (including the Teach'lext 
program that's supplied with the system software). 

The graphics files arc named ··Picture 1, .. '·Picture 2," and so on. 
The number of screen images you can take is limited only by 
available disk space. 

When you n1n into trouble 
For specific troubleshooting information related to a particular 
procedure. go to the chapter that describes the procedure. 



Take your time 
When you see an error message, you don~t have to take action 
immediately. The message stays on the screen until you click the 
OK button or turn off the Macintosh. 

To help diagnose and correct the problem, gather as much 
information about the situation as you can before starting over: 

• Make a note of exactly what you -vvere doing when the 
problem occurred. Write down the message on the screen and 
its ID number (if any) as well as the programs you 1\\rere using 
and the names of any items you know have been added to the 
System Folder since the system software was installed. (This 
information will help a service person diagnose the problem 
should you need to take the computer to your authorized 
Apple dealer for repair.) 

• Check the screen for any clues. Is a menu selected? What 
programs and document icons are open? Note anything else 
that seems relevant. 

• If you were typing text and were not able to save it before the 
problem occurred, you can write down the parts of the text still 
visible on the screen so that some of your work will be easy to 
replace. 

• Ask other Macintosh users about the problem you're having: 
they may have a solution for it. 

Start over 

Often you can eliminate a problem simply by clearing the 
computer's memory and starting over. 

If you can, save any open documents before restarting the 
Macintosh. If your system is "frozen" and does not respond to any 
input, or if you have a "bomb'' message on the screen, saving may 
not be possible. You can t1y pressing x-Option-Esc to quit the 
program in use when the problem occurred; if this works, you can 
then save the documents open in other programs before restarting. 

To restart your Macintosh, tty the following steps: 

1. If you can, choose Restart from the Special menu or 
from the dialog box that's on screen. 

2. If you can't choose Restart, hold down the x and 
Control keys while you press the Power On key. 

3. If nothing happens, look for the reset and interrupt 
switches on the front or side of your Macintosh and 
press the reset switch (the one marked with a triangle). 

Not all Macintosh models have reset and interrupt switches, 
'\vhich are usually installed as a unit when the computer is first 
set up. 

Pressing the reset switch is like nirning the power S'\Vitch off 
and on. (The interrupt switch is intended for use by 
programmers who have debugging software installed.) 

COlllillW!S ..... 
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4. H pressing the reset switch does nothing or if your 
Macintosh does not have a reset switch, turn off your 
computer using the power switch, wait at least 10 
seconds, then turn it on again. 

5. If the power switch doesn't turn off the computer, 
unplug your Macintosh. 

If you suspect that the problem is with a peripheral device, such 
as a printer or external hard disk, turn it off for 10 seconds or 
more, then turn it on again and restart the Ylacintosh. 

Rebuild your desktop regularly 

A process known as "rebuilding the desktop'' helps your 
Macintosh keep track of data on your startup disks. 

• To rebuild the desktop of a startup disk, hold down the Option 
and X keys while starting up your computer. Keep holding 
down the keys until you see a message asking whether you 
want to rebuild the desktop. Click OK. 

• Rebuild the desktop of your startup disks once a month or so. 
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Solutions to common problems 

The computer is turned on but the screen is dark 

The .Macintosh or the monitor is not getting power~ or the screen is 
adjusted too dark. 

• Check that the power cord is plugged in and firmly connected 
to the computer and that the electrical outlet has power. 

• If you have a separate monitor, check that the monitor is 
turned on. 

• Check the screen's brightness control and turn it up if 
necessary. 

• If you use a screen saver program, press a key or move the 
mouse to turn off the screen saver. 



When you start up, an icon appears in the middle of the 
screen and the desktop doesn't appear 

The system software is not installed on your hard disk or your 
hard disk is not working properly. 

When you turn on the Macintosh, one of these icons appears in 
the middle of the screen: 

• The "happy Macintosh'' icon indicates that your Macintosh 
has found a startup disk (which has the system software 
installed in the System Folder) and is starting up. 

• The disk icon with a blinking question mark indicates that your 
Macintosh cannot find a startup disk. If you inserted a floppy 
disk, or if you have a hard disk installed, your ~facintosh 
doesn·t recognize that disk as a startup disk. 

Use the system software disk labeled Disk 1bols to start up your 
lvlacintosh. (Sec "Starting Up With a Floppy Disk" in Chapter 8, 
"Setting Up Your Macintosh System,,. and ''Testing and 
Repairing Disks" in Chapter 9. "'Hard Disks and Floppy Disks,'! 
for instructions on sta1ting up with a floppy disk and repairing 
damaged disks.) 

• The disk icon with an X appears when your Macintosh ejects a 
floppy disk that is not a startup disk. 

• The "sad Macintosh" icon appears when your l'vlacintosh 
cannot sta1t up because of a problem with the system software 
or possibly the computer hardware. 

Eject any floppy disks by turning off the computer and then 
holding down the mouse button while you turn the computer 
on again. 'Ily starting up \\·ith a different startup disk. If the 
.. sad j,facintosh .. icon appears again. see your service provider. 
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The pointer doesn't move when you move the mouse 

The mouse is not connected properly or its signals are not 
reaching the computer. 

• Turn off the computer using the pmwr S\vitch. then check that 
the mouse cable is connected properly. 

• Clean the mouse. (See Chapter 15, "Care and "faintenance ... ) 

• Resta11 the Macintosh with a different startup disk. If the 
pointer still doesn't move. consult your service provider. 
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Typing on the keyboard produces nothing on the screen 

The insertion point hasn ·r been set. no text is selected. the 
keyboard is not connected properly. or its signals are not reaching 
the computer. 

• Make sure the program you want to type in is the active 
program. 

• Place the pointer in the active window and click to set an 
inse11ion point or drag to select text (if applicable). 

• lltrn off the computer. then check that the keyboard cable is 
connected properly at both ends. 

• If the connections are secure and typing still yields no results, 
shut down and turn off the Macintosh, then unplug the 
keyboard cable. Connect the cable to the other Apple Desktop 
Bus port on the computer and the other ADB po11 on the 
keyboard. ('rhu may have to unplug the mouse to do this.) If 
typing still shows nothing on the screen, the problem is most 
likely in the keyboard itself. 

• Restart the Macintosh with a different startup disk. If typing still 
doesn ·r produce te;.a on the screen. see your service provider. 



A dialog box with a bomb appears 

Your system has a software problem. 

• Write clown what you were doing when the message 
appeared, and write down the number on the message, if there 
is one. 

• Resta1t your Macintosh (see .. Start Over"' earlier in this chapter). 

• Check the sta1tup disk and program you were using when the 
message appeared. Make sure that all programs. desk 
accessories, and system extensions you're using are compatible 
with the system software. Reinstalling the system software may 
correct the problem. 

• Sometimes incompatible system extensions or control panels 
can cause system sothvare problems. Rescan while holding 
dmvn the Shift key: this disables all system extensions. If 
startup is nonnal with this method, then remove all extensions 
and put them back into the System Folder one at a time, 
staning up after you add each extension. This procedure 
should iclenti~~ any incompatible extensions. 

The pointer "freezes'' on the screen 

four system has a software problem. 

• Press X-Option-Esc to dose the program in use when the 
problem ocrnrred. If this works, you can then save the 
documents open in other programs before restatting. 

• Restart your Macintosh (see ''Start Over" earlier in this chapter). 

• Check the startup disk and program you were using when the 
message appeared. Make sure that all programs, desk 
accessories. and system extensions you're using are compatible 
with the system software. Reinstalling the system software may 
correct the problem. 
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Your program quits unexpectedly 

The program needs more memory than your Macintosh has 
available. or the program requires a floating-point unit (FPU and 
your .Macintosh doesn't have one. 

• Quit from the programs that you have open and then open the 
program you want to use, or restart your Macintosh. 

• Check the documentation that came with the program to find 
out if the program requires a Macintosh with an FPU, and 
check the setup book that came with your Macintosh to find 
out if your computer is equipped with an FPU, or if an FPC can 
be installed. Consult your authorized service provider for 
information about installing an FPC in your computer. 
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Summaty 

Working on the 
Macintosh Desktop 
Jn th is chapter 

• Using the mouse 

• \'\forking wirh icons 

• Working wirh windows 

• Working with menus 

• Keyboard shortcuts in the Finder 
and in directory dialog boxes 

• Working with disks 

• Working with programs 

Using the mouse 

Point 

• Point to an object on screen by moving the mouse so 
that the pointer is over that object. 

When rhe pointer is an arrow, the tip of the arrow must be over 
rhe objecr. 

Click 

• Click an object on screen by pressing and quickly 
releasing the mouse button while the pointer is over 
that object. 

Clicking an object selects it. 
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Drag 

• Drag an object on screen by pointing to that object and 
holding down the mouse button while you move the 
mouse. 

Dragging an object from one disk to another copies it, 
dragging an object from one place to another on a single disk 
moves it within that disk without making a copy, and dragging 
an object to the Trash throws it away. 

Press 

• Press by holding down the mouse button without 
moving the mouse. 

Pressing a menu name opens the menu. 
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Double-dick 

• Double-click an object on screen by pointing to the 
object and clicking twice in rapid succession, without 
moving the mouse. 

Double-clicking is a common shortcut for opening an icon or 
the selected item in a directory dialog box. 

Shift-dick 

• Hold down the Shift key while clicking. 

Shift-clicking is a way to select more than one icon or item 
in a list. 



Working with icons 
Icons qn the Macintosh desktop represent disks (floppy disks and 
hard disks) and files (programs and documents). When you open 
an icon, its window appears, showing you what's "inside" the disk 
or file. 

Selecting icons 

To do this 

Select an icon 

Deselect an icon 

Select multiple icons 

Deselect an icon in a 
group of selected icons 

Select multiple icons 
that are near each other 

Select contiguous icons 
in a list 

Select text in an icon's 
name 

Take these steps 

Click the icon. 

Click anywhere except the selected icon. 

While holding down the Shift key, click 
each icon. 

While holding down the Shift key, click 
the icon. 

1. Place the pointer at one corner of the 
group of icons. 

2. Drag diagonally to select the icons, then 
release the mouse button. 

1. Place the pointer to the left of the top icon 
or the bottom icon. 

2. Drag up or down the list. releasing the mouse 
button when the pointer is left of the last icon. 

1. Click the icon ·s name to selea it. 
2. Place the pointer at one end of the text 

to be selected. 
3. Drag to select the text. then release the mouse 

button. 

Opening an icon 

You open an icon by selecting it and choosing Open from the File 
menu or using the keyboard shortcut X-0 or X-Down Arrow. Or 
you can double-dick the icon. 

Moving, copying, and renaming an icon 

To do this 

Move an icon 

Copy an icon onto 
another disk 

Copy an icon on the 
same disk 

Rename an icon 

Take these steps 

Drag the icon to where you want it. 

Drag the icon to the icon of the other disk {or to 
an icon or window that belongs to that disk). 

1. Click the icon to select it. 
2. Choose Duplicate from the File menu, or 

press X-D. 
3. lf you wish, rename the icon and drag it to a 

new location. 
'\bu can also make a copy by holding down the 
Option key while you drag the file's icon to 
where you want the copy. 

1. Select the icon ·s name by clicking the name 
{not the icon). 

2. Type a new name and press the Return key. 
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Storing icons in a folder 

Drag the icons to the folder until both the icons and the folder are 
selected, and then release the mouse button. 

Removing an icon 

You remove an icon from the desktop or any Finder window by 
dragging it to the Trash. To erase the contents of the icon from 
your disk, you choose the Empty Trash command from the Special 
menu. 

The Trash displays a warning before its contents are discarded. 
You can't throw away a locked file or an item that's currently in 
use. 
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Working with windows 
A window appears when you open an icon to show you what's 
"inside" the icon. 

Making a window the active window 

You make a window active by clicking inside it. You may have to 
move or resize other windows if the one you want to make active 
is covered by other windows. You can also make a window active 
by clicking its icon (even though it's dimmed) and choosing Open 
from the File menu, or by double-clicking the dimmed icon. 



Moving a window and changing its size 

To do this 

Move a window 

Resize a window 

Close a window 

Take these steps 

~ -
~ 
~--

Drag the window's title bar (at the 
top of the window) to the new 
location. 

Drag the size box (in the 
lower-right corner). 

Or click the zoom box (in the 
upper-right corner). 

Click the close box (in the 
upper-left comer). 
Or choose Close from the File 
menu. 
Or press X-\Y/. 

Scrolling through the contents of a window 

Ill Trees'" 
I L511l in dtsk 7 .51-S ovoillbJ. 

Li] 
Svsttm Fold•r 

CJ 
Fo.-Chlmin9 

EJ 
Notts-K•tt 

CJ 
From Andy EJ 

Saroh's rfl'O'I 

CJ 
Rtpo.-ts/Lisa 

CJ 
~ 

TtothTtxt 

For Mimi 

I Scroll arrow (used 
to view the content 
beyond the 
window's borders) 

CJ 
Appl1cot~1 

~.._Scroll box (shows relative 
location in window) 

I Eveiy window has two scroll bars, one for venical 
scrolling and one for horizontal scrolling. (A grny 
scroll bar indicates more content bevond window's 
borders; a clear bar indicates all content is visible.) 

• Click the up, down, left, or right scroll arrow. 

• Click the vertical or horizontal scroll bar (when it's 
gray). 

• Drag the vertical or horizontal scroll box along its 
scroll bar. 
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Opening higher-level folder windows 

You can open a higher-level folder window (whose contents 
include the active window) from a pop-up menu in the active 
window's title. 

1. Hold down the ~ key as you press the active window's 
title. 

A pop-up menu of the higher-level folders (and disk) appears. 

2. Drag to choose a higher-level folder (or the disk), and 
then release the mouse button. 

The folder (or disk) window you chose appears as the active 
window. 

Open pop-up menu with the 
name of the active windo,,· 
at the top ('·Old repons") 

~ ~ Kind 
D Doeum•nt• l=======r'7'1 

D Eliz•b•th 4 / 4 

D Jerom~ '• St tus 6/20 

Act ive window shO\\·ing 
the coments of the folder 
named ··old report ··· 

This folder coma ins the folder "Old rcpons.·· 

If you hold down the Option key as well as the ~ key, the old 
window closes when the·new window appears. 
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Using the outline form in list views 

Any list view you choose from the View menu (that is, any view 
except the icon and small icon views) shows the contents of the 
active window in outline form. You can see tl1e contents of a 
folder without opening the folder in its own window. 

Open folder (with contellls 
indented belo\\') 

Ill JH data/2 ell 
t;.,,,. S~• Kind 

v DArt mu •• foldf't'" ~ 
0 11sl't'iot 11t 7K documoHl1 

I"" L scrffn shots - foldtt' 
D S«t«11 l • k doeu"rltnt 

t>~ C:.iispM""m.ps - fo1d+r 

tj cr'+dit un""'~<o...nt i7K dc>curn.nt 
q Rudt'lf' IK Tt~hhxt doc 

t>S Scree-ns 3k -lliH 

~ Tt~l•x-1 43K ~l~ttOn pr~ 

IQL :..... . I~ l't!l 

Open folder inside 
a nothcr folder 
(with contents 
indemcd below) 

A downward- ointinu trian .,le indicates t r 0 g hat the folder"s 
contents are displayed; a right-pointing triangle 
indicates that the folcler·s comems are not displayed. 

Click the triangle next to a folder name to display or hide d1e 
folder's contents in the active window. 

If you double-click a folder. it opens in its own window, and its 
outline view closes. 

·:· Shortwts: When a folder is selected in an outl ine view, 
pressing ~-Right Arrow displays the list of its contents and 
~-Left Arrow hides the list of its contents. ·:· 



Working with menus 
Macintosh menus come in two types: pull-down menus and 
pop-up menus. The menus in the menu bar are pull-down menus. 

Menu bar (you 
pull down menus 
from here) 

Dimmed command 
(not available) 

The Help menu, which 
you use to display 
information about items 
on the screen 

The Application 
menu, which 
shows the 
programs that are 
currently open 

Menu commands affect 
whatever vou'vc selected­
in this case, "Hard disk #2. '' 

Pop-up menus often appear in dialog boxes that you use to set 
options or preferences. You can recognize a pop-up menu by a 
small solid ttiangle, pointing clown, next to its name. The name 
shows the current option or preference. 

J 
Pop-up menu <closed) 

Select a Document] 

[c:::::> Wallhrop ..,1 Clicking the triangle 
displays the menu (hut 
does not allow you to 
choose a menu item). 

•1tm!1&!1.• 
c:i Art ideas 
c:i ort-10/4 
c:i Car info 
c:i Caspar maps 
O credit union accoun~ 
Cl E11uelopes 
Cl Glossary 
c:i JH as writer 

c:::::>Wallhrop 

~ 
(Desktop) 

·-·~---~--

ff open J 
~ 

Clickin the menu title or ti g 1e icon displays 
the menu and selects the title (allowing you 
to choose a menu item by dragging to ie). 
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Choosing an item from a menu 

To choose a command from a menu, point to the menu name, 
press to "pull down" or "pop up~' the menu, drag to the item you 
want to choose so that it's highlighted, and then release the mouse 
button. 

Choosing an item from a submenu 

Some menu items are submenus. A submenu name has a small 
solid triangle next to it, pointing to the right. The submenu opens 
when the submenu name is highlighted. 

To choose an item in a submenu: 

1. Point to the menu name and press to pull down or pop 
up the menu. 

2. Drag to the menu item so that the submenu appears. 

Italic 
Underline 
mrnoanmca 
~[i)fD(il(!l[!!J 
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3. Drag sideways to the submenu, drag down to the 
submenu item you want to choose so that it's 
highlighted, and then release the mouse button. 

Underline 
mrnonnm© 
~[i)fD(il(!l[!!J 



Keyboard shortcuts in the Finder and 
in directory dialog boxes 
Key 

Up, Down, Left, 
or Right Arrow key 

Tab key 

Character 
key (a, b, c ••• ) 

X-Down Arrow 

Action 

Selects the next item in the direction of the 
arrow 

Select~ the next item alphabetically (except in a 
directory dialog box and the Chooser) 

Selects the first item whose name begins with 
that character (or the character following 
closest to it in the alphabet) 

Opens the selected icon 

X-Option-Down Arrow Opens the selected icon and closes the current 
folder 

X-Up Arrow Opens the folder that contains the current folder 

X-Option-Up Arrow Opens the folder that contains the current 
folder and closes the current folder 

Return or Enter In the Finder: Selects the selected icon's name 
for editing or saves the edited name 

In a dialog box: the same as clicking the button 
with the bold outline around it 

Working with disks 
See Chapter 9, "Hard Disks and Floppy Disks," for more 
information about using disks. 

Inserting a floppy disk 

1. Hold the disk between thumb and forefinger, with the 
label facing upward and the metal shutter pointing away 
from you. 

2. Gently push the disk into the floppy disk drive, label 
side up and metal shutter first, until the disk drive pulls 
the disk in the rest of the way. 

Copying the contents of a disk 

1. Click the disk icon to select it 

2. Drag the disk icon to the icon that represents the disk 
where you want the copy made until both disk icons are 
selected. 

3. Release the mouse button. 

Respond to any messages that appear by clicking the 
appropriate buttons. 
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Removing a floppy disk from the disk drive 
1. Click the disk icon to select it. 

2. Choose Put Away from the File menu. 

3. When the floppy disk drive ejects the disk, remove it 
from the disk drive. 

You can also drag the disk icon to the Trash. This action ejects the 
disk; it does not erase the disk. 

Locking and unlocking a floppy disk 
1. Hold the disk between thumb and forefinger, with the 

label facing upward and the metal shutter pointing away 
from you (as if you were going to insert the disk into a 
drive). 

2. Find the square hole in the lower-left corner of the 
floppy disk. 

3. Lock the disk by sliding the tab on the back side of the 
disk so that the square hole is open. 

Unlock the disk by sliding the tab back so that the 
square hole is blocked. 
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Working with programs 
For specific information about a particular program, go to the 
manuals that came with the program. 

Saving your work 
• Choose Save from the File menu, or hold down the 

X key as you press the S key. 

Switching programs 
• Click anywhere in a window to make it the active 

window and its program the active program. 

You can also choose the program from the Application menu. 

Closing a document 
• Click the close box of the document window near the 

left end of the title bar, or choose Close from the File 
menu. 

Respond to any messages that appear by clicking the 
appropriate buttons. 



Quitting a program 

• Choose Quit from the File menu, or hold down the 
X key as you press the Q key. 

Respond to any messages that appear by clicking the 
appropriate buttons. 

Backing up your files 
1. Click to select the icon of the document or program you 

want to back up. 

2. Drag the icon to the disk icon where you want to store 
the backup copy until both icons are selected, then 
release the mouse button. 

Respond to any messages that appear by clicking the 
appropriate buttons. 

Making a copy of a file 
1. Click to select the fde icon. 

2. Choose Duplicate from the File menu. 

Saving another version of a document 
1. Open the document 

2. Make the changes you want in the new version. 

3. Choose Save As from the File menu. 

4. Type the name of the new version. 

5. Click Save. 
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Appendix A 

Keyboards and 
Character Sets 
This appenclL'\ shO\YS the layout of the \ lacin1osh Classic and 
Macintosh LC sranclarcl keyboard. the Apple Keyboard. and the 
Apple Extended l\eyboard II. 

·Typing :\on-Engl ish Characters and Special Symbols" is at 
the encl of this appendix. 

Macintosh Classic and Macintosh LC 
standard keyboard 
For instructions on adjusting the height of th is keyboard. go 10 

Chapter 8. "Setting t.;p Your .\ lacinrosh System ... 

Tab key: .\ love~ the insenion poim 
horizomally to the next ~topping 
pbce (such a' a iab 'IOP or data 

field in a dialog box or program). 

Caps Lock key: :\ locking Shift ke\' 
for letters only (numbers and 

symbols aren't :dkcrecl). 

Shift key: Prcxlure'> upperc1se letters 
(or the upper character on the key). 

Control key: Like the 3l: ke\'. 
\\'orks in combination with mher 

kers to pro1·ide shoncuts 
or modi!\· other actions. 

Option key: Produce;. an optional 
~er of sp1:cial ch:11xr1:rs 11·hen 

pre~sed in combination 
11 ith other key~: also 

modifie~ other anions. 

l]i1 l 
~ 

-=_J I ~ I 
# 

I 3 
'--

l tab __, la lw l 
l caps 
lock _J l~J ~ 

I 

shih II_ x 

ctr! I option I ~ ~J 

L_ 
7x (Command) ke : \\'orks 11·ith y 

Olh1:r keys as an altcrnatirc to 
choo~ing a menu command or 
Cin 'ome program~! canceling 

:1n operation in progres~. 

such as printing. 



Power On key: On 
Macintosh II models. 
pressing this key 
turns on the computer. 
On the Macintosh Classic. 
this ker has no function 

Delete key: Deletes any material 
currentlv selected. or whatever 

ch;m~cter is to the left of the 
insertion point 

Return key: Moves the insenion 
point to the beginning of the next 
line. In a dialog box. pressing 
Return is the same as dicking 

Numeric keys: These keys 
produce numbers and 
mathematical symbols; 
some programs allow you to 
use these keys as function 
keys to initiate an action. the outlined button 

I ~ I I ~I I : I I (_ I I J_ I L I + I I 

~ L__1 li_J l!_J l_U ~Ji~ di_ele_te __ 

J LJ ~J lJ :~ lJ lLI liJ ll_J 
lJ ~ LJ ~I [_J LJ LI [return I 

J ~ l~ l~ [_J I~ ~~ lshih .J 

-~ [esc! bJ ~I~ it I 

Escape key: The function 
of this key depends on 

the program you're using. 

-------...----
Arrow keys: ~lore 
the insertion point. as an 
alternative to using the mouse. 
ln some programs. the arrow 
keys hare other functions. 

~~ l.___,a I !,_9 .1 t-=-J 

1~6: lJ 

1 .. _,__o ___ 

1 

I._· 

1 

Clear key: Deletes the 
current selection. just as 
the Delete key does. In 
some programs. Clear 
has other functions. 

Enter key: In a dialog 
box. pressing Enter is the same 
as clicking the outlined button (or 
pressing Return): some programs 
require that you use Enter (not 
Return> to confim infonnation 
you have provided. 
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Apple Keyboard 
This keyboard has no height adjustment. 
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Escape key: The function of this key 
depends on the program you're using. 

Tab key: Mores the insettion point 
horizontally to the next stopping 
place (such as a tab stop or field 

in a dialog box or program). 

Control key: Like the 3€ key. works 
in combination with other keys to pro\'ide 

shrntcuts or modify other actions. 

Shift key: Produces upperca:-;e leners 
(or the upper character on rhe keyl. 

Caps Lock key: A locking Shift 
kcv for letters onlr (numbers 
an~l symbols an.~1i'·1 affected l. 

Option key: Produces 
special characters \\·hen 
pressed in combination 

\\'ith other keys: also 
modifies other actions. 

~~J 
r I 

LJ l!J lJ 
l tab 

I l~J ~~ 
l control J ~ ~ 
lshih J ~ 

~ ~ 

l=J ~'!J ~ 
...:.. 

~ 
3€ (Command) ke y : Combines with 

another key as an alcernacin:' co 
choosing a menu command or 
(in some programs) canceling 

an operacion in progress. 
such as printing. 



Power On key: On 
Macintosh II models. 
pressing this key 
turns on the computer 

J 

Delete key: Deletes any material 
currently selected. or whate\"l'r 

character is to the left of the 
insertion point 

Return key: \f m·es the 
inscnion point to the beginning 
of the next line. In a dialog box. 
pressing Return is the same as 
clicking the outlined hulton 

l lJ LU LlJ lll ~ ~ ~ ldelete 
1 

!~ l::__, :L __ . 

~~L_lJlJl~JLlLJ 
lJ ~ lJ lJ l~ ILJ LI I~ 
J ~ lJ ~ tJ Li lLJ} l._shih __ _! 

___ J l_J ld I~--~) lLJ LLJ 
ILJ u 1~~ 
lP_~ __ _, I_._ _: 

Numeric keys: These keys produce 
numbers and mathematical 
symbols: some programs allo\\" 
you to use these keys as function 
ke\'S to inifrlle an action. 

I I 

L~_, 

I I 

l< I 
i 

enter 
~ .... __ ...... ____ ......... __ .......... __ _,1 

:r 

Arrow keys: Mo\"e the insertioJ 
point. as an alternatire to using 
the mouse. In some programs. 

the arrm\· keys have 
other functi<>11s. 

Clear key: Deletes the 
current selection. just as 
the Delete key does. In 

some progi~uns. Clear has 
other functions. 

Enter key: In a dialog box. pressing 
Enter is the same as clicking the outlined 
hunon (or pressing Return l; ~ome 
programs require that you use Enter 
(not Return l to confirm information 
you hare prorided. 
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Apple Extended Keyboard II 
A reversible plastic template that comes "·ith this keyboard fits 
over the row of function keys. You can label the function keys by 
writing on the template (in pencil, not pen or marker). 

For instructions on adjusting the height of this keyboard, go to 
Chapter R "Setting Up Your Macintosh System." 
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Function keys: Some programs allow you to use 
function keys to give commands. You can assign 

commands or action sequences to function 
keys with special utility programs. 

Escape key: The function of this key____, __ __... 
depends on the program you're using. 

Tab key: ~lm·es the insenion poinc 
horizontally- to the next stopping 
place (such as a tab stop or field 

in a dialog box or program). -l----1-I 

Caps Lock key: A locking Shift key -~-"' __ ; ______ _ 
for letters onlv (numbers and -i--__...1 

symbols ~ren't affected). __ :t/ __ ___ ._ _________ ..........., ____ _ 
Shift key: Produces uppercase letters j 

(or the upper character on the key). ,_sh._ih ___ _. 

a--------------------.~ 
Control key: Like the 3€ key. works-l-----a.. 

in combination \\'ith other keys to pro\'ide 
shortcuts or modi~· other actions. 

Option key: Produces special 
characters "·hen pressed in 

combination \\'ith other kevs: 
also modifies other actio;1s. 

3€ (Conunand) key: Combines 
\\'ith another key as an altemati\"e 

for choosing a menu command or 
(in some programs) canceling 

an operation in progress. 
such as printing. 



Delete key: Deletes any material Special keys: The function 
currently selected, or whatever of these keys depends on the 

character is to the left of the opernting system and program 
insertion point. you're using. 

Numeric keys: 
These keys produce 

numbers and 
mathematical symbols. 

Power On key: On 
.\facintosh lI models. 
pressing this key 
turns on the computer. 

0 

I=' I 1- l 
~~ 

- -num caps scroll 
lock lock lock 

Return key: Moves the insertion 
point to the beginning of the next 

line. In a dialog box, pressing 
Return is the same as clicking the 

outlined button. 

Arrow keys: Move the 
insertion point. as an 

alternative to using 
the mouse. In some 

programs. the arrow 
keys hare other 

functions. 

bJ L_i LJ 
LJ ... LJ .. bJ 

LJ.l~J u 
'----1----'. LJ enter 

Clear key: 
Deletes the 
current selection, 
just as the Delete 
key does. In some 
programs, Clear has 
other functions. 

Enter key: In a dialog box, 
pressing Enter is the same as 
clicking the outlined button 
(or pressing Return); some 
programs require that you use 
Enter (not Return) to confirm 
information you have provided. 
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Typing non-English characters 
and special sy111bols 
You can type a variety of non-English characters (with diacritical 
marks) and special symbols by pressing the modifier keys (such as 
Shift, Option, and Control) in combination with certain letter and 
number keys. 

The Key Caps program, which is instctlled with the system 
sofrware, shows you the characters produced ,,·hen you type 
certain keys and key combinations in the fonts you have (choose 
Key Caps from the Apple menu. then choose the font rrom the 
Key Caps menu). 

Ch;1racters appear here when you press keys 
on the keyboard or dick them in the windo\\·. 

- Ke Caps 

f--'--,--'-,.-'-,....._,_...,_.....,... ................................ ..-'--,.--'-r-'-r-----1 : I <I· . · 1 ~ I 8 9 -

l--.--''-T-1-l-"--'-'-l...:...L.'-..L.._L-'--l-,--L.:.._+~---1 .• 1 :_·!·Fl . p ~ 0 ~ ~ • 

Characters ;l\·ailabk: in the 
Monaco font (on the Apple 

Extended Keyboard II ) 
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Key Caps 

The highlighted key represents the 
ker held down on the kerboard­
in ihis case. the Option key. 

Special characters available 
in the \lonaro font \\·hen 
thc Option key is prcssed 



To type a character with a diacritical mark (such as an acute accent 
or an umlaut), you press the Option key with a specific letter key, 
then you type the character. 

Diacritical mark 

Grave accent (') 

Acute accent ( , ) 

Circumflex (A) 

Tilde(-) 

Umlaut(") 

The letter c with a cedilla(<,:) 

Key combination 

Option-', then type the character 

Option-e, then type the character 

Option-i, then type the character 

Option-n, then type the character 

Option-u, then type the character 

Option-c 

If the character appears ajierthe diacritical mark (rather than 
with it), then the marked character is not available in the font 
you're using. 
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Appendix B 

Exchanging Disks and Files 
With MS-DOS and Apple II 
Computers 
Apple File Exchange is a file format com·ersion program that is 
supplied on the system software floppy disks. The program and 
three special translator files are stored in the Apple File Exchange 
Folder. 

You can use the program to initialize a disk in ~ IS-DOS or 
ProDOS® (Apple II) format and convert files to and from MS-DOS 
or ProDOS. (Apple File Exchange cannot open converted files: 
you need to use an application program that recognizes the 
converted files to open them.) 

Apple File Exch.:inge 

Initializing a disk in MS-DOS 
or Pro DOS f orn1at 
1. Locate the Apple File Exchange icon and open it. 

Apple File Exchange is supplied on the system software disks. 

The program's window opens. The contents of the active 
window are listed on the lefr side and an empty box appears 
on the right side. 

2. Place a blank disk in your floppy disk drive. 

A dialog box appears. reporting that the program can't read the 
disk and asking if you \\·ant to initialize ic. This dialog box 
shows the names of formats available in Apple File Exchange, 
including Macintosh. MS-DOS, and ProDos. 

(You can initialize a disk that is not blank by inserting it, 
clicking the Drive bunon until its name appears in the window, 
and choosing Erase Disk from ci1e File menu.) 

3. Click MS-DOS or ProDOS. 



4. If necessary, click the capacity (in K) of the disk you 
inserted. 

If you want to initialize a high-density disk in MS-DOS format, 
1440K is the only option and is already selected. If you 
inserted a double-sided disk, click 720K. 

rem! Rpple File EHchange cannot 
lDJ read this disk. Do you wish to 
__ 1n_1t_1a_11z_e_it_1 _______ Disk capacity is the 

• 1440K Meclntosh B! same for Macintosh 
and MS-DOS 

Pro ODS lo high-density disks. 

( lnitlollze Jll Eject ll 

5. Click the Initialize button. 

When initialization is completed, a dialog box appears, asking 
you to name the disk. 

6. Type a name for the disk, then click OK. 

MS-DOS file names can have up to eight characters, followed 
by an optional period and up to three characters. 

The dialog box closes, and the name of the disk you initialized 
appears, above an empty window. This disk's icon doesn't 
appear on your Macintosh screen (because the Macintosh 
cannot recognize a disk in MS-DOS or ProDOS format). 

7. Choose Quit from the File menu when you are finished 
using Apple File Exchange. 

Apple File Exchange cannot initialize a high-density disk in 720K 
format, nor can it read a double-sided disk that has been 
initialized in the high-density (1.4 MB) fom1at. 

·:· 5.25-inch disks: Some Macintosh models can use an external 
5.25-inch floppy disk drive that can read files from MS-DOS 
disks. An internal adapter or expansion card is required to 
connect a 5.25-inch disk drive to the Macintosh. Apple File 
Exchange can translate files from these disks and store files on 
them. ·:· 
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Conve1ting files to and from MS-DOS 
or Pro DOS f onnat 
Apple File Exchange provides nvo methods of file conversion­
text and binarv. You use text translation for text files. and binarv 

J • 

translation for other files. 

In addition, Apple File Exchange can use special translator files 
designed to convert files into formats that specific programs can 
use. One of these special translator files is provided ·with Apple 
File Exchange: DCA-Rff/MacWrite, which converts documents 
between MacWrite'F) format for the Macintosh and Document 
Content Architecn1re/Revisable Form Text format (used by many 
word-processing programs) for MS-DOS. 

• 

File selected 
for translation 

l 
File Edit Mac to MS-DOS 

= 
T 

MS-DOS to Moc 

= 
ovnl.'..":O"' Apple File EHthllll_[e ·-

IG92i l(g) MSDOS.jjhl 

•mi ,. D BUDGET.90 
Cl Disk lmnges I »Translate») 

D BUDGET.91 
D labels () BUDGET .OUW 

I Re moue ) 

27K 
bytes 

selected 
.IE: 

=Humme;J 
:I 

(g) MSDOS.JJhf 

5094K bytes ou11il11ble I 324K bytes ouailable 

( fllHrn ) I Oriue ) ( 0!)1'11 l ~ 
(New Folder) ! r jc~c t ) (New Folder) ~ 

.\lenus of 
translator 
files 

Directory 
title or c.t'isk 
name 

Disk name 
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Follow these steps to translate a file: 

1. Locate the Apple File Exchange icon and open it. 

Apple File Exchange is supplied on the system software disks. 

The program ·s ·window opens. The contents of the active 
window are listed on the left side and an empty box appears 
on the right side. 

2. Insert the floppy disk that contains the ftles you want to 
translate. 

3. Use the Open, Drive, and Eject buttons to display the 
fdes you want to translate and the disk or folder where 
you want to store the translated fdes. 

4. Click the names of the ftles or folders you want to 
translate . 

To select multiple files or folders, hold down the Shift key and 
click each name. You may have to scroll to locate the names of 
some files or folders. 

The appropriate translation menus (one for translating from 
Macintosh format and another for translating to Macintosh 
format) appear on the menu bar when you select either 
MS-DOS or ProDOS files. 



5. Open the translation menu you want by pressing its 
name. 

6. Make sure that the translators for the types of files 
you've selected have checkmarks; if not, choose them so 
that checkmarks appear next to them. 

An active translator has a checkmark. The default translator has 
a diamond (indicating that ifs always active). Choosing an 
active translator makes it inactive. 

7. Compare the size of the files or folders selected for 
translation with the space available on the destination 
disk. 

The total space required appears between the lists; the space 
available on the destination disk appears below it'i name. 

If the size of the selected items is greater than the space 
available on the destination disk. deselect some of the items 
(by Shift-clicking them), remove some files on the destination 
disk (using the Remove button), or change to another 
destination disk (using the Eject button). 

8. Click the Translate button. 

If Apple File Exchange finds t·wo or more active translators­
other than Text or Default-capable of translating a selected 
file~ it presents a dialog box asking you to select the translator 
you want. 

If the names of files or folders on the destination disk are the 
same as those of files or folders being translated, Apple File 
Exchange presents a dialog box asking you to rename the file 
being translated. 

If a translator requires you to select options before a file is 
translated, it presents a dialog box in which you select the 
options. 

9. Respond to any dialog boxes presented by selecting a 
translator, renaming the file, or selecting options. 

The selected files or folders are translated. Messages report the 
status of copying. 

If Macintosh files are being translated into MS-DOS files, the 
names of translated files may be shortened to conform to the 
naming conventions of MS-DOS. 

continues 1iJ1J-
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10. When all translations are ftnished, choose Quit from 
the File menu. 

•!• Converting MS-DOS.files on a file se1ver: Some file servers can 
store information created by both Macintosh computers and 
MS-DOS computers. For example, the AppleShare PC program 
allows MS-DOS computers to store and translate files on an 
AppleShare file server. Consult your authorized Apple dealer 
or representative for more information about using a file 
server and MS-DOS files. ·:· 

Other file-conversion options 

Apple File Exchange's File menu provides several other options to 
assist you with file conversions. 
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The program keeps a log of all files translated, 
showing the date, time, and type of conversion. 

Show User Log 
[ h)S(~ 

S<W<~ lh·f~r t O~j fl~,,, 
[ h~t~r Us<~r Lot_i 

The active translators and 
the options for each 
translator can be saved in 
a special file with the 
··save settings as" 
command. You can then 
use these options any time 
by choosing the "Restore 
settings from" command Restore settings from ... 

Saue settings as ... --- and opening the file. 

Page Setup ... 
Print Us<~r Lot.l ,,, 

th~nt~mf~ lh~sHrH~Hon nh~s "' 
'Y""Show Only Eligible Files 38E 

Erase Disk ... 

Quit 38Q 

You can reinitialize a disk in any 
available format with this command. 

)bu can rename destinacion 
(lrJnslated) files. 

The names of files that can't 
he converted by the active 
translators are dimmed 
when this item is checked. 

More information about Apple File Exchange options 

lb see explanations of the translators Apple File Exchange uses, 
choose About the Apple File Exchange from the Apple menu. 
Select a translator in the list that appears, then click the About 
button for information about that item. (Click Done to return to 
the program's window.) 



Appendix C 

Where to Get More 
Information About 
Your Macintosh 
As you increase your knowledge of computers and develop new 
uses for your Macintosh. you may want to know what other 
Macintosh users in your area are doing i;>.·irh their computers, or 
you may want to learn more about programming, hardware 
design, or other technical topics. 

The inforrnation in this appendix provides a starring point for you 
to expand your Macintosh knowledge and contacts. 

Macintosh user groups 
Whatever your level of computer experience, you can get lots of 
support by joining a .\lacimosh user group. Macimosh user groups 
are composed of people who work with Macintosh computers 
and who enjoy sharing what they know with others. Activities may 
include demonstrations of new products. question-and-answer 
sessions, and classes on using popular programs or learning to 
write your own prograrns. Many user groups have special 
beginners' meetings. 

Ask your authorized Apple dealer for the name of the Macintosh 
user group nearest you, or call 800-538-9696. For names of user 
groups out'iide the United Stares, or if you're interested in starting 
your own user group, conract 

Berkeley Macintosh User's Group 
1442-A Walnut Street. =62 
Berkeley, CA 94709 
U.S.A. 
415-549-81\·I ·c (415-549-2684) 

or Boston Computer Society 
One Center Plaza 
Boston, MA 02108 
U.S.A. 
617-367-8080 
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Technical information 
A variety of technical documentation is available for the 
Macintosh. Apple Computer releases technical information 
through three p1imary outlets: the Apple Technical Library and the 
Apple Communications Library, both published by Addison­
Wesley Publishing Company, and the APDN~· developers· source. 

Apple Technical Library 

The Apple Technical Library includes comprehensive technical 
documentation for all Macintosh computer models and the 
multivolume guide to the Macintosh operating system for all 
models, Inside 1Hacintosh. 

Other books in the Apple Technical Library cover designing 
expansion cards and programming device chivers for the 
Macintosh, writing application programs for the Macintosh, and 
designing the user interface for Macintosh programs. 

You'll find the Apple Technical Library in most well-stocked 
bookstores. 
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Apple Communications Library 

The Apple Communications Library offers complete technical 
information about Macintosh communications products and the 
Macintosh in a network environment. The library includes an 
introductory volume. lJ11dersta11di11g Compuler Networks, and the 
comprehensive guide to the AppleTalk network system, Inside 
Apple1lllk. 

The books in the Apple Communications Library are available at 
bookstores. 



APDA 

APDA (Apple Programmers and Developers Association) offers 
worldwide access to a broad range of programming products, 
resources, and information for anyone developing on Apple 
platforms. You'll find the most current versions of Apple and third­
party development tools, debuggers, compilers, languages. and 
technical references for all Apple platforms. To establish an APDA 
account, obtain additional ordering information, or find out about 
site licensing and developer training programs, please contact 

APDA 
Apple Computer, Inc. 
20525 Mariani Avenue, M/S 33-G 
Cupertino, CA 95014-6299 

800-282-2732 (United States) 
800-637-0029 (Canada) 
408-562-3910 (International) 
Fax: 408-562-3971 
Telex: 171576 
AppleLink address: APDA 

If you provide commercial products and services, please call 
408-97 4-4897 for infonnation on the developer support programs 
available from Apple. 

Assistance for hardware and software developers 

If you plan to develop hardware or software products for sale 
through retail channels, you can get valuable support from Apple 
Developer Programs. Write to 

Apple Developer Programs 
Apple Computer, Inc. 
Mailstop 51-\Y/ 
20525 Mariani Avenue 
Cupertino, CA 95014-6299 
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Glossary 

A 

access privileges The ability ro see folders. see files. or make 
changes to a shared disk or folder. Access pri\·ileges are 
granted by the owner of ci1e shared item and are used to 
determine what other network users can do with the disk or 
folder and its contents. 

active program The program you·re currently using. You can 
have several programs open at a time, but only one of them 
is the active program. Open programs appear in the 
Application menu at the right end of the menu bar, with a 
checkmark next to the name of the active program. The 
menu icon changes to indicate which program is the active 
program. 

active ~vinclow The winclO\\. that 's on top of all others on the 

§0 Dee's disk E!l§ 
5 items 36 MB in disk 

~ 
Q 

Teach Text 
Q 

IQ.I LQ '2J 

ADB See Apple Desktop Bus. 

Macintosh desktop. The active 
window has solid lines 
running across its title bar and 
it "belongs" to the active 
program. 

Alarm Clock A desk accessory program (an Apple menu item) 
that works like a digital alarm clock. 

alert box A box that appears on the screen to give a warning or 
other message, sometimes accompanied by an alert sound. 

Ji\ This process will erase all 
ffi info rm ation on this disk. 

Cancel n Erase J) 
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alias A file that stands for and points to a file, folder, or disk that 
you use as if it were the original. When 

~ you open an alias, you're actually opening 
TedehText.?11.i-s its original. 

Apple Desktop Bus (ADB) Input circuiuy built into most 
:::=-.' Apple computers. You use ADB ports (marked 
c{---::. with the ADB icon) to attach the keyboard, the 

mouse, and other devices, such as graphics tablets 
and bar-code readers. See also bus. 

Apple menu The menu at the left end of the menu bar. indicated 

About This Macintosh ... 

~ Alarm Clock 
mill Calculator 
~Chooser 

by the Apple symbol. You 
choose items from this 
menu to get information 
about programs· memory 
use and open items 
placed in the Apple Menu 
Items folder (in the System 
Folder). 

AppleShare file server A Macintosh computer running 
AppleShare File Server software that allows network users to 
store, retrieve, and share files and application programs on 
that computer. 
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AppleTalk network A combination of devices, cables, and 
software that operate according to the protocols (rules) 
developed by Apple Computer. A communications 
environment in which many different kinds of computers, 
peripherals, and software can work together. Uses LocalTalk, 
EtherTalk, or TokenTalk network connection types. 

Application menu The menu at the right end of the menu bar 

Ill 

Hide Finder 
Hide Others 
Show HH 

./~Finder 
~TeachTeHt 

Cits icon changes to indicate which 
program is the active program). You 
choose items from this menu to hide 
wine.lows belonging to open but 
inactive programs and to make an 
open program the active program. See 
also active program. 

application program A program that you use to do your work 
on the computer, such as word processing. database 
management, graphics, or telecommunication. 

B 
back panel The back of the computer, '"here you find the 

power switch and po1ts for attaching external devices. 

back up To make a copy of a disk or of a file on a disk. Backing 
up your files and disks ensures that you \von't lose 
information if the original is lost or damaged. 



halloons Small boxes containing text identifying objects on the 

............... . . . . . . . . . . . . . . . . 
: ~ Help menu 

: : Use this menu to get 
: : information that helps 
: ~ \I ou use \I our computer. 

screen and explaining their 
use. You can hide or show 
balloons by choosing the 
appropriate command 
from the Help menu. 

bit Binal)' digit. The smallest unit of information that a computer 
can hold. The value of a bit (either 1 or 0) represents a 
two-way choice (on or off true or false, black or white). 

bitmap A set of bits that represents a graphic image. 

bitmapped character A character in a font that's rendered as a 
bitmap and drawn as a pixel pattern on the screen. See also 
font, pixel 

bitmapped font A font in a single point size made up of 
bitmapped characters (also called fixed-size font). Some 
fonts stored in the Macintosh System file are bitmapped 
fonts. Compare outline font, TrueType font. 

buffer A "holding area" in memory where information can be 
stored by one program or device and then read by another. 
For example, some printers have built-in memory to store 
text that comes from the computer faster than it can be 
printed. This memory, which frees the computer for other 
work while the printer is printing, is called a print bujje1~ 

bus Circuits inside the computer that transmit information from 
one part of a computer system to another. For example, the 
Apple Desktop Hus transmits information about mouse 
movement or keyboard input. In a network, a bus is a line of 
cable with connectors that link devices together. 

button An image, sometimes resembling a pushbutton, that you 
click to designate, confirm, or 

I[ ]II cancel an action. Compare 1 oK, [ cancel ) 
mouse button. 

(Options ) ( Help ) 

byte A unit of information consisting of a fixed number of bits. 

c 

One byte usually consists of a series of eight bits. See also 
kilobyte, megabyte. 

cache See memory cache, disk cache. 

Cancel button A button that appears in most dialog boxes. 
Clicking it cancels any command or options you might have 
chosen and closes the dialog box. 

central processing unit (CPU) The ''brain" of the computer; the 
microprocessor that perfonns the actual computations. See 
also processor, coprocessor. 

character Any symbol that has a widely understood meaning 
and thus can convey information (letters, numerals, 
punctuation marks, and other symbols). 
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checkbox A small box associaced with an opcion in a dialog box 
or window. You click the checkbox co turn the option on or 
off. An oprion is "On .. when there's an X in the checkbox. 

chip See integrated circuit 

choose To give a command by dragging through a menu and 
releasing the mouse button when the command is 
highlighted. 

Chooser A program char lets you designate devices, such as 
printers and shared disks on a network. for your Macintosh 
to use. 

Clear A command in the Edit menu that remo,·es selected 
material without placing ic on the Clipboard. You can use the 
Undo command immediately after using Clear if you change 
your mind. Compare Cut. 

click To position the pointer on an object on the screen. and then 
co press and quickly release the mouse button. 

Clipboard An area in the computer's memo1y that f unccions as a 
holding place for what you last cm or copied. Information 
on the Clipboard can be pasted into documents. 

close box The small box on che left end of the title bar of 
an accive window. Clicking it closes the 

~ window. 
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color wheel Available on computers wich color capability, the 
color wheel dialog box lets you adjust hue, saturation, and 
brighmess of the highlight color and other color choices. It is 
also used to adjust shades of gray. 

command An instrnction thac causes che compucer to perform 
some action. 

configuration (1) The way you have your compucer sec up. 
(2) The combined hardware components- computer, 
monitors, keyboard. and peripheral devices-that make up 
a computer system. (3) The software seuings that allow 
various hardware components of a computer system to 
communie<ne wich each other. 

control panels Programs that let you ch11nge various Macinrosh 
features. such as sound. mouse movemenc. and keyboard 
options. Control panels are locaced inside the System Folder. 

coprocessor An auxiliary processor designed to relieve the 
demand on the main processor by performing a few specific 
tasks. Generally, coprocessors handle tasks that would be 
performed much more slowly by the main processor, such 
as mathematical calculacions. 

Copy A command in the Edit menu that copies selecced material 
and places it on che Clipboard, withouc removing che 
material from che original document. See also Clipboard. 



copy-protect To make a disk difficult if not impossible to copy. 
Software publishers sometimes copy-protect their disks to 
prevent them from being illegally duplicated. See also lock. 

CPU See central processing unit 

current application See active program. 

current startup disk The disk that contains the System Folder 
the computer is currently using. The startup disk icon 
appears near the upper-right corner of the desktop. 

cursor See pointer. 

Cut A command in the Edit menu that removes selected material 
and places it on the Clipboard; from there you can paste it 
elsewhere. Compare Clear. See also Clipboard. 

cut and paste To move text, graphics, or other material from one 
place in a document to another place in the same or a 
different document. 

D 
default A value, action, or setting that a computer system 

assumes, unless you give it a different instruction. (Also 
called preset.) 

deselect To change a selected item, such as an icon, so that it is 
no longer selected. In the Finder, you deselect highlighted 
icons by pressing the Shift key and clicking the icon you 
want to deselect, or by selecting something else. 

desk accessories Small application programs that you can add 

About This Macintosh ... 

~ Alarm Clock 
l!lli) Calculator 
~Chooser 
1§1 Control Panels 
~Key Caps 
~Note Pad 

to your system. Desk 
accessories (DAs) are 
often installed in the Apple 
menu. Those provided 
witl1 the Macintosh include 
the Alarm Clock, the 
Calculator, the Chooser, 
control panels, Key Caps, 
and the Scrapbook. 

desktop Your working environment on the computer (the menu 
bar and the background area on the screen), on which you 
work with icons and windows. 

• rue Edit utew Label ~pec1a1 CD SI 1- Menu bar 
l'P=~=======M=ac=in=tos=hH=O:::zz===::::::::;J:---~---:7.~. •N•) 

3 •t..,,,s 3.9 Ha.._ dts.k )4 1 t'8 •¥.ullblf. l . :::- . C:i::J 
,_,ID!L· - - · -#A§§ system rolde .. '·"··"·;•H"' 211 :.:~.· .... · .... "'.' .. ~ ....... ·.··· .. ~I- Desktop 

8 ,t.ms 3 9 MO tr. dt:sk 34_1 r1l n.u1.abW : :.: 

LQ] ~ 9 
0 tc::J 
Fi ·-==.~~d DtJk. Too 

b1itnstons Contrclf>.,...b fw.dff' 

r©l liil 

destination The disk or folder that receives a copied or 
translated file, as in destination disk. 
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dialog box A box that contains a message~ often requesting 
more information from you or allowing you to select 
options. 

dimmed Gray or filled in with a pattern of dots, indicating that 
an icon is already open or a menu. menu item, or other 
option is not available. 

~~(~z=t-- Dimmed command 

111111111!1!1!-! ---Dimmed folder icon 

·iii!llllliii!::-= ---Dimmed program icon 

directory A list of the contents of a folder or a disk. 

directory dialog box A dialog box that lets you see the contents 
of disks and folders so that you can save a document in a 
particular folder or disk, or open a document that ·s in a 
particular folder or disk. A directory dialog box appears 
when you choose Save or Open from a program's File 
menu. 

disk A flat, circular object with a magnetic surface that computers 
use to store files (programs and documents). The files are 
stored as magnetic signals, similar to the way sounds are 
recorded on tape. See also floppy disk, hard disk. 
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disk cache A po11ion of the computer's random-access memory 
(RAM) that is set aside for programs to store frequently used 
instructions. You use the Memory control panel to adjust the 
size of the disk cache. Compare memory cache. 

disk capacity The maximum amount of data a disk can hold, 
usually measured in megab}1es (MB) or kilobytes (K). 

disk drive The device that holds a disk, retrieves information 
from it. and stores information on it. 

document Whatever you create with an application program. 
See also file. 

double-click To position the pointer on an object, such as an 
icon, and then to press and release the mouse button twice 
in quick succession without moving the mouse. 

drag To position the pointer on an object, press and hold the 
mouse button, move the mouse, and release the mouse 
button. 

driver A program that the computer uses to direct the operation 
of a peripheral device, such as a printer or scanner. (Also 
called a reso11rce.) 

drop folder A shared folder with access privileges that don't 
allow network users to open it but do allow network users 
to place files or folders into it. 



E 
Easy Access A control panel that you use to adjust the keyboard 

so that you can control the pointer from the numeric keypad, 
type keyboard shoncuts without having to press the keys at 
the same time, and type ve1y slowly. You also can make these 
keyboard adjustments without opening the control panel. 

Edit menu A menu that is available in most programs and lists 
editing commands-such as Cut, Copy, and Paste. 

eject To remove a disk from a disk drive. 

error message A message displayed on the screen that tells you 
of an error or problem in a program or in your 
communication with the computer system. 

Ethernet A high-speed, widely used network type. 

EtherTalk A type of network connection (provided by EtherTalk 
software installed in your Macintosh) that allows you to use 
AppleTalk network services on an Ethernet network. 

Everyone A category of users for whom you can set access 
privileges to shared folders and disks. The category refers to 
anyone who connects to a computer as a guest or registered 
user. 

expansion card A removable circuit board that plugs into one of 
the expansion slots in some models of Macintosh 
computers. Expansion cards enable the computer to use a 
special device or to perform an additional function. 

expansion slot A long, rectangular socket on the main circuit 
board of some Macintosh models into which you can install 
an expansion card that gives the computer additional 
capabilities. 

extension See system extension. 

F 
file Any named, ordered collection of infonnation stored on a 

disk. Application programs and documents are examples of 
files. YOu create a file when you type text or draw graphics, 
give the material a name, and save it on a disk. 

File menu A menu that lists commands that affect whole 
documents and other files-commands such as Save, Print, 
and Quit. 

file server A computer with special software that allows network 
users to store and retrieve files on the hard disks or other 
storage devices attached to it. 

file sharing The capability of sharing files among computers on 
a network. 
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Finder Part of the system software, the Finder is the program that 
creates the Macintosh desktop and keeps track of your files. 

floppy disk A disk made of flexible plastic that stores computer 
data. The 3.5-inch disks used in .Macintosh floppy disk 
drives are floppy disks housed in rigid plastic shells for 
support and protection. Floppy disks come in three types: 
high-density (1.4 MB capacity), double-sided (SOOK), and 
single-sided ( 400K). 

folder A container for documents, programs. and other folders 
on the desktop or in directory windows. 

font A collection of letters, numbers, and symbols in a distinctive 
typographic design. See also 

This is New York font. bitmapped font, outline 

This is Geneva font. 
font, TrneType font. 

format See initialize. 

G 
guest A person that connects to another computer on a network 

without havi.ng to give a name or password. 

guest access A type of access to a computer that permits any 
network user to connect to the computer for the purpose of 
file sharing or program linking. Each Macintosh owner can 
control whether guest access is allowed on that computer. 
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group A set of registered users on a network for whom you set 
access privileges as a unit. Groups are a convenient way for 
a person who is sharing files to control access privileges for 
a number of users at once. 

H 
hard disk A disk made of metal and permanently sealed in a disk 

drive or cartridge. A hard disk can hold much more 
information than a floppy disk, and a hard disk spins much 
faster. 

highlighted Visually distinct, usually because the colors are 
reversed. 

I,J 
I-beam A type of pointer shaped like the capital letter I, used 

for entering and editing tex't. See also I insertion point. 
stationlyl- I-beam 

icon A small pictorial representation of a file, disk, menu, option, 
or other object or feature. 

I bl 
Document Trash Floppy Disk 



initialize To prepare a disk to receive information by organizing 
its surface into tracks and sectors; also known as format. If 
you initialize a disk with information on it, the information is 
erased. 

input Information transferred into a computer from some 
external source: such as the keyboard, the mouse, a disk 
drive, or a modem. Compare output. 

insertion point The place in a document where text you type 

I 
will be added; you set it by clicking at the spot 
where you want to make the insertion. The 
insertion point is marked with a blinking 

statioi\, vertical bar. 

I Insertion point 

Installer A program that you use to install or update your system 
software or to add resources such as networking software. 

integrated circuit (IC) An electronic circuit entirely contained in 
a single piece of semiconducting material, usually silicon. 
Often referred to as a chip. 

interface The way a computer communicates with external 
devices, such as a printer (through its printer port, or printer 
interface), or with you (through its user interface or human 
interface). 

K 
K See kilobyte. 

keyboard equivalent See keyboard shortcut. 

keyboard shortcut A combination of key presses that you can 
use to give a command or set an option. Keyboard shortcuts 
always involve the use of at least one modifier key, such as 
the X key or the Option key. 

Key Caps A desk accessory that shows you the characters 
available for each font in your system. 

kilobyte 1024 bytes. See also byte, megabyte. 

L 
label A word or short phrase that you can assign to an icon by 

using the Label menu. (You can also assign the color that's 
associated with a label if your Macintosh displays color.) You 
can change labels and their associated colors in the Labels 
control panel. 

LocalTalk A built-in network connection that allows a Macintosh 
computer to participate on an AppleTalk network. 

LocalTalk cable system A system of cables, cable extenders, and 
connector boxes that connect computers and network 
devices to an AppleTalk network system. 

lock To prevent files or disks from being changed or deleted (but 
they can still be opened or copied). 
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M 
main logic board A circuit board that holds RAM, ROM. the 

microprocessor, custom integrated circuits. and other 
components that make the computer work. 

main memory See random-access memory. 

megabyte (MB) 1024 kilobytes, or 1,048.576 bytes. See also 
byte, kilobyte. 

member A registered user on a network who belongs to a group. 

memory A hardware component of a computer system that can 
store information for later retrieval. See also main memory, 
random-access memory, read-only memory. 

memo1y cache Memory that is set aside to increase the 
efficiency and operating speed of the computer. Compare 
disk cache. 

menu A list of items from which you can choose. Menus 
commonly appear when you press menu names in the 
menu bar or in a dialog box. You choose a command by 
dragging through the menu and releasing the mouse button 
when the command you want is highlighted. See also 
pop-up menu. 
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menu bar The white strip across the cop of your screen that 
contains the names of the menus available to you. 

a File Edit Uiew Label Special 
::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: 
::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: 

menu name A word, phrase, or icon in che menu bar or in a 
dialog box thac gives you access to the menu. Pressing the 
menu name opens the menu. 

modem Short for modulator/demodulat01: A device that links 
your computer to other computers and information services 
over telephone lines. 

modem port A socket on the computer's hack panel marked by 
a telephone icon, used to connect a modem to your 
Macintosh. 

monitor See video monitor. 

mouse A device that controls the pointer on the screen. 

mouse button The mechanical button on top of the mouse. In 
general. pressing the mouse button initiates some action on 
whatever is under the pointer on the screen, and releasing 
the button confirms the action. 

J\fouse Keys An Easy Access f ea tu re that lets you use keys on the 
numeric keypad to control the pointer. 

!VIS-DOS Microsofr Disk Operating System, a commonly used 
computer operating system. 



N 
network A collection of devices such as computers and printers 

that are connected together. A network is a tool for 
communication that allmvs users to store and retrieve 
information, share printers, and exchange information. 

network administrator A person responsible for setting up, 
maintaining. or troubleshooting your network. 

network service A capability such as file service or print service 
provided by special sothvare on the network. 

network user A person whose computer is connected to a 
network. 

Note Pad A desk accessory that lets you enter and edit small 
amounts of text. 

NuBus An address bus and data bus used in the .Macintosh II 
family and some other Macintosh computers. >JuHus lets you 
add a variety of components to the computer system. 
through expansion cards installed in NuBus expansion slots 
inside the computer. See expansion slot. 

numeric keypad A calculator-style keypad. to the right of the 
alphabet keyboard, that you can use to type numbers. Some 
application programs designate the keys on the numeric 
keypad as function keys. 

0 
open To make available. Ybu open files in order to work with 

them. Opening an icon usually causes a window to appear, 
revealing the document or application program the icon 
represents or sho\\fog you the contents of a folder or disk. 

operating system A program that organizes the internal activities 
of the computer and its peripheral devices. An operating 
system performs basic tasks such as moving data to and 
from devices and managing information in memory. 

outline font A font that describes each character mathematically 
as a set of formulas. The mathematical description adjusts 
itself to render the character in different sizes. See also 
TrueType font, bitmapped font, font. 

output Information transferred from the computer!s 
microprocessor to some external device, such as the screen, 
a disk, a printer, or a modem. Compare input. 

owner The O\Yncr of a Macintosh is named in the Sharing Setup 
control panel. On a network, the owner of a shared folder or 
disk is named in the Sharing dialog box, identifying the 
person who can set or change the access privileges assigned 
to the shared item. 

owner name The name of the mvner of a shared folder or disk 
that appears in the Sharing dialog box. The owner can be 
the Macintosh owner. a registered user. or a registered 
group. The owner can set or change the access privileges of 
the shared item. 
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P,Q 
password A unique word or set of characters that must be 

entered before a network user can gain access to a computer 
that he or she is registered on. 

Paste A command in the Edit menu that places the contents of 
the Clipboard-whatever was last cut or copied-at the 
location of the insertion point. See also Clipboard. 

peripheral device A piece of hardware-such as a monitor. disk 
drive, printer, or modem-used ·with a computer and u~der 
the computer's control. 

PICT A file format used by a number of graphics and page layout 
programs. 

pixel Picture element. The smallest dot that the computer and 
monitor can display, or the representation on the screen of 
the value of a bit. Also, a location in video memory that 
corresponds to a pixel on the screen. See also bit. 

pointer An arrow or other symbol on the screen that moves as 
you move the mouse. 

pop-up menu A menu (usually in a dialog box) in which the 
selected option is shown next to a 

Tabloid ... solid triangle and inside a box with a 
shadow around it. The rest of the 
menu "pops up" when you press the 
box. Compare pull-down menu. 
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p01t A socket on the back panel of the computer where you can 
plug in a cable to connect the computer to another device. 

printer port A socket on the computer's back panel marked with 
a printer icon, used to connect a printer or an AppleTalk 
network connector to the computer. 

privilege See access privileges. 

processor The computer hardware component that performs the 
computations directed by software commands. In 
microcomputers such as the Macintosh, the processor is a 
single integrated circuit called a microprocessor. See also 
central processing unit. 

program A set of instructions describing actions for a computer 
to perform to accomplish a task, conforming to the rules and 
conventions of a particular programming language. 
Computer programs are collectively referred to as software. 
See also application program. 

program linking The ability of an application program to 
exchange information directly with another program over a 
network. To use program linking, both programs must have 
the capability. 

pull-down menu A menu (usually in the menu bar) whose 
name or icon is shown. You "pull down" the menu by 
pressing the name or icon. Compare pop-up menu. 



R 
RANI See random-access memory. 

random-access memory (RAM) The part of a computer's 
memory available for programs and documents, also knmvn 
as main memory. The contents of RAM are lost when the 
computer is turned off. Compare read-only memory. 

Read .Me document A document that is included on some 
application program and system software disks to provide 
you with late-breaking infonnation about the product. 

read-only memory (ROM) Memo1y whose contents the 
computer can read, but not change. Information is placed 
into read-only memory only once, during manufacturing. 
The contents of RO.\i1 are not erased when the computer's 
power is turned off. Compare random-access memory. 

registered group A group of registered users that is listed on a 
computer on a network. 

registered user A network user whose name and password are 
listed on a computer on the network. Usually. registered 
users have greater access privileges to shared folders and 
disks than do guest users. 

resource A file that is contained in the System Folder and that 
the computer uses for its operations. System files and device 
drivers are examples of resources. 

RGB monitor A type of color monitor that receives separate 
signals for each primary color (red, green, and blue) and 
uses these signals to display color images. 

ROM See read-only memory. 

s 
save To store information by transferring it from main memory 

(RAM) to a disk. Work that is not saved disappears when 
you turn off the computer or if the power is interrupted. 

scanning order The order in which the Macintosh searches the 
disk drives for a startup disk. See also startup disk. 

Scrapbook A desk accessory in which you can save frequently 
used pictures or passages of text. The Sera pbook can store 
multiple images. You can cut or copy images from the 
Scrapbook and paste them into documents created with 
most application programs. Compare Clipboard. 

scroll To move a document or directory in its window so that a 
different part of it is visible. You scroll using the scroll 
arrows, scroll bars, or scroll box. 

SCSI See Small Computer System Interface. 
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SCSI cable terminator A device used in a SCSI chain to maintain 
the integrity of the signals going through the chain. With 
some devices, such as the Apple internal hard disk, the 
terminator is built in. 

SCSI chain A group of SCSI devices linked to one another 
through SCSI peripheral cables and linked to the SCSI port 
on the computer through a SCSI system cable. 

SCSI port The socket on the back panel of the computer to 
which you connect SCSI devices. 

select To designate which object will receive the next action you 
take. Selecting is usually done by clicking or dragging. 

selection The selected object or objects. A selected object is 
usually highlighted. 

serial ports The connectors for peripheral devices that receive 
data in a serial format (that is, one bit at a time). The printer 
and modem ports on the Macintosh are serial ports. 

shared disk A hard disk, CD-ROM disc, or other medium whose 
contents can be retrieved over the network. A disk can be 
shared by a file server or a Macintosh computer that has file 
sharing turned on. 

shared folder A folder that is available to some or all network 
users over the network. 
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Shift-click To click the mouse button while holding down the 
Shift key. used to extend or shorten a selection and to select 
more than one item. 

Shift-drag To drag while holding down the Shift key, used to 
select two or more groups of objects by holding down the 
Shift key while you drag diagonally to enclose each group of 
objects in a rectangle. 

SIMM Single In-line Memory Module, a circuit board that 
contains eight RAM chips. SIMMs are connected to SI.MM 
sockets on the computer's main circuit board. See also 
random-access memory. 

size box A box on the bottom-right corner of the active 

mmiH J ::~~~:: Dragging the size box resizes the 

Slow Keys An Easy Access feature that lets you set a delay 
before each keystroke is accepted by the computer. 

Small Computer System Interface (SCSI) A specification of 
mechanical, electrical, and functional standards for 
connecting peripheral devices such as hard disks, printers, 
and optical disks to small computers. 

sound output port A socket on the back panel of the .Macintosh 
marked with a speaker icon, used to connect headphones or 
speakers to your Macintosh. 



source The disk or folder that holds the original of a file to be 
copied or translated, as in source disk. 

startup disk A disk with all the necessary program files-such as 
the Finder and System files contained in the System 
Folder-to set the computer into operation. 

startup drive The disk drive from which you start up your 
computer system. The disk in this drive must contain a 
System Folder. 

stationery A document that serves as a template. When you 
open a stationeiy document, a copy of the document is 
created and opened. The original remains unchanged. 

Sticky Keys An Easy Access f ea tu re that lets you type 
combination keystrokes ·without actually pressing the keys 
simultaneously. 

system extension A program that expands the capabilities of 
system software (for example, device drivers). System 
extensions are stored in the E:x1ensions folder in the System 
Folder. 

System file The file that Macintosh computers use to start up 

In 
~ 

System 

and to provide systemwide information, 
including fonts, sounds, and keyboard layouts. 
The System file must be in the System Folder. 

System Folder A folder containing the programs that .Macintosh 

~ 
System Folder 

computers use to start up and operate. A 
disk that contains a System Folder is a 
startup disk. 

system software Software components that support application 
programs by managing system resources (such as memory) 
and input and output devices. Also known as the operating 
system. 

T 
TeachText A program provided with the Macintosh system 

software that functions as a limited word-processing 
program, used primarily to open Read Me documents. 

terminator See SCSI cable terminator. 

3.5-inch disk A flexible, plastic disk measuring 3.5 inches in 
diameter encased in a rigid plastic shell. These disks come in 
three types: high-density (1.4 MB capacity on the 
Macintosh), double-sided (SOOK), and single-sided ( 400K). 
See also floppy disk. 
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title bar The bar at rhe top of a \rindow that sho\\"S the name of 
the windo\Y. \\ihen the ~,· indow is acti,·e. the title bar is 
highlighted with horizontal lines. 

= Duane Title bar 
206K •vall• bl• 

To Do 

Token Ring A widely used network type originally developed by 
International Business Machines Corporation. 

Token Talk A type or network connection that allo\\"s you to use 
AppleTalk services on a Token Ring net\rork. 

'fotsh An icon on the desktop that you use to discard programs, 
documents. and folders. 

mm 
Trash 

'frueType fonr A type of outline font supplied \rith the 
Macintosh system software. See also outline font. Compare 
bitmapped font. 
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u 
unlock To allo,,· a locked disk or document to be changed. 

deleted. or renamed. See also lock. 

user group A computer club \rhere computer users exchange 
tips and information. 

User/Group A category of users for whom you can set access 
privileges to shared folders and disks. Can be any user or 
group that is registered on the computer containing the 
shared folder or disk . 

user interface See interface. 

user name The name chosen by a Macintosh owner or network 
administrator to identify a user. After th is identification is 
complete, the user is a registered user and can connect to 
that computer as such. 

v 
version A number indicating a program's chronological position 

.rela tive to previous and subsequent releases of the program. 

video monitor A display cle,·ice that can receive video signals by 
direct connection. Also known as a monitor. 



virtual memo1y Hard disk space ser aside and used as an 
e:\.1ension of rhe compurer"s main memory. 

virus A program designed '"irh malicious inrenc ro damage files. 
Vims programs can be spread though networks and 
bulletin board services as well as on disks. Virus-detection 
and -elimination programs are available through dealers 
and user groups. 

volume Space on a hard disk or a file server that"s defined and 
named as a place to store fil es. A hard disk is usually a single 
volume, but it can be partitioned into several volumes. 

W, X,Y 
window A rectangular area that displays information on the 

desktop. You create and view documents through windows, 
and you riew the contenrs of disks in \Yindo\\"s. 

z 
zone Zones are set up by a network administrator and are used 

to group the devices on the network for easier access. 

zoom box A small box in the top-right corner of the title bar of 
the active window. Clicking the zoom 
box resizes the windo"· so that you can 
see all of its contents (if possible); 
clicking it again returns the window to its 
pre,·ious size. 
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Index 

A 

About This ~lacintosh (Apple 
menu) 148 

accent marks. typing 250-251 
accessing. See also opening 

files on other computers 
175-180 

\lacintosh while awav from it 
195-1 96 . 

access privileges (nem·orks) 
180-181, 197- 207 

checking 202 
setting 199- 201 
strategies for 200 

activating. See also disabling: 
opening 

Alarm Clock 127-128 
AppleTalk 56. 155. 172 
CloseView 1 '16 
file sharing 183-184 
Finder 43- 44 
Help 13alloons 78 
Mouse Keys 130 
program linking 205 
Slow Keys 132 
software programs 40. 94, 

242 
Sticky Keys 131 

activating ( co11/ imted) 
32-bit addressing 152 
·ri·ash icon 14-15 
virtual memory 151 
,,·indm,·s 14-15. 43-45, 236 

acrive desk accesso1y 94 
active sofmrare prog;·am 242 

identi~·ing -13- 45. 9-1 
multiple 43-45, 9LI 
opening documents in 44. 

~8.68 
quick reference for 242 
S\\'itching bet\\'een 43-45. 

9-i 
active window, closing 14- 15, 

31. 43-45. 236 
adapting Macintosh to your own 

USC 121 -152 
ADB dc,·ices 21'1 
ADB port 21 4 
adding 

alert sounds 13'1 
device drivers to System 

Folder 210 
files to folders 69 
folders to folders 1 I 0 
fonrs to S\·stem Folder I 6!i 
items to Apple \lenu I 13. 

122 

adjusting 
blinking of menu items 137 
disk cache 149 
keyboard 87, 129-130. 132 
mouse operations 128-129 
speaker volume 132-133 
virtual memory 150-151 

Alarm Clock. setting 127- 128 
alert sounds 

customizing 132-135 
disabling 133 
installing 133 
recording and removing 134 
Sticky Keys and 131 

aliases 70-72, 112- 113. See also 
documents: files: 
folders 

connecting to shared disks 
\\'ith 179 

creating 11 2 
definition of 71 
getting information about 

(Get Info) 113 
locating original of 113 
locking 104 
opening 112 
opening at startup 122 
purpose of 112 
trouble with 112 

APDA 259 
Apple Canada 22!i 
AppleCare Service Agreement 

224. See also 
maintenance 

Apple Communications Libra1y 
258 

Apple Computer. Inc., Customer 
Relations 224 

Apple Desktop Bus devices 
connecting 21 4 
power requiremems of 214 

Apple Desktop 13us port 21-1 
Apple Extended Keyboard II 87, 

248- 249 
Apple File Exchange 252-256. 

See also ner,vorks 
converting files to and from 

~IS-DOS or ProDOS 
with 254-256 

initializing MS-DOS or 
ProDOS disks with 
252-253 

Apple HD SC Setup program 
icon for 98, J 08 
initializing hard disks with 

98 
testing hard disks with 108 
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Apple Keyboard 87, 246-247 
Apple menu 

About This ~facintosh 148 
Alarm Clock 127-128 
Chooser 54-56, 153-156, 

172 
Control Panels 101, 124-145, 

149-154, 174 
installing items in 113. 122 
Key Caps 250-251 
removing items from 113, 

122-123 
Apple Menu Items folder 113, 

122 
Apple Programmers and 

Developers 
Association 259 

AppleShare 176. See also 
AppleTalk; networks 

ApplcTalk 171. See also 
AppleShare; networks 

activating 56, 155, 172 
choosing printer for 155-157 
inactive 55, 156 
zones 55-56, 155. 177 

Apple Technical Libral)' 258 
Apple II computers, exchanging 

disks and files with 
252-256 
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Application menu 40. 4-L 9'!-95, 
239 

Finder command +i 
Hide Others command 95 
icon for 40, 94 
Show All command 94 

application programs. See 
software programs 

arranging icons on desktop 109 
arranging your office 86 
arrow keys 23, 241. 245, 247, 

249 
arrmvs, scroll arrows 16-17. 20, 

237 
attaching. See connecting 
audio ports 13-L 215 
A/CX 89, 98 

B 
background printing 156. 

160-162 
backing up files 58-59, 243. See 

also copying 
backspacing with Delete key 41 
backup disks 92 
Balloon Help 78-79 
battery. clock 223 
beeps. See alerts 
bitmapped fonts 162-163. 

225-226 

blinking insertion point, 
changing 137 

blinking menu items. adjusting 
137 

blinking question mark disk icon 
229 

bomb error message 227, 231 
borders, window, changing 

colors of 142 
brightness 

of color wheel 141 
of screen 145. 220. 228 

Brightness control panel 1,15 
Brightness icon 145 
bulletin board~. See also 

networks 
folders as 201 
viruses and 93 

bus. See Apple Desktop Bus 
By Label command (View 

menu) 140 

c 
cables 

handling 219 
Locallhlk-compatible 171 
SCSI peripheral interface 

cable 211 
SCSI system cable 211 

cable terminators, built-in 212 
cache. See disk cache; memory 
calendar. setting 125-126 
canceling 

initialization 100 
printing 161-162 

Caps Lock key 244, 246, 248 
cards 

expansion cards 216-218 
memo1y expansion cards 

218 
NuBus expansion cards 

216-217 
video cards 216 

CDEVs 122. See also Control 
Panels 

CD-ROM discs, sharing over 
networks 175, 
184-185 

chains. See daisy chains 
changing 

alert sounds 132-135 
Apple menu 122 
blinking rates 137 
clock battery 223 
colors 

in color wheel 141 
in Label menu 124-125 
in Monitors control panel 

142-143 



changing (continued) 
desktop pattern 135-136 
documents 48-53 
icon names 64-65 
icons, appearance of 

139-140 
keyboard layout 130 
keyboard operation 

129-130, 132 
keyboard shortrnts with 

Sticky Keys 131 
L1bel menu items 124-125 
memory used by software 

95-96 
mouse operations 128-131 
pa per size 156 
passwords 181. 196-197 
screen brightness 145 
speaker volume 132-133 
system startup 122 
window color 140, 142 
window displays 138 

character keys 131, 241 
characters, non-English and 

special symbols 
250-251 

character sets 244-251. See also 
fonts; keyboards 

Chooser (Apple menu) 54-56. 
153-156 

activating AppleTalk with 
172 

connecting to shared disks 
with 176 

choosing printer with 
153-156 

networks and 155-157 
choosing 

items from menus 240 
items from submenus 240 
printers 54-56, 153-157 

deaning system components 
221-223 

Clean Up command (Special 
menu) 12. 109 

Clear command (Edit menu) 53 
clearing memory 227 
Clear key 245, 247, 249 
dicking. See also choosing: 

mouse; opening: 
pointer; selecting 

clicking with mouse 9. 
233-234 

clicking with numeric keypad 
130-131 

double-dicking 48, 53, 234 
changing speed of 129 
with keypad 131 

Shift-dicking 51 

Clipboard 52 
clock 

bane11·. changing 223 
setting 125-126 

close box for windmvs 21-22. 
31. 237 

Close command (File menu) 
242 

CloseView 146-147 
Close Window command (File 

menu) 22. 31 
closing. See also quitting 

documents 4 5 
lh1sh 22, 35 
windows 21-22. 31, 237 

Color control panel 140. 142 
color documents. printing 159 
colors, changing 

desktop pattern 136 
highlight 140-141 
icons 140 
in color wheel 124-125. 141 
in Labels control panel (Label 

menu) 124-125 
windows 140. 142 

Command key 23. 2.:t4. 246. 
248. See also keyboard 
shortcuts 

commands. See also menus or 
specijlc command 

choosing from menus 12 
dimmed 239 
help for 78-79 
shortcuts for. See keyboard 

sh01tcuts 
communication. See networks 
communications products, 

System 7 and 208 
Communications Toolbox 208 
components. See also peripheral 

devices or spec{fic 
component 

connecting 209-217 
handling 219-221 

computers. See specific 
computer or topic 

computer viruses 93 
configuring 

Macintosh for networks 
172-175 

multiple monitors 143-144 
connecting 209-216 

AD B devices 214 
external floppy disk drive 

214 
hard disks 209-212 
headphones 215 
Local'falk cables 171 
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connecting (cu11tinued) 
microphone 215 
modem 213 
monitors 216 
printers 213 
safety tips for 219 
SCSI devices 209-212 
speakers 215 
to network 171-172 
to shared disks 176-178 
trackballs 214 

connectors, handling 219 
contrast control 145 
Control key 244, 246, 248 
Control Panels (Apple menu) 

101 
Brightness control panel 14 5 
Color control panel 140, 142 
File Sharing Monitor control 

panel 194 
General Controls 125-126, 

135. 137 
Keyboard control panel 

129-130 
Labels control panel 

124-125 
Memory control panel 

149-152 
Monitors control panel 

142-144 
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Control Panels (continued) 
Mouse control panel 

128-129 
Network control panel 

li3-174 
Sharing Setup control panel 

174, 183.205 
Sound control panel 132-135 
Startup Disk control panel 

101 
Users & Groups control panel 

185-187. 191. 195.206 
Views control panel 138 

controlling pointer from 
keyboard 130-131 

converting 
documents to stationery pads 

118 
DOS and ProDOS disks and 

files 254-256 
copying 

disk contents 104, 241 
documents 

to backup disk 58-59, 
101,243 

to or from shared disks 
180 

with Duplicate command 
64. 243 

with Save As command 
66-67, 243 

with shortcut 243 

copying ( collfinued) 
graphics 139 
icons 58. 235 

from one disk to another 
58, 234 

on same disk 235 
onto another disk 235 

software onto hard disk 
29-31.36-37 

copyright laws 185 
correcting mistakes. See editing 
creating 

aliases 70-72. 112 
documents 41 
folders 69. 110 

on shared disks 180-182 
stationery templates 72-75. 

118-119 
current startup disk. See stam1p 

disk 
cursor. See pointer 
customizing 121-152 

alert sounds 132-135 
Apple menu 122-123 
blinking rates 137 
colors or grays 124-125, 

142-143 
desktop pattern 135-136 
highlight colors 140-141 
icon appearance 139-140 

customizing (continued) 
keyboard 129-132 
keyboard shortcuts 131 
Label menu 124-125 
menu items, blinking of 137 
mouse operations 128-129 
screen 145-147 
System Folder 122-123 
system software 90, 122-123 
system startup 122 
window display 138 

Cut command (Edit menu) 52. 
See also deleting: 
editing; erasing; Paste 
command 

cutting text 52 

D 
daisy chains 211-212, 214 
damaged disks 104 
darkened icons. See highlighted 

icons 
Data Access Language (DAL) 

208 
date, setting 125-126 
default network zones 174 
Delete key 41. 49, 53, 245, 247, 

249 



deleting. See also Clear 
command: Cut 
command; editing; 
erasing: removing: 
'Irash 

files from System Folder 123 
fonts from System Folder 

123, 1·64 
items from Apple menu 123 
items from disks (Trnsh) 

34-35 
System Folders, extra 37 
text 52-53 

deselecting icons 235-236 
designating startup disk 

101-102 
desktop. See also files: Finder; 

folders or spec[(ic 
desktop element 

activating windows on 236 
arranging icons on 109 
changing how icons are 

displayed on (View 
menu) 120, 238 

changing icon names on 
64-65 

changing window display on 
138 

cleaning up 12 
copying icons on 235 
creating folders on 69, 110 

desktop (continued) 
description of 5, 18 
disks and 241-242 
displaying window contents 

on (View menu) 120, 
238 

dragging icons on 233 
failure to appear 229 
folders and 19, 68-69. 110. 

236, 238 
hiding and showing windows 

on 94 
icons and 18, 233-236 
introduction to 7-24 
key commands and 23. 2-t 1 
menus and 19, 239-240 
moving icons on 235 
moving items to 114 
moving windows on 21-22, 

237 
naming folders on 110 
naming icons on 64-65 
opening higher-level folder 

\vinchws on 238 
opening icons on 13. 

234-235 
pattern. changing 135-136 
printing files from 159 
printing \Vindow contents 

from 160 
quick reference for 233-243 

desktop (cu11ti11uedJ 
rebuilding 228 
removing hard disk icon from 

105 
removing icons from 34-35, 

236 
renaming icons on 100. 235 
selecting icons on 233, 235 
shortcuts for 241 
software and 242-243 
Trash and 19, 34-35, 234, 

236 
windows and 14-22, 

236-238 
developers, assistance for 259 
device drivers 

installing 122. 15<1-159. 210 
networking 123 
printer 154-155. 157-159 
removing from System Folder 

12.3 
scanner 122 

device numbers. See SCSI ID 
numbers 

derices. See peripheral devices 
or specific device 

diacritical marks. typing 
250-251 

dialog boxes 241, 111. See also 
menus 

dimmed commands 239 

directory dialog boxes. See also 
menus 

purpose of 111 
shortcuts for 241 

disabling 
Alam1 Clock 128 
alert sound 133 
CloseView 146 
Empty Trash warning 148 
file sharing 193 
Mouse Keys 130 
Slow Keys 132 
Sticky Keys 131 

disconnecting 
from shared disks 178 
network users 194 

discs. See CD-ROM discs 
disk cache, adjusting 149. See 

a/so memory 
disk drive po1t 214 
disk drives. See also floppy disks 

drives: hard disks 
accessing with Drive button 

99 
care and maintenance of 221 
connecting 214 

diskettes. See floppy disks 
Disk First Aid program 107 
disk icons 18, 229 

blinking question mark on 
disk 229 

X on disk 229 
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disks 26-37, 97-108. See also 
CD-ROM discs; floppy 
disks: hard disks: 
icons; initializing: 
startup disk 

backup disks 92 
care and maintenance of 

106, 221 
copying 241 
damaged 93, 104 
directories of 111 
Disk Tools 92. 98. 107 
ejecting 32, 59. 105, 242 
exchanging with MS-DOS 

and Apple II 
computers 252-256 

5.25-inch (MS-DOS) 252 
handling 221 
initializing 97-100 

in MS-DOS or ProDOS 
format 252-253 

inserting into drive 29. 241 
introduction to 26-37 
locking/unlocking 102-104. 

242 
opening. See icons, opening 
Printing disk 157 
privacy and 201 
protecting information on 

102 
quick reference for 2-11-242 
reference for 97-108 
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disks ( conti11uedJ 
saving files on. See saving 
shared 18. 175-185 
sta1tup disk. purpose of 5 
switching between 99 
testing and repairing 

106-108 
Disk 1bols disk 92. 98. 107 
displaying 

folder contents 238 
fonts 166 
menus 239 

documents. See also files; icons: 
software programs; 
text 

adding to folders 69 
alias 70-72, 104, 112-113 
backing up 104. 243 
changing 48-53 
closing 45, 242 
copying with Duplicate 

command 6~ 
creating 41 
creating templates for 

118-119 
empty 41 
erasing with Trash 34-35 
getting infonnation about 

(Get Info) 74, 119-120 
locked. searching for 117 
locking 103. 119 

documents r col//i1111edJ 
naming 41-42, 63 
opening 

at startup 122 
by double-clicking 48, 

234 
with Open command 

13-14, 16 
organizing 61-75. 109-120 
printing 56-57, 152-168 
purpose of 19 
saving 

aliases of 70-72 
as stationery pads 73, 118 
different versions of 

66-67 
on different disk 58-59 
trouble with 104 
\\'ith Duplicate command 

64 
with Save As command 

66-67. 2·13 
with Save command 

41-42. 51. 242 
searching for 114-117 
sharing over networks 

182-187 
stationery pad 72-75. 

118-119 
unlocking 117 
"untitled .. -! 1 

DOS. See MS-DOS 
double-clicking 48, 53, 234. See 

also clicking; mouse 
changing speed of 129 
with numeric keypad 131 

double-sided floppy disks 
(800K). See also disks: 
floppy disks 

description of 26-27 
initializing 99-100 

downloading fonts 165. See also 
fonts 

dragging 
icons 10-11, 234 

from Trash 3 5 
on a single disk 234 
to another disk 104, 234 
to desktop 114 
to Trash 234 
to System Folder 122-123 
with keypad 130-131 

O\'er text ~9 
size box 15 
window title bar 21-22 

Drive button~ switching disks 
with 99 

drivers. See device drivers 
Duplicate command (File menu) 

64,243 
duplicating documents 64-67, 

243. See also copying 



E 
Easy Install option (Installer) 89 
editing 

desktop pattern 135-136 
text 41. 48-49, 52-53 

Edit menu 
Clear command 53 
Cut command 52 
Paste command 52 

800K floppy disks. See <louble­
sidcd floppy disks: 
floppy disks 

Eject Disk command (Special 
menu) 105 

ejecting disks 
shortcut for 105 
with Eject Disk command 

105 
with Put Away command 32, 

59~ 105,242 
"'ith Trash 105 

electrical grounding 220 
electronic bulletin boards 93. 

201. See also networks 
empty documents 41 

Empty Trash command (Special 
Menu) 35 

disabling 148 
Erase Disk command (Special 

menu) 101 
erasing 

floppy disks 
during initialization 

28-29. 97. 100 
with Erase Disk command 

101 
with Trash 34-35, 236 

text 
with Clear command 53 
·with Clear key 245, 247, 

249 
with Cut command 52 
with Delete key 53. 245. 

247. 2"19 
error messages 227, 231. See 

also troubleshooting 
Escape key 245-246, 248 
EtherTalk networks 172-173. 

See also nem·orks 
exchanging disk and files with 

MS-DOS and Apple II 
computers 252-256 

expanding 
Macintosh system 209-218 
memory 218 

expansion cards 216-218 
expansion slots 216-217 
Extended Keyboard II 248-249 
external devices. See also 

peripheral devices or 
specijlc del'ice 

connecting 209-212 
turning off 6 
turning on 'l 

external floppy disk drives. See 
also disk drives: floppy 
disk drives 

connecting 214 
ejecting disks from 105 

external hard disks. See also 
disks: hard disks 

connecting 209-212 
ensuring recognition of 102 
SCSI ID number for 106 
turning off 6 
turning on 4. 102 

eyestrain, avoiding 86 

F 
fatigue, avoiding 86 
File menu 

Close command 242 
Close Window command 22. 

31 
Duplicate command 64 
Find Again command 

115-116 
Find command 114-117 
Get Info command 74. 95, 

103, 113, 119-120 
Make Alias command 70. 

112 
New Folder command 69, 

110 
New User command 186 
Open command 13-14, 16. 

31 
Page Setup command 

156-157 
Print command 56-57 
Print Window command 160 
Put Away command 32, 35, 

59. 105. 114, 178 
Save As command 66-67. 

118 
Save command 41-42, 51 
Sharing command 199 
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files. See also directories; 
documents; folders; 
icons; software 
programs; system 
software; text 

accessing on other 
computers 175-180 

adding 
to folders 69-72 
to system software 90 

aliases for 70-72, 104, 
112-113 

arranging on desktop 109 
backing up 58-59, 104, 243 
closing 45 
converting to and from MS­

DOS or ProDOS 
254-256 

copying 58-59, 64, 235 
creating 41 
damage from vimses 93 
directories of 111 
erasing with Trash 34-35, 

236 
exchanging with MS-DOS 

and Apple II 
computers 252-256 

finding 114-117 
folders and. See folders 
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files (conti11uedJ 
getting information about 

(Get Info) 74, 119-120 
graphics 226 
installing in Apple menu 

113. 122 
locked 117 
locking 103, 119 
moving 

on desktop 235 
to desktop 114 

MS-DOS 252-256 
naming 41-42, 63-65 
networks and 169-208 
opening 

at startup 122 
by double-clicking 48, 

234 
\Vith Open command 

13-14, 16 
organizing 61-75, 109-120 
Postscript 168 
printing 56-57. 152-168 
ProDOS 252-256 
protecting 102 
removing 

from disk 34-35, 236 
from System Folder 123 

renaming on desktop 64-65 

files (co111i11ued) 
saving. See saving documents 
searching for 114-117 
sharing over networks 

180-197 
storing in more than one 

folder 70-72 
unlocking 117 
"untitled" 41 
viewing on networks 198 

file servers. See also networks 
aliases and 112 
converting MS-DOS files on 

256 
definition of 175 
system software and 89 
vimses and 93 

file sharing 175, 182-189. See 
also networks 

activating 183-184 
disabling 193 
monitoring activity of 

194-195 
File Sharing Monitor control 

panel 194 
filing system. See desktop; files: 

Finder; folders 
Find Again command (File 

menu) 115-116 
shortcut for 115 

Find command (File menu) 
114-117 

shortcut for 114 
uses for 117 

Finder. See also desktop 
activating 43-44 
icon for 43, 94 
printing documents from 159 
printing window contents 

from 160 
purpose of 43-44 
shortcuts for 241 

Finder command (Application 
menu) 44 

finding files or folders 
with aliases 112-113 
with Find command 114-117 

5.25-inch disks (MS-DOS) 252 
fixed-size fonts 162-163 
floppy disk drives. See also disk 

drives; floppy disks 
care and maintenance of 221 
connecting 214 
ejecting disks from 32, 59, 

105,242 
external 105. 214 
inserting disk into 26, 241 
SuperDrive 26, 32 

floppy disk icon 18, 30 



floppy disks 97-108. See also 
disks; floppy disk 
drives; hard disks 

as startup disks 88, 92 
capacities of 27 
care and maintenance of 34, 

221 
compared with hard disks 30 
copying contents of 29-31, 

104, 241 
damaged 104 
description of 27, 30 
double-sided (800K) 26-27 
ejecting 

shortcut for 105 
with Eject Disk command 

105 
with Put Away command 

32, 59, 105 
with Trash 105 

erasing 
during initialization 

28-29, 100 
with Erase Disk command 

101 
with Trash 34-35 

5.25-inch (DOS) 252 
full 104 
handling 221 
high-density (1.4 MB) 26-27, 

33 

floppy disks (continued) 
initializing 28-29, 99-100 

in ~IS-DOS or ProDOS 
format 252-253 

inserting into drive 26, 241 
labeling 26 
locking/unlocking 33, 

102-104. 242 
naming 100 
older Macintosh computers 

and 27 
1.4 MB 26-27, 33 
quick reference for 241-242 
reference for 97-108 
removing from drive 242 
renaming on desktop 100 
saving files on. See saving 
testing and repairing 

106-108 
types of 26-27 
untitled 100 

folders. See also files; icons; 
software: System 
Folder 

access privileges and 
180-181. 199-201 

adding files to 69, 70-72 
aliases and 70-72. 112 
Apple Menu Items folder 

113, 122 

folders (continued) 
as bulletin boards 201 
creating 

on desktop 69, 110 
on shared disks 180-182 

directories of 111 
dragging icons to 236 
erasing with Trash 34-35 
finding with find command 

115-117 
higher-level. opening 238 
locking 104 
naming 69, 110 
nesting 110 
networks and 180-182. 

199-201 
opening 13. 238 
organizing icons in 68-69 
outline views of 238 
owned 180-182. 192. 197 
privacy and 201 
purpose of 19, 110 
searching for 114-117 
shared 184-185 
Sta1tup Items folder 122 
storing files in more than one 

70-72 
"untitled" 69 
viewing contents of 238 
viewing on networks 198 

fonts 162-168 
adding to System Folder 164 
appearance of 225-226 
hitmapped 162-163, 

225-226 
definition of 162 
displaying 166 
downloading 165 
installing 164 
outline 162-163, 165, 

225-226 
Postscript 165 
printing 225-226 

list of 166 
samples of 166 

removing from System Folder 
123, 164 

software programs and 166 
transferring to LaserWriter 

165-166 
TrueType 163, 226 

forms. See stationery pads 
"frowning .. Macintosh icon 229 
frozen system 227 
full disks 104 
function keys 23. 248 
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G 
General Controls (Apple Menu) 

changing blinking of 
insertion point with 
137 

changing desktop pattern 
with 135-136 

changing menu item blink 
rate with 137 

setting time and date with 
125-126 

Get Info command (File menu) 
74, 95, 103, 113, 
119-120 

aliases and 113 
reference for 119-120 
shortcut for 119-120 

graphics 
copying 139 
pasting 140 

graphics files 226 
graphics programs 139 
gray-scale printing 159 
gray shades. customizing 

142-143 
grounded outlets 220 
Group icon 188 
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guest network users 

H 

access privileges for 186, 
197-198 

connecting to shared disks 
17i 

denying access to 191-192 
linking to programs 206-207 
sharing owned folders with 

180 

halftone printing 159 
handling system components 

219-221 
"happy Macintosh'' kon 5, 229 
hard disk drives. See hard disks 
hard disk icon 18. 30 

removing from desktop 105 
hard disks 97-108. See also 

disks; floppy disks 
as startup disks 88, 101-102 
A/UX and 89-98 
compared with floppy disks 

30 
description of 30 

hard disks ( co11ti11uedJ 
external 30 

connecting 209-212 
Macintosh recognition of 

102 
SCSI ID number for 106 
turning off 6 
turning on 4 

hard disk space as memrny 
150-151 

initializing 98-99, 167 
installing software on 29-31. 

36-37.92 
internal, built-in terminator 

for 212 
naming 99 
precautions for 106 
reference for 97-108 
SCSI ID numbers of 98-99 
sharing over networks 175, 

184-185 
testing 108 
volume names of 98 

hardware developers. assistance 
for 259 

hardware, setting up 85-87 

HD SC Setup. See Apple HD SC 
Setup program 

headphones, connecting 215 
Help icon 78 
Help menu 239 

Hide Balloons command 79 
Show Balloons command 

78-79 
Help System 78-79. 239 
Hide Balloons command (Help 

menu) 79 
Hide Others command 

(Application menu) 95 
high-density disks ( 1.4 MB). See 

also floppy disks 
description of 26-27 
initializing 28-29, 99-100 
locking/unlocking 33 

highlight colors, changing 
140-141 

highlighted icons 9, 13, 31 
highlighted text 49 



I, J 
I-beam pointer 48 
IBM-compatible disks and files. 

See.MS-DOS 
icons 235-236. See also 

desktop; disks; files; 
folders 

ADB port 214 
adding to folders 69 
Alarm Clock 127 
alias 70 
Apple HD SC Setup 98. 108 
AppleShare 176 
Application menu 40, 94 
arranging on desktop 109 
assigning colors to 140 
Brightness 145 
Calendar 126 
changing appearance of 

139-140 
changing name of 64-65 
clicking 9, 233-234 
CloseVicw 146 
copying 58, 235 
deselecting 235-236 
device driver 210 
dimmed 94 
disk 18 
disk drive port 214 

icons (co11ti1111edJ 
double-clicking 48, 234 
dragging 10-11. 234 

from Trash 35 
on a sirigle disk 234 
to another disk 104. 234 
to desktop 114 
to System Folder 122-123 
to ll"ash 234 
with keypad 130-131 

Finder 43, 94 
floppy disk 18. 30 
folders and 68-69, 185, 236 
getting infom1ation about 

(Get Info) 74. 95. 103. 
113, 119-120 

Group 188 
"happy Macintosh'' 5. 229 
hard disk 1-5, 18, 30 
Help 78 
highlighted 9. 13, 31 
Keyboard 129 
labeling 140 
Labels 124 
Memory 149-150 
modem port 213 
:i.Ionitors 142-143 
naming 64-65 
\etwork 173 
New Group 187 
opening 13, 48, 234-235 

icons f continuedJ 
organizing 68-69 
pointing to 8 
pressing 9 
printer 54. 154 
Printer port 213 
purpose of 18, 235 
question mark(?) disk 5, 88. 

229 
quick reference for 235-236 
removing 236 
renaming 100, 235 
"sad Macintosh.. 229 
SCSI 209 
selecting 235-236 

by clicking mouse 9, 
233-23~i 

by clicking with keypad 
130-131 

more than one by Shift-
clicking 234 

shared folders 185 
Sharing Sen1p 174, 183 
Sound 132 
sound input 134, 215 
sound output 215 
Stationery pad 118 
Trash 14-15. 19, 22, 34-35 
types of 18 
Views 138 
X disk 229 

ID numbers. See SCSI ID 
numbers 

images. See also icons 
inverted 147 
reduced 156 
snapshots of 226 

lmage\Vriter printers. See also 
printers; printing 

connecting 213 
Page Setup dialog box for 

156 
Select light on 160-161 

initializing disks 97-100 
floppy disks 28-29, 99-100. 

252-253 
hard disks 98-99, 167 
MS-DOS or ProDOS disks 

252-253 
INils 122 
inserting 

floppy disk into drive 26, 211 
text 49 

insertion point. See also pointer 
changing blink rate of 137 
definition of 48 
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Installer 88-91 
Customize option 90 
Easy Install option 89 
Minimal software option 91 
networks and 89 
updating printer drivers on 

networked computers 
with 157-159 

installing 
alert sounds 133 
CloscView 146 
drivers 122, 154-159, 210 
expansion cards 216-217 
files in System Folder 

122-123 
fonts 164 
items in Apple menu 113, 

122 
printer drivers 

in System Folder 154-155 
on networked computers 

157-159 
software on hard disk 29-31, 

36-37,92 
system software 88-91 

customized system 90 
small system 91 
standard system 89 
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interference. radio and TV xiii, 
216,220 

internal floppy disk drive. See 
floppy disk drives; 
SuperDrive 

internal hard disks. See disks: 
hard disks 

international keyboards 130 
interrupt and reset switches 227 
inverting images on screen 147 

K 
Keyboard control panel 

129-130 
keyboard files. removing from 

System Folder 123 
Keyboard icon 129 
keyboards. See also keyboard 

shortcuts; keys 
adjusting 

for slow typing 132 
position of 86-87 

Apple Extended Keyboard II 
248-249 

Apple Keyboard 246-247 
care and maintenance of 220 

keyboards fco11ti11uedJ 
character sets and 244-251 
customizing 129-130, 132 
description of 244-251 
international use of 130 
layout, changing 130 
Macintosh Classic 244-245 
non-English characters and 

250 
special characters and 250 
spills on 220 
trouble with 230 

keyboard shortcuts 
CloseVicw and 147 
customizing with Sticky Keys 

131 
ejecting floppy disks 105 
Find Again command (X-G) 

115 
Find command (X-F) 114 
Finder and directory dialog 

boxes 241 
Get Info command (X-D 119 
Print (X-P) 159 
purpose of 51 
Quit command (X-Q) 57 
Save (X-S) 51, 242 

Key Caps (Apple menu) 
250-251 

keyboard commands 23 

keypad, numeric 
controlling pointer with 

130-131 
description of 245, 247, 249 

keys. See also keyboards; 
keyboard shortcuts; 
keypad 

arrow keys 23, 241, 245, 247, 
249 

CapsLock 244,246,248 
character keys 131, 241 
Clear 245, 247, 249 
Command 23, 244, 246, 248 
Control 244, 246, 248 
Delete 40, 49, 53, 245, 247, 

249 
Enter 245, 247, 249 
Escape 245-246, 248 
function kcvs 23, 248 
layout of, changing 130 
modifier keys 23, 131, 

250-251 
numeric keys 245, 247, 249 
Option 109, 244, 246, 248 
Power On 4, 245, 247, 249 
repetition rate of 129 
Return 245, 247, 249 
Shift 23. 51. 244, 246, 248 
Tab 241.244, 246.248 



L 
labeling. See also naming 

floppy disks 26 
icons 140 

Label menu, changing items in 
124-125 

Labels icon 124 
LaserWriter Font Utility 165-168 

downloading fonts with 
165-166 

finding out about fonts with 
166 

initializing hard disks with 
167 

restarting LaserWriter with 
168 

transferring PostScript files 
with 168 

turning sample page on or 
off with 167 

LaserWriter printers. See also 
printers; printing 

background printing with 
161-162 

connecting 213 
LaserWriter Font Utility and 

167-168 
LaserWriter IINT 213 
Personal LaserWriter SC 55, 

154, 213 
Print dialog box for 159 
restarting 168 
transferring fonts to 165-166 
transferring Postscript files to 

168 
linking programs over networks 

202-207 
LocalTalk networks 171. See 

also networks 
locating files or folders 114-117 
locked files, searching for 117 
locking 

files 103, 119 
floppy disks 33, 242 
folders 104 
mouse button with keypad 

131 

M 

Macintosh. See also specific 
model or topic 

adapting to your own use 
121-152 

basic skills for 1-81 
care and maintenance of 

219-223 
connecting components to. 

See connecting 
expanding 209-218 
naming for network use 

174-175 
networks and 169-208 
obtaining additional 

information about 257 
operating environment for 

223 
reference for 83-259 
restarting 227 
setting up 85-96 
starting 4-5 
"talking" to 12 
trouble with. See 

troubleshooting 
turning on and off 3-6 
viruses and 93 

Macintosh Classic 
monitors and 216 
turning on/off 4, 6 

.Macintosh desktop. See desktop 
Macintosh LC 

expansion slot in 217 
sound inpur and 134 
turning on/off 4, 6 

Macintosh II 
NuBus slots and 217 
turning on/off 6 

Macintosh Ilci 
expansion slot in 217 
monitors and 216 

Macintosh Ilfx 
cable terminator for 212 
monitors and 216 

Macintosh Hsi, slot adapter for 
217 

Macintosh user groups 257 
magnifying screen images 

146-147 
maintenance 219-223 

cleaning components 
221-223 

floppy disks 34 
keyboard 220 
monitor 220 
spills, dealing with 220 
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Make Alias command (File 
menu) 70. 112 

.\lake Changes access privilege 
198 

managing mcmo1y 148-151 
manual paper feed 162 
memory 148-152 

checking use of 148-149 
clearing 227 
disk cache 149 
expanding 218 
hard disk space as 150-151 
managing 148-151 
memory cache expansion 

slots 216-217 
Memoiy control panel 

149-152 
memory expansion cards 

218 
networks and 149 
RAM 148-151 
software programs and 

95-96 
32-bit addressing 152 
video and 143 
virtual mcmmy 149-151 

Memory icon 149-150 
memos. See stationery 

documents 
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menu bar, appearance of 5 
menus 18-19, 239-240 

changing blinking rate of 
items in 137 

choosing items from 12, 240 
dimmed icons in 94 
displaying 239 
opening 234 
pop-up 111, 239-240 
pull-down 239-240 
purpose of 18-19 
quick reference for 239-240 
suhmenus 240 
titles 239 
viewing options in (pressing) 

9 
\Yorking with 239-240 

microphones 134. 215 
modem port 55, 154, 213 
modem port icon 213 
modems. connecting 213 
modifier keys 23. 131. 250-251. 

See also keys 
monitors. See also screen 

additional 143-144, 216 
care and maintenance of 220 
configuring multiple 

1-B-144 

monitors ( co11ti1111ed) 
connecting 216 
icons for 1-13 
ID numbers for 144 
interference on 216 
large 216, 220 
position of 86 
trouble with 230-231 
turning on/off 4. 6 

Monitors control panel 142-14~1 
Monitors icon 142-143 
mouse 

button 
changing double-click 

speed of 129 
locking and releasing with 

keypad 131 
cleaning 222-223 
clicking (selecting) objects 

with 9, 233-234 
controlling with keypad 

130-1.31 
customizing operation of 

128-129 
double-clicking (opening) 

objects with 48, 53, 
Zlt 

mouse ( cuntinuecV 
dragging objects with 10-11. 

234 
holding 10 
pointing at objects with 8, 

233 
pressing objects with 9. 234 
quick reference for 233-234 
Shift-dicking (selecting) 

objects with 51, 34, 
234 

techniques for 8-11. 
233-234 

trouble moving pointer with 
230 

Mouse control panel 128-129 
.Mouse Keys. controlling pointer 

with 130-131 
moving 

icons (dragging) 10-11, 233 
items to desktop 114 
text 51-53 
windows 21-22. 237 

MS-DOS 252-256 
converting files to and from 

254-256 
initializing disks for 252-253 

multiple monitors. configuring 
143-144 



N 
naming 

documents 41-42, 63 
floppy disks 100 
folders 69. 110 
groups of network users 

187-188 
hard disks 99 
icons 235 
Macintosh and owner for 

network use 174-175 
registered network users 186 
users to link programs 207 

network administrator 171, 174, 
176 

Network control panel (Apple 
menu) 173-174 

network drivers, removing from 
System Folder 123 

Network icon 173 
nemurks 169-208 

accessing Macintosh while 
away from it 195-196 

access privileges and 
180-182. 197-207 

AppleTalk 55-56, 155-157, 
171-172, 177 

capabilities of 170-171 

networks rco111i1111ed) 
choosing printer for 155-157 
configuring Macintosh for 

172-175 
connecting to 171-1 i2 
copyright laws and 185 
disconnecting users on 194 
EtherTalk 172-173 
groups of users on 187-192 
guest users on 177. 180, 186. 

191-192. 197-198. 
206-208 

Installer and 89 
installing printer drivers on 

157-159 
Local'Ialk 171 
memory and 149 
naming Macintosh and its 

O\Yner 174-175 
passwords and 175, 177, 

180-181. 196-197 
printers and 55-56 
privacy and 185, 201 
registered groups on 182, 

197-199 
registered users on 177, 180, 

182, 185-186, 191, 
197-199 

restricting access to 191 

net\YOrks (cu11ti11uedJ 
selecting network connection 

173 
setting up .\lacintosh for 

171-175 
shared disks and 18. 

175-182 
sharing files and folders on 

180-187 
software programs and 

202-207 
TokenTalk 172-17 3 
viruses and 93 
zones 55-56. 173-174 

default 174 
selecting 56. 155, 

173-174, 177 
:\ew Folder command (file 

menu) 69, 110 
New Group icon 187 
New User command (file menu) 

186 
non-English characters 250-251 
NuBus expansion cards and 

slots 216-217 
numeric keypad, controlling 

pointerwith 130-131 
numeric keys 245, 247. 219 

0 
office, arranging 86 
on/off switch 4. 6 
1.4 MB floppy disks. See floppy 

disks; high-density 
disks 

Open command (File menu) 
13-14, 16, 31 

opening 
aliases 112 
documents 48. 68 
files 

at starn1 p 122 
by double-clicking 48. 

234 
with Open command 

13-14, 16. 68 
folders 13. 238 
icons 48, 234-235 
menus 234 
software programs 40. 94, 

242 
statione1y pads 118 
System Folder 16 
Trash 35 

open software programs. See 
active software 
program 
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operating environment for 
Macintosh 223 

operating systems. See also 
system software 

A/UX 89, 98 
MS-DOS 252-256 
ProDOS 252-256 
System 6 91, 163, 208 
System 7 91, 148, 208 

Option key 109, 244, 246, 248 
organizing files 109-120 
organizing your work 61-75 
outline fonts 162-163, 165, 

225-226 
outline views of folders 238 
owned folders 180-182, 197 

transferring ownership of 
182. 192 

p 

Page Setup (File menu) 156-157 
paper. See also printing 

feed, manual 162 
sizes, changing 156 
supply, monitoring 162 
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passwords. See also networks 
changing 196-197 
setting 187 
typing 174-175, 180 
unaccepted 177 

Paste command (Edit menu) 52 
pasting 

graphics 140 
text 52 

pattern of desktop, changing 
135-136 

peripheral devices. See also 
specific device 

connecting 209-217 
handling 219-221 

peripheral interface cahle. See 
SCSI peripheral 
interface cable 

Personal LaserWriter SC 55, 154, 
213 

phono jack adapters 134 
pictures. See graphics 
pointer 

arrow 8 
controlling from keyboard 

130-131 
controlling with mouse 

8-1 L 233 
I-beam 48 
trouble moving 230-231 

pointing at objects with mouse 
8.233 

pop-up menus 111, 239-240. 
See also menus 

ports 
ADB poll 214 
definition of 209 
disk drive port 213 
modem port 55, 154, 213 
printer port 55, 154. 171, 213 
SCSI port 209. 211 
sound input port 134, 215 
sound output port 215 
video port 216 

PostScript 165 
files, transferring to 

LaserWriter 168 
fonts 225-226 
printers 226 

power 
requirements 

of AD B devices 214 
of NuBus expansion cards 

217 
trouble with 228 
turning on/off 4-6 

Power On key 4, 245, 247. 249 
power supply 221 
power switch 4, 6, 228 

preparing disks for use. See 
initializing 

pressing ohjects with mouse 9, 
234 

Print command (File menu) 
56-57, 159 

shortcut for 159 
printed circuit boards. See cards 
printer drivers. See also system 

software 
installing in System Folder 

154-155 
installing on networked 

computers 157-159 
printer fonts. See fonts 
printer port 55~ 154, 171, 213 
Printer port icon 213 
printers. See also p'rinting or 

specific printer 
choosing 54-56, 153-156 
connecting 213 
drivers for 154-155, 157-159 
icons for 54, 154 
ImageWriter 156, 159-162, 

213 
LaserWriter 55, 154, 167-168, 

213 
networks and 55-56 
Postscript 226 
telling computer which to 

use 54-56, 153-156 
trouble with 160-161 



Printer Update document 
(Printing disk) 157 

printing 56-57, 152-168. See 
also printers 

background 156, 160-162 
canceling 161-162 
color or gray-scale 

documents 159 
fonts 162-168, 225-226 
from Finder 159 
learning about 56-57 
manual paper feed 162 
monitoring status of 162 
options for 156-157, 

159-160 
reduced images 156 
reference for 152-168 
sample pages 167 
setting print time 161-162 
several documents 161 
while using computer for 

other work 156. 
160-162 

window content'> 160 
Printing disk 157 
Print.Monitor 156, 161-162 
Print Window command (File 

menu) 160 

problems. See troubleshooting 
processor-direct expansion slots 

216-217 
ProDOS 252-256 

converting files to and from 
254-256 

initializing disks for 252-253 
programs. See software 

programs 
protecting disks. See locking 
pull-down menus 239-240. See 

also menus 
Put Away command (File menu) 

disconnecting from shared 
disks with 178 

Q 

ejecting disk with 32, 59, 105 
moving items to desktop with 

114 
restoring Trash items with 35 

question mark(?) disk icon 5, 
88 

Quit command (File menu) 57. 
243 

quitting software programs 57, 
243 

R 

radio interference xiii, 216. 220 
RAM (random-access memory). 

See aLm memory 
checking use of 148-149 
expanding 218 
managing 148-151 

rearranging icons on desktop 
109 

recording sounds 134 
recovering items from Trash 35 
reduced images, printing 156 
registered network groups. See 

also networks 
access privileges for 197-201 
giving folder ownership to 

182 
registered network users. See 

also networks 
access privileges for 197-201 
connecting to a shared disk 

177, 180 
giving folder ownership to 

182 
naming 185-186 
removing membership of 

191-192 
reinstalling system software 

88-91 

releasing mouse button with 
keypad 131 

removing. See also deleting; 
erasing 

alert sounds 134 
disk from drive 32, 59, 105, 

242 
files from System Folder 123 
fonts from System Folder 164 
icons from desktop 236 
items from Apple menu 113, 

122-123 
System Folders, extra 37 
users from a network 

191-192 
renaming icons 64-65, 235 
repairing disks 106-108 
reset and interrupt switches 227 
resizing windows 43, 237 
Restart command (Special 

menu) 227 
restarting 

LaserWriter 168 
Macintosh 227 

restricted network access 
180-181, 191 

Return key 245, 247, 249 
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s 
"sad tvlacintosh ·· icon 229 
sample pages, printing 167 
Save As command (File menu) 

66-67, 118, 243 
compared with Save 

command 67 
Save command ffile menu) 

41-42, 51, 242 
compared with Save As 

command 67 
shortcut for 51. 242 

saving documents 
as aliases 70-72 
as stationery pads 73, 118 
different versions of 66-67 
on different disk 58-59 
trouble with 104 
with Duplicate command 64 
with Save As command 

66-67, 243 
with Save command 41-42, 

51. 242 
scalable fonts 162-163 
scanners, drivers for 122 
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screen. See also monitors 
brightness control 1 •6. 220, 

228 
burn in, avoiding 220 
capturing "Snapshot" of 226 
changing colors and gray 

shades on 140-143 
cleaning 221 
contrast control 145 
damage to 115 
dark 228 
interference on 216, 220 
inverting images on 147 
magnified images on 

146-147 
trouble with 228. 230-231 

screen saver programs 145, 220. 
228 

scroll arrows 16-17. 20, 237 
scroll bars 16-17. 20, 237 
scroll box 20. 237 
SCSI cables 211 
SCSI chains 210-211 
SCSI devices 209-212 

built-in tem1inators for 212 
chains of 210 
connecting 209-212 
turning on 212 
types of 210 

SCSI hard disk. testing 108 
SCSI icon 209 
SCSI ID number indicator 211 
SCSI ID numbers 

hard disks 98-99. 106 
monitors 14•! 
setting 211-212 

SCSI ID number switch 211 
SCSI peripheral interface cable 

211 
SCSI pott 209, 211 
SCSI terminators 212 
searching for files and folders 

114-117 
See Files access privilege 198 
See Folders access privilege 198 
selecting 

disks or folders to share 
184-185 

icons 
by clicking mouse 9, 

233-234 
by clicking with keypad 

130-131 
by Shift-clicking 234 

multiple items 51, 234 
programs for linking 205 
text 

by double-clicking 53 
by dragging and 

highlighting 49-50 
by Shift-clicking 51 

Select light (lmageWriter printer) 
160-161 

service agreement 224 
setting 

Alarm "Clock 127-128 
alert sounds 132-135 
net\vork access privileges 

199-201 
network passwords 187 
print time 161-162 
SCSI ID numbers 211-212 
time and elate 125-126 

setting up 85-96 
for networks 171-175 
hardware 85-87 
system software 88-92 

shared disks 18, 175-185. See 
also networks 

access privileges and 
180-181. 199-201 

connecting to 176-180 
at startup 179-180 
with aliases 179 

copying files to or from 180 
creating folders on 180-182 
disconnecting from 178 
limited access to 176 
privacy and 185. 201 
sharing files and folders on 

180-182 



shared files 182-197. See also 
networks 

shared folders 184-185. See also 
networks 

Sharing command (File menu) 
199 

Sharing Setup control panel 
183,205 

Sharing Setup icon 174, 183 
Shift-clicking 

to select multiple items 234 
to select text 51 

Shift key 23, 51, 244, 246, 248 
Show All command (Application 

menu) 94 
Show Balloons command (Help 

menu) 78-79 
Shut Down command (Special 

menu) 
disconnecting from shared 

disks with 178 
shutting down Macintosh 

with 6 
silent alerts 133 
SIMMs (Single In-Line Memory 

modules) 218 
size box for windows 15, 17, 43, 

237 
slots. See expansion slots 

Slow Keys 132 
Small Computer System 

Interface. See SCSI 
small system software, installing 

9i' 
smiling Macintosh icon 5, 229 
software developers, assistance 

for 259 
software programs. See also 

documents; files: 
menus; system 
software 

activating 94. 242 
active 43-45, 48, 68, 94, 242 
aliases for 112 
hacking up 92 
documents and. See 

documents 
folders and 110 
fonts and 166 
graphics programs 139 
installing 

in Apple menu 122 
on hard disk 29-31, 

36-37,92 
locking 103 
memory usage, changing 

95-96 
networks and 202-207 

software programs (continued) 
opening 40,94,242 
purpose of 19 
quick reference for 242-243 
quitting 57, 243 
saving documents in. See 

documents, saving 
screen saver 145, 220, 228 
setting up 25-37 
switching 43-45, 94, 242 
trouble with 231-232 
types of 44 
upgrading 92 
virus-detection/elimination 

93 
working with several at once 

94 
Sound control panel 132-135 
Sound icon 132 
sound input devices 134 
sound input port 134, 215 
sound output port 215 
sounds 

customizing 132-135 
recording 134 
removing from System Folder 

123 
speakers, connecting 215 
speaker volume, changing 

132-133 

·special menu 
Clean Up command 12, 109 
Eject Disk command 105 
Empty Trash command 35, 

148 
Erase Disk command 101 
Restart command 227 
Shut Down command 6, 178 

special symbols 250-251 
spills, dealing with 220 
starting up Macintosh 4-5 
startup. See startup disk; system 

startup 
Startup Disk control panel 101 
startup disk. See also disks; 

System Folder; system 
software; system 
startup 

bypassing internal hard disk 
as 102 

floppy disks as 92 
hard disks as 101-102 
purpose of 5, 30 
rebuilding desktop of 228 
removing extra System Folder 

from 37 
search sequence for 102 
setting up 88-92 
System Folder and 37 
virtual memory and 151 
viruses and 93 
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Startup Items folder 122 
stationery pads 72-75, 118 

creating 72-75 
icon for 118 
opening 118 
saving 73, 118 

Sticky Keys 131 
straightening up files 109 
submenus 240 
SuperDrive 26, 32. See also 

disks; floppy disk 
drives 

support and service 224 
switches. See on/off switch; reset 

and interrupt switches; 
SCSI ID switch 

System 6 91. 163. 208 
System 7 91-92, 148, 208 
system cable. See SCSI system 

cable 
system extensions 122 
System file, installing alert 

sounds in 133 
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System Folder. See also stam1p 
disk; system software 

adding alert sounds to 133 
adding fonts to 164 
Apple Menu Items folder 113 
customizing 122-123 
danger of using more than 

one 91 
dragging items to 122-123 
fonts and 162-168 
installing device drivers in 

154-155. 210 
installing files in 122-123 
installing printer drivers in 

154-155 
on software program disks 

92 
opening 16 
purpose of 30, 88 
removing extra 37 
removing files from 123 
removing fonts from 164 
setting up 88-92 
Startup Items folder 122 

system software. See also 
software; startup disk; 
System Folder 

customizing 122-123 
fonts and 162-168 
installing, reinstalling, 

updating 88-92 
customized system 90 
small system 91 
standard system 89 

networks and 89 
purpose of 44 
trouble with 229 
virtual memory and 151 

system sta1tup. See also startup 
disks 

connecting to shared disks 
during 179-180 

customizing files for 122 
floppy disks and 92 
trouble with 229 

T 
Tab key 241, 244, 246, 248 
''talking" to Macintosh 12 
technical infom1ation, obtaining 

258 
television interference xiii 
templates (stationery pads) 

72-75. 118-119 
terminators. See cable 

terminators 
testing and repairing disks 

106-108 
text. See also documents 

accent marks and special 
characters 250-251 

cutting 52 
dragging over 49 
editing 41, 48-49, 52-53 
erasing 

with Clear command 53 
with Clear key 245, 247, 

249 
with Cut command 52 
with Delete key 53, 245, 

247,249 
highlighted 49 
I-beam pointer and 48 



text (continued) 
inserting 49 
moving 51-53 
pasting 52 
selecting 49-51 

by double-clicking 53 
by dragging and 

highlighting 49-50 
by Shift-clicking 51 

typing 41 
32-bit addressing 132. See also 

memory 
3.5-inch disks. See floppy disks 
time 

setting Alarm Clock 127-128 
setting system clock 125-126 

tips and troubleshooting 
225-232 

title bar for windmrs 21-22 
TokenTalk networks 172-173. 

See also networks 
tracking speed (mouse). 

changing 129 
transferring 

fonts to Laser\\;'riter 165-166 
Postscript files to LaserWriter 

168 
translating MS-DOS and ProDOS 

files 254-256 

lhish 34-35 
activating 14-15 
dosing 22. 35 
deleting items with 3-:i-3i 

236 
disconnecting from shared 

disks with 178 
dragging icons to 234 
ejecting floppy disks with 

105 
emptying 35: \varning, 148 
opening 35 
purpose of 19 
recovering items from 35 

troubleshooting 225-232 
aliases 112 
Apple menu items 113 
dark screen 228 
desktop fails to appear 229 
disks 106-108 
error messages, responding 

to 227 
expansion cards 217 
frozen system 227 
monitors 228 
network pass,rords 177 
pointer does not move 230-

231 
printing 160-161 

troubleshooting ( conti1111edl 
saving files on floppy disk 

10~1 

software program quits 
unexpectedly 232 

system soft\rare 229 
system sta11up 229 
typing produces nothing on 

screen 230 
lh1el)'pe fonts 163. 226. See 

also fonts 
turning Alarm Clock on/off 

12i-128 
turning AppleTalk on 172 
turning CloseView on/off 146 
turning external cb·ices on/off 

4.6 
turning external hard disks on 

102 
turning file sharing off 193 
turning file sharing on 183-184 
turning ~lacintosh on/off 4-6 
turning monitor on/off 'l. 6 
turning SCSI devices on 212 
turning Sluw Keys on/off 132 
turning Sticky Keys on/off 131 
turning 32-bit addressing on 152 
turning virtual memory on 151 
TV interference 216. 220 

two-sided disks. See douhlc­
sided floppy disks 

typefaces. See fonts 
typing. See also keyboards: keys: 

text 

u 

non-English characters and 
special symbols 
250-251 

practice for 41 
slow, adjusting keyboard for 

132 
trouble with 230 

unlocking 
files 117 
floppy disks 33. 242 

untitled 
disks 100 
folders 69 
\Yinclcm·s 40-41 

updating system software 88-92 
user groups for Macintosh 257. 

See also registered 
network user groups 
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Users & Groups control panel 
(Apple menu) 

accessing your remote 
computer with 195 

linked programs and 

v 

206-207 
naming users with 185-188 
restricting access with 191 
setting passwords with 187 

variable-size fonts 162-163 
video, built-in 143 
video cards 143, 216 
View menu 120, 140, 238 
Views control panel 138 
Views icon 138 
virtual memory 149-151. See 

a/so memory 
viruses 93 
volume. changing 132-133 
volume names of hard disks 98 
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w 
windows 

activating 14-15. 43-45, 236 
border color, changing 142 
closing 21-22, 31, 237 
color. changing 140, 142 
customizing display of 138 
displaying contents of (Viev.r 

menu) 120 
hiding and showing 94 
highlight color, changing 142 
moving 21-22, 237 
printing contents of 160 
purpose of 18-19 
quick reference for 236-238 
scroll bars 237 
scrolling 16-17, 20, 237 
size. changing 15-17, 43. 

237 
title bar 21-22, 237 
untitled 40-41 
viewing contents of 14-20 
viewing in outline fom1 238 
zoom box and 15-16, 237 

work groups, viruses and 93 
work space. See desktop 

XY 
' 

X disk icon 229 

z 
zones, AppleTalk 55-56 
zoom box 15-16, 237. See also 

windows 
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